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Preface 

This book is about object-oriented programming in C. But, 
more than that, it stresses the ease with which object-ori
ented programs can be developed with the aid of an excellent 
development environment, an extremely robust class library, 
and a powerful user interface design and code-generation 
tool. 

The book describes the evolution of a complete, multipurpose 
application, starting from a skeleton application, automatically 
generated by AppMaker. The user interface of the skeleton ap
plication is enhanced within AppMaker to create a single Edit
Text window, in which text can be written in any font, style, or 
justification. The generated code is enhanced to provide the 
capability of changing the selected text style, size, and justifi
cation, using a custom-designed dialog box for making these
lections. Custom code is also provided to write the text to a file 
and have the ability to open the file at a later date, revise the 
text, and save the file with the same or a different name. The 
book describes all of the custom additions to the code, in a 
manner that shows how the application can gradually evolve 
from a mere skeleton to a full-fledged Macintosh application. 

In subsequent chapters, a spreadsheet window is designed, 
the generated code for this new addition to the application is 
described, and the custom code to make it fully functional is 
covered in full. This is the third stage of evolution for the appli
cation. A dialog for changing the characteristics of the spread
sheet window is then designed, implemented, and described. 

The penultimate addition to the application is a drawing win
dow, in which graphs depicting patterns in the spreadspeet 
data are prepared. The user interface design, the generated 

xvii 
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code, and the customizing needed to fully implement the 
graphing addition's functionality are discussed. 

Finally, chapters that implement and describe the printing of 
the various windows' contents and a tutorial for creating a 
stand-alone application are presented. As a whole, the applica
tion is called Ensemble, to indicate that it embodies a combi
nation of complementary modules that work together to 
provide a notebook, worksheet, and graphing facility which 
would make a good addition to any user's repertoire. 

More than anything else, the book strives to show that com
plex Macintosh applications can be developed quite easily, in 
an evolutionary manner, by using the right tools and by apply
ing them in a step-by-step fashion. Because of the object-ori
ented approach of the book, a great number of features in 
Symantec's THINK Class Library are presented. These illus
trate the power of a comprehensive class library that works be
hind the scenes to minimize the amount of complex code that 
the programmer is required to develop. 

Few, if any, Macintosh programming books cover the evolution 
of an entire application; most merely focus on the use of indi
vidual programming techniques. This book attempts to show 
how a real application can be simply and easily developed, step 
by step. The presentation is punctuated with data flow dia
grams that illustrate the dynamic structure of the application 
at various stages of its development. There are tutorials on 
how to use AppMaker to produce the various user interface el
ements for the windows, dialog boxes, and menus employed in 
the application. The book contains a detailed examination of 
the code generated by AppMaker for each new user interface 
feature, as well as the manually added custom code to make 
each new feature fully functional. The application is complete 
and fully operational at each stage of its development. 

Not only is the application whole and complete, but it is non
trivial. It makes use of features of the Macintosh toolbox, as 
well as the THINK Class Library, that would be difficult to 
present outside the context of a complete application. The En
semble application incorporates quite a few programming prin
ciples that reinforce a useful structure for object-oriented 
applications in general. These principles can be applied over 
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and over again, especially if the programmer is using App
Maker and the THINK C programming tools. 

The enclosed disk contains folders which include the source 
code, THINK C project files, and AppMaker resource files for 
six versions of the Ensemble application. These versions repre
sent six distinct phases in the application's evolution and cor
respond directly to the chapters in the book associated with 
each folder's name. An executable version of the final Ensem
ble application, along with its corresponding data file is also 
included on the disk. 

It should be possible to open this book at any one of its chap
ters and refer to the interface design or customizing descrip
tions without having to reread the entire book. Each major 
user interface feature is described by a triad of chapters. The 
first chapter describes how the feature is designed within the 
AppMaker environment. The second chapter discusses the 
code that is generated to implement the default behavior of the 
feature, and the third chapter describes the custom code that 
was added to make the new feature fully functional. 

I used two mainstream development tools to create the appli
cation described in this book: AppMaker version 1.5, created 
by Bowers Development Corporation, and THINK C version 
5.0, created by Symantec Corporation. 

AppMaker is a resource editor and code-generation application 
that allows the programmer to create complex user interface 
elements with a visual paradigm. Its WYSIWYG (what you see 
is what you get) tools allow windows, dialog boxes, menus, and 
alerts to be designed. It also includes a balloon help editor and 
comprehensive text styling for all of the user interface ele
ments. Through the use of AppMaker, your windows and dia
logs can contain all of the standard Macintosh user interface 
elements, including checkboxes, radio buttons, lists, buttons, 
drawing panes, borders, gray lines, PICT images, ICONs, and 
other elements. Once a user interface element is designed, 
AppMaker will generate code in any one of a variety of popular 
languages and dialects, including THINK C, THINK Pascal, 
MPW C, MPW Pascal, or C++. For each of these languages, the 
generated code can be procedural or object oriented, as de
sired. 
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Acknowledgments 

THINK C is an ANSI-compliant C language compiler, with ob
ject programming extensions that are a compatible subset of 
those found in the C++ language. The object features of the 
language are supplemented by a comprehensive class library 
called the THINK Class Library (TCL). All of the code in this 
book is written with the underlying functionality provided by 
AppMaker and TCL classes. In addition, THINK C is a marvel
ously efficient development environment, where editing, com
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Chapter 1 

Introducing the Tools 

This chapter describes the tools that were used to construct 
the application that is developed in this book. In addition, it 
contains a tutorial that will allow you to get started using the 
tools to develop the framework for the sample application 
that makes up the body of this book. 

The fundamental software tools are AppMaker version 1.5 
and THINK C version 5.0, although we will also be using Ap
ple's ResEdit program in some instances. In addition, the 
book will sometimes refer to Apple's six-volume set of Inside 
Macintosh manuals, which contains full documentation of the 
toolbox routines that provide the Macintosh operating system 
with its amazing capabilities. You may wish to refer to other 
important books concerning Macintosh programming. The 
four volume set titled Macintosh Revealed, by Stephen Cher
nicoff (Hayden Books), and the two-volume set titled Macin
tosh Programming Primer are particularly good. The first 
volume of the Macintosh Programming Primer was written by 
Dave Mark and Cartwright Reed. The second volume was 
written solely by Dave Mark. (Both are published by Addison
Wesley.) 

The Chernicoff books are written for use by Pascal program
mers, but because it is quite easy to translate between Pascal 
and C, this should not be a deterrent to C programmers 
wanting to know some of the inside secrets of programming 
the Macintosh. The Mark and Reed book and Dave Mark's 
second volume of that series are devoted to programming in 
C, especially THINK C. 

This book departs from those others by illustrating object-ori
ented programming techniques at the outset. Object-oriented 
programming is becoming such an essential part of all soft
ware development-on a variety of platforms-that I feel that 

1 
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it is important to begin to demystify the whole topic and teach 
new and experienced programmers alike about the principles 
of object-oriented programming for the Macintosh. 

As with any other endeavor, having the right tools for the job 
not only makes the job easier to accomplish, but can even 
turn what seems an impossible chore into something that is 
entirely feasible, as well as enjoyable, to accomplish. 

When the Macintosh was first introduced, it provided a fea
ture within its file structure that was entirely revolutionary. 
Macintosh files had resource forks, which contained descrip
tions of the user interface elements used within a given appli
cation. To modify the position of a window, the wording of a 
menu item, or the name of a push button, all you had to do 
was edit the appropriate resource, and the change was ac
complished, with no need to recompile the program. In fact, 
many early users of the Macintosh became quite adept at 
customizing their favorite programs, and even the operating 
system itself, with no access whatsoever to the source code. 

The tool of choice in the early days was ResEdit, which is still 
a viable resource-editing tool that has been kept up to date 
by Apple with the addition of editor modules for all the latest 
resource types. ResEdit requires quite a bit of technical 
knowledge about the various resources it creates and edits, 
so it is often shunned by beginning Macintosh programmers, 
who are intimidated by its potential to wreak havoc in their 
systems. In fact, almost every tutorial on the use of ResEdit 
hastens to caution the user about its potential dangers, and 
always includes the admonition to work on a copy of the file 
to be edited. Nonetheless, ResEdit continues to be a handy 
utility, especially when custom resources need to be created 
and the user is careful in its use. ResEdit will be used both to 
modify and to create new resources in this book. 

For the applications described in the book, AppMaker will be 
used almost exclusively. While AppMaker is able to edit the 
resources in existing applications, its greatest asset is its 
ability to create the needed user interface resources for new 
applications by using its onscreen WYSIWYG tools and then 
generating the code to operate the interface. 
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In fact, AppMaker generates a complete application program 
skeleton that includes all the elements which allow the appli
cation's user interface, once compiled, to be exercised. Com
mands can be selected from menus, buttons can be clicked, 
and dialog boxes can even be opened by making an appropri
ate menu selection. Visual proof that the interface is operable 
is provided by the standard highlighting of selected menu 
commands, check marks appearing and disappearing in 
checkboxes, and single-selection radio buttons that operate 
within the group in which they have been defined. The inter
face is truly operational. 

Compilation of an AppMaker-generated application is easily 
accomplished by using the Starter project for the THINK 
Class Library (supplied in the AppMaker product), adding the 
generated source files to the project, and then telling the 
compiler to bring the project up to date. This process consists 
of compiling not only the generated files, but also all the files 
that form the THINK C Class Library (TCL). Because almost 
all of the TCL is added to each project, and because THINK C 
keeps the object code inside the project file, it is not unusual 
for a THINK C project file to be several megabytes. Do not fear 
that your compiled program will be that large, because the 
THINK C linker will only include the files your program actu
ally needs to execute properly. 

Once the entire project has been compiled for the first time 
(which might take quite a while, depending on the speed of 
your particular Macintosh model), future compilations will be 
limited to only the files that have changed (and others that 
depend on these files) since the last compilation. In this re
spect, THINK C is a vecy efficient environment for developing 
new applications. 

Creating a New Resource File with AppMaker 

AppMaker is both a resource editor and a code generator. The 
outputs from AppMaker are a resource file and (optionally) a 
set of source files for the selected language. In this book, 
AppMaker will be used to create and enhance the resource 
file for our application and also to create source files for com
pilation by THINK C. 
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Figure 1-1 
AppMaker's open file 
dialog box 

Complete instructions for using AppMaker are contained in 
the product's manual; however, it is useful to repeat the in
structions for creating a new resource file at this point. I'm 
assuming that you are sitting in front of your Macintosh and 
are getting ready to launch the AppMaker application at this 
time. It will be convenient for you to do so as you continue to 
read this tutorial. Following are the steps for creating a new 
resource file for your object-oriented programming project: 

1. First, create a new folder on the disk where you want your 
THINK C project and its source files to be stored. Name 
the folder Ensemble. 

2. Navigate back to the folder in which the AppMaker appli
cation resides and launch AppMaker version 1.5. 

3. You will see an open file dialog box for the folder in which 
AppMaker is located, as shown in Figure 1-1. 
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Desktop 

Open II 
New l 

Cancel 

4. Navigate to the Ensemble folder, and click on the New 
button, as shown in Figure 1-2. 

5. When the New button is clicked, AppMaker will display 
the dialog box shown in Figure 1-3. You should name the 
new resource file Ensemble.1t.rsrc, as shown. This is 
because THINK C project files are typically named with a 
file extension of '.1t', and our THINK C project file will be 
named Ensemble.1t when we get to that point. THINK C 
will always look for a resource file whose name exactly 
matches that of the project, with the further file extension 
of · .rsrc'. Click the Save button. 



Figure 1-2 
Creating a new 
AppMaker resource 

Figure 1-3 
Naming the new 
resource file 
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(Desktop ] 
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Cancel ] 

6. After the Ensemble.n.rsrc file has been created, App
Maker will add a number of resources that THINK C and 
the TCL require. These are shown in Figure 1-4, which is 
a screen dump of the contents of the file's resource fork, 
as shown by the ResEdit utility. As you can see, quite a 
number of resources are automatically written into the 
Ensemble.n.rsrc file's resource fork. These constitute the 
minimum set needed to support our AppMaker-generated 
application, which automatically includes a menu bar, 
Apple, File, and Edit menus, and a default Window defi
nition. The other resources are needed by the TCL and 
AppMaker's default generated code. 

7. Look at AppMaker's working area screen, which is 
depicted in Figure 1-5. Notice that in addition to the stan
dard Apple, File, and Edit menus, Appmaker adds an 
active Select menu and inactive View, Tools, and 
Options menus. In addition, there is a window on the 
right portion of the screen that contains a list of items in 
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Figure 1-4 
Initial resources 
written into 
Ensemble.n.rsrc by 
App Maker 

Figure 1-5 
AppMaker's working 
area screen 
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the current selection category. By default, AppMaker 
selects the available menus and lists the MainMenu in 
this window. Other resources can be selected by pulling 



Figure 1-6 
AppMaker's default 
application menu bar 

Figure 1-7 
AppMaker's default 
Apple menu 
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down the Select menu and choosing one of the other 
items. 

8. Keep AppMaker's default selection of Menus, and double
click on the MainMenu item in the current selection win
dow. AppMaker will display the default menu bar that will 
automatically be included in your application, as shown 
in Figure 1-6. 

t~D 
:·:·:·:·:~:-:·:·:~:i:I:~ :-:· :-:~:?.:i:~·:·:·:·:·:·:· ................................ .. .. . .. . .. . ... .... ... . .. . . . . . . . . 

9. Click on the Apple symbol in the menu bar, and App
Maker will drop down the Apple menu, whose commands 
will be included in your application. The menu is shown 
in Figure 1-7. Notice that it only includes an About item 
and a gray line. The names of the current desk accesso
ries (or Apple Menu Items in System 7) will be filled in at 
run time, when the application is started. The '#256' 

File Edit 

...... ~.~·~·~·~ ... ~.~·~·~·~·~·~·~·~·~·~·~ ............ ! ... ~.~·~·~········· 
appearing in the menu entry is the command number 
required by the TCL for dispatching the selection of that 
menu command. 

10. Now. click on the word File, and the default File menu 
will drop down. AppMaker inserts the appropriate File 
menu commands, as required by the TCL, into the default 
menu, pictured in Figure 1-8. Notice that each of the File 
menu's commands has a conunand number, as is required 
by the TCL for command dispatching. 

11. Finally, click on the word Edit to see the default Edit 
menu provided by AppMaker. This menu contains all the 
standard commands for cutting and pasting and also the 
command to show the contents of the automatically gener-
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Figure 1-8 
AppMaker's default 
File menu 
commands 

Figure 1-9 
AppMaker's default 
Edit menu 
commands 

Edit 
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ated Clipboard. The default Edit menu is shown in Figure 
1-9. Once again, each of the Edit menu's commands has 
been assigned a standard command number, which corre
sponds to the definitions in the TCL for these commands. 

Undo 

Cut 
Copy 
Paste 
Clear 

Show Clipboard 

3€21#16 

3€H #18 
3€C #19 
3€U #20 

#21 

#22 

12. Now that you have seen the default menus that are auto
matically generated by AppMaker for your application, 
click on the Select menu and choose the Windows item. 
You will see two standard window items in the current 



Figure 1-10 
AppMaker's default 
Main Window 
definition 
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selection window. One is the Clipboard, and the other is 
a standard window called MainWindow. Double-click on 
the MainWindow item to see its appearance on your 
screen, as shown in Figure 1-10. The default MainWin
dow shown in the Figure has a close box, a zoom box, and 
also a size box. It is initially created as an (untitled) win
dow; however, these characteristics can be changed, as 
with any of AppMaker's generated resources. For now, 
leave the window definition alone. 

(untitled) 

13. If you decide to do so, you can choose the Dialogs com
mand from the Select menu and see that no dialogs are 
listed. Selecting the Alerts command results in the dis
play of quite a few standard Alerts in the current selection 
window. Figure 1-11 shows a list of the default ALRT 

resources defined by AppMaker. You can look at any of 
these Alerts by double-clicking on any of the entries in 
the current selection window. 

14. After you have examined the Alerts, you should request 
that AppMaker generate the code that implements your 
application's skeleton, using the default set of window, 
menu, and alert resources that it has generated. To do 
that, choose Generate from AppMaker's File menu, as 
shown in Figure 1-12. When this command is selected, 
the dialog box shown in Figure 1-13 is displayed. This 
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Figure 1-11 
AppMaker's default 
ALRT resources 

Figure 1-12 
Choosing the 
Generate command 
from the File menu 
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dialog lists all the modules that AppMaker has deter
mined are needed to implement the current user interface 



Figure 1-13 
App Maker's 
Generate dialog 

Figure 1-14 
AppMaker's save 
changes dialog 
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design, which in this case includes only the default 
resources described in the preceeding steps. 

Generate 

Generate which modules? 
EnsembleMain.c {? m 
Ensemble!Jata.c • EnsembleOata.h 

Language: 
THINK C: 5.0 

zEnsembleApp.c 
zEnsembleApp.h 

with C:lass Library 

En.sembleApp.c 
EnsembleApp.h 
zEnsembleOoc:.c: K Generate J) 
zEnsembleOoc:.h 
Ensemble!Joc.c Cancel 
Ensemble!Joc.h 
zMainUlindow.c 
zMainUlindow.h 
MainUlindow.c 
MainUlindow.h m 

15. Once all the modules have been generated, you can 
choose the Quit command in AppMaker's File menu. Be 
sure to click Yes when AppMaker displays the dialog box 
shown in Figure 1-14. 

Saue changes to "Ensemble.11.rsrc copy"? 

( Don't Saue Cancel -
At this point, you have created a complete set of source files 
that, when compiled along with the THINK Class Library rou
tines, will implement a working application. The next section 
will discuss how to set up a THINK C project file for this de
fault application and how to add your source files to it. We 
will also discuss compiling the resulting set of files and run
ning the application. 
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Perhaps you noticed in the previous set of steps that we al
lowed AppMaker to use its default set of resources for our ini
tial application. This is an important point. In most cases, the 
default resources can be used as a starting point for applica
tions you will develop. The next chapter will begin a discus
sion of the structure of the Ensemble application and the 
relationship between the classes from which it is composed. 

This might be a good time to take a break and review the op
erations involved in creating a set of default resources and 
the source files that implement their functionality. Almost ev
ery THINK C application that uses the TCL will be built in the 
same way. 

Creating the Think C Project 

This section describes how to set up a THINK C version 5.0 
project file that will contain all the necessary TCL source 
files, as well as those generated by AppMaker for our Ensem
ble example. 

1. The first step is to make sure that AppMaker's AMClass
LibC folder is inside the THINK C 5.0 Folder on your 
development disk. This will ensure that the additional 
classes provided with AppMaker will be available to your 
projects. 

2. Inside the AMClassLibC folder is a file called Starter.1t, 
which should be duplicated and moved into the folder 
called Ensemble that you created in the previous section. 
The Ensemble folder holds your new AppMaker resource 
file and the generated source code files. 

3. Rename the Starter.1t file Ensemble.1t (the '7t' symbol is 
created by holding down the Option key and pressing the 
'p' key). Your set of files should contain those shown in 
Figure 1-15, which is a small icon view in the Finder. 

4. Double-click on the Ensemble.1t file to launch THINK C 
version 5.0. You will notice that a great number of files 
have already been added to the project window, as shown 
in Figure 1-16. Notice that only a small fraction of the 
number of files is shown. You can scroll through the files 
using the scroll bar in the Ensemble.1t project window. 



Figure 1-15 
List of Ensemble 
project files in Finder 

Figure 1-16 
THINK C's Ensemble 
project files 
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SANE 0 
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CAppleEvent.c 0 
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CBartender .c 0 
CChore.c 0 
CCluster .c 0 
CCollaborator .c 0 
CCo llection .c 0 

CDataFile .c 0 
CDecor ator .c 0 
CEnvironment .c 0 
CError.c 0 
CFile.c 
Clist.c 
CMBarChore .c 0 i:£:i 
CMouseTask.c 0 '2J 
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You will also see that the files have already been grouped 
into segments (separated by gray lines) that are of an 
appropriate size. If you scr9ll back to the beginning of the 
list, you will see a file in the first segment called 
Place Holder.c. This file is in the first segment merely to 
act as a placeholder for your project's files. It serves no 
other purpose. 
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Figure 1-17 
Selecting THINK C's 
Add command 

5. Click on the Place Holder.c file to highlight it. This 
selects the first segment for the next operation. Once you 
have done that, pull down the Source menu and select 
the Add command, as shown in Figure 1-17. 
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6. When the Add command is sebcted, you V\,ill see the dia
log box shown in Figure 1-18. This dialog box has two 
sectior..s. Make sure that you navigate to the Ensemble 
folJer using the pop-up menu at the top of the dialog box 
if it doesn't already indicate that folder's n::ime. Click the 
Add All button, as shown in the figure. 

7. After you have added all the files shown in the upper por
tion of the dialog box, you'll notice that the box is empty, 
and all the file names have moved to the lower portion, as 
shown in Figure 1-19. Click Done, as shown. 

8. If you look in the Ensemble.1t project window, you will see 
that all the C language source files have been added to 
the project, in alphabetical order, as shown L~ Figure 
1-20. In the next step, the }':>lat!e Holder.c file will be 
_·emoved. 



Figure 1-18 
Adding all the 
Ensemble files 

Figure 1-19 
Clicking Done in the 
Add dialog box 
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9. Click on the Place Holder.c file to highlight it, and then 
pull down the Source menu and select the Remove com
mand, as shown in Figure 1-21. 

10. At this point, you are ready to compile all the files in the 
project. Select the Bring Up To Date command from 
THINK C's Project menu, as shown in Figure 1-22. This 
will cause THINK C to begin compiling all the source files. 

11. When the compilation is complete, select Run from the 
Project menu, and THINK C will display its debugger win
dows, with the execution cursor positioned at the begin
ning of your application's main function, as shown in 
Figure 1-23. The figure also shows that the Go button in 
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Figure 1-20 
All Ensemble files 
have been entered 
into the proj ect 

Figure 1-21 
Removing the 
Place Holder.c file 
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the debugging window is about to be pressed. Doing so 
will cause the application to begin execution. 

12. When the application begins execution, it will display the 
menus and default window that were created by App
Maker, as described in the previous section. The display 
will be similar to that shown in Figure 1-24. 



Figure 1-22 
Bringing the project 
up to date by 
compiling all its files 

Figure 1-23 
Ensemble 
application ready to 
run 
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ii': Name 

• ErisembleApp.c 

• EnseombleData.c 
• EnsembleDoo.o 
• EnsembleHaln.c 

806 

148 
50 

• HainYindow .c 1 88 
• zEnsembleApp.o 566 
• zEnsembleDoc.c 880 

.... ~---~~.:!'.~.~.!!_A_'!~:!.~.!? ............................ ~~ 
Exceptions.c 1080 
GlobalYars.c 
LongCoor-dilllates.c 
HacTr-aps 
HacTr-aps2 

Data 

13. When the application is running (Figure 1-24), the default 
window and menus are active. Make some selections from 
the File menu. If you choose New, another new untitled 
window will be created. If you choose Close, the current 
window will be closed. If you choose Open, then you will 
be given the opportunity to open a file. This will result in 
the file's name being displayed in the window title; how-
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Figure 1-24 
Ensemble 
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ever, because there is no code in the default program to 
display the contents of the file-because AppMaker is in 
no position to infer the format of the data in the selected 
file-nothing will be displayed at this time. The code to 
display the contents of various types of files used in the 
Ensemble application will be covered in later chapters. 

14. When you have finished trying out the various com
mands, you should choose Quit from the File menu to 
stop execution of the application. 

At this point, you have created, compiled, and executed a 
complete Macintosh application. It's true that it doesn't ac
complish much, but we've all heard that creating the user in
terface for an application is the most difficult and time
consuming chore there is in program design. This is certainly 
true if it must be accomplished with inadequate tools; how
ever, you have accomplished the feat with ease. 

The combination of AppMaker's resource editor and code 
generation, and the TCL's extraordinary facilities for perform
ing much of the work in animating the user interface, is 
something that you will come to appreciate more and more as 
you continue to develop the Ensemble application and grow 
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more proficient at using the AppMaker and THINK C develop
ment tools described in this text. 

This book contains a number of exercises at the end of each 
chapter. Some of the exercises will be simple to complete, 
while others could be classified as relatively major projects. 
Even if you are not a student, it will be worthwhile for you to 
work the simple problems and think about the more complex 
tasks that are suggested as "extra-credit" projects. All "extra
credit" projects are noted as such in the text of the exercise or 
in a footnote. 

1. Describe the features and functions of the AppMaker 
application, and contrast them with the features of 
Apple's ResEdit application. 

2. Modify the contents of the About alert for the default 
application. This alert will be shown when the About 
Application command is chosen in the Apple menu for 
the application that is running. 

3. Experiment with some of the tools in AppMaker, and cre
ate a few simple user interface elements. Generate code 
for a variety of languages and examine the results. 

4. Contrast the code generated in exercise 2 for a procedural 
language, such as the procedural version of THINK C, 
with the object-oriented code generated for that same lan
guage. 

5. Explain the purpose of the Placeholder.c file in the start
ing THINK C project file. 



Chapter 2 

Examining Ensemble's Structure 

This chapter discusses the structure of the initial version of 
the Ensemble application's files, classes, and methods. It 
also describes how the generated classes and methods relate 
both to each other and to the THINK Class Library (TCL) rou
tines. 

The discussion begins with a description of the THINK C 
source program files generated by AppMaker. The files in
cluded in the Ensemble project can be grouped into two cate
gories: 

1. Those in the first category have names beginning with the 
letter 'z' and contain classes and methods that you 
should never need to modify. Each of the classes in these 
modules is referred to as a superclass. Each time you 
modify the Ensemble.7t.rsrc resource file and then gener
ate code, AppMaker will generate new contents for all the 
superclass files. There is nothing special about the letter 
'z'; it is merely a standard adopted by AppMaker to aid in 
differentiating between the two categories of files. 

2. In most cases, the second category of files contains direct 
descendants of the classes and methods in the superclass 
files. The file names in the second category do not begin 
with the letter 'z' and will never be automatically regener
ated by AppMaker if the Ensemble.7t.rsrc resource file is 
modified. These files usually contain subclasses of the 
corresponding superclasses and will eventually contain 
all the code that implements the application's unique 
functionality. 

In general, each THINK C source file also has a corresponding 
header file, whose name ends in the extension '.h'. The excep
tions to this rule, in the default set of files, are the file En-
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sembleMain.c (which has no header file) and 
Resourc"'Defs.h (which has no corresponding source file). 

As you follow along with the tutorials in the succeeding chap
ters of this book, you will be making modifications to the files 
in the second category. The automatically regenerated files 
should be treated as though they are "read only." 

The header files (whose names end in '.h') contain the class 
and method declarations. The source files (whose names end 
in '.c') contain the method definitions (the code that imple
ments each method's functionality). The default source files 
are as follows (their contents will be described in greater de
tail later in the chapter): 

EnsembleMain.c This file contains the main function. in which execution ini
tially commences. 

zEnsembleApp.c This file contains the initialization method for Ensemble's 
application class. It also contains the methods to create new 
documents, open existing documents, set up the initial 
menus, update menu items, and handle menu commands. It 
will be regenerated each time the Ensemble resource file is 
modified. 

EnsembleApp.c This file contains a method that specifies the type and creator 
for files read and/ or written by the application. In addition, it 
contains methods that inherit and extend the behavior of the 
methods in the zEnsembleApp.c file for updating menus and 
handling menu commands. 

zEnsembleDoc.c This file contains methods associated with the Ensemble 
application's document class. The methods are invoked to 
create a new file, open an existing file, save an existing file, 
revert to a previously saved version of an existing file, create 
the initial windows for the application, update menu items, 
and handle menu commands. 

EnsembleDoc.c This file contains methods that override the behavior of its 
ancestor's methods in the zEnsembleDoc.c file. In particular, 
the file contains application-specific initialization and meth
ods to update menu items and handle menu commands. 

EnsembleData.c This file contains the methods that actually read, write, open, 
close. save. and dispose of data contained in Macintosh files. 
The methods in zEnsembleDoc.c call corresponding meth-
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ads in the EnsembleData.c file to handle the specifics of the 
physical file formats. 

zMainWindow.c This file contains the initialization method to establish the 
appearance of the MainWindow resource (See page 9), as well 
as methods to update menu items and handle commands. 

MainWindow.c This file contains methods that override those in its ancestor 
class in zMainWindow.c for performing application-specific 
initialization, updating menu items, handling commands, 
and handling other events associated with the window's user 
interface items. 

ResourceDefs.h This file contains mnemonic definitions for each of the 
resources defined in the generated code. Instead of referenc
ing a menu command by its number, you can use the corre
sponding mnemonic. When new resources are added to the 
Ensemble.n.rsrc file, the contents of the ResourceDefs.h file 
are rewritten. 

The primary purpose served by describing these files is to 
give you an idea where the various functions of the Ensemble 
application are handled. To fully comprehend the relation
ship of the application's classes and methods, it will be im
portant for you to understand the structure of the generated 
code modules, how these interrelate, and how they relate to 
the TCL. 

In preparation for a discussion of the class structure of the 
Ensemble application, you should examine Figure 2-1, which 
illustrates the structure of the application and its connection 
with the TCL. Notice in the figure that there are three catego
ries of classes, indicated by the different background appear
ances of the ovals. The two sets of generated classes (shaded 
and unshaded) are respectively contained in the superclass 
and subclass files described earlier. The ovals with a black 
background refer to classes in the TCL. Not all of the TCL 
classes that interact with the Ensemble application are 
shown. 

Ensemble's Classes and Methods 

Figure 2-1 shows the relationship between the various 
classes in the application and the TCL. The main function, 
where execution begins, is located in the module whose name 
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Figure 2-1 
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is EnsembleMain, in the figure . The main function is not 
represented as a method of any class. It is not object ori
ented. When it begins executing, none of the other superclass 
or subclass instances exist. The complete code for the main 
function is as follows : 

void main() 
{ 

gApplication = new CEnsembleApp; 
((CEnsembleApp *) gApplication)->IEnsembleApp (); 
gApplication->Run () ; 
gApplication->Exit (); 
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It should be evident that the purpose of the main function is 
to create an instance of the CEnsembleApp class, initialize 
that instance, and then send it the Run and Exit messages. 
The presumption is that when the Run method is sent to the 
application, it will continue running and not return to the 
main function until the user has selected the Quit command. 
When this occurs, sending the application an Exit message 
gives it the opportunity to clean up and exit in an orderly 
fashion. 

Messages can be sent to the application at any time, by refer
ring to the global variable called gApplication, in which a 
handle to the application's instance is stored. Because the 
TCL's definition of the gApplication variable requires that it 
contain an instance of class CApplication, the foregoing code 
must "recast" gApplication as an instance of CEnsembleApp 
to call the initialization method. 

The following section describes the actions that result from 
sending an IEnsembleApp message to the CEnsembleApp 
instance and how this simple message results in a set of ac
tions that perform a host of initialization functions which 
prepare the application to begin execution. 

CApplication's Initialization Method 

Figure 2-2 shows the structure of the Ensemble application 
at the time the IEnsembleApp message is sent to the CEn
sembleApp instance. Note that this message is inherited 
from its superclass instance, ZEnsembleApp. The superclass 
is responsible for performing all of the default initialization 
for the application and does so (in this case) by sending the 
IApplication message, which is processed by the corre
sponding method in the CApplication class in the TCL. The 
implications of executing the IApplication method are shown 
in the figure, which also illustrates the new object instances 
that are created during execution of the IApplication 
method. To reiterate, the IApplication message is sent to the 
gApplication instance in response to its IEnsembleApp's 
method being called. When the IA.pplication method-inher
ited from CApplication-gains control, it creates instances of 
a number of additional classes, including the following: 
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Figure 2-2 
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CBartender This instance manages the menu bar and initially receives con
trol when the mouse is clicked in the menu bar. CBartender 
can be addressed by use of the global variable gBartender. 

CClipboard This instance controls the operation of the application clip
board and is responsible for exchanging its contents with the 
contents of the system clipboard when the application is acti
vated or deactivated. It can be addressed by use of the global 
variable gClipboard. 

CDecorator This instance handles the positioning of windows on the desk
top. It is responsible for initially sizing and placing windows. 
It can be addressed by use of the global variable gDecorator. 

CDesktop This instance manages a view that encompasses the entire 
screen. It manages a list of windows and can be addressed by 
use of the global variable gDesktop. 

CDirectorOwner This class is part of the TCL. The CApplication class inherits 
functionality from the CDirectorOwner class. The CDirec-
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torOwner class is shown in the figure because the superclass 
is initialized when the IApplication message is handled. 

CSwitchboard This instance manages the main event loop and is responsi
ble for dispatching events to other methods in the applica
tian. All events, including key presses, mouse clicks, update, 
activate, suspend, resume, and high-level (Apple) events are 
processed by CSwitchboard. 

ill addition to creating and initializing the preceeding in
str nces, the IApplication method allocates the memory re
sources that are anticipated by the application for allocating 
handles and pointers in the application heap. In the course of 
this acti.:m, IApplication sets up a memory reserve, called 
the "rainy day fund," and allocates space for a number of 
master pointers. It also creates instances of two other enti
ties: An instance of class CList is created to handle "Idle 
Chcres," followed by creation of an instance of CCluster to 
hold "Urgent Chores." 

Before continuing with the discussion of the CEnsembleApp 
class and the actions of the IApplication method, it is impor
tant to stress that instances of ZEnsembleApp and CApplica
tion, as depicted in Figure 2-2, don't really exist. Instead, only 
the CEnsembleApp instance exists. When it is created, by vir
tue of the TCT ... object hierarchy, it inherits all the instance 
vari...tbles and metnods of its ancestors. The CEnsembleApp 
instance is a CApplication object, in every sense of the word. 
Therefore, at this stage of our a?plication's execution, only 
C~nsembleApp and the instances created by its IApplication 
i.lherited method actually exist. These include the CDest:top, 
CCli~board, CDecorator, CBartender, and CSwitchboard 
class instances. In this book, we will continue to show both 
the real (subclass) instance, its direct superclass, and that 
class's ancestor in the TCL, to aid in clarifying the relation
ship between the classes and the location of their correspond
ing methods. Hopefully, this will not mislead you into thinking 
that a multiplicity of instances exist ior newly created objects 
that are deeply buried in the TCL's class hierarchy. 

After the CDesktop, CClipboard, and CDecorator instances 
have been created and initialized, the iApplication method 
sends the SetUpFileParameters message, for which it has a 
default method. However, the SetUpFileParameters method 
is overriG.den by a method of the same name in the CEn-
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sembleApp subclass. (Note that overridden methods are 
shown in oblique type in Figure 2-2.) Although the SetUp
FileParameters method in the CEnsembleApp subclass first 
calls the corresponding inherited method in CApplication, 
this is a suitable place to customize the file types and creator 
you wish to use for your application. By default, AppMaker 
generates code to set a single file type of "TEXT' and a signa
ture (creator code) of 'XXXX'. These can easily be changed (as 
shown in a later chapter). 

After sending the SetUpFileParameters message, the !Appli
cation method sends the SetUpMenus message, for which it 
also has a default method. Once again, however, this method 
has been overridden by a method with the same name in the 
ZEnsembleApp superclass. The purpose of the override in 
this case is to load and initialize any special menus not han
dled by the normal operation of the !Bartender method (such 
as pop-up menus and the like). Because our application does 
not currently have any special menus to initialize, the gener
ated code merely calls the inherited SetUpMenus method in 
the CApplication class. 

The last act of the IApplication method is to set the value of 
the gGopher global variable to point to the CEnsembleApp 
instance. (Tile gGopher is a global variable that points to the 
currently active member of the Chain of Command.) Contrary 
to the stable state shown in Figure 2-1, where the gGopher 
global variable points to the CEnsembleDoc instance, an in
stance of this class doesn't exist at the time !Application is 
called. Therefore, gGopher is set to point to the CEnsemb
leApp instance. 

CApplication's Run Method 

After CEnsembleApp receives the IEnsembleApp message, 
and the preceding sequence of events is complete, the main 
module sends a Run message to the CEnsembleApp object. 
The Run method is not overridden by methods in the CEn
sembleApp or ZEnsembleApp classes. Instead, the message 
is directed to the Run method inherited from the CApplica
tion class. 

It is important to note that at the time the Run method is ex
ecuted, the Ensemble application may have been initially in
voked in one of two different ways: 
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1. The Ensemble application's icon can be double-clicked, 
or it can be selected and then the Open command in the 
Finder's File menu can be chosen. 

2. One or more of Ensemble's files (types that carry the 
Ensemble application's creator code) is selected, and 
then either the Finder's Print command or Open com
mand is chosen from its File menu. 

In the first case, nothing special needs to be done inside the 
CApplication class's Run method. In the second case, how
ever, the selected files must be opened or printed, as re
quired. One of the first actions of the Run method is to 
determine in which way the application was invoked and 
then handle that situation in an appropriate manner. This is 
accomplished by invoking the Preload method, which per
forms the following actions: 

1. If the icon was double-clicked or the icon was selected 
and then opened, the Preload method does nothing, and 
the Run method can begin processing events. 

2. If one or more files were selected, and either the Open or 
Print Finder command was chosen, the Preload method 
is obligated to open the chosen files, one by one, and pro
cess them in an appropriate manner. In the case of the 
Open command, the application is sent an OpenDocu
ment message, which happens to be overridden by our 
superclass, ZEnsembleApp. In the case of the Print com
mand, a DoCommand message with a parameter of cmd
Print is sent to the application, which in our case is 
ignored (for the moment). 

After the Open or Print command has been handled, the Run 
method resumes control and begins processing events. It 
sends a ProcesslEvent message, which is handled by a 
method inside the CApplication class. This method sends a 
ProcessEvent message to the CSwitchboard instance, 
which, in turn, sends a GetAnEvent message that is nor
mally processed by its method of the same name in the CS
witchboard instance. 

If the GetAnEvent method returns with a valid event, then a 
DispatchEvent message is sent. This is usually handled by 
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Processing Events 

the method of that name in the CSwitchboard instance. If no 
event is currently in the queue, then the GetAnEvent 
method sends a Doldle message, which is handled by its 
method of that name, which sends an Idle message to the ap
plication by referring to the gApplication global variable. 

After the event has been processed (event processing is cov
ered later in the chapter). the CApplication class's Pro
cesslEvent method regains control. It then determines 
whether any urgent chores need to be processed and if so, 
performs them one by one. Finally, it handles switching to 
and from a desk accessory, if necessary, cleans up, and re
turns to the event-processing loop inside the Run method. 
Events are continually processed inside this method until 
something resets the CApplication instance's running vari
able to FALSE. When that occurs, the application returns to 
the main function (inside the CEnsemble module), at which 
time the Exit message is sent to the CEnsembleApp in
stance. In the case of our application, this message is handled 
by the Exit method inherited from CApplication, which is an 
empty (do-nothing) method. The main function then returns 
to the operating system, where the Finder regains control. 

When the Preload method is ready to return to the Run 
method, it sends the application a StartUpAction message, 
which is handled by a method of that name in the CApplica
tion class. The StartUpAction method tests whether any 
files were preloaded by either the Open or Print commands 
and also whether the application environment supports high
level Apple Events. If neither of these conditions is true, then 
the method sends a DoCommand message, with a cmdNew 
parameter, to the instance referenced by the current value of 
the global gGopher variable. This results in the execution of a 
New command, as though the user had chosen the command 
from the application's File menu. 

If no files were preloaded and the application is capable of re
ceiving high-level Apple Events, then when the application be
gins processing events, it will discover an Open Application 
event (placed in the queue by the Finder). It will handle this 
event by sending a DoAppleEvent message, containing the 
Open Application event code, to the instance referenced by tlie 
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current value of the global gGopher variable (which points to 
the CEnsembleApp instance at this point in our application). 

The DoAppleEvent message will be handled by a method of 
the same name in the CApplication class, which will send a 
DoCommand message with a cmdNew parameter to the in
stance referenced by the gGopher variable. This will result in 
the creation of a new document, just as if the user had cho
sen the New command from the application's File menu. 

Although the preceeding process seems rather circuitous, it 
is necessary in an environment in which an application can 
be started by any other application simply by sending the 
Finder a request to start it. It should also be evident that the 
TCL automatically handles a variety of situations. The entire 
set of linkages is illustrated in Figure 2-3. 

Event Queue 

Open Application 

.. ·· .. ··· 
.. .. .. 

/DoCommand 

/• (cmdNew} 

. ..··········· 
: •• •• DoCommand 
:: (cmdNew} 
# 

. . . · . .. .. 
Create Document 

Run 
DoCommand (cmdNew} 
Create Document 

Sending the application (gGopher) the DoCommand message 
with cmdNew as a parameter starts another sequence of 
events, which is described in the next section. Bear in mind 
that event processing is the primary job of any Macintosh ap
plication; eve:ry application action is triggered by an event of 
some kind. 
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Handling the DoCommand (cmdNew) Message 

TheTRY, CATCH, 
andENDTRY 
statements are part 
of the TCL' s error 
recovery features. 

When the DoCommand message is sent to the gGopher in
stance with a parameter of cmdNew, the CEnsembleApp 
doesn't recognize that command, so it passes it on to its su
perclass, ZEnsembleApp, which then passes it on to the 
CApplication class method of the same name. The DoCom
mand method in the CApplication class handles the cmd
New parameter by sending a CreateDocument message to 
the current application instance (CEnsembleApp in our 
case). The method that implements this message is inherited 
from the ZEnsembleApp superclass. 

The CreateDocument method in the ZEnsembleApp class is 
responsible for creating a new subclass of the CDocument 
class, which is the supervisor of the data file and default win
dow associated with the Ensemble application. The code for 
the ZEnsembleApp class's CreateDocument method is as 
follows: 

void ZEnsembleApp::CreateDocument(void) 
{ 

CEnsembleDoc*theDocument; 

TRY 
{ 

theDocument = new CEnsembleDoc; 
theDocument->IEnsembleDoc (this, TRUE); 
theDocument->NewFile (); 

} 
CATCH 

{ 
ForgetObject (theDocument); 

} 
ENDTRY; 

The foregoing code was entirely generated by AppMaker. It 
uses the new error-handling features of the TCL, which in
clude the ability to place statements that might fail inside a 
block headed by the TRY keyword and the ability to put the er
ror-handling code inside a block headed by the CATCH key
word. The CATCH block is ended by an ENDTRY keyword. 
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The function of the CreateDocument code is to create a new 
instance of class CEnsembleDoc, which is a subclass of ZEn
sembleDoc, which is itself a subclass of CDocument, as 
shown in Figure 2-1. 

After the instance is created, it is initialized by sending the 
IEnsembleDoc message, which is inherited from the ZEn
sembleDoc superclass. The initialization consists of setting 
the itsMainWindow instance variable to NULL and then send
ing an !Document message, which is handled by the inher
ited method of that name in the CDocument class. This 
message serves to initialize a number of the instance vari
ables inherited from the CDocument class. 

After the CEnsembleDoc instance has been initialized, it is 
sent a NewFile message, which is handled by the method of the 
same name inherited from and contained within the ZEnsem
bleDoc module. The code for the NewFile method is as follows: 

void ZEnsembleDoc::NewFile (void) 
{ 

CEnsembleData *theData; 

TRY 
{ 

theData = new CEnsembleData; 
theData->IEnsembleData (this); 
itsFile = theData; 

BuildWindows (theData); 
itsWindow->Select (); 

} 
CATCH 

{ 
ForgetObject (theData); 

} 
ENDTRY; 

In the NewFile method (inherited from the ZEnsembleDoc 
module), a new instance of class CEnsembleData is created. 
Although there is no generated superclass for this instance, it 
inherits its behavior and instance variables from the TCL's 
CDatafile class-which, in turn, inherits instance variables 
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and methods from the CFile class. When the CEnsemble
Data instance has been created, it is sent the IEnsemble
Data message, to initialize the instance. The initialization 
code is as follows: 

void CEnsembleData::IEnsembleData (CDocument *theDocument) 
{ 

inherited::IDataFile (); 
hasFile = FALSE; 
itsDocument = theDocument; 

II your application-specific initialization 
itsData = NULL; 

The preceeding code was generated by AppMaker. It first 
sends an IDataFile message, which is inherited from the 
CDatafile class, and then initializes the hasFile instance 
variable to FALSE, indicating that no file is currently open for 
this document. The itsDocument instance variable points 
back to the CEnsembleDoc instance, so that the CEnsem
bleData instance can subsequently refer to the document's 
methods. The itsData instance variable is set to NULL, indi
cating that no data currently exist. Note that AppMaker has 
indicated with a comment that this is a good place to insert 
additional initialization code that is pertinent to the CEnsem
bleData instance's functionality. None is needed at this time. 

The NewFile method (shown on page 33) follows up the initial
ization of the CEnsembleData instance by setting the itsFile 
instance variable to the value of the CEnsembleData instance. 
It then sends a BuildWindows message, which is handled by 
the method of the same name inherited from the ZEnsemble
Doc superclass. The code for this method is as follows: 

void ZEnsembleDoc: :BuildWindows(void) 
{ 

itsMainWindow = new CMainWindow; 
itsMainWindow->IMainWindow (this, itsData); 
g Decorator->StaggerWindow (itsMainWindow); 
itsMainPane = itsMainWindow->itsMainPane; 
itsWindow = itsMainWindow; 
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The purpose of the BuildWindows method is to create the 
windows that are intended to be open initially in the applica
tion. In our case, this is a single window whose default sub
class name is CMainWindow. The method begins by creating 
an instance of CMainWindow, and then initializes the win
dow, passing it arguments of this (CEnsembleDoc) and the 
value of the itsData (CEnsembleData) instances. 

The CEnsembleDoc instance is the supervisor of the window, 
as required by window initialization methods, and passing 
the CEnsembleData instance allows the window to be able to 
refer to the instance variables and methods in that subclass. 
In particular, if data are entered into the window, it will be 
possible to mark the window as dirty and refer to other data 
structures associated with the data class instance. The code 
for IMainWindow is as follows: 

void CMainWindow::IMainWindow(CDirector*aSupervisor, 
CEnsembleData*theData) 

itsData = theData; 
inherited:: IZMai n Window ( aSupervisor); 
II any additional initialization for your window 

Once again, this code was wholly generated by AppMaker. 
The reference to the CEnsembleData instance is saved in the 
window's itsData instance variable, and then the IZMain
Window message (inherited from the ZMainWindow class) is 
sent. The code for the IZMainWindow method is as follows: 

void ZMainWindow::IZMainWindow(CDirector 
{ 

CView *enclosure; 
CBureaucrat *supervisor; 
CSizeBox *aSizeBox; 

* aSupervisor) 

!Window (MainWindowlD, FALSE, gDesktop, aSupervisor); 
itsMainPane = NULL; 
enclosure =this; 
supervisor = this; 
aSizeBox = new CSizeBox; 
aSizeBox->ISizeBox (enclosure, supervisor); 
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The IZMainWindow method (inherited from the ZMainWin
dow class) calls the !Window method inherited from the 
TCL's CWindow class. Then the IZMainWindow method sets 
the itsMainPane instance variable to NULL, indicating that no 
pane currently exists. 

The IZMainWindow method sets local variables called enclo
sure and supervisor to point to this, which is the CMain
Window instance. It then creates an instance of a CSizeBox 
class and initializes that class, malting the window the super
visor and enclosure of the size box that appears at the lower 
right-hand corner of the default window. 

When the IZMainWindow and IMainWindow methods return 
to the BuildWindows method (see page 34), that method 
sends the CDecorator class instance {via the global gDecora
tor variable) a StaggerWindow message, which staggers the 
window with respect to any other windows on the screen. 
This ensures that all active windows are at least partially vis
ible. The last act ofBuildWindows is to set the itsWindow in
stance variable to the value of itsMainWindow 
(CMainWindow in our case). 

The BuildWindows method returns to the CEnsembleDoc 
NewFile method (see page 33), which sends the window a Se
lect message, making the window visible. This is the culmi
nation of handling the cmdNew command that was created 
within the CApplication's Run method. 

Examining the Chain of Command 

A command is defined either as an item selected from one of 
the application's menus or a keyboard shortcut for that item 
(e.g., typing Command-C, instead of choosing Copy from the 
Edit menu). In addition, AppMaker creates "click commands" 
for buttons, checkboxes and radio buttons. Commands begin 
as events that are fetched from the event queue and pro
cessed according to the following rules: 

•:•The CApplication instance's Run method sends the Pro
cesslEvent message, which is handled by the method of 
that same name in the CApplication class. 

•:• The Process !Event method sends a ProcessEvent mes
sage to the CSwitchboard instance. 
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•:• The ProcessEvent method sends a GetAnEvent message, 
which is handled by a method of that name in the 
CSwitchboard instance. 

•:• The GetAnEvent method in CSwitchboard calls the Mac
intosh event manager to fetch an event. Upon returning to 
the ProcessEvent method, the event is examined. If no 
event or a system event was fetched, then ProcessEvent 
sends a Doldle message. If an event for this application 
was fetched, then ProcessEvent sends a DispatchEvent 
message, which is also handled in CSwitchboard. 

•:• The DispatchEvent method discriminates between the 
various types of events (mouse events, key presses, disk 
events, update, activate, high-level events, etc.) and sends 
a message to the appropriate handler. In the case of a 
mouse-down in the menu bar, DispatchEvent sends a 
DoMouseDown message. 

•:• The DoMouseDown method in CSwitchboard sends a Dis
patchClick message to the CDesktop instance. 

•:• The DispatchClick method discriminates between the var
ious places on the desktop in which a mouse click can 
occur and sends an UpdateAllMenus message to the 
CBartender instance. It also sends a MenuSelect mes
sage, and if a menu command was selected, it sends a 
DoCommand message to the instance stored in the global 
gGopher variable (in our case, CEnsembleDoc). 

•:• If, instead of a mouse click, the DispatchEvent method 
recognizes a key press event, it sends a DoKeyEvent mes
sage, which is handled by the method of that name in the 
CSwitchboard instance. This method determines whether 
the Command key is down, and if so, it sends an 
UpdateAllMenus message to the CBartender instance. 
Then, if a valid Command key combination was entered, 
DoKeyEvent sends a DoCommand message to the 
instance stored in the global gGopher variable (which, 
again, is our CEnsembleDoc instance). 

Looking at the default code generated by AppMaker, you can 
see that when the CMainWindow instance is created, the its
Gopher instance variable is set to point to the CEnsemble-
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DoCommand 
method code 
(beginning) 

Doc instance, as shown in Figure 2-1. This means that all 
commands will first be handled by the DoCommand method 
in the CEnsembleDoc instance. 

If you examine the code for the DoCommand method in the 
CEnsembleDoc class, you will see that it does not handle even 
a single command, but, instead, calls the inherited DoCom
mand method in the TCL's CDocument class. The code for the 
CEnsembleDoc class's DoCommand method is as follows: 

void EnsembleDoc::DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

default: 
{ 

inherited::DoCommand (theCommand); 
break; 

The commands handled by the DoCommand method inher
ited from the CDocument class include cmdSave, cmd
SaveAs, cmdRevert, cmdPageSetup, cmdPrint, and 
cmdUndo. All of these commands correspond to similarly 
named items in the File and Edit menus. If the chosen com
mand is not one of these, then the DoCommand method in
herited from the CBureaucrat class (which is an ancestor of 
the CDocument class in the TCL) will send the DoCommand 
message to the supervisor of the current instance (which in 
this case would be CEnsembleApp). 

The DoCommand method of CEnsembleApp doesn't do 
much to handle any other command, but it is worthwhile to 
look at its code: 

void CEnsembleApp::DoCommand (long theCommand) 
{ 

short theMenu; 
short theltem; 
Str255 theltemText; 

if (theCommand < 0) 



Do Command 
method code 
(concluded) 

DoCommand 
method code 
(beginning) 

} 
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/*menu generated dynamically*/ 
theMenu = HiShort (-theCommand); 
if (theMenu == MENUapple) 
{ 

/* handle Apple menu in superclass *I 
inherited::DoCommand (theCommand); 

else 
{ 

theltem = LoShort (-theCommand); 
Getltem (GetMHandle (theMenu), theltem, theltemText); 
/*do the right thing with the text of the item*/ 

else 
{ 

switch (theCommand) 
{ 

default: 
inherited::DoCommand (theCommand); 
break; 

There are several important features of AppMaker's generated 
code in the CEnsembleApp instance's DoCommand method. 
First, the code tests whether the command number is nega
tive. This will be the case only for desk accessories or other 
dynamically generated menu commands. 

The handling of Apple menu items is relegated to the super
class (ZEnsembleApp). Other menu commands created at 
run time should be handled by adding code at the place indi
cated by the comment. If the command number is positive, 
then the command is automatically passed to the inherited 
DoCommand method in the superclass. 

The DoCommand method in the ZEnsembleApp instance 
also handles a single instance: the About Application com
mand from the Apple menu, as shown in the following code: 

void ZEnsembleApp::DoCommand(long theCommand) 
{ 

short itemNr; 
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DoCommand 
method.code 
(concluded) 

switch (theCommand) 

{ 
case cmdAbout: 

itemNr =Alert (1, NULL); 

break; 

default: 

{ 
inherited::DoCommand (theCommand); 

break; 

When the About Application command is chosen from the 
Apple menu, the foregoing code will display an Alert. All other 
commands are passed to the inherited DoCommand method. 
In this case, the DoCommand method in CApplication is in
voked. This method handles the commands cmdNew, cmd
Open, cmdClose, cmdQuit, cmdUndo, cmdCut, cmdCopy, 
cmdPaste, cmdClear, and cmdToggleClip. All of these cor
respond to commands in the File and Edit menus. 

CApplication's DoCommand method also handles any com
mands with negative command numbers that are passed up 
the chain of command for it to handle. If no other method in 
the chain of command is able to handle it, a command will be 
ignored if the DoCommand method in CApplication cannot 
handle it. 

Examining Event Handling 

To recap, events are continuously fetched by the loop inside 
the Run method of the CApplication class. 

The Run method sends the ProcesslEvent message, which 
sends a ProcessEvent message to the CSwitchboard in
stance. The corresponding ProcessEvent method sends Get
AnEven t and then DispatchEvent messages to the 
CSwitchboard instance. The DispatchEvent method is the 
crucial discriminator in how various types of events are sub
sequently handled. 
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In the discussion regarding the dispatch of commands (either 
from menu choices or by combinations keyboard commands), 
occurrence of the event was followed by sending a DoCom
mand message to the current instance held in the gGopher 
global variable. 

Handling of events other than commands takes place in a dif
ferent fashion. When the DispatchEvent message is sent, the 
corresponding method determines what type of event has oc
curred and how it should be handled. Some of the possibili
ties are: 

•:• In all cases, a mouse click is sent to the CDesktop 
instance for resolution by its DispatchClick method. 
Clicks in the menu bar are handled as described in the dis
cussion of the chain of command. Other possibilities for 
mouse clicks are: 

• If the mouse click occurs on an insignificant part of the 
desktop, the number of clicks is counted and the 
DoClick message is sent; however, neither CDesktop 
nor its CView ancestor performs any function for this 
message. 

• If the mouse click occurs in a "system window" (i.e., a 
desk accessory), the toolbox SystemClick routine is 
used to handle the event. If this is the case, the applica
tion's event handler has washed its hands of the event, 
and no further processing takes place. 

• If the mouse click occurs in the content region of a win
dow, then if the window is inactive, it is selected, and if 
the actClick instance variable for the window is TRUE, 

the window is sent an Activate message. If the 
wantsClicks instance variable for the window is TRUE, 
then a DispatchClick message is sent to the window; 
otherwise, the click is handled in the same way as a 
click in the desktop (i.e., it is essentially ignored). 

• If the click occurs in the drag region of the window's title 
bar, a Drag message is sent to the window. The CWin
dow class's Drag method sends a Dragwind message to 
the CDesktop class to handle dragging the window on 
the desktop. 

• If the mouse click event occurs in the grow box of a win
dow, then a Resize message is sent to the window. The 
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Resize method of the CWindow class handles this event 
by calling the GrowWindow toolbox call, and then 
Resize sends a ChangeSize message to change the win
dow's physical size within the maximum and minimum 
size constraints for the window. Resize also sends an 
Update message to the window, to force it to redraw its 
contents. 

• If the click occurred in the go-away box of a window, 
then a Close message is sent to the window. The CWin
dow class handles the Close message by sending the 
window's supervisor a CloseWind message. In the case 
of the Ensemble application, CEnsembleDoc is the 
supervisor of the window, and a CloseWind message 
would be handled by the inherited method of that name 
from the CDocument class. 

• If the click occurred in the zoom box of a window, then if 
a mouse-up event also occurs in that box, the window is 
sent a Zoom message. The CWindow class handles this 
case by calling the ZoomWindow toolbox method, and 
then ZoomWindow adjusts the size of all the subviews 
by sending them an AdjustToEnclosure message. 

•:• Mouse-up events result in sending a DoMouseUp message 
to the last view that was referenced by the initial mouse
down click (held in the gLastViewHit global variable). 

•:• For key-down, key-up, or repeated key (autoKey) events, 
the CSwitchboard's DispatchEvent method sends a DoK
eyEvent message, which the CSwitchboard class's 
method of that name handles differently, depending on the 
type of event that is involved. In most cases, the gGopher 
global variable contains the destination instance to receive 
the event. This allows keystrokes to be sent directly to an 
active text field, minimizing the dispatch time. 

• If the event is a key-down event and the Command-key 
is also pressed, the event is treated as a command, as 
previously described. 

• If a key-down event was the Fl function key, it is han
dled as an Undo command by sending a DoCommand 
message with cmdUndo to the current gGopher 
instance. 



Ensemble's Classes and Methods 43 

• If a key-down event was the F2 function key, it is han
dled as a Cut command by sending a DoCommand 
message with cmdCut to the current gGopher instance. 

• If a key-down event was the FS function key, it is han
dled as a Copy command by sending a DoCommand 
message with cmdCopy to the current gGopher 
instance. 

• If a key-down event was the F4 function key, it is han
dled as a Paste command by sending a DoCommand 
message with cmdPaste to the current gGopher 
instance. 

• All other key-down events result in sending a DoKey
Down message to the current gGopher instance. 

• Key-up and repeated key events are sent as DoKeyUp 
and DoAutoKey messages, respectively, to the current 
gGopher instance. 

•:•The DispatchEvent method also handles "disk events" by 
sending a DoDiskEvent message, which the CSwitch
board method of that name ignores, unless the event mes
sage indicates that an error has occurred (i.e., the disk 
requires formatting). If this is the case, an alert is dis
played and the user is given the opportunity to format the 
disk. 

•:• If an Update event occurs, DispatchEvent sends a DoUp
date message, which its method of that name handles by 
sending an Update message to the window associated with 
the Update event. Activate and Deactivate events are 
handled in the same way, by sending a DoActivate or a 
DoDeactivate message, which, in turn, causes an Acti
vate or a Deactivate message to be sent to the appropriate 
window. 

•:• Suspend and Resume events occur when another applica
tion is selected while running under Multifinder or when 
the current application is being resumed after a previously 
active application was suspended while running under 
Multifinder. DispatchEvent sends a DoSuspend or 
DoResume message in this case, which, in turn, causes a 
Suspend or a Resume message to be sent to the gA.pplica
tion instance. 
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•!•High-level events (Apple Events) are handled by sending a 
DoHighLevelEvent message, which the CSwitchboard 
method handles by checking whether the system is capa
ble of handling Apple Events, and then if so, calling the 
AEProcessAppleEvent toolbox routine to handle the stan
dard Apple Events. If an application is capable of handling 
other than the standard Apple Events, then it can override 
the DoHighLevelEvent method and process the additional 
high-level events. 

•!• If any other event occurs, DispatchEvent sends a 
DoOtherEvent message, which results in the method of 
that name in the CSwitchboard class being invoked. The 
DoOtherEvent method is empty, but can be overridden to 
produce any other desired behavior. 

Summary of Ensemble's Structure and Capabilities 

The Ensemble application is quite useless in its present 
form. While most of the necessary structural members are 
implemented, the application lacks a purpose or intrinsic 
functionality. 

This chapter has focused on the structure of the application 
and how commands and events are handled, with the inten
tion of convincing you that almost every application that you 
create will embody at least the default features described in 
the foregoing text. 

Most applications have at least one window and at least the 
standard Apple, File, and Edit menus. Commands and 
events are handled identically, regardless of the structure or 
complexity of an application built upon the THINK Class Li
brary. The function of the global gGopher, gDesktop, gBar
tender, gApplication, and other global variables does not 
change as the application increases in complexity. 

Subsequent chapters will discuss the procedures for trans
forming the Ensemble application into a worthwhile pro
gram. Each major addition to the application will be built 
upon what has previously been presented. This is a standard 
technique used when constructing applications. 

While you may elect to define a greater percentage of the user 
interface in a single session, incrementally adding the fea-
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tures described, combined with AppMaker's power to main
tain the integrity of your unique code, provides the incentive 
to approach the application development process in a step
by-step, methodical way. 

1. Explain how AppMaker's code-generation approach for 
THINK C will allow subsequent changes to be made to the 
user interface without requiring the programmer to cut 
and paste code from one generation to the next. 

2. Describe the situations in which AppMaker's code genera
tion approach will inhibit rather than help during the 
development of a large program. (Hint Suppose you 
decide to redesign the user interface completely. What 
effect would this have on the generated code?) 

3. When the user clicks the mouse button in various areas 
of the screen, what TCL method receives these events, 
and where are they dispatched? 

4. What happens when the user enters keystrokes when the 
application is active? Why is there no visible result of 
these keystrokes in our default Ensemble application? 

5. What is the purpose of the TRY and CATCH blocks in the 
generated code? Explain what service these perform. 
(Hint Look in the Object-Oriented Programming Manual 
for THINK C.) 

6. Explain the purpose of the gGopher variable, what it con
tains, and how it serves the object-oriented application. 
In particular, how is the gGopher variable related to the 
handling of events? 

7. Assuming that Figure 2-1 illustrates the universe of 
objects at the time the illustration was drawn, how many 
actual object instances exist? Explain. 

8. Describe the meaning of the terms "encapsulation," 
"inheritance," and "polymorphism" with respect to object
oriented programs. 
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Creating the Ensemble Application 

This chapter begins the task of improving and customizing 
the operation of the Ensemble application. Up to this point, 
we have used AppMaker to generate a default user interface, 
with standard menus and a single window, but no specific 
functionality. In this and the succeeding chapters, we will 
mold the user interface and the code into a useful application. 

It is the intent of this book to document the creation of a sin
gle, but nontrivial application, discussing many of the fea
tures of the TCL and how they are applied to realize a variety 
of functions inside the application. The application is named 
Ensemble because it embodies a set of cooperative functions 
inside a cohesive framework. It is an ensemble of functional
ity. 

In order to explore most of the TCL's intrinsic capabilities, the 
Ensemble application will incorporate the features of text ed
iting, spreadsheet, and graphing functions. Together, these 
will operate as a cooperative ensemble. The main intention is 
to explore the facilities of the TCL that support text editing, 
rectangular cellular tables, and drawing functions. With 
some experience in all these disciplines, it should be quite 
easy to apply these techniques to other, similar applications. 

Adding Text-editing Features to Ensemble 

The first, and easiest feature to add to the Ensemble applica
tion is a text-editing window. The intention of the design is 
not to provide an editor that is of desktop-publishing quality, 
but to create a window that contains text in a single font, 
size, style, and justification, with limited cut-and-paste edit
ing abilities. The design is similar to a notebook in which you 
would write short sections of text. The design will allow you to 

47 
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have multiple open text windows, and each of these can have 
its own text font, size, style, and justification. 

The primary purpose of adding features to the Ensemble ap
plication in a piecemeal fashion is to illustrate how easy it is 
to add capabilities incrementally to an existing object pro
gram. We'll be using AppMaker to create the new user inter
face elements, and then we will add the necessary code to 
bring the interface to life. Once the coding is complete, we'll 
compile and run the application. 

Using AppMaker to Enhance the MainWindow 

Figure 3-1 
Selecting Windows 
inAppMaker 

Recall that the resource file for the Ensemble application is 
named Ensemble.n.rsrc. If you double-click on this file, you 
will launch AppMaker, telling it to use the file. In the follow
ing tutorials, we will be adding functionality to the previously 
created resource file, and then we will also generate code to 
operate the new resources. The steps to enhance the Ensem
ble application's resource file are as follows: 

1. Launch AppMaker by double-clicking on the Ensem
ble.n.rsrc file. 

2. You will see a screen that looks like that shown in Figure 
1-5 on page 6. Only the selection window is displayed, 
and it contains the currently defined menu bars. In our 
case, only the Maln:Menu bar exists at this time. 

3. Click the mouse cursor on the Select menu and choose 
Windows, as shown in Figure 3-1. 



Figure 3-2 
Picking the 
MainWindow entry 

Figure 3-3 
Ensemble's default 
Main Window 
definition 
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4. Note that the current selection window now displays the 
Clipboard and default MainWindow entries. Double-click 
on the MainWindow entry, as shown in Figure 3 -2. 

§0~ Ensemble. n .rs re §0§ 

2 Wi ndo'w's: 

5. When the MainWindow entry is selected, the default win
dow that we created in Chapter 1 will be displayed. This 
window has the appearance shown in Figure 3-3. Notice 

(untitled) 

that there are no scroll bars or other indications that the 
window contains an editing pane. In fact , it does not. The 
purpose of the next few steps is to instruct you how to 
construct a text-editing pane inside this MainWindow 
definition. You start the process by clicking the Scroll
Pane tool , as shown in Figure 3-4. 
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Figure 3-4 
Selecting the 
ScrollPane tool from 
the Tools menu 
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6. When you select the ScrollPane tool, the cursor changes 
into a cross, and you should position the cross at the top 
left corner of the blank portion of the window pane, 
depress the mouse button, and drag the cursor down to 
the lower right corner of the window pane (right to its bot
tom right edge). When you release the mouse button, you 
will see that a scroll pane has been constructed. App
Maker constructs scroll panes with only a vertical scroll 
bar, by default. The horizontal scroll bar can easily be 
added. A scroll pane is a pane with a scroll bar that 
allows an enclosed pane (called a panorama) to be 
scrolled-either horizontally, vertically, or in both direc
tions. In our case, the panorama is the EditText pane, 
whose construction is described in the next step. The 
complete construction of the text-editing pane is shown in 
Figure 3-5, and you may wish to refer to this figure for the 
succeeding steps. 

7. The next step is to add the EditText pane. Select the 
EditText tool, as shown in Figure 3-6. The cursor will 
again turn into a cross, and you should move it to the top 
left corner of the scroll pane, click and hold the mouse 
button down, and drag the mouse down to the lower right 
corner of the blank portion of the scroll pane. The Eclit
Text pane will show lines that correspond to the line 



Figure 3-5 
Adding a ScrollPane 
to the MainWindow 

Figure 3-6 
Selecting 
AppMaker's Ediffext 
tool 
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(untitled) 

---Window 

.....,,..---- CScroll Pane 

... Ediffext Tool 

spacing of text in the default font, size, and style. You 
don't have to bother changing this at the present time: 
We're going to provide the user with a method of changing 
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Figure 3-7 
Complete text
editing window 

D 

the text font, size, and style that will change the appear
ance of the entire text in a single operation. The complete 
text -editing window appears as shown in Figure 3-7. 

(untitled) 

.... ................................................... ...................................................... ....... Q 

................ ....... ......... .. ..................... ...... ... tr=i:l 
... .............. ............ ...... ·······~~ 

This completes the creation of the text-editing window. How
ever, in order to provide the user with the ability to change 
the text font , size , and style, we are going to create a new 
menu, a menu command, and a corresponding dialog box for 
changing the text window's appearance. 

Adding a New Menu to Ensemble 

The next few steps describe the step-by-step approach for 
adding a new menu to the Ensemble application's menu bar. 
This menu will contain only a single command at this time; 
however, new commands will be added as the application's 
feature set grows. 

1. The first step in creating a new menu requires that you 
click on AppMaker's Select menu, pull it down, and 
select the Menus choice, as shown in Figure 3-8. 

2. AppMaker's selection window will show the MainMenu 
choice. Pick that choice by double-clicking on it in the 
window, as shown in Figure 3-9. 

3. The default menu bar will appear on your screen. At this 
point, go to the Edit menu and choose the Create Menu 
command, as shown in Figure 3-10. This will create a 
new blank menu to the right of the Edit menu in the 



Figure 3-8 
Choosing Menus 
from AppMaker's 
Select menu 

Figure 3-9 
Picking the 
MainMenu bar in 
AppMaker's 
selection window 

Figure 3-10 
Select Create Menu 
from AppMaker's 
Edit menu 
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Figure 3-11 
New blank menu 

Figure 3-12 
New Format menu, 
with Notebook ... 
command 

Ensemble application's MainMenu menu bar, as shown 
in Figure 3-11. 

D MainMenu 

Blank Menu s File Edit L ---

4. The next step is to click inside the rectangle at the top of 
the new blank menu, type the name Format and then 
enter a carriage return. AppMaker will create a rectangle 
for the first menu command in the Format menu. You'll 
notice that it has three compartments, containing, from 
left to right, the command name, the command key, and 
the command number. Enter the name Notebook ... (note 
that the ellipsis ' .. .' is formed either by typing three con
secutive periods or by using the Option-; key combina
tion), tab twice to skip the command key field, and type 
2000 for the command number. The entire menu entry is 
shown in Figure 3-12. Type the Enter key to indicate that 

Z Notebook ... r··"·M• #2000 

the menu is complete, and then click on the close box of 
the menu bar to dismiss the window. 

Adding a New Menu Bar and Font Menu to Ensemble 

The next series of steps creates a new menu bar for the En
semble application. The purpose of this menu bar is simply to 
contain a Font menu that we will be using when adding new 



Figure 3-13 
Create a new menu 
bar to hold the Font 
menu 

Figure 3-14 
New SubMenus 
menu bar 
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code to insert the user's installed fonts into the Format Note
book dialog box that will be described shortly. 

1. Make sure that the MainMenu window is closed, but that 
Menus are still checked in the Select menu. 

2. Pull down the Edit menu and select Create Menu Bar, as 
shown in Figure 3-13. 

Select Fieni Tools 

!: 1Hd Undo '.*:Z 

!: Ht :.irn 
[ O!H.~ :~:c 

Pash~ :~:ll 

!: h~ar 

Tn1t S1~jl(L,_ :~:v 

Edit Balloons... ~E 

(re ate Menu Bar... :~:K 

3. After you release the mouse button, AppMaker will dis
play a dialog in which you can name your new menu bar, 
as shown in Figure 3-14. The suggested new name is 
SubMenus. This is fine, so click OK in the dialog box. 
AppMaker will display a new blank menu bar, and the 
name SubMenus will be in the selection list. 

OK J 
( Cancel ) 

Name: 

ID: IL..-2 _ __, 

4. Select Create Menu from the Edit menu at this time, as 
shown in Figure 3-15. 
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Figure 3-15 
Create new menu to 
hold FONT 
information 

Figure 3-16 
New Font menu and 
two initial entries 
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5. Finally, type in the name Font at the top of the new 
menu, and enter the names System and Application into 
the menu, as shown in Figure 3-16. This will provide the 
first two entries for the new menu. AppMaker will auto
matically generate code to load the user's FONT names 
into this menu, as you will see in the next chapter. 

Font 

System 
Application 

This concludes the operations necessary to create the Font 
menu in a new menu bar. This menu will never be displayed; 
however, the two initial entries and the user's font names 
that are added by AppMaker's generated code will be used to 
create a scrolling list of font names in the Format Notebook 
dialog box. 

Adding a Dialog Box to Ensemble 

The next series of steps involves the creation of a dialog box 
that will automatically open when the Format Notebook 



Figure 3-17 
Choosing Dialogs 
from AppMaker's 
Select menu 

Figure 3-18 
Choosing Create 
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command is chosen. When additional dialog boxes are added, 
we will follow this same procedure. 

1. The first step is to choose Dialogs from AppMaker's 
Select menu, as shown in Figure 3-17. 
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Windows 8€2 

2. You will notice that AppMaker's dialog selection list is 
empty at this point. This is because no dialogs have yet 
been defined. To create a new dialog, pull down the Edit 
menu and choose Create Dialog, as shown in Figure 3-18. 
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3. AppMaker will display a screen that shows the various 
choices for types of dialog windows. Type in the informa
tion and select the standard plain dialog window, as 
shown in Figure 3-19. 
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Figure 3-19 
AppMaker's dialog 
information box 

Figure 3-20 
AppMaker's dialog 
selection list 
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4. You should type the name Notebook for the name of the 
dialog and anything you want for the title, which is not 
displayed for a plain dialog window. The name Notebook 
is used by AppMaker to match against corresponding 
Menu commands, and because this name matches the 
command with that name in the Format menu (see Fig
ure 3-12), AppMaker will generate code to open our Note
book dialog automatically when that menu command is 
chosen. When you have completed this step, click the OK 
button, and you'll see the Notebook entry appear in App
Maker's Dialog Selection List, as shown in Figure 3-20. 

~D~ Ensemble.n.rsrc ~0~ 
1 Dialog: 

5. Double-click on the Notebook entry in the selection list 
and you will see the empty Notebook dialog that is shown 
in Figure 3-21. In the next few steps, you will be filling in 
the contents of this dialog. 
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Empty Notebook 
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Figure 3-22 
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6. In order to help you visualize what you need to do to 
duplicate its appearance, the Notebook dialog is shown 
in its completed state in Figure 3-22. 

CDialogText Items 

7. Note that the dialog is created with default OK and Can
cel buttons. The first step is to resize the dialog box to 
make it wide enough to contain all the items shown in the 
figure. You will also need to move the OK and Cancel but
tons by clicking on them with the arrow tool and dragging 
them to appropriate positions in the dialog. 

8. Creation of the scrolling lists consists of combinlng sev
eral interface components. This is best illustrated by the 
diagram in Figure 3-23. 
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Figure 3-23 
Construction of 
scroll pane 
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9. Notice that the scrolling list is created from three basic 
components: a CScrollPane, a CBorder, and a CTable 
component. If you choose Show Tools as Text from App
Maker's View menu, you will be able to choose these 
components by name. Start by choosing the CScrollPane 
tool, position the cursor (cross) at the top left edge of 
where you want to locate the pane, press the mouse but
ton, and drag down and to the right to create the pane. 
When you release the mouse button, a pane with a verti
cal scroll bar will be shown. 

10. The next step is to create the border that encloses the 
blank portion of the scroll pane. This is accomplished by 
choosing the CBorder tool, positioning the cursor (cross) 
at the upper-left corner of the ScrollPane, pressing the 
mouse button, and dragging down and to the right just 
until the border pane covers the blank portion of the 
scroll pane. 

11. The final step is to create a CTable object that fits within 
the border. Select the CTable tool, click the cursor (cross) 
at the top left of the border pane, press the mouse button, 
and drag down and to the right so that the CTable pane 
fits within the border previously drawn. When you release 
the mouse button, you will see that AppMaker has writ
ten four entries into the pane, to show you the appear
ance of the completed table. These entries read: one, two, 
three, infinity. 



Figure 3-24 
Construction of 
radio group 
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12. Create another scrolling list by following steps 9-11. This 
will be the Font Size scrolling list. Create the CScroll
Pane, CBorder, and CTable components, as shown. 

13. The next step is to create the checkboxes that will be used 
to set the text style. Because text styles are additive, mul
tiple boxes can be checked simultaneously. The checkbox 
is the perfect interface element for this application. A 
checkbox is a user interface element that changes state 
from on to off each time it is clicked. The on status is 
shown as an X inside the box, whereas in the off state, 
the interior of the box is empty. To create a checkbox, 
select the CCheckbox tool and click the mouse button at 
the left edge of where you want the checkbox and its label 
to be positioned. After you release the mouse button, you 
will be able to type in the label for the checkbox. Although 
AppMaker allows you to specify the style of each of the 
text items you define, leave all the text in its default style. 

14. The next interface item consists of two components: a 
CRadioGroupPane and multiple CRadioControl ele
ments. A radio group pane groups a set of radio button 
elements, the distinguishing feature of which is that only 
one button in the group can be active. The active state is 
shown as a black dot inside the button, whereas when a 
radio button is off. the interior of the button is empty. 
The construction of this item is shown in Figure 3-24. 
You have to create the CRadioGroupPane first, by select
ing that tool. Then, position the cursor at the top left cor
ner of the pane, press the mouse button, and drag down 
and to the right to the bottom right corner that marks the 
extent of the group. The CRadioControl elements are 
placed inside the CRadioGroup pane. 

r·@-L~f;---- ------------.. :·_-._, - CRadioGroup 

Pane O Center 

0 Right 

__ C2_~-~-~:_:_~:1-~ _____ _J 
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15. Create the CRadioControl elements by selecting that tool 
and then clicking the mouse button at the position where 
you wish the left edge of the button to be located. When 
you release the mouse button, you will be able to type in 
the text associated with the button. If you need to resize 
the CRadioGroupPane to accommodate the number of 
buttons, that is easily accomplished by selecting the 
Arrow tool, clicking on the pane's border, and then using 
the pane's size box to change the size of the pane. 

16. Next, create the CDialogText elements by choosing that 
tool and creating a single-line element below each of the 
scrolling lists, and a third element below the RadioGroup
Pane. These will be used to show the chosen font, the 
chosen size, and a sample of the actual text, respectively. 

17. The final step in creating the dialog box is to enter the 
Static Text items that identify the Font, Size, Style, and 
Justification elements in the dialog box. 

18. This completes the modifications to the Ensemble.1t.rsrc 
file at this time. Save the file and choose the Generate 
option from the File menu. You will see that all of the files 
whose names begin with the letter 'z' will be regenerated, 
and four new files will have been added to the list: Note
book.c, Notebook.h, zNotebook.c, and zNotebook.h. 
These four files comprise the code that implements the 
Notebook dialog box that you have just created. 

During the course of creating the Notebook dialog box inter
face elements, you may have to resize the dialog box or one or 
more of the elements. Feel free to do so, until everything 
looks correctly proportioned to your eye. You will be able to 
change any item at any time in the future, so don't worry 
about getting everything right the first time. You can also de
lete an element and recreate it at any time. This is one of the 
powerful features of AppMaker; it allows you to modify the in
terface appearance at any time. If you make changes by add
ing or deleting elements, make sure that you choose 
Generate from the File menu before you quit. Always save 
the results of modifying the Ensemble.1t.rsrc file when an 
AppMaker session is complete. 
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Each time you generate files in AppMaker, you will discover 
that all of the files whose names begin with the letter 'z' are 
regenerated. In addition, AppMaker will regenerate the Re
sourceDefs.h file, because this file contains definitions of the 
resource numbers for important user interface elements. 

You'll notice that AppMaker never regenerates the files whose 
names do not begin with the letter z. In this particular case, 
we have defined a new dialog box, and therefore, two brand 
new files are generated. The subclass files called Notebook.c 
and Notebook.h will be generated this time, in addition to 
their superclass files zNotebook.c and zNotebook.h. 

You can force AppMaker to regenerate a subclass file by de
leting the file from the project folder. When AppMaker notices 
that it is missing, it will elect to regenerate the file. 

Compiling the Generated Code 

After the changes have been made to the Ensemble.n.rsrc 
file, and new source code files have been generated, you can 
launch THINK C to add these new source files to the project. 
To do this, double-click on the Ensemble.n project file and 
choose the Add command from THINK C's Source menu. 
Navigate to the project's folder if necessary, and add the 
Notebook.c and zNotebook.c files. (These should be the only 
entirely new files.) Now you can compile the new code. The 
best way to do this is to select Make from the Source menu. 
Click the Use Disk button, wait for THINK C to determine 
which files need to be recompiled, and then click on the Make 
button. 

When the source files have been recompiled, select Run from 
the Project menu. This will display the debugger's windows, 
with the execution cursor positioned at the first instruction 
in the main function. Click the Go button in the debugger 
control window. The Main Window will be displayed. If you 
click the mouse inside the window, you will be able to type 
text in a default font. You can also zoom and resize the win
dow. If you type more text than will fit inside the window, the 
vertical scroll bar will become active and you will be able to 
scroll through the text. The standard Macintosh Cut and 
Paste commands will also be active for this window. Try cut
ting or copying some text to the clipboard and then pasting it 
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Exercises 

back into the window. The text-editing features, with the ex
ception of font, size, and style selection, are now complete. 

You will also see that a Format menu has been added to the 
menu bar, and pulling down that menu will display the Note
book command. Choose this command now. The Notebook 
dialog box should be displayed on the screen, just as it was 
defined in AppMaker. Note that the scrolling lists include en
tries with the words one, two, three, and infinity. This is the 
result of code that AppMaker has automatically generated 
and that we will modify for our own purposes in Chapter 5. If 
you click on one of the scrolling list entries, it should become 
highlighted. Clicking below all the entries should remove any 
existing highlight. 

If you click in the checkbox elements, the check marks will 
appear and disappear with multiple clicks. The radio button 
elements will work as a group, allowing only one member of 
the group to be selected at a time. 

It should be apparent that quite a bit of the code to operate 
the application has already been automatically generated. 
This is the real value of the AppMaker and THINK C combina
tion. Between AppMaker's generated code and the features of 
the THINK Class Library, most of the hard work has already 
been accomplished. 

The next chapter describes portions of the newly generated 
code, accenting the code that implements the new text-edit
ing features added to the Ensemble application. 

1. Describe the purpose of the scroll pane, border, and text
editing user interface elements. Indicate how these inter
act during the course of the application's execution. 

2. Use AppMaker's Text Style dialog to change the style of 
the text associated with each of the checkboxes in the 
Notebook dialog. The box titled Bold should be displayed 
in a boldface style; the one titled Italic should be dis
played in an italic style, and so forth. 
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3. Explain the difference in functionality between the check
box and radio button interface elements. When -is the use 
of one preferred over the other? 

4. Why are the radio buttons placed inside a radio group ele
ment in the Notebook dialog? What would be the effect if 
the radio group were not present. How would the radio 
buttons react to mouse clicks? 

5. Consider the consequences of allowing the user to enter a 
font name or font size into the corresponding dialog text 
fields. What should be done, if anything, to protect 
against the entry of a non-existent font name or font size? 
Explain. 

6. The text-editing pane could have been created as a 
CStyleText element instead of a CEditText element. 
Describe the difference in functionality between these two 
element types. (Hint: Refer to the description of the CEdit
Text class in the THINK C Object-Oriented Programming 
Manual, and the source code for the CStyleText class in 
the Text Classes folder within the THINK Class Library 1.1 
folder in the THINK C version 5.0 product.) 

7. Design and implement the text-editing pane as a CStyle
Text element. Make provisions for the pane to include 
text in multiple fonts, sizes, and styles. 1 

1. Creating and supporting the text-editing feature as a CStyleText element is a rather large 
undertaking. Covering this topic as part of an advanced course in object-oriented software 
development is highly recommended. 



Chapter 4 

Examining the EditText Code 

Let's take a moment to summarize the accomplishments de
scribed in the previous chapter. The Ensemble application's 
default resource file was initially created by AppMaker, as de
scribed in Chapter 2. Beginning with that file, according to 
the descriptions in Chapter 3, the following functions have 
been added: 

•!• ScrollPane and Ediffext panes to the MainWindow win
dow generated by AppMaker. 

•!• A new Format menu, with a command named Notebook. 

•!• A new SubMenus menu bar with a Font menu containing 
two initial entries; System and Application, referring to 
the System and Application fonts, respectively. 

•!• A Notebook dialog box with static text, scroll pane, text 
editing, checkbox, radio group, and radio button elements. 

•!• Generated code for the newly added features. This code 
consists of new versions of the zEnsembleApp, zEnsem
bleDoc, and zMainWindow files, and the new zNotebook 
and Notebook files. The ResourceDefs.h file has also been 
regenerated. 

All of the new interface elements are implemented in code 
within the files mentioned. As previously indicated, a file 
whose name begins with a character other than 'z' is never 
regenerated. The Notebook.c and Notebook.h files were gen
erated this time, because they are completely new files. On 
subsequent invocations of AppMaker, these files will not be 
automatically regenerated. 

67 
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The EditText Code Structure 

Figure 4-1 
Ensemble 
application's 
enhanced structure 
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The best way to see how the new code differs from AppMak
er's default-generated code is to compare the diagram in Fig
ure 4-1 with the diagram for the default code shown in Figure 
2-1 on page 24. 
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Notice that the new CNotebook and ZNotebook classes are 
now attached to the ZEnsembleDoc class. This is by virtue of 
the new code generated into the ZEnsembleDoc's DoCom
mand method. In addition, because the MainWindow has a 
pane that will accept events, the gGopher and the chain of 
command extend to the CMainWindow instance, as shown in 
the diagram. The CNotebook instance is created by the 
DoNotebook function that is embedded in the generated code 
for the CNotebook module. When the Notebook dialog is 
open, the gGopher variable will point to the CNotebook in
stance. In this case, the DoCommand method of the Note
book dialog will be the first to receive any commands sent to 
the gGopher. 

What might not be apparent from looking at Figure 4-1 is 
that quite a bit of new code has been added to several of the 
'z' file classes. In order to put the newly generated code into 



Table 4-1 
Generated code for 
the new EditText pane 
and new Format 
menu 
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perspective, Table 4-1 has been prepared to show the classes 
in which new code has been generated, the specific methods 
that have been enhanced, and the nature of the enhance
ments. Later sections will discuss the details of the generated 
code. 

Class Method Description 

ZEnsembleApp SetupMenus Includes code to create the FONT 
menu and add all the font names 

ZEnsembleDoc DoCommand Adds code to handle the Format 
Notebook command 

ZMainWindow IZMainWindow Additional code to create and 
install the CScrollPane and 
CEditText panes 

ZNotebook IZNotebook Code to create all the elements of 
the Format Notebook dialog 

CNotebook DoNotebook Not really a method of this class, 
but a global function that oper-
ates the Notebook dialog 

The sections that follow in this chapter describe the new 
code. Chapter 5 shows the details of the custom code, added 
to these classes, that fully implements the text-formatting 
features of the Ensemble application. 

Newly Generated Code in ZEnsembleApp 

In the new version of the generated code, the ZEnsembleApp 
module has been updated to include additional functionality. 
In general, only one of the original methods has been updated 
with new code. The remaining methods in the ZEnsemble
App module are unchanged. 

SetUpMenus Method Code 

The ZEnsembleApp module's SetUpMenus method has been 
enhanced to include code to create the Font submenu, and 
also automatically add the names of all the FONT resources 
by generating the AddResMenu code. The newly generated 
code is as follows: 
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void ZEnsembleApp::SetUpMenus(void) 
{ 

MenuHandl macMenu; 

inherited::SetUpMenus (); 
macMenu = GetMenu (5); //Font menu 
FailNILRes (macMenu); 
AddResMenu (macMenu, 'FONT'); 

The default version of this method contained only the call to the 
inherited SetUpMenus method, which is responsible for setting 
up the standard MainMenu menu bar and its menus. The new 
version adds the code to read in the menu (5) resource. 

The names of the user's list of installed fonts are added to the 
new menu using the Mac Toolbox's AddResMenu function, 
which adds the names of all the open font resources to the 
menu, in alphabetical order. This is the approved method for 
obtaining a list of the installed fonts. 

The new menu won't be used as such, but its list of fonts will 
be invaluable when the Format Notebook dialog box is cre
ated. 

Newly Generated Code in ZEnsembleDoc 

DoCommand 
method code 
(beginning) 

The next significant change to the generated code, as shown 
in Table 4-1, is the additional code in the ZEnsembleDoc 
class's DoCommand method. The new code for DoCommand 
is as follows: 

void ZEnsembleDoc::DoCommand (long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdNotebook: 
{ 

DoNotebook(this); 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 



DoCommand 
method code 
(concluded) 

The EditText Code Structure 71 

break; 

Note that the DoCommand method handles only the Note
book command from the Format menu. The generated code 
calls a global function DoNotebook, which is contained in 
the Notebook.c file. The single parameter passed to the 
DoNotebook function is a handle to the current object (CEn
sembleDoc). If any other command is chosen, the DoCom
mand method calls its inherited method in the TCL's 
CDocument class. 

Newly Generated Code in ZMainWindow 

IZMainWindow 
method code 
(beginning) 

The next new addition to the generated code can be found in 
the IZMainWindow method in the ZMainWindow.c file. It's 
easy to see how the new code, shown on page 71, differs from 
the code in the default version, shown on page 35. Specifi
cally, new code has been generated to install and initialize the 
CScrollPane and CAMEditText elements in the window. 

AppMaker can take care of creating these elements, because 
it has all the information it needs to do so. The resources that 
define the CScrollPane and CAMEditText elements are 
found in the Ensemble.1t.rsrc file, from which AppMaker can 
generate the appropriate code. 

AppMaker's general approach to adding new user interface 
elements is to generate a TCL-compatible resource containing 
the parameters associated with the element, and then use the 
IViewRes method inherited from the CView class in the TCL 
to initialize the newly created element. Since most elements 
have a few parameters that aren't visible in the current ver
sion of AppMaker. it is possible to "tune" the element's ap
pearance or behavior by using ResEdit or other resource
editing applications. The code for the new IZMainWindow 
method is as follows: 

void ZMainWindow::IZMainWindow (CDirector *aSupervisor) 
{ 

CView *enclosure; 
CBureaucrat *supervisor; 



72 Chapter 4> Examining the EditText Code 

IZMainWindow 
method code 
(concluded) 

CSizeBox *aSizeBox; 
!Window (MainWindowlD, FALSE, gDesktop, aSupervisor); 
itsMainPane = NULL; 

enclosure = this; 
supervisor = this; 

Scro11Pane1 =new CScrollPane; 
ScrollPane1->IViewRes ('ScPn', 131, enclosure, supervisor); 

Field3 = new CAMEditText; 
Field3->IViewRes ('AETx', 133, Scro11Pane1, supervisor); 

Scro11Pane1->lnsta11Panorama (Field3); 

aSizeBox = new CSizeBox; 
aSizeBox->ISizeBox (enclosure, supervisor); 

Note that in the first (default) version of this method (shown 
on page 35), AppMaker only generated code to call the inher
ited !Window method and create the CSizeBox instance. 

In the new version of the IZMainWindow method, AppMaker 
has generated code to create the CScrollPane (ScrollPanel) 
and CAMEditText elements and install the CAMEditText 
(Field3) element as the panorama for the CScrollPane. This 
code is all that is needed to allow you to type into the Main
Window pane, using the default system font. 

Newly Generated Code in ZNotebook 

The ZNotebook module (and its companion CNotebook mod
ule) implements the content and user interface functions of 
the Format Notebook dialog. The ZNotebook superclass 
contains four methods, each of which will be fully described 
in this section. 

IZNotebook Method Code 

The IZNotebook method is responsible for creating each of 
the user interface elements in the Format Notebook dialog 
and for initializing those elements. Each element is installed 
into the window by creating an instance of its associated 
class and then calling the appropriate IViewRes method to 
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set up its appearance and behavior. The code, which is quite 
long, is as follows: 

void ZNotebook::IZNotebook (CDirectorOwner *aSupervisor) 
{ 

CView *enclosure; 
CBureaucrat *supervisor; 

inherited::IAMDialogDirector (NotebooklD, aSupervisor); 

enclosure= itsWindow; 
supervisor = itsWindow; 

OKButton = new CAMButton; 
OKButton->IViewRes ('CtlP', 128, enclosure, supervisor); 

CancelButton =new CAMButton; 
CancelButton->IViewRes ('CtlP', 129, enclosure, supervisor); 

Fontlabel = new CAMStaticText; 
Fontlabel->IViewRes ('AETx', 129, enclosure, supervisor); 

Sizelabel = new CAMStaticText; 
Sizelabel->IViewRes ('AETx', 130, enclosure, supervisor); 
Stylelabel = new CAMStaticText; 
Stylelabel->IViewRes ('AETx', 131, enclosure, supervisor); 

BoldCheck = new CAMCheckBox; 
BoldCheck->IViewRes ('CtlP', 132, enclosure, supervisor); 

ltalicCheck = new CAMCheckBox; 
ltalicCheck->IViewRes ('CtlP', 133, enclosure, supervisor); 

UnderlineCheck = new CAMCheckBox; 
UnderlineCheck->IViewRes ('CtlP', 134, enclosure, supervisor); 

OutlineCheck = new CAMCheckBox; 
OutlineCheck->IViewRes ('CtlP', 135, enclosure, supervisor); 

ShadowCheck = new CAMCheckBox; 
ShadowCheck->IViewRes ('CtlP', 136, enclosure, supervisor); 

CondenseCheck = new CAMCheckBox; 
CondenseCheck->IViewRes ('CtlP', 137, enclosure, supervisor); 

ExtendCheck = new CAMCheckBox; 
ExtendCheck->IViewRes ('CtlP', 138, enclosure, supervisor); 
Justificationlabel = new CAMStaticText; 
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IZNotebook method 
(condluded) 

Justificationlabel->IViewRes ('AETx', 132, enclosure, supervisor); 

Field14 = new CAM Dialog Text; 
Field14->IViewRes ('ADTx', 128, enclosure, supervisor); 

Field15 = new CAMDialogText; 
Field15->IViewRes ('ADTx', 129, enclosure, supervisor); 

Field16 =new CAMDialogText; 
Field16->IViewRes ('ADTx', 130, enclosure, supervisor); 

Group17 = new CRadioGroupPane; 
Group17->IViewRes ('Pane', 128, enclosure, supervisor); 
CenterRadio =new CAMRadioControl; 
CenterRadio->IViewRes ('CtlP', 140, Group17, Group17); 
RightRadio =new CAMRadioControl; 
RightRadio->IViewRes ('CtlP', 141, Group17, Group17); 
ForceleftRadio =new CAMRadioControl; 
ForceleftRadio->IViewRes ('CtlP', 143, Group17, Group17); 
LeftRadio =new CAMRadioControl; 
LeftRadio->IViewRes ('CtlP', 139, Group17, Group17); 

Scro11Pane22 = new CScrollPane; 
ScrollPane22->IViewRes ('ScPn', 132, enclosure, supervisor); 

Rect24 = new CAMBorder; 
Rect24->IViewRes ('Bord', 130, Scro11Pane22, supervisor); 

List25 = Newlist25 (); 
List25->IViewRes ('ATbl', 134, Rect24, supervisor); 

Scro11Pane22->lnsta11Panorama (List25); 

Scro11Pane26 =new CScrollPane; 
ScrollPane26->IViewRes ('ScPn', 133, enclosure, supervisor); 

Rect28 = new CAMBorder; 
Rect28->IViewRes ('Bord', 131, Scro11Pane26, supervisor); 

List29 = Newlist29 (); 
List29->IViewRes ('ATbl', 135, Rect28, supervisor); 

Scro11Pane26->lnstall Panorama (List29); 
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As you can see, there is a great deal of generated code to im
plement the appearance of the Format Notebook dialog. The 
code performs the following actions: 

1. The OKButton is the first to be created. AppMaker will 
automatically create standard OK and Cancel buttons in 
every new dialog. The OK button is the element that will 
be given the bold outline when the dialog is first shown. 

2. The Cancemutton is the next to be defined and initial
ized. This button does not have a bold outline. 

3. The next three elements are CAMStaticText elements 
called FontLabel, SizeLabel, and StyleLabel. They 
appear in this order only because they were defined in 
that order. 

4. The next series of elements conprises instances of CAM
Checkbox, which implements a standard Macintosh 
checkbox function. The TCL takes care of automatically 
drawing the 'X' in the box when it's selected and clearing 
the 'X' when it's deselected. The CAMCheckbox elements 
are named according to their labels: BoldCheck, Italic
Check, UnderlineCheck, OutlineCheck, ShadowCheck, 
CondenseCheck, and ExtendCheck. 

5. The JustificationLabel CAMStaticText element is the 
next element to be defined. When the dialog box was cre
ated, that label was added after the width of the checkbox 
elements had been determined. 

6. The next three elements are the CAMDialogText items, 
corresponding to the blank boxes in the dialog. The vari
ous elements of the dialog are shown in Figure 3-22, on 
page 59, where they are referred to as EditText items. 
They are named Fieldl4, Fieldl5, and Fieldl6 and will 
eventually hold the selected font name, selected font size, 
and a sample of the font in the selected size, style, and 
justification, respectively. 

7. The next element, called Groupl7, is a CRadioGroup
Pane instance, which holds and manages the text justifi
cation radio buttons. 
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8. The individual text justification CAMRadioControl 
instances are named CenterRadio, ForceLeftRadio, 
RightRadio, and LeftRadio, to correspond to their 
respective labels. Each of these is created and initialized 
by passing the IViewRes method its supervisor, the 
Groupl 7 CRadioGroupPane element. 

9. The final two elements are the scrolling lists that will hold 
the font names and font sizes when the dialog is fully ini
tialized. Each of the scrolling lists is built as shown in 
Figure 3-23 on page 60. An instance of CScrollPane is 
created, an instance of CAMBorder is placed inside of the 
scroll pane, and then a new list is created and placed 
inside the border. When the elements have all been cre
ated, the list is installed as the panorama for the compos
ite pane. 

The two scrolling lists are very similar; their only fundamen
tal difference is the use of the NewList25 and NewList29 
methods to create the list instances. The rationale for provid
ing custom methods for the lists is discussed in the following 
section. 

NewList25 Method Code 

The IZNotebook method calls the NewList25 method to cre
ate the font name list. 

The code to implement this (along with AppMaker's com
ments) is as follows: 

II The only purpose of this function is so that you can override it 
II to create the list as your subclass of CAMTable 

CAMTable *ZNotebook::Newlist25 (void) 
{ 

CAMTable *thelist; 

thelist = new CAMTable; 
return (thelist); 

As indicated by the generated comment, AppMaker expects 
you to use an override method in the CNotebook module to 
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fully create and initialize the list instance. In fact, AppMaker 
even generates an override method in the CNotebook class, 
as will shortly be shown. 

NewList29 Method Code 

As with the NewList25 code, AppMaker generates a method 
to create an instance of the font size list. AppMaker expects 
you to use an override method to fully create and initialize 
the list instance. The code generated into the ZNotebook 
module for the NewList29 method is as follows: 

CAMTable *ZNotebook::Newlist29 (void) 
{ 

CAMTable *thelist; 

thelist = new CAMTable; 
return (thelist); 

UpdateMenus Method Code 

The ZNotebook class also contains an override of the inher
ited CAMDialogDirector class's UpdateMenus method, 
merely to provide a method for the CNotebook class to over
ride. The code that implements this method is as follows: 

void ZNotebook::UpdateMenus (void) 
{ 

inherited::UpdateMenus (); 

As is apparent, the generated code merely calls the inherited 
method. 

Newly Generated Code in CNotebook 

Quite a few methods are provided in the AppMaker-generated 
CNotebook module. In addition, the DoNotebook global 
function is also generated into this module. This is the func
tion that the code in the DoCommand method of the ZEn
sembleDoc class calls to initiate the opening of the Format 
Notebook dialog. The next few sections discuss the code that 
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was generated into the CNotebook.c file. In order to provide 
the dialog with full functionality, additional code, described 
in Chapter 5, will be provided. 

DoNotebook Function Code 

The generated code for the global DoNotebook function is 
found in the CNotebook module. The function is global so 
that the dialog can be called from any module in the applica
tion, not just the ZEnsembleDoc module. The code for the 
function is as follows: 

void DoNotebook (CDirectorOwner *aSupervisor) 
{ 

CNotebook *dialog; 
long dismisser; 

dialog = NULL; 
TRY 
{ 

dialog = new CNotebook; 
dialog->INotebook (aSupervisor); 

/* initialize dialog panes *I 
dialog->BeginDialog (); 
dismisser= dialog->DoModalDialog (cmdOK); 
if (dismisser== cmdOK) 
{ 

/* extract values from dialog panes *I 
} 
dialog->Dispose (); 

} 
CATCH 
{ 

ForgetObject (dialog); 
} 
ENDTRY; 

The generated code for DoNotebook contains an exception 
handling mechanism that is a new feature in THINK C ver
sion 5.0. The TRY and CATCH keywords are used, respectively, 
to introduce code that might fail when the enclosed code is 
executing and to specify the exception-handling procedure to 
use if that situation occurs. The ENDTRY keyword delimits the 
end of the exception-handling code. If an error occurs (such 
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as the inability to allocate memory for a new instance of the 
CNotebook class), the CATCH code will receive control, dis
pose of the dialog object, and propagate the failure condition 
up the exception handler stack, which eventually will display 
an appropriate alert to the user. It is possible to customize 
the CATCH handler to display its own alert, with information 
that is pertinent to the current application context. 

AppMaker has generated comments in the code for the 
DoNotebook function to indicate where to place additional 
custom code to initialize the dialog and also where to extract 
the results of the user's actions when the dialog is dismissed 
by clicking the OK button. 

INotebook Method Code 

The initialization code for the CNotebook instance created in 
the DoNotebook function is as follows: 

void CNotebook::INotebook (CDirectorOwner *aSupervisor) 
{ 

inherited::IZNotebook (aSupervisor); 

Basically, this code calls the inherited IZNotebook method, 
which creates instances of all the dialog interface elements 
and initializes their default appearances. The purpose of such 
an override method is to provide a place to perform additional 
initialization of the dialog's interface elements. IZNotebook 
will later be enhanced with custom code additions. 

CList25 IViewTemp Method Code 

The code for this method is as follow: 

void CList25::1ViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

II any additional initialization for your subclass 
AddRow (4, O); II e.g., add 4 rows at the beginning of the list 
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GetCellText 
method code 
(beginning} 

AppMaker generates code in the CNotebook subclass to over
ride the ZNotebook class's IViewTemp method for creating 
the scrolling lists. In this case, AppMaker also generates a 
single line of code that adds four rows to the beginning of the 
list, just to indicate how adding rows is done. This method 
will be modified to perform the appropriate initialization of 
CList25, using the font names from the Font menu con
structed within AppMaker. 

CList25 GetCellTe:rt Method Code 

The standard method that AppMaker uses in its generated 
code for user interface elements of the CTable class is to 
override the CTable class's GetCellText method. This over
ride provides a very simple method of supplying the text for 
table cells. 

The GetCellText method is called with three arguments. The 
first argument contains the cell (column and row) that 
CTable requires; the second provides the width of the cell, for 
situations where you want to provide special clipping of the 
cell's contents; and the third is a pointer to a Str255 variable, 
in which the text for that cell is to be stored. The function of 
the GetCellTe:rt method is to provide the text for the cell. 

Notice that the CTable class in the TCL keeps track of which 
cells have text that needs to be updated. This is a perfect ex
ample of the power of the THINK Class Library providing most 
of the functionality of an interface element. Given the cell 
whose text is required, you need only supply the code that 
provides it, as as follows: 

void CList25::GetCellText (Cell aCell, 
short availableWidth, StringPtr itsText) 

II replace with your own code which uses the cell coordinates to access 
II your private data structures, then convert the cell data to a Str255. 
switch (aCell.v} { 

case 0: 
CopyPString ("\pOne", itsText); 

break; 
case 1: 

CopyPString ("\pTwo", itsText); 
break; 

case 2: 
CopyPString ("\pThree", itsText); 
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method.code 
(concluded) 

break; 
default: 
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CopyPString ("\plnfinity", itsText); 
break; 

The default-generated code uses the cell's row (aCell.v) value 
to determine which of the four messages to copy to the its
Text string. Notice that cell rows (aCell.v) and columns 
(aCell.h) are zero based. That is, their values begin with 0, in
stead of 1. In the section of this chapter that discusses cus
tomizing the GetCellText code, all of this code will be 
customized to store the font names into the table's cells. 

CNotebook NewList25 Method Code 

The ZNotebook superclass defined a method called New
List25, shown on page 76. This method provides the oppor
tunity to override NewList25's functionality in the 
CNotebook subclass, to provide a different type of list, or to 
add new functionality to the list. The NewList25 code will not 
need to be changed: 

CAMTable *CNotebook::NewList25 (void) 
{ 

CList25 *theList; 
theList = new CList25; 
return (theList); 

CList29 Class Methods 

The CList29 class is generated for the font size table, and the 
default initialization code generated for it is nearly identical 
to the corresponding IViewTemp, GetCellText, and New
Listn code for the CList25 class. 

In general, AppMaker will generate a similar new class and 
corresponding methods for each list element defined in the 
user interface. Each such class will contain an IViewRes 
method for its initialization, a GetCellText method to provide 
the contents of each cell to the default DrawCell method in
herited from the CTable class in the TCL, and finally, a New-
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DoCommand 
met1wd code 
(beginning) 

Listn method that creates the instance of the list. We will not 
be showing duplicates of these classes and methods in this 
book, except when they need to contain unique custom code. 

CNotebook UpdateMenus Method Code 

AppMaker also generates an UpdateMenus method, as an 
override of the same method generated in the ZNotebook su
perclass. The method is intended for situations where menu 
commands need to be enabled or disabled, depending on the 
status of the dialog. The default-generated code is as follows: 

void CNotebook::UpdateMenus (void) 
{ 

inherited::UpdateMenus (); 

The code for the UpdateMenus method will not need to be 
modified. 

CNotebook DoCommand Method Code 

The generated code for the CNotebook class also contains 
code for a DoCommand method. When the Format Note
book dialog is active, the gGopher global variable points to 
the dialog. Whenever an event occurs while the dialog is ac
tive, its DoCommand method will be called. The code for the 
DoCommand method is as follows: 

void CNotebook::DoCommand (long theCommand) 
{ 

switch (theCommand) { 
case cmdBoldCheck: 

/* DoBoldCheck ();*/ 
break; 

case cmdltalicCheck: 
/* DoltalicCheck ();*/ 

break; 
case cmdUnderlineCheck: 

/* DoUnderlineCheck ();*/ 
break; 

case cmdOutlineCheck: 
/* DoOutlineCheck ();*/ 

break; 
case cmdShadowCheck: 

/* DoShadowCheck ();*/ 
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method code 
(concluded) 

break; 
case cmdCondenseCheck: 

/* DoCondenseCheck ();*/ 
break; 

case cmdExtendCheck: 
/* DoExtendCheck ();*/ 

break; 
case cmdCenterRadio: 

/* DoCenterRadio ();*/ 
break; 

case cmdRightRadio: 
/* DoRightRadio ();*/ 

break; 
case cmdForceLeftRadio: 

/* DoForceLeftRadio ();*/ 
break; 

case cmdleftRadio: 
/* DoLeftRadio ();*/ 

break; 

default: 
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inherited::DoCommand (theCommand); 
break; 

The DoCommand method is called with the command num
ber for the interface element associated with the command. It 
is important to note that AppMaker generates click com
mands for all of the checkboxes and radio buttons in the For
mat Notebook dialog. 

AppMaker also generates comments in the code which recom
mend that you supply methods that handle the various types 
of commands (e.g., DoBoldCheck( )). The custom code will be 
added directly to the DoCommand method's individual 
cases. This is appropriate because each command will only 
require the addition of a single statement. Creating separate 
methods or functions for the purpose would be inefficient. 

CNotebook ProviderChanged Method Code 

The final method generated into the CNotebook class is called 
ProviderChanged. This is a veiy powerful method that is part 
of the TCL's provider and dependent notification methodology. 



84 Chapter 4> Examining the EditText Code 

There are many cases in which it is important to indicate to 
an instance that the user has modified an interface element 
associated with a different class. For example, if you had an 
application that computed conversions in inches, picas, 
points, or ciceros, it would be important to know that the 
user had typed a value into one of these fields and to be able 
to automatically update the others to reflect the change. 

The TCL implements a class called CCollaborator which con
tains methods that allow you to add providers and depen
dents, such that when a provider class senses a change, it 
can broadcast the nature of the change, and its dependents 
can determine what to do in each instance. 

The TCL's CBureaucrat class directly overrides the CCollabo
rator's BroadcastChange method and sends a Provider
Changed message to the supervisor of the class in which the 
change occurred. 

Each of the user interface items in the dialog is supervised by 
the CNotebook class. When the user types into any of the di
alog text panes, a BroadcastChange message is sent by the 
DoKeyDown method inherited by the CAMDialogText in
stance from the CDialogText class. 

In a similar fashion, the SetValue method inherited from the 
CControl class sends a BroadcastChange message when the 
state of a control (checkbox or radio button) is changed, and 
finally, the SelectRect and DeselectRect methods of the 
CTable class send the BroadcastChange message when a ta
ble entry is selected or deselected, respectively. Other classes 
in the TCL also send the BroadcastChange message; however, 
the ones previously mentioned pertain directly to the classes 
whose elements appear in the Format Notebook dialog. 

When the user clicks on one of the selections in the font 
name list, for example, the SelectRect method inherited 
from the CTable class sends a BroadcastChange message 
that includes the argument "tableSelectionChanged", which 
is intercepted by the BroadcastChange method override in 
the CBureaucrat class. This method in turn sends a Pro
viderChanged message to the table's supervisor, which is an 
instance of our CNotebook class. The CBureaucrat class 
also passes on the BroadcastChange message to the CCol-
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laborator class, which sends a ProviderChanged message to 
any of the registered dependents of the provider class. In our 
case, there are no registered dependents. 

The ProviderChanged method in the CNotebook class will 
catch the changes made to selections in the scrolling lists, as 
well as keystrokes entered into any of the text panes. The de
fault-generated code for the ProviderChanged method 
merely identifies which user interface element is affected by 
the change and leaves it up to us to provide appropriate code 
to respond to the change. This method will be customized to 
handle new list element selections and data typed into the 
text panes. The default-generated code for the Provider
Changed method is as follows: 

void CNotebook::ProviderChanged (CCollaborator *aProvider, 
long reason, 

if (aProvider == Field14) { 

} 

if (Field14->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == Field15) { 

} 

if (Field15->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == Field16) { 

} 

if (Field16->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == List25) { 
if (List25->HasSelection ()) { 

void* info) 

II perhaps activate some buttons 
} else { 

II perhaps deactivate 
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ProviderChanged 
method code 
(concluded) 

if (aProvider == List29) 
{ 

if (List29->HasSelection ()) { 
II perhaps activate some buttons 

} else { 
II perhaps deactivate 

AppMaker generates code for the text fields that determines 
whether the fields contain data or are empty. In the case of 
the list panes, AppMaker generates code that determines 
whether a selection has been made or whether the click that 
caused the method to be called has deselected all elements in 
the list. The comments indicate the type of actions your code 
might perform when the various events occur. 

Recap of the Generated Code 

Exercises 

As previously mentioned, AppMaker will generate new ver
sions of all the superclass modules (the ones whose names 
begin with the letter 'z'), and it will also generate both super
class and subclass modules for new windows and dialogs. 
The zNotebook and Notebook modules are examples of this 
code-generation philosophy. 

When a new menu command is added, code will be added to 
the DoCommand method of the document's superclass (e.g., 
zEnsembleDoc) to recognize the new command. If a dialog 
has the same name as a menu command, then code will be 
generated to invoke the dialog (e.g., DoNotebook) in the Do
Command method. 

The next chapter discusses how the generated code pre
sented in this chapter can be customized to fully implement 
the EditText features of the Ensemble application. 

1. Assuming that Figure 4-1 shows the universe of objects 
that exist at the time the illustration was drawn, how 
many actual object instances are represented in the dia-
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gram? Why are some of the classes not "real" object 
instances? 

2. Explain how the "chain of command" operates and what 
happens to commands and keystroke events that are rel
evant to the "chain of command." 

3. Explain the operation of the DoCommand method in the 
ZEnsembleDoc class. When and for what purpose does 
this method execute? 

4. Describe the interaction of the CScrollPane and CAMEdit
Text class methods. In what way are these interrelated in 
our application? (Hint Look up the description of the 
CPanorama class in the Object-Oriented Programming 
Manual for THINK C.) 

5. The IZNotebook method illustrates a very flexible feature 
of AppMaker's approach to code generation. What is sig
nift.cant about the code in IZNotebook? 

6. Describe the meaning of "collaboration," as this term is 
used in the THINK Class Library, and how our application 
benefits from its use. 

7. Describe the purpose and operation of the Provider
Changed method in the CNotebook class. 



Chapter 5 

Customizing the EditText Code 

Table 5-1 
Customized methods 
to fully implement 
EditText features 

Table 5-1 shows the classes and methods that will be cus
tomized and described in this chapter. 

Class Method Description 

CEnsembleApp SetUpMenus Adds Font menu 

CEnsembleDoc IEnsembleDoc Creates CFontData instance 

CEnsembleDoc NewFile Overrides the NewFile code 

CEnsembleDoc IniffextFormat Initializes the EditText pane 

CEnsembleDoc OpenFile Sets handle to file data into 
EditText pane 

CEnsembleDoc DoCommand Invokes DoNotebook dialog 

CEnsembleData IEnsembleData Initializes itsEditTextData 
handle 

CEnsembleData ReadData Reads itsTextData from file 

CEnsembleData WriteData Gets EditText handle and 
write out its contents 

CEnsembleData Do Revert Disposes of current data 

CFontData IFontData, Get- New class to encapsulate data 
FontData, Set- for Format Notebook dialog 
FontData controls and settings 

CMainWindow GetEdiITextHan Access methods for getting 
die, SetEdit- and setting the handle to the 
TextHandle EditText pane 

CMainWindow SeffextFontlnfo Sets the text font information 

CNotebook DoNotebook, Implements the Format Note-
and others book dialog box 

89 
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Customizing Methodology 

This is an appropriate place to mention the overall philoso
phy of customizing AppMaker's generated code. The modules 
generated for our application are typical, especially at this 
point in its construction. They include: 

CEnsembleMain The main program function, which creates the initial 
instance of CEnsembleApp and serves to initiate execution of 
the application. 

CEnsembleApp The subclass module for the application instance. Along with 
its ZEnsembleApp superclass, it defines the applicationwide 
behavior of the application. 

CEnsembleDoc The document subclass that owns the primary window and 
interfaces directly to the abstract data class, CEnsemble
Data. Along with its superclass, ZEnsembleDoc, this class 
forms the basis for all document-oriented behavior of the 
application. 

CEnsembleData The abstract data class for the application. All operations 
that interface with the file system are routed through this 
module. Its direct ancestor is the TCL's CDataFile class. 

CMainWindow The primary window in the application and the one owned 
directly by the CEnsembleDoc class. Along with its super
class, ZMainWindow, it defines the appearance of data 
within the window. 

CNotebook The single dialog class, that, along with its ZNotebook super
class, provides the appearance and functionality of the dia
log. It is instantiated via its embedded DoNotebook global 
function. 

Following is a list of what. in general, we must always cus
tomize: 

1. To implement any applicationwide features, such as add
ing the Font menu to the CBartender instance's list, we 
must modify the CEnsembleApp instance's methods. 

2. To customize aspects of our application that relate to its 
document, including the creation of new container 
classes for document-oriented data, modifications to the 
input/ output interface routines, and the handling of doc-
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ument-oriented commands, we must modify the appro
priate methods in the CEnsembleDoc instance. 

3. To implement the input/output (1/0) functions that are 
specific to our document, we must modify the methods in 
the CEnsembleData instance, especially the Read.Data, 
WriteData, and Revert methods. These are the sole inter
face with the physical data with which we will deal. 

4. To implement the appearance of the main window, which 
handles specific drawing functions, we must modify the 
methods associated with the CMainWindow instance. In 
the case of our Ediffext pane, all of the drawing is auto
matically handled; however, we must still provide the win
dow with access to the data to be transferred to and from 
the window via the document and its abstract data class. 

5. Finally, to implement the functionality of the Notebook 
dialog, we must modify the DoNotebook function and the 
methods in the CNotebook instance. 

Each new window added to the application will result in the 
generation of both a subclass and superclass, with methods 
that are similar to those in the MainWindow modules. Each 
new dialog will also result in the generation of a subclass and 
superclass for the dialog, with a Do<dialog-name> global 
function that must be modified, along with the methods in 
the dialog subclass instance. If a new addition requires that 
the file formats be changed, then modifications will have to 
be made to the CEnsembleData instance's methods. The 
customization methodology is thus predictable. The following 
section begins a step-by-step examination of our first set of 
custom changes to AppMaker's generated code. 

Customizing the CEnsembleApp Methods 

The CEnsembleAp_ module has been modified to add func
tionality to the application level. A SetUpMenus method has 
been added to override the superclass's method, making the 
menu available in the CBartender class's list of menus. The 
code for the enhanced method is as follows: 
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void CEnsembleApp::SetUpMenus () 
{ 

inherited::SetUpMenus(); 
gBartender->AddMenu (5, TRUE, hierMenu);// Font menu 

The override method first calls the inherited method and then 
sends a message to the CBartender instance (using the glo
bal gBartender variable) to add the Font menu (menu 5) to 
its list, treating the menu as a hierarchical menu (which 
won't cause the menu bar to be redrawn). 

This method merely adds the menu to the gBartender in
stance's list of menus. It does not cause the menu to be in
stalled in the menu bar. The primary purpose of adding this 
customized feature is to permit the menu's contents to be ac
cessed easily by other application methods. Placing the ini
tialization in the application guarantees that the menu will be 
installed at the earliest possible moment. 

Implementing the File Menu Commands 

The next set of changes to AppMaker's generated code in
volves implementing the standard File menu commands. 
These provide for saving text that has been entered into the 
MainWindow pane, opening and reading text previously 
saved in a file, and reverting to a previously saved version of a 
file. 

The commands named New, Open. Save, Save As, and Re
vert that appear in the File menu are all sent to the DoCom
mand method of the class whose handle is stored in the 
gGopher global variable. 

While the MainWindow is active, these commands will be 
sent to the MainWindow subclass instance because the 
gGopher variable will be pointing to that instance. (The Acti
vate method for the CMainWindow class sets the new value 
of the gGopher variable, when the window is activated.) 

The sequence of events that occur when one of these com
mands is issued is shown in Figure 5-1 and is described in 
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the steps that follow (the numbers in the figure correspond to 
the step numbers below): 

····· .... ~~;,4 . • © 0

\ ~Q)cmdOpen •• •• ~'!'!!?;."' 
~ .. /®j\.:···........... ~ 
~/ i \ ····· ... ..., 

© . .· : ~ cmdOpen ••• cmdOpen : 

cmdOpen j / f \ ~nWlndow .f 
CEnsembleApp ... / •••• ••• j ~ OoCommand •• l 

gAppllcatlon OoCommand •••••••• • cmdOpen i : (2\ • ••• •• 
0 cmdOpen i i cmdopeP..: •• •• ~ 

/ :j .. ···· ···::::::• gGop er 

~ .• CMainWindow •• 
~ •• DoCommand 

cmdOpen ©: .... / 
ZE~!"!lieDoc •••••• : .... .... 

Open File O~OQC!)ritllnd ...... .... 

CEnsembteDoc ••••• .·:...····-· -<"= 
OoCommand dO •• • 

7,j"\ cm pen ••• CEnsembteOata 
·· .. '2. ........... . 

Open Data 

1. Assuming that the Open command has been selected, 
CSwitchboard will send this command to the DoCom
mand method of the current gGopher, which is pointing 
to the CMainWindow instance. 

2. The CMainWindow's DoCommand method calls the 
inherited DoCommand method in the ZMainWindow 
class. 

3. The ZMainWindow's DoCommand method doesn't recog
nize the Open command, so it calls its inherited DoCom
mand method, in the CBureaucrat class. 

4. The CBureaucrat's DoCommand method sends the Open 
command to the DoCommand method in the supervisor 
for the current instance, which in this case is an instance 
of CEnsembleDoc. 

5. Neither CEnsembleDoc nor its superclass, ZEnsemble
Doc, recognizes the Open command; instead, they pass it 
up to the inherited method in the CDocument class. 
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6. Once again, the CDocument's DoCommand method is 
unable to recognize the Open command, so it passes the 
command to its inherited method from the CDirector 
class, which then passes the command up to the CBu
reaucrat class to handle. 

7. As in step 4, the CBureaucrat class sends the command 
to the DoCommand method in the supervisor of the cur
rent instance, which in this case would be an instance of 
the CEnsembleApp class. 

8. Neither the CEnsembleApp nor its ZEnsembleApp 
superclass handles the Open command in its DoCom
mand method, so the command is passed to the CAppli
cation class. 

9. Fortunately, the command's long trek ends here, because 
the DoCommand method in the CApplication class does 
indeed recognize the Open command. In addition, it also 
recognizes the New, Quit, and Show Clipboard com
mands. When the Open command is recognized, the CAp
plication's DoCommand method calls the 
OpenDocument method, which is an empty method in 
that class, but is overridden in the ZEnsembleApp class. 

The preceeding steps describe the (somewhat circuitous) 
journey of a command to its intended handler. Most of the 
commands in the File menu are recognized in either the 
CApplication or CDocument class in the TCL. The cases in 
the corresponding DoCommand methods in those classes 
call upon other methods that must be overridden in the us
er's supplied code. The reason for this is that only the user 
knows what is required to open the selected document, how 
to read its data, how to save its data, and how to revert to a 
previously saved version of a file. 

Fortunately, AppMaker generates most of the code to provide 
the functionality we need for these tasks. The following sec
tions describe the additional code that we have added to im
plement the File menu command handlers. 

CreateDocument Method Code 

The CApplication class recognizes the New command and 
sends a CreateDocument message, which is handled by the 
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override method in the ZEnsembleDoc class, as shown on 
page 32. The override method in turn sends a NewFile mes
sage, which is also handled by the generated code in the ZEn
sembleDoc class, as shown in the sample code on page 33. 
The generated code for these methods is unchanged in the 
new version of the Ensemble application. However, because 
we wish our text window to be initialized so that the user can 
immediately begin typing, we have added an override for the 
NewFile method in our CEnsembleDoc class. The code for 
this method is as follows: 

void CEnsembleDoc::NewFile (void) 
{ 

inherited ::NewFile(); 
lnitTextFormat(); 

After the inherited NewFile method is called, we invoke a new 
method that initializes the text pane format. This method 
makes use of the new instance variables that we have defined 
in the EnsembleDoc module. The complete class definition 
for the new module is as follows: 

class CEnsembleDoc : public ZEnsembleDoc 
{ 
public: 

II 
II manually added instance variables 
II 
CFontData *theTextData; 

II 
II generated public methods 
II 
void IEnsembleDoc (CApplication *aSupervisor, II is override 

Boolean printable); 
void UpdateMenus(void); II is override 
void DoCommand(long theCommand); II is override 

II 
II manually added methods 
II 
void NewFile (void); II is override 
void OpenFile(SFReply*macSFReply); II is override 
void lnitTextFormat(void); 
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CEnsembleDoc 
class declaration 
(concluded) 

CMainWindow *GetTextWindow (void); 

protected: 
II your application-specific instance variables: 

}; 

The new InitTextFormat method is responsible for changing 
the text format to the font, size, style, and alignment saved in 
the text file. The code for the InitTextFormat method is as 
follows: 

void CEnsembleDoc::lnitTextFormat(void) 
{ 

itsMainWindow->SetT extFontl nfo(the TextData); 

The InitTextFormat method sends a message that is han
dled by the SetTextFontlnfo method in the CMainWindow 
instance to accomplish its purpose. The theTextData is an 
instance of the CFontData class, as shown in the CEnsem
bleDoc class declaration. To complete the picture, the code 
for the SetTextFontlnfo method is as follows: 

void CMainWindow::SetTextFontlnfo (CFontData *theFontData) 
{ 

fontinfo itsFontData; 

itsFontData = theFontData->GetFontData(); 
Field3->SetFontNumber(itsFontData.fontNumber); 
Field3->SetFontSize(itsFontData. fontSize); 
Field3->SetFontStyle(O); II reset first 
Field3->SetFontStyle(itsFontData. fontStyle); 
Field3->SetAlignment(itsFontData.fontAlign); 

The CMainWindow class must handle changing the at
tributes of its panes, because, for example, the Field3 vari
able is specific to the CMainWindow class (and refers to the 
CAMEditText pane). The theFontData argument to the Set
TextFontlnfo method will be discussed later, in the context 
of the Notebook dialog code descriptions. 
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OpenDocument Method Code 

The generated code for the OpenDocument method in the 
ZEnsembleApp class is left as is. The code sends an Open
File message to a newly created instance of CEnsembleDoc. 
The OpenFile method is called with the SFReply record, 
identifying the file that the user wishes to open. The code for 
the CEnsembleDoc's OpenFile method is as follows: 

void CEnsembleDoc::OpenFile (SFReply *macSFReply) 

{ 
Handle theData; 

inherited::OpenFile(macSFReply); 

theData = ((CEnsembleData *)itsFile)->GetEditTextHandle(); 

((CMainWindow *)itsWindow)->SetEditTextHandle (theData); 

theData = ((CMainWindow *)itsWindow)->GetEditTextHandle(); 

( ( CEnsembleData *)its File )->SetEditTextHandle(theData); 

lnitTextFormat(); 

The code in the CEnsembleDoc's OpenFile method first calls 
the method inherited from its ZEnsembleDoc superclass. It 
is important to recall that the superclass code is never cus
tomized; all customizing is applied to the subclass code. This 
enables AppMaker to regenerate the superclass code as new 
interface elements are added to the application, and the sub
class code can remain untouched. 

The superclass method (ZEnsembleDoc::OpenFile) is re
sponsible for creating a new instance of the CEnsembleData 
class, initializing this instance, and then sending it the nec
essary messages to implement the required input/ output op
erations. The CEnsembleData class is charged with the 
responsibility for handling all of the physical I/ 0 for the ap
plication. This partitioning of tasks between the CEnsemble
Doc and CEnsembleData classes is important. While the 
former can inherit behavior from the CDocument hierarchy, 
the latter class inherits its behavior from the CDataFile and 
CFile classes. This gives the CEnsembleData class methods 
the ability to use the TCL methods for performing file 1/0. 
Following is the ZEnsembleDoc's OpenFile method, shown 
for reference: 
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None of the code in 
the 'z'file superclass 
nwdules is modified 
in any way. 

void ZEnsembleDoc::OpenFile 
{ 

Str63 theName; 

(SFReply *macSFReply) 

itsData = new CEnsembleData; 
itsData->IEnsembleData (this); 
itsData->SFSpecify (macSFReply); 
itsData->OpenData (fsRdWrPerm); 
itsFile = itsData; 
BuildWindows (); 
itsFile->GetName (theName); 
if (itsWindow != NULL) { 

itsWindow->SetTitle (the Name); 
itsWindow->Select (); 

Notice that the superclass method creates a new instance of 
CEnsembleData, initializes the instance, and sends it SF
Specify and then OpenData messages. The code for the IEn
sembleData method is as follows: 

void CEnsembleData::IEnsembleData (CDocument *theDocument) 
{ 

inherited::IDataFile (); 
hasFile = FALSE; 
itsDocument = theDocument; 

II your application-specific initialization 
itsEditTextData = NULL; 

The IDataFile message is handled by the CDataFile class in 
the TCL. The IDataFile method initializes the instance vari
ables for the class. The IEnsembleData method sets the has
File instance variable to FALSE, saves the reference to 
theDocument into its itsDocument instance variable, and 
includes the line of code to set a new instance variable called 
itsEditTextData to NULL. 

The OpenFile method for the ZEnsembleDoc superclass 
sends the SFSpecify message, which is handled by the CFile 
class in the TCL. The SFSpecify method saves the volume, 
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directory, and file name information for the selected file. Fi
nally, the OpenData message is sent to the new CEnsemble
Data instance, whose code is as follows: 

void CEnsembleData::OpenData (SignedByte permission) 
{ 

Open (permission); 
hasFile =TRUE; 
ReadData (); 

The permission argument passed to the OpenData method 
is a constant named fsRdWrPerm that gives both read and 
write permission for the file. The OpenData method then 
calls the Open method that is inherited from the CDataFile 
class. The Open method performs the toolbox call that opens 
the file. When it returns, the OpenData method sets the has
File instance variable to TRUE and then sends a ReadData 
message. 

All of the code for the OpenData method was generated by 
AppMaker and has not been altered. However, AppMaker 
isn't able to know the format of the data in the file that was 
just opened. Nevertheless, it generates code that is almost 
perfect for our application in this stage of its development. 

The code for the ReadData method is located in the CEnsem
bleData module and is as follows: 

void CEnsembleData::ReadData (void) 
{ 

II 
II modified to reference itsEditTextData 
II 
itsData = ReadAll (); 
itsEditTextData = itsData; 

The only code we have added to AppMaker's generated code 
in the preceeding method is the replacement statement that 
saves the handle to the data (returned by the ReadAll 
method in the CDataFile class) into a new instance variable 
that we've called itsEditTextData. At the point when Read
Data finishes execution, the entire contents of the file have 
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been read, the file is still open and positioned at its end, and 
a handle to the data has been saved. When ReadData re
turns, it will resume execution in the OpenFile method of the 
ZEnsembleDoc class, as shown on page 98. The next action 
taken by the ZEnsembleDoc's OpenFile method (on page 98) 
is to create the document's window, by sending the Build
Windows message. The BuildWindows code is found in the 
ZEnsembleDoc module and will be described later, when we 
discuss the generated code for the MainWindow class. After 
creating the MainWindow, the OpenFile code gets the file 
name and places it in the title bar of the window. Then it se
lects the window, bringing it to the front as the active win
dow. This completes the process of opening an existing file, in 
response to the Open command. 

DoSave Method Code 

When the user chooses the Save command from the File 
menu, the command travels through the route shown in Fig
ure 5-1 and is intercepted by the DoCommand method in the 
CDocument class. The code in that method sets the cursor to 
the watch icon and then sends a DoSave message. The 
DoSave method in the CDocument class is empty; however, 
it is overridden in the ZEnsembleDoc superclass: 

Boolean ZEnsembleDoc::DoSave (void) 
{ 

if (itsFile == NULL) 
{ 

return (DoSaveFileAs ()); 

else 
{ 

if (itsData->Save ()) 
{ 

dirty = FALSE; 
return (TRUE); 

else 
{ 

return (FALSE); 
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As usual, the DoSave code was generated by AppMaker and 
is unmodified. It first checks whether a file is already associ
ated with the document. If not, it sends a DoSaveFileAs mes
sage; otherwise, it sends a Save message to the class 
associated with the itsData instance variable. In the case of 
the Ensemble application, this is the CEnsembleData class. 

AppMaker generates code for all of the methods that perform 
operations on file data in the CEnsembleData class. This not 
only keeps the physical file operations separate from the 
methods that are appropriate to the document as a whole, 
but allows the CEnsembleData methods to reference the in
herited methods directly in the CDataFile and CFile classes. 

The code for the Save method is as follows: 

Boolean CEnsembleData::Save (void) 
{ 

if (hasFile) 
{ 

return (WriteData ()); 
} 
else 
{ 

II shouldn't be called in this case 
return (FALSE); 

The Save method code generated by AppMaker has not been 
modified. It tests to ensure that a file has been opened or pre
viously saved, and if so, it calls the WriteData method, the 
code for which is as follows: 

Boolean CEnsembleData::WriteData (void) 
{ 

CMainWindow *theTextWindow; 
Handle theData; 

II 
II modified WriteData to get the TextEdit pane's Text Handle 
II and then write out the contents of that handle. 
II 
theTextWindow = ((CEnsembleDoc *)itsDocument)->GetTextWindow(); 
theData = theTextWindow->GetEditTextHandle(); 
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WriteData method 
code (concluded) 

SetEditTextHandle(theData); 
WriteAll (itsEditTextData); 
return (TRUE); 

The code for the WriteData method has been modified to get 
a handle to the CAMEditText pane in the CMainWindow in
stance and then write out the contents of that handle. The 
data in the handle represents the edited version of the origi
nal data and is what we want to save to a file. The WriteAll 
method is located in the CDataFile class in the TCL. The 
method of getting the handle to the data is somewhat compli
cated by the nature of data isolation afforded by the object
oriented programming methodology. In this case, the CEn
sembleData class "knows" nothing about the nature of the 
source of the data, but merely that it needs to write the data 
out. To get the handle to the CAMEditText pane, we first 
send a message to the document to retrieve a reference to its 
text window (GetTextWindow). 

Once we have a reference to the proper window, we can send 
it a message to return a reference to its EditText data (Get
EditTextHandle). When we have retrieved the handle to the 
EditText data, we also store it into an instance variable in 
the CEnsembleData class by sending it in a SetEdit
TextHandle message. With a handle to the data, we can now 
write the data out through the WriteAll method in the 
CDataFile class of the TCL. 

The WriteAll method repositions the selected file to its begin
ning and writes out the entire contents of the text addressed 
by the handle. 

SaveAs Method Code 

When the user selects the Save command from the File 
menu, and no data file is currently associated with the con
tents of the MainWindow, the DoSave method (shown on 
page 100) sends a DoSaveFileAs message. The DoSave
FileAs message is also sent by the CDocument class when 
the user selects the SaveAs command from the File menu. In 
either case, the DoSaveFileAs method (located in the CDocu
ment class) displays a standard "Save File" dialog box and al
lows the user to specify the file into which the data are to be 
saved. 
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This is accomplished by sending a PickFileName message, 
which is also handled in the CDocument class in the TCL. The 
method associated with this message calls the SFPutFile tool
box function to perform the function of displaying the dialog 
box and allowing the user to navigate within it to specify the 
desired file. When the file has been selected, then the DoSave
FileAs method sends a DoSaveAs message, which is overrid
den by the ZEnsembleDoc class. The code is as follows: 

Boolean ZEnsembleDoc::DoSaveAs (SFReply *macSFReply) 
{ 

if (itsData->SaveAs (macSFReply)) 
{ 

itsFile = itsData; 
if (itsWindow != NULL) 
{ 

itsWindow->SetTitle (macSFReply->fName); 
} 
dirty = FALSE; 
return (TRUE); 

else 
{ 

return (FALSE); 

When the DoSaveAs method executes, it sends a SaveAs 
message to the class associated with the itsData instance 
variable, which is the CEnsembleData class in this case. The 
code for the SaveAs method is as follows: 

Boolean CEnsembleData::SaveAs (SFReply *macSFReply) 
{ 

OSErr ignoreErr; 
if (hasFile) 

Close(); 
SFSpecify (macSFReply); 
ignoreErr = HDelete (volNum, dirlD, name); II in case already exists 
CreateNew (gSignature, kFileType); 
Open (fsRdWrPerm); 
hasFile =TRUE; 
return (Save()); 
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The first thing the SaveAs method does is check whether a 
file is already associated with the data. If so, it closes that file 
and then executes the SFSpecify method inherited from the 
CFile class to set the new volume, directory, and file name 
information. It then calls the HDelete toolbox method to de
lete the new file if it currently exists, calls the CreateNew 
method inherited from the CFile class, and calls the Open 
method inherited from the CDataFile class in the TCL. 

After opening the file, it can save the data by calling the Save 
method in the CEnsembleData class, as shown on page 101. 
The data are written out to the new file with the same Write
Data method used by the Save command. 

Revert Method Code 

The cmdRevert command is recognized by the DoCommand 
method in the CDocument class. The code for this case 
sends a DoRevert message to the document, which is inter
cepted by the override method in the ZEnsembleDoc class. 
The code for the DoRevert method is as follows: 

void ZEnsembleDoc::DoRevert (void) 
{ 

itsData->Revert (); 
dirty = FALSE; 

The method accomplishes its task by sending a Revert mes
sage to the CEnsembleData class, represented by the its
Data instance variable. 

As previously mentioned, all the physical file 1/0 is per
formed by the CEnsembleData class, due to its ability to in
herit methods from the CDataFile and CFile classes. 

When the user decides to revert to a previous version of a file, 
the application must first determine whether a file in fact ex
ists. If not, then the Revert method should dispose of the 
current data and do nothing else. This is the best interpreta
tion of the user's intent. 

If the file does exist, then the Revert method can read the 
data from it and proceed to enter its data into the EditText 
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pane in the main window. These operations are shown in the 
following code for the Revert method: 

void CEnsembleData::Revert (void) 
{ 

CMainWindow *theTextWindow; 
Handle theData; 

DisposeData (); 
it (hasFile) 
{ 

II 
II reread the original file's data 
II 
ReadData (); 
theTextWindow = ((CEnsembleDoc *)itsDocument)->GetTextWindow(); 
if(the TextWindow) 
{ 

II 
II set the new EditText handle, and then get it back 
II 
the TextWi ndow->SetEditT extHandle(itsEditT extData); 
theData = theTextWindow->GetEditTextHandle(); 
SetEditTextHandle(theData); 

In order to replace the existing data with the contents of the 
file, the code must first dispose of the existing data, read the 
contents of the file, and then store a handle to the EditText 
data into the CAMEditText pane in the MainWindow. The 
process of getting a reference to the window and then sending 
it the message to set the new EditText handle is similar to 
the approach outlined on page 101. In this case, we are, of 
course, storing the handle, rather than retrieving it. 

Once the handle has been set by sending the SetEdit
TextHandle message to the window, it is immediately re
trieved. This is necessary because the CEditTex:t class's 
SetTextHandle method makes a copy of the data and then 
changes the handle to point to the copy. Our Revert method 
then saves the new handle by calling the SetEditTextHandle 
method in our CEnsembleData class. 
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Adding Methods to the CMainWindow Class 

We have written three new methods for this class that imple
ment getting and setting the EditText pane's handle and also 
setting its text font parameters. The code for the GetEdit
TextHandle method is as follows: 

Handle CMainWindow::GetEditTextHandle (void) 

{ 
return ((Handle) Field3->GetTextHandle ()); 

As is apparent, this method calls the GetTextHandle method 
that is inherited from the TCL's CEditText class and returns 
it to the caller. The code for the counterpart method, SetEdit
TextHandle, is as follows: 

void CMainWindow::SetEditTextHandle (Handle theData) 

Field3->SetTextHandle (theData); 

The foregoing code sends a SetTextHandle message to the 
EditText field, which is inherited from the TCL's CAbstract
Text class. It is important to bear in mind that the Set
TextHandle method creates a copy of the data contained in 
the itsData instance variable and installs a new handle into 
the EditText pane. Therefore, the methods that we have pre
viously shown that reference the SetEditTextHandle method 
immediately send a GetEditTextHandle message, to acquire 
the real handle to the text. 

The data used to set the EditText pane's font, size, style, and 
alignment are handled by a new method called SetTextFon
tlnfo. As you will see in the next section, concerned with im
plementing the Format Notebook command, the 
CEnsembleDoc class's DoCommand method calls SetText
Fontlnfo to change the EditText pane's parameters, based 
on the new values obtained from the DoNotebook method's 
execution. The code for the SetTextFontlnfo method, from 
page 96, is as follows: 
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void CMainWindow::SetTextFontlnfo {CFontData *theFontData) 
{ 

fontinfo itsFontData; 

itsFontData = theFontData->GetFontData{); 
Field3->SetFontNumber{itsFontData.fontNumber); 
Field3->SetFontSize{itsFontData. fontSize); 
Field3->SetFontStyle{O); II reset first 
Field3->SetFontStyle{itsFontData. fontStyle); 
Field3->SetAlignment(itsFontData. fontAI ign); 

As you can see, the method sends a GetFontData message to 
the CFontData class, which retrieves a handle to the object. 
When the object's handle is stored into the local itsFontData 
variable, then the various text font, size, style, and alignment 
methods in the CEd.itText class of the TCL can be referenced 
to set the new parameters. 

Implementing the Format Notebook Command 

The first step in implementing the Format Notebook com
mand is to devise methods for setting the initial values of the 
various fields and controls in the Notebook dialog and for re
trieving and saving these values from one invocation of the 
dialog to the next. 

We decided that the best way to encapsulate these values and 
also provide access to them was to create a completely new 
class, whose name was chosen to be CFontData. 

The CFontData object is described in a new header file called 
FontData.h, and its methods are defined in a new source 
code file called FontData.c. 

The FontData.h file contains the definition of a structure to 
hold the initial or current font information for the text pane. 
It also contains instance variables to hold those data, as well 
as the definition of each of the changeable controls and fields 
in the Notebook dialog. The complete content of the FontDa
ta.h file is shown in two sections. The header for the file and 
the definition of the fontinfo structure are as follows: 
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/* FontData.h -- font data class*/ 

#define _H_FontData 
#include <CObject.h> 

typedef struct 
{ 

short fontNumber; 
short fontSize; 
short fontStyle; 
short fontAlign; 

} fontinfo; 

The definition of the CFontData class and its instance vari
ables and methods are as follows: 

class CFontData : public CObject 
{ 
public: 

fontinfo fontData; 

short BoldCheck; 
short ltalicCheck; 
short UnderlineCheck; 
short OutlineCheck; 
short ShadowCheck; 
short CondenseCheck; 
short ExtendCheck; 
Str255 FontNameString; 
Str255 FontSizeString; 
Str255 FontSampleString; 
long RadioStation ID; 
short FontSelection; 
short SizeSelection; 

void IFontData(void); 
fontinfo GetFontData(void); 
void SetFontData (fontinfo theData); 

}; 

The methods declared in the class definition for the new class 
are GetFontData, SetFontData, and IFontData. 
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The code for the CFontData class's GetFontData method is 
as follows: 

fontinfo CFontData::GetFontData (void) 
{ 

return fontData; 

As you can see, all this access method does is return the 
structure holding the current font number, size, style, and 
alignment settings. 

The code for the SetFontData method is very similar to that 
for GetFontData. It merely sets the fontData structure's 
content: 

void CFontData::SetFontData(fontlnfo theData) 
{ 

fontData = theData; 

Finally, the code to set the default values of all the CFont
Data instance's variables, is as follows: 

void CFontData::IFontData (void) 
IFontData method { 
code fontData.fontNumber = O; 

fontData.fontSize = 12; 
fontData.fontStyle = O; 
fontData.fontAlign = teFlushleft; 

BoldCheck= O; 
ltalicCheck= O; 
UnderlineCheck= O; 
OutlineCheck= O; 
ShadowCheck= O; 
CondenseCheck= O; 
ExtendCheck= O; 
RadioStationlD= 139; // LeftRadioViewlD 
CopyPString("\pSystem", FontNameString); 
CopyPString("\p12", FontSizeString); 
CopyPString(''\pSample", FontSampleString); 
FontSelection= O; 
SizeSelection= 3; 
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The preceeding code is invoked by the CEnsembleDoc class's 
IEnsembleDoc method, to create an instance of the CFont
Data class for each open document-the Ensemble applica
tion will let you have more than one document open at a 
time-and then initialize the instance. 

The IEnsembleDoc method, as customized, is as follows: 

void CEnsembleDoc::IEnsembleDoc (CApplication *aSupervisor, 
Boolean printable) 

CFontData*aFontData; 

inherited:: I EnsembleDoc ( aSupervisor, printable); 
aFontData = new CFontData; 
aFontData->I FontData(); 
theTextData = aFontData; 

After calling the inherited IEnsembleDoc method, which is 
found in the ZEnsembleDoc superclass, the IEnsembleDoc 
method creates a new instance of the CFontData class, 
sends it an IFontData initialization message, and then stores 
the new instance reference into the document's theTextData 
variable. The initial settings for the Notebook dialog are: 

•!• In the fontData structure, the font is set to 0, which refers 
to the "System Font," the size is set to 12 points, the style 
is set to 0, which is "plain," and the alignment is set to left
justified. 

•!• All the font style checkboxes are initialized as being 
unchecked. 

•!•The "StationlD," referring to which radio button is selected 
in the set of alignment choices, is initialized to enable the 
left justified button. 

•!• The font name string is set to "System", the font size string 
is set to "12", and the font sample string is set to "Sample". 

•!• The number of the highlighted cell in the font name list is 
set to 0 (the first cell, which refers to the system font), and 
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the number of the highlighted cell in the font size list is set 
to 3 (the fourth cell, which refers to the size 12 entry). 

Initializing the instance variables in the CFontData instance 
provides a firm basis for the initial text font characteristics of 
the EditText pane. When the MainWindow instance is cre
ated, the EditText pane is initialized with the default font 
settings. Both the New and Open commands in the File 
menu call a method named InitTextFormat, whose code is 
shown on page 96. This method sends a message to the 
MainWindow method SetTextFontlnfo, whose code is also 
shown on page 96. The SetTextFontlnfo method uses the 
CFontData class's GetFontData access method to retrieve 
the contents of the fontinfo structure, so that it can initialize 
the EditText pane with the current font information. 

Up to this point, we've discussed how the EditText pane's 
text characteristics are initialized and set. What remains is a 
discussion of how the default characteristics are changed 
and what methods are involved in this process. The first link 
in the modification chain is the DoCommand method in the 
CEnsembleDoc class. This method overrides the behavior in 
its superclass, as follows: 

void CEnsembleDoc::DoCommand (long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdNotebook: 
{ 

DoNotebook(this); 
lnitTextFormat(); 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 
break; 

The override DoCommand method specifically tests for the 
existence of a cmdNotebook command, which is sent to the 
method in response to the user's selection of the Format 
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Part 1 of the 
DoNotebook global 
junction 

menu's Notebook command. The handler then calls the 
DoNotebook function (a global function) with a handle to the 
CEnsembleDoc instance (shown as this in the function's ar
gument). The DoNotebook function is responsible for creat
ing, initializing, and managing the operation of the Notebook 
dialog, as well as retrieving the values from its controls and 
fields when the user has completed a set of text format modi
fication actions. 

The default-generated code for the DoNotebook function is 
shown on page 78. The following listing of the function is bro
ken into several parts, so that its custom features can be 
more easily explained. 

Initial DoNotebook Code 

The first section of code for the DoNotebook function is as 
follows: 

void DoNotebook (CDirectorOwner *aSupervisor) 
{ 

CNotebook *dialog; 
long dismisser; 
Str255 fontNameString; 
Str255 fontSizeString; 
Str255 fontSampleString; 
short aChoice; 
CFontData *theFontlnfo; 

dialog = NULL; 
theFontlnfo = ((CEnsembleDoc *) aSupervisor)->theTextData; 
TRY{ 

dialog = new CNotebook; 
dialog->INotebook (aSupervisor); 

The code is nearly identical to the default code generated by 
AppMaker; we have merely added some new local variables to 
hold the font name, font size, and font sample strings. 

A variable has been defined to hold the chosen entry in the 
font name and font size lists. In addition, the initialized 
CFontData instance is assigned to the theFontlnfo variable, 
by accessing the theTextData instance variable in the CEn
sembleDoc class, using the aSupervisor argument to refer
ence the instance. 
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After creating a new instance of the CNotebook class, the 
code calls the !Notebook method to initialize the instance. 
The default code for the !Notebook method is shown on 
page 79. We have enhanced this code by adding some state
ments that assign "StationID's" to the text justification radio 
buttons. 

The definition of the "StationID's" is contained in the Note
book.h header file, as shown in the following code: 

en um 

}; 

LeftRadioViewlD= 139, 

CenterRadioViewlD, 

RightRadioViewlD, 

ForceleftRadioViewlD 

The "StationID's" have been assigned an arbitrary sequence 
of codes, beginning with 139. These were chosen to coincide 
with the resource ID's for the radio button controls. The code 
for the new version of the !Notebook method is as follows: 

void CNotebook::INotebook(CDirectorOwner *aSupervisor) 

{ 
inherited: :IZNotebook ( aSupervisor); 

LeftRadio->ID= LeftRadioViewlD; 

CenterRadio->ID= CenterRadioViewlD; 

RightRadio->ID= RightRadioViewlD; 

ForceleftRadio->ID= ForceleftRadioViewlD; 

When this method calls the inherited IZNotebook method, 
the Notebook dialog and all its controls and fields are created 
and initialized, as shown on page 73. During the execution of 
the IZNotebook method, several of the dialog item instances 
require additional initialization. AppMaker has generated the 
skeleton for the !Notebook method, and we have added the 
custom code. 
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Sizing the Font Name List 

The font name list is the first to be customized. The declara
tion for the CList25 class in the Notebook.h module con
tains the definition of the fontMenu instance variable, as 
shown in the following code: 

class Clist25 : public CAMTable 
{ 
public: 

}; 

II 
II new instance variables 
II 
short numFonts; 
MenuHandle fontMenu; 

void IViewTemp(CView*anEnclosure, 
CBureaucrat*aSupervisor, 
Ptr viewData); II is override 

void GetCellText(CellaCell, 
short availableWidth, 
StringPtr itsText); II is override 

The IViewTemp initialization method for the font name list 
class (CList25) must be modified to add the font names to 
the list: 

void CList25::1ViewTemp(CView*anEnclosure, 
CBureaucrat*aSupervisor, 
Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

fontMenu = GetMHandle(FontlD); 
numFonts = CountMltems(fontMenu); 
AddRow (numFonts, O); 

This method makes use of the Font menu we created in 
Chapter 3, beginning on page 54. AppMaker generated code 
to add the names of all the user's fonts to the menu in the 
ZEnsembleApp class's SetUpMenus method, shown on 
page 70. The override method gets the handle to the Font 
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menu, calls the toolbox routine CountMltems to determine 
how many names are in the menu, and then adds that num
ber of rows to the CList25 instance. When the rows are 
added, methods in the TCL's CTable class will compute the 
number of cells in the table, and then will repeatedly call the 
GetCellText method to get the text for each of the table's 
cells. 

Initializing the Font Names 

We override the GetCellText method for the CList25 in
stance and provide the font names as follows: 

void CList25::GetCellText (Cell 
short 
StringPtr 

short index; 

index = aCell.v; 

a Cell, 
available Width, 
its Text) 

Getltem(fontMenu, index+ 1, its Text); 

The GetCellText method uses the vertical (row) component of 
the aCell argument to the function to get the menu item as
sociated with that cell number. The toolbox routine Getltem 
retrieves the font name directly into the location pointed to by 
the itsText argument to the method. 

Sizing the Font Size List 

The CList29 dialog item is handled in a similar fashion. The 
code in the IViewTemp method generated by AppMaker has 
been customized to initialize the font size list with a set of 
constant strings, as follows: 

void CList29::1ViewTemp (CView *anEnclosure, 
CBureaucrat *aSupervisor, Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 
CopyPString ("\p 8 910121416182024283236", typeSizes); 
AddRow (12, O); 
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After the inherited IViewTemp method is called, an instance 
variable called typeSizes is initialized with a string consist
ing of font sizes in text form, and the CTable class's AddRow 
method is called to add 12 rows to the table. When this is 
done, the CTable class will call the GetCellText method to 
access each of the list's font size values. 

Initializing the Font Size List 

The GetCellText method has been rewritten as follows to 
provide the text for the requested cells: 

void CList29::GetCellText (Cell aCell, short availableWidth, 
StringPtr itsText) 

short strlndex; 
strlndex = (aCell.v « 1) + 1; 
*itsText++ = 2; 
*itsText++ = typeSizes[strlndex++]; 
*itsText = typeSizes[strlndex]; 

Recall that the text for the font size list was stored as a single 
string, as shown on page 115. Each size is stored as exactly 
two characters in the string (note the blank space before the 
entries of '8' and '9'), so we can build the text entry pointed to 
by the itsText argument simply by storing a string length 
of 2 and the two characters of the size string that correspond 
to the selected cell. 

When the Notebook dialog is invoked for the first time, the 
settings of the checkboxes, the selected list entries, the radio 
buttons, and the text fields will be set to the default values 
established when the CFontData instance was first initial
ized. (See the IFontData code on page 109.) 

When the user changes the default values, the new code in 
the DoNotebook function copies the new values to the 
CFontData instance, so that these values are shown on the 
next invocation of the dialog. 

Continuing the DoNotebook Code's Initialization 

The next section of the DoNotebook function performs fur
ther initialization of the dialog's items: 
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dialog->thelnfo = theFontlnfo->GetFontData(); 

dialog->BoldCheck->SetValue(theFontlnfo->BoldCheck); 

dialog->ltalicCheck->SetValue(theFontlnfo->ltalicCheck); 

dialog->UnderlineCheck->SetValue(theFontl nfo->UnderlineCheck); 

dialog->OutlineCheck->SetValue(theFontl nfo->OutlineCheck); 

dialog->ShadowCheck->SetValue(theFontlnfo->ShadowCheck); 

dialog->CondenseCheck->SetValue(theFontlnfo->CondenseCheck); 

dialog->ExtendCheck->SetValue(theFontlnfo->ExtendCheck); 

dialog->Group 17->SetStation I D(theFontlnfo->RadioStation ID); 

dialog->List25->SetChoice(theFontlnfo->FontSelection); 

dialog->List29->SetChoice(theFontlnfo->SizeSelection); 

CopyPString(theFontlnfo->FontNameString, fontNameString); 

dialog->Field 14->SetTextString(fontNameString); 

CopyPString(theFontl nfo->FontSizeString, fontSizeString); 

dialog->Field 15->SetTextString(fontSizeString); 

CopyPString(theFontlnfo->FontSampleString, fontSampleString); 

dialog->Field16->SetTextString(fontSampleString); 

dialog-> Field 16->SetFontNumber( dialog->thelnfo. fontN umber); 

dialog->Field16->SetFontSize(dialog->thelnfo.fontSize); 

dialog-> Field 16->SetFontStyle( dialog-> the Info. fontStyle); 

dialog->Field16->SetAlignment(dialog->thelnfo.fontAlign); 

The foregoing statements access the data stored in the in
stance of the CFontData class retrieved into the theFontlnfo 
variable. They set the values of the controls and fields in the 
dialog to the previous settings. The fields and controls are ad
dressed via the dialog variable, which points to the CNote
book instance. 

Creating and Operating the Dialog 

After the dialog has been initialized, the next step is to make 
it visible and let the user make any desired changes. This is 
accomplished by the following code: 

dialog->BeginDialog (); 

dismisser= dialog->DoModalDialog (cmdOK); 

These statements show and operate the dialog. The BeginDi
alog and DoModalDialog methods are inherited from the 
CDialogDirector class in the TCL. 
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Handling User Interaction 

Once the Notebook dialog has been made visible, the next 
phase of operation is to handle any changes that the user 
makes to the dialog's setting. The TCL will provide all of the 
functionality with regard to user feedback when the dialog is 
operated: 

+ Checkboxes are checked or unchecked automatically. 

•:. A previously selected radio button is deselected, and the 
new one is selected when clicked. 

•:. List items are highlighted as they are clicked. 

Even though the user feedback for these items is automati
cally provided, we must also add feedback that shows the re
sul.ts of the user's selections. Notice that the Notebook dialog 
(see Figure 3-22) has an EditText field just below the Font 
list, another just below the Size list, and a third just below 
the group of Justification radio buttons. Our custom code 
must perform the following actions for these items: 

+ The field below the Font list must show the name of the 
currently selected font. 

•> The field below the Size list must show the currently 
selected size. 

•:• The field below the Justification radio button group must 
show an example (the word Sample is the default) of the 
application of all the settings. 

In order to accomplish the preceeding objectives, we must be
come aware of any changes made to the initial settings. This 
is accomplished in two different ways: 

<• When the checkboxes and radio buttons are defined, App
Maker automatically assigns each of these a "click com
mand" that is sent to the current gGopher when the user 
clicks on the item. 

•:• When text is entered into the EdiIText panes, or if any of 
the list items is selected, the appropriate class sends a 
BroadcastChange message, which is intercepted by the 



DoCommand 
method code 
(beginning) 

Implementing the Format Notebook Command 119 

TCL's CBureaucrat class and reissued as a Provider
Changed message to the item's supervisor (the Notebook 
dialog in this case). 

For the first case, a DoCommand method in the CNotebook 
class is used to intercept clicks in the checkboxes and radio 
buttons. When the Notebook dialog is operational, the 
gGopher variable will be set to point to the CNotebook class. 
It will revert to the CMainWindow class when the dialog is 
dismissed. The concept of the DoCommand method is dis
cussed in Chapter 4. 

For the second case, a ProviderChanged method is gener
ated, and all changes to the font or size list or to the text 
fields will be handled in this method. The concept of the Pro
viderChanged method is discussed in Chapter 4. The modi
fied DoCommand code is as follows: 

void CNotebook::DoCommand(longtheCommand) 
{ 

short style = -100, align = -100; 
switch (theCommand) 
{ 

case cmdBoldCheck: 
{ 

} 

style= bold; 
break; 

case cmdltalicCheck: 
{ 

} 

style = italic; 
break; 

case cmdUnderlineCheck: 
{ 

} 

style = underline; 
break; 

case cmdOutlineCheck: 
{ 

} 

style = outline; 
break; 

case cmdShadowCheck: 
{ 

style = shadow; 
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DoCommand 
method.code 
(concluded) 

} 

break; 
} 
case cmdCondenseCheck: 
{ 

} 

style= condense; 
break; 

case cmdExtendCheck: 
{ 

} 

style = extend; 
break; 

case cmdCenterRadio: 
{ 

} 

align = teCenter; 
break; 

case cmdRightRadio: 
{ 

} 

align = teFlushRight; 
break; 

case cmdForceLeftRadio: 
{ 

} 

align = teFlushDefault; 
break; 

case cmdLeftRadio: 
{ 

align = teFlushLeft; 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 
break; 

if(style != -100) 
{ 

} 

Field16->SetFontStyle(style); 
thelnfo.fontStyle A= style; 
DrawSample(); 

if(align != -100) 
{ 

Field16->SetAlignment(align); 
thelnfo.fontAlign =align; 
DrawSample(); 
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Notice that we have merely set the values of the style and 
align variables in the individual cases and then added code 
at the end of the method to call the SetFontStyle and Set
Alignment methods for Fieldl6, which is the EditText field 
that shows an example of the formatted text, located below 
the Justification radio group. In addition, in each case, once 
the style or alignment is changed, we call a new method to 
draw the sample text in the Fieldl6 pane. 

The code for the DrawSample method is as follows: 

void CNotebook::DrawSample(void) 
{ 

StringPtr fontName; 
short fontNum; 
long fontSize, strlength; 
Str255 theFontText, theSizeText, the SampleText; 

strlength = Field14->Getlength(); 
if(strlength > 0) 
{ 

Field 14->GetTextString(theFontText); 
if(EqualString(theFontText, ''\pSystem", TRUE, TRUE)) 
{ 

fontNum = systemFont; 
} 
else if(EqualString(theFontText, "\pApplication", TRUE, TRUE)) 
{ 

fontNum = applFont; 
} 
else 
{ 

GetFNum(theFontText, &fontNum); 

} 
else 
{ 

fontNum = systemFont; 
} 
strlength = Field15->Getlength(); 
if(strlength > 0) 
{ 

Field15->GetTextString(theSize Text); 
StringToNum(theSizeText, &fontSize); 

else 
{ 
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DrawSample 
method code 
(concluded) 

ProviderChanged 
method code 
(beginning) 

fontSize = 12; 
} 
CopyPString("\pSample", theSample Text); 
Field16->SetTextString(theSample Text); 
Field 16->SetFontNumber(fontNum); 
Field16->SetFontSize(fontSize); 
thelnfo.fontNumber = fontNum; 
thelnfo.fontSize = fontSize; 

The DrawSample code has to make special provisions for the 
System (systemFont) and Application (applFont) font 
name choices and also has to handle the case where the user 
has deleted or typed in a new font name. The font size isn't 
quite as important, because if the size is too small or too 
large, the sample will not be visible in the Fieldl6 EditText 
field. Different text can also be typed into the sample field if 
desired. 

The final event-handling method is ProviderChanged, which 
is invoked with changes to the list selections or when the 
user types into the EditText fields. The code for Provider
Changed is as follows: 

void CNotebook::ProviderChanged (CCollaborator *aProvider, 
long reason, 
void* info) 

short index, num; 
Str255 theText; 

if (aProvider == Field14) 
{ 

} 

if (Field14->Getlength () != O) 
{ 

II there is some text, so show a sample in Field16 
DrawSample(); 

if (aProvider == Field15) 
{ 

if (Field15->Getlength () != 0) 
{ 

II there is some text, so show a sample in Field16 
DrawSample(); 
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if (aProvider == List25) 
{ 

} 

if (List25->HasSelection ()) 
{ 

II store selection in EditText field 
if(List25->GetChoice( &index)) 
{ 

Getltem(((Clist25 *)List25)->fontMenu, index+ 1, the Text); 
Field14->SetTextString(theText); 
DrawSample(); 

if (aProvider == List29) 
{ 

if (List29->HasSelection ()) 
{ 

II store selection in EditText field 
if(List29->GetChoice( &index)) 
{ 

index = (index « 1) + 1; 
theText[O] = 2; 
theText[1] = ((Clist29 *) List29)->typeSizes[index++]; 
theText[2] = ((Clist29 *) List29)->typeSizes[index++]; 
Field15->SetTextString(theText); 
DrawSample(); 

In the foregoing, we've modified the version of Provider
Changed shown in Chapter 4 by changing the code to test for 
nonzero text field lengths and eliminating the code for han
dling changes to the Fieldl6 (Sample) field entirely. The text 
written into the Fieldl6 field will always be the word Sample, 
in the selected font, size, style, and justification. In each case 
where the font name or font size text field contents have been 
entered manually by the user, the code in the Provider
Changed method calls the DrawSam.ple method to show the 
results of the change. In a similar fashion, when a selection is 
made in either the font name or font size list, the selected cell 
is identified, and its contents are written into the correspond
ing EditText field. The DrawSample method is also called in 
these cases. 
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Part4of 
DoNotebook 
junction 

Part-5 ojthe 
DoNotebook 
function (beginning) 

Retrieving the Modified Dialog Values 

Finally, after the user finishes making changes and dismisses 
the dialog by clicking on either the OK or Cancel buttons, the 
following code is executed in the DoNotebook function: 

if (dismisser== cmdOK) 
{ 

theFontlnfo->SetFontData(dialog->thelnfo); 
theFontlnfo->BoldCheck = dialog->BoldCheck->GetValue(); 
theFontlnfo->ltalicCheck = dialog->ltalicCheck->GetValue(); 
theFontlnfo->Under1ineCheck = dialog->Under1ineCheck->GetValue(); 
theFontlnfo->OutlineCheck = dialog->OutlineCheck->GetValue(); 
theFontlnfo->ShadowCheck = dialog->ShadowCheck->GetValue(); 
theFontlnfo->CondenseCheck = dialog->CondenseCheck->GetValue(); 
theFontlnfo->ExtendCheck = dialog->ExtendCheck->GetValue(); 
theFontlnfo->RadioStationlD = dialog->Group17->GetStationlD(); 
dialog->List25->GetChoice( &a Choice); 
theFontlnfo->FontSelection = aChoice; 
dialog->List29->GetChoice( &aChoice); 
theFontlnfo->SizeSelection = aChoice; 
dialog->Field1 4->GetTextString(fontNameString); 
CopyPString(fontNameString, theFontlnfo->FontNameStri ng); 
dialog->Field15->GetTextString(fontSizeString); 
CopyPString(fontSizeString, theFontlnfo->FontSizeString); 
dialog-> Field 16->GetTextString(fontSampleString); 
CopyPString(fontSampleString, theFontlnfo->FontSampleString); 

If the dialog was dismissed by clicking the OK button, then 
the foregoing code will extract the values of the fields and 
controls and store them back into the corresponding instance 
variables of the CFontData instance. 

If the user dismissed the dialog by clicking the Cancel but
ton, then the values would not be replaced in the CFontData 
instance. 

Disposing of the Dialog and Handling Failures 

The final action of the DoNotebook function is unchanged 
from the default-generated code: 

dialog->Dispose (); 
} 
CATCH 



Part-5 of the 
DoNotebook 
function (concluded) 

Exercises 

ForgetObject (dialog); 
} 
ENDTRY; 
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In the event that a failure is detected during the creation or 
operation of the Notebook dialog, the CATCH block will han
dle the failure and then propagate the condition up to the 
next higher level. At the point of this failure, the only thing 
that we can do is delete the dialog by using the ForgetObject 
method. 

When the DoNotebook function returns to the CEnsemble
Doc class's DoCommand method, that method calls the Init
TextFormat method to set the current font, size, style, and 
justification for the MainWindow pane's text (see page 111). 
Note that although the InitTextFormat method is called 
even if the dialog was cancelled, the previous settings will be 
intact, so the InitTextFormat method will change the pane's 
settings to their previous values. 

The next chapter introduces a completely new feature into 
the Ensemble application, and the succeeding chapters ex
plain the default code generated by AppMaker and the 
changes needed to make the default code fully operational. 

1. Explain the THINK Class Library's technique of process
ing command events. What flexibility does the intercep
tion of commands in the CBureaucrat class provide? 

2. Describe the relationship of the CEnsembleDoc and CEn
sembleData classes. Why are these separate classes in 
AppMaker's generated code? 

3. What is the purpose of the Revert method in the CEn
sembleData class? 

4. Explain why the GetEditTextHandle and SetEditText 
Handle methods are necessary in the MainWindow class. 
How are these used in the application? 
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5. Describe the purpose of defining the CFontData class. 
Why isn't the fontinfo structure just global to the appli
cation as a whole? Under what circumstances could mul
tiple instances of this structure exist? 

6. Describe a method for creating a list of font sizes other 
than the fixed string that is presented. (Hint Think about 
a similar list of items that is implemented as a resource.) 

7. Describe what mechanism is used to direct mouse clicks 
on buttons and checkboxes in the Notebook dialog to the 
corresponding DoCommand method? 

8. Although the generated code for the ProviderChanged 
method only includes tests for the text fields and list 
instances in the Notebook dialog, describe how this 
method could be used to advantage to handle events that 
occur in other user interface elements in the Notebook 
dialog? (Hint Examine the implementation of the Set
Value method in the TCL's CControl class to aid in 
forumlating your answer.) 
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Adding a Worksheet Window 

In this chapter, we are going to add a spreadsheet like win
dow to the Ensemble application. The chapter will focus on 
the additions to the user interface, providing step-by-step in
structions for using AppMaker to construct the window. The 
following chapter will discuss the default-generated code for 
this new window, and the chapter after that will document 
the custom additions to AppMaker's generated code to make 
the worksheet completely functional. 

This and the next two chapters are quite detailed, so you may 
want to stop and review what we've covered so far before con
tinuing. The addition of the worksheet window to the applica
tion is intricate; however, with the facilities of AppMaker and 
the THINK Class Library, its implementation is quite straight
forward. 

Beginning in this chapter, we will discontinue showing pic
tures of menu command choices being made. We assume 
that, by now, you have become familiar with the menus in 
AppMaker and THINK C and will not need these pictures as a 
reference. 

We will also introduce the use of Apple's ResEdit application 
in the latter part of the chapter to "fine-tune" the resources 
that AppMaker constructs. The instructions on how to ac
complish the necessary modifications will be detailed in a 
step-by-step approach. 

The result at the end of this and the next two chapters will be 
an operational worksheet that handles the calculation of for
mulas that include constants, operators, and worksheet cell 
references. The contents of a worksheet can be saved and 
read, along with the text in the original main window. 

127 
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Creating a New Window for Ensemble 

Figure 6-1 
Cale Window 
appearance inside 
App Maker 

Adding a new window to Ensemble is a very simple procedure 
when AppMaker's tools are used. However, the window we 
will be adding has quite a few components that must be 
placed in particular locations, so the construction process is 
somewhat detailed. The diagram in Figure 6-1 shows the fully 
constructed window, so that you will have an idea of its final 
appearance. 
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The numbered panes in the figure correspond, in general, to 
composite structures. The only exception to this is the 
CStaticText field, shown as item@. 

Basically, the window consists of three layers of objects on 
top of a standard Macintosh window. Notice that the window 
has no close box. We will construct each item in the steps 
that follow and show the exact position and measurements of 
the item, according to AppMaker's Item Info dialog. The fol
lowing steps are liberally illustrated with screen shots of the 
Item Info dialog boxes. 

Before beginning the step-by-step discussion of the construc
tion of the window, it is appropriate to explain the nature and 
composition of the numbered panes in Figure 6-1. The details 
of each item are summarized in Table 6-1. 
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No. Outside Inside Dimensions Sizing 

(!) Bord 132 AEI'x 135 (4,80 24,192) H;4, V:4 

@ Bordl33 n/a (32,-1 21,405) H:5, V:4 

@ Bord 134 ATbll37 (0,32 21,358) H:5, V:4 
(1,1 19,356) H:5, V:4 

@ Bord 135 n/a (52,-1 181,33) H:4, V:5 

@ Bord 136 ATbl 138 (0,0 165,33) H:4, V:5 
(1,1 163,30) H:4, V:5 

® ScPn 134 ATbl 136 (53,32 H:5, V:5 
180,372) H:5, V:5 

(0,0 164,356) 

® @ Pane 129 (1,2 19,29) H:4, V:4 

@ @ Pane 130 (1,390 19,15) H:4, V:4 

® @ Pane 131 (165,l 15,30) H:4, V:5 

® AEI'x 134 n/a n/a n/a 

The information in the table is rather detailed, but it will 
come in handy later, for "tweaking" the locations and dimen
sions of the CalcWindow components. The columns of the ta
ble are described as follows: 

•:• The No. column contains the number corresponding to the 
CalcWindow item in Figure 6-1. 

•:• The Outside column contains the resource type and num
ber of the outermost item of the item group. In most cases, 
this is a Bord (CBorder) resource, but it may be a ScPn 
(CScrollpane) or AETx (CEdiIText) resource. In the three 
cases where this column contains a No. item, the number 
refers to the "owning" item number. 

•:•The Inside column identifies the resource type and num
ber of the inside item of the item group. This may be an 
AETx (EdiIText), ATbl (CTable), or Pane (CPane) item. 

•:•The Dimensions column contains the position and dimen
sions of the components of each item. They are given, in 
order, as Top, Left, Height, and Width values (in pixels). 
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Figure6-2 
Exploded view of the 
construction of the 
CalcWindow element 

When two rows of dimensions are given, the top row corre
sponds to the Outside element, and the bottom row corre
sponds to the Inside element. 

•> The Sizing column specifies the final sizing characteristics 
for each element of the item. If two rows are given, the top 
row contains the sizing specification for the Outside ele
ment, and the bottom row specifies the sizing for the 
Inside element. Only two different sizing characteristics 
are used: 

• A value of 4 indicates that the corresponding dimension 
(H = horizontal, V = vertical) is fixed and does not stretch 
or shrink as the window is resized. 

• A value of 5 indicates that the corresponding dimension 
is able to stretch or shrink in proportion to the degree to 
which the window is resized. 

The final point of interest, before we get into the step-by-step 
construction, is an exploded view of the CalcWindow, show
ing the base window and the three layers of elements. This 
view is shown in Figure 6-2. 
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Beginning Construction of the CalcWindow 

The purpose of the following steps is to show how to add a 
new window to the Ensemble application's user interface. 
This window will perform many of the functions of a standard 
spreadsheet, so it will have a pane to enter a value into a 
specified cell, a main spreadsheet pane with individual rows 
and columns, and corresponding row and column label 
panes. The window will be added to the resource file that we 
zzused in the previous chapters of this book, that we have 
called Ensemble.1t.rsrc. The steps for constructing the win
dow are as follows: 

1. Launch AppMaker, by double-clicking on the Ensem
ble.1t.rsrc file, and then choose the Windows command 
from the Select menu. 

2. Selecting Windows allows you to modify an existing win
dow or create a new window. To make all the window 
tools available, choose the Tools as Text command from 
the View menu. 

3. Pull down the Edit menu and choose the Create Window 
command. 

4. When you choose the Create Window command, App
Maker will display a dialog that shows pictures of the var
ious types of windows that are available and the optional 
accessories for each. We want to select a standard docu
ment window, but one without a close box. The title and 
name of the window and the selected options are shown 
in Figure 6-3. Notice that except for the lack of a close 
box, this is a standard Macintosh document window. 
We've given the window the name CalcWindow and made 
its title (Untitled). AppMaker will use the name you type 
to create the name of the corresponding source code mod
ules, in this case, CalcWindow. The title is displayed, by 
default, in the title bar of the window when it is first 
opened. 

5. The appearance of the new window is shown in Figure 
6-4. This window is almost identical to the one we created 
for the MainWindow in Chapter 3 (see Figure 3-3). The 
only difference is the absence of a close box in the new 
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Figure 6-3 
Cale Window 
information dialog 
box 

Figure 6-4 
Untitled 
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CalcWindow. We will later add a third window to the 
Ensemble application that will be identical to this win
dow. In our user interface, no individual window can be 
closed without closing all of the windows. This is accom
plished by clicking in the close box of the MainWindow or 
by choosing the Close command in the File menu when 
the MainWindow is in front. 

(Untitled) 

6. Position the default window near the upper left corner of 
your screen, and make its dimensions approximately 5.9 
inches wide by 3.5 inches tall. It is rather important that 
you size the window fairly close to these dimensions, as 



Figure 6-5 
Selecting 
CalcWindow from 
AppMaker's Selection 
window 
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the various elements that make up the window's contents 
will need to be positioned and sized as the window is con
structed. You can lay a ruler against your screen, and if 
your display has a resolution of 72 dots per inch (which is 
the case for most Mac displays), then the measurement 
will be quite accurate. Select the CalcWindow window by 
double-clicking on its name in the Selection List, as 
shown in Figure 6-5. 

§0§ Ensemble. rr .rs re §t!]§ 

3 W1 ndo"Ws: 

Clipboard, ID = 200 
MainlUindow, ID = 1 

7. With the window active (its title bar is not dimmed), pull 
down the Tools menu and choose the CBorder tool. You 
are going to create the border element for the cell entry 
pane, shown as item <!) in Figure 6-1. Position the mouse 
with the cursor at the approximate position of the top left 
corner of the border frame, and draw the border down 
and to the right, so that it has approximately the appear
ance shown in Figure 6-1. 

8. Next, choose the Item Info command from the View 
menu. 

9. You will see a dialog box with settings for the position and 
size of the element that is currently selected. This is iden
tified at the bottom of the dialog box as a CAMBorder ele
ment. Change the settings in the dialog box to match 
those shown in Figure 6-6 by selecting and typing the 
new values into the corresponding fields. 

10. The next item is the wide horizontal border that is identi
fied as item ® in Figure 6-1. This item spans the entire 
width of the window and is approximately 20 pixels tall. 
With the CBorder tool still selected, position the mouse 
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Figure 6-6 
Item Info settings 
for the Entry pane 
border 

Figure 6-7 
Item Info settings 
for the wide 
horizontal border 
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on top of the window's left border, at the approximate 
position of the top left corner of the new border, and draw 
down and across to the right window border. The Item 
Info settings for this element are shown in Figure 6-7. If 
the border doesn't seem to be in quite the right relation to 
the window border, resize the window slightly by dragging 
on its resize box, so that the border's right edge overlaps 
the window's right border. Notice that the left edge of the 
new border is at position -1, with respect to the window 
coordinates. This ensures that the left edge of the new 
border overlaps the window's left border. 

§0 Item Info 

Item 2 

Top:~ 
Left: [TI 

Rectangle 

Height: @=] 
Width: 1406 I 

@Enabled O Disabled 

Class: I CRMBorder 

11. The next element is also a border and is identified as 
item ® in Figure 6-1. This border overlaps the wide hori
zontal border, beginning about 31 pixels to the right of 
the window's left edge, and extends to about 16 pixels 



Figure 6-8 
Item Info settings 
for CalcWindow's 
column label border 
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from the window's right edge. It lays right on top of the 
wide border, so when you draw it, position the mouse 
right on top of the previous border's top line, at approxi
mately the position of the new border's top left corner. 
Click and drag the mouse to draw a border that is the 
same height, but not quite as wide as the wide border. 
This creates a border within a border and is the easiest 
way to create the appearance and functionality we desire. 
The Item Info for this border is shown in Figure 6-8. 
Change the settings for your border to match those 
shown in the figure. This border will enclose the column 
labels for the spreadsheet. 
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12. The next element is also a border and is identified as 
item ® in Figure 6-1. This is a tall, vertical border that is 
approximately 30 pixels wide and extends from the bot
tom of the wide horizontal border, at the left side of the 
window, to the bottom of the window. Position the mouse 
at the bottom left corner of the wide horizontal border, 
and drag down and to the right, to overlap both the bot
tom of the wide horizontal border and the bottom window 
border. The Item Info data for this border is shown in 
Figure 6-9. Make sure that the settings for your border 
match those shown in the figure. Like the wide horizontal 
border, this border is largely decorative, but will enclose 
another border, described next. 

13. The final border lies on top of the previous border to form 
the enclosure for the spreadsheet's row label pane. The 
border's top left corner lies exactly on top of the top left 
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Figure 6-9 
Item Info settings 
for tall vertical 
border 

Figure 6-10 
Item Info settings 
for row label pane 
border 
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corner of the previous (tall vertical border) but isn't quite 
as tall. This new border is identified as item ® in Figure 
6-1. It extends to within 16 pixels of the bottom window 
border. The Item Info settings for this border are shown 
in Figure 6-10. Make sure that your settings agree. 
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14. This completes the drawing of the CAMBorder elements. 
When you're done with the preceding steps, the window 
should have the appearance shown in Figure 6-11. Notice 
that the wide horizontal border overlaps the window's 
right and left borders and that the tall vertical border 
overlaps both the bottom of the horizontal border and the 
bottom window border. The horizontal and vertical label 
borders, which will hold the column and row label panes, 
exactly overlap their corresponding wide horizontal and 



Figure 6-11 
CalcWindow with all 
borders drawn 
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tall vertical borders. The next series of steps will show you 
how to add the panes that go inside the border elements. 

(Untitled) E!Ja 

l J 
1 

r----1 _@ 

15. Pull down the Tools menu and choose the CEditText 
tool. 

16. Position the mouse cursor just within the Entry border, 
identified as item © in Figure 6-1. Click and drag the 
mouse to create a CAMEdiIText pane that is entirely 
within, but about 1 pixel smaller on each side, of the 
Entry border. After you release the mouse, click inside the 
pane and type the name Entry inside it. The Item Info 
settings for this pane are shown in Figure 6-12. Notice 
that this item is Enabled. 
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Figure 6-13 
Item Info settings 
for CScrollPane 

17. The next element is identified as item ® in Figure 6-1. 
This is the CScrollPane that permits the spreadsheet to 
scroll both horizontally and vertically. Choose the 
CScrollPane tool from the Tools menu. 

18. The CScrollPane object is going to cover the majority of 
the bottom portion of the window. Its top left corner is 
positioned about 1 pixel below and 1 pixel to the right of 
the intersection of the horizontal and vertical label panes 
(shown as items® and@ respectively, in Figure 6-1). 

Position the mouse cursor near the point of this intersec
tion, click, and drag down and to the right, until the scroll 
pane overlaps the right and bottom borders of the window 
frame. The Item Info settings for this element are shown 
in Figure 6-13. The scroll pane provides the horizontal 
scroll bar only. We will add the vertical scrollbar in the 
next step. The scroll pane also provides a framework 
within which the spreadsheet panorama can be installed. 
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19. Create the horizontal scroll bar by choosing CScrollBar 
from AppMaker's Tools menu. Position the cursor on the 
middle bottom edge of the window, so that the cursor still 
retains the shape of a cross, and click the mouse button 
once. A horizontal scroll bar that fills the width of the 
scroll pane should be automatically drawn. If you don't 
achieve the desired results in the first try, delete the 
imperfect scroll bar and try the procedure again. 
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Item Info settings 
for CArrayPane 
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20. Now that the scroll pane is installed, along with its scroll 
bars, we can place the spreadsheet pane on top of it as its 
panorama. For the purpose of the Ensemble application, 
the TCL's CArrayPane class provides an excellent basis 
for our spreadsheet. Basically, CArrayPane is a subclass 
of the CTable class in which the data associated with 
each of the table's cells is kept in a separate array. The 
array and the table are associated, however, by an explicit 
dependency connection via the CCollaborator class. 
Whenever an element in the array is changed, the associ
ated table will get a ProviderChanged message to trigger 
redrawing the affected cell. To create the spreadsheet 
pane, pull down the Tools menu and choose the CArray
Pane tool. 

21. To draw the CArrayPane in the window, position the 
mouse at the top left corner of the CScrollPane element 
(shown as item® in Figure 6-1), and drag down and to 
the right until the pane covers the entire blank portion of 
the scroll pane element (excluding the scroll bars). The 
Item Info settings for the CArrayPane are shown in Fig
ure 6-14. 
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22. After the CArrayPane is installed, we want to set its text 
style so that the text is smaller and in a different font than 
the default 12 point Chicago system font. Make sure that 
the CArrayPane is still selected, and then pull down the 
Edit menu and choose the Text Style command. Match 
the settings with those in the dialog box depicted in Figure 
6-15 (9-point Geneva, plain style, with left justification). 
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Figure 6-15 
Setting the Text 
Style for the 
CAMArrayPane 
element 
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23. This and the next two steps are concerned with installing 
the CTable panes for the row and column labels. First, 
pull down the Tools menu and choose the CTable tool. 

24. With the CTable tool selected, position the mouse cursor 
just inside the horizontal label border element (shown as 
item @ in Figure 6-1), at its top left corner, and then click 
and drag until the table fills the inside of the border. You 
may experience some difficulty in creating a CTable pane 
that fits inside the border. Don't worry; just draw it the 
best you can, and then use the Item Info settings in Fig
ure 6-16 to modify your settings to correct the table's 
position and size. 
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25. The vertical row label CTable pane is constructed in the 
same fashion as in step 24. Position the mouse at the top 



Figure 6-17 
Item Info settings 
for Vertical "row" 
label CTable element 
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left corner, inside the border shown as item @ in Figure 
6-1. Click and drag the mouse down and to the right, 
until the entire row label border is filled. The Item Info 
settings for this element are shown in Figure 6-1 7. 
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26. If you look carefully at the illustration in Figure 6-11, you 
will see that there are small "holes" in the horizontal and 
vertical border construction, at the top left, top right, and 
bottom left. These are currently unused portions of the 
window but we are going to fill them in with panes that 
could have useful purposes as we enhance the Ensemble 
application later. To "plug" these "holes," choose the 
CPane tool from the Tools menu. 

27. Click within the top left hole of the horizontal border, and 
drag down and to the right to fill in the small "hole" in 
that border with a CPane element. The settings for this 
element are shown in Figure 6-18. 

28. The next "hole" we're going to fill in is the top right pane. 
Click inside the border of that hole, and drag down and to 
the right to fill in that portion of the border with a CPane 
element. The Item Info settings for this element are 
shown in Figure 6-19. 

29. The final "hole" that we will fill is at the bottom left corner 
of the window. Click the mouse inside the small border, 
and drag it down and to the right to fill in the "hole." The 
Item Info settings for this element are shown in Figure 
6-20. This completes the procedure for filling in the holes 
in the CBorder panes. 
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Figure 6-18 
Item Info settings 
for top left CPane 

Figure 6-19 
Item Info settings 
for top right CPane 
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Item Info settings 
for CStaticText 
CellNum element 
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30. The last set of steps completes the construction of the 
remaining three user interface elements. Pull down the 
Tools menu and choose the CStaticText tool. 

31. Position the mouse cursor at the top left of the window, 
about 10 pixels in from the left window border and cen
tered vertically within the top and bottom boundaries of 
the Entry pane. Click the mouse button once. This will 
cause AppMaker to set the position of the leftmost char
acter in the static text field. Type the characters CellNum 
at this time. The Item Info settings for this element are 
shown in Figure 6-21. Notice that the item is Disabled. 
This will prevent it from reacting to mouse clicks. 
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32. Select the CButton tool from the Tools menu. 

33. Position the mouse cursor at the approximate location of 
the Enter button, as shown in Figure 6-1, and click the 
mouse button once. This will create a standard-size Mac
intosh button element. We are going to use a smaller ver
sion of this, so change the settings for this button to 
match those shown in Figure 6-22. Make sure that the 
button is Enabled, as it won't accept mouse clicks if it is 
set to Disabled. 

34. Now, pull down the Edit menu and select the Text Style 
command, which will show the dialog pictured in Figure 
6-23. Change the font and style of the text to correspond 
with the settings in the dialog (a 10-point, plain-style sys
tem font with center justification). Click OK, click inside 
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Figure 6-22 
Item Info settings 
for the Enter button 
element 
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35. Next, create the Cancel button in the same way you cre

ated the Enter button. Click the mouse at the left edge of 
where the button is supposed to be situated, and then 
modify the Item Info settings to correspond to those 
shown in Figure 6-24. Once again, pull down the Edit 
menu and select the Text Style command, causing the 
dialog shown in Figure 6-23 to be displayed. The proper 
settings for the Cancel button duplicate those for the 
Enter button. Click inside the button and type the word 
Cancel. 

The preceding set of steps completes the construction of the 
CalcWindow window. At this point, we are ready to generate 



Figure 6-24 
Item Info settings 
for Cancel button 
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code, but it will be helpful for you to look once again at the il
lustration in Figure 6-1 to make sure that your window ap
pears as shown in the figure. If so, you're ready to generate 
code for the new version of the Ensemble application. 

Generating Code for the CalcWindow Addition to Ensemble 

Figure 6-25 
AppMaker's 
suggested list of files 
to generate 

To generate code for the newly added window, pull down the 
File menu and choose the Generate command. 

When the Generate command is chosen, AppMaker will dis
play a dialog that lists all the files that it intends to generate, 
as shown in Figure 6-25. In most cases, you will want to gen-
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Figure 6-26 
Complete set of files 
for the new version of 
the Ensemble 
application 

erate all the files that it suggests; however, in some cases, 
where all you have done is "tweak" a user interface element 
setting, or move an element within the window, you may 
want to generate code for only the particular affected mod
ules. With practice using AppMaker, and observing the code 
that it generates, you will be able to make that determination. 
For our purposes, all of the suggested modules will be gener
ated. Notice that two new files called CalcWindow.c and Cal
cWindow .h, have been added and that AppMaker also 
intends to regenerate all the files whose names begin with the 
letter z. These are the superclass files, many of which will be 
modified to take into account the new window we've added. 
Click the Generate button for this window, and when App
Maker is finished, choose the Quit command from the File 
menu and click Save to save the changes to the resource file. 

After the files have been generated, you will want to recompile 
the project. Figure 6-26 shows all the files for the new version 
of the project, as seen in the Finder's small icon view. 
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To recompile the project, follow these simple directions: 

1. Launch the THINK C application by double-clicking on 
the Ensemble.n project file. Pull down the Source menu 
and select the Add command. 

2. When the Add command is chosen, THINK C will display 
a dialog that shows all of the source files in the current 
folder that are not present in the project. This is illus
trated in Figure 6-27. 
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Selecting Add All in 
the Add dialog 
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3. After the Add All button is clicked, and the file names all 
show in the bottom window in the dialog, click the Done 
button, as shown in Figure 6-28. This will dismiss the 
dialog and cause all the files in the bottom window to be 
added to the project. 

Notice that the Add dialog doesn't list any of the header 
files. THINK C will automatically add the header files that 
are needed by each source file as it is compiled. 
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.................................................. -................................................................................................................... . 
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4. Figure 6-29 shows a portion of the project window, with 
all of the files for the Ensemble project added. At this 
point, none of the newly modified files has been compiled. 



148 Chapter 6> Adding a Worksheet Window 

Figure 6-29 
Ensemble.it project 
file showing all files 
added 

Figure 6-30 
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5. The next step is to pull down the Source menu and 
choose the Make command. Use this command, rather 
than the Bring Up To Date command from the Project 
menu, because changes to files are not recorded in THINK 
C, unless they have been made with its internal editor or 
unless the files have never been compiled. 

6. Choosing the Make command will cause THINK C to dis
play a dialog, as shown in Figure 6-30. This dialog lists all 
the source files in the project. Click the Use Disk button, 
as shown in the figure. This will cause THINK C to scan 
the files for any changes that may have been made since 
it was last invoked. In this way, you can make THINK C 
subsequently recompile the modified files. 
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Figure 6-31 
Clicking the Make 
button in the Make 
dialog 
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7. After THINK C has scanned the files in the project and 
determined which ones need to be updated (indicated by 
check marks next to their names). you should click the 
Make button at the bottom of the dialog (which is enabled 
only if one or more files needs to be updated). as shown in 
Figure 6-31. 

If you are sure that one or more files needs to be recom
piled, and THINK C fails to enable the Make button, click 
the Quick Scan checkbox to get rid of the check mark, 
and click the Use Disk button once again. 

Rather than just perform a quick scan of the files, THINK 
C will do a more thorough job and will undoubtedly check 
the files that need recompilation. In the worst case, where 
even this step fails, you can check files manually, by 
clicking at the left of their names in the Make dialog. 
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8. THINK C will commence compiling each of the files that it 
has determined need to be recompiled. In many cases, 
files that were not modified will require recompilation, 
because they refer to header files that have changed. 

9. You are now ready to run the default version of the new 
Ensemble application. Pull down the Project menu and 
choose the Run option. Since the debugger is enabled by 
default, you will also have to click the Go button in the 
debugger's window. At this point, the initial EditText 
window will be in front. Resize and move that window so 
that it is below the CalcWindow that appears on the 
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Figure 6-33 
AppMaker vl.5 
resources shown by 
ResEdit 

When AppMaker writes the parameters for border and pane 
elements, it chooses the most likely values for the sizing 
characteristics in the corresponding resource. In most cases, 
this choice will be correct; however, for the complex overlap
ping borders and panes of the CalcWindow design, we need 
to correct a few of the default-generated sizing values. 

The process of modifying the generated resources is pre
sented in a step-by-step fashion. In this case, we will be us
ing the ResEdit program that is shipped with the THINK C 
version 5.0 product. This should be ResEdit version 2.1 or 
later. The process is as follows: 

1. First, make a copy of the TMPLs file that is shipped with 
AppMaker version 1.5. We will not be altering the copy, 
but will hold it aside, in case we run into problems while 
performing the following steps. The original version of the 
file can easily be replaced with the copy. 

2. Launch ResEdit, and locate and open the TMPLs file. You 
will see that ResEdit displays the existing resource types 
as a series of icons in a window, as shown in Figure 6-33. 
The TMPLs file only contains the ICON and TMPL 
resource, as pictured . 

. ~D TMPLs 

ICON 

3. Make sure that the 'TMPL' resource icon is selected, and 
then pull down the Edit menu and choose the Copy com
mand (or press Command-C). This will copy the TMPL 
resources to the clipboard. 

1. For more information on the sizing parameters of panes and other interface elements, see the 
THINK C Object-Oriented Programming Manual, version 5.0, pages 107 through 113. 



Figure 6-34 
ResEdit 
Preferences file 
opened 

Figure 6-35 
TMPL resources 
pasted 

Creating a New Window for Ensemble 153 

4. Pull down the File menu and choose the Quit command 
to quit ResEdit. If ResEdit asks you whether you want to 
save changes before you quit, click No. You can discard 
the copy of the TMPLs file at this time. 

5. Locate the ResEdit Preferences file. It will be in the Pref
erences subfolder if you are running System 7.0 or 
directly in the System folder if you are running System 
6.0.x. Make a copy of this file, and then double-click the 
original file to launch ResEdit. When it is launched, 
ResEdit will display the resources that currently exist in 
its Preferences file, as shown in Figure 6-34. 

§0g ResEdit Preferences §0§ 

~ 
PREF PREF PREF 

FILE GNRL PAGE 

\ \ 
PREF YIEW 

PREF RUEW 

6. Pull down the Edit menu and choose the Paste command 
(or press Command-VJ. This will paste the TMPL 
resources copied from the TMPLs file to the ResEdit Pref
erences file, as shown in Figure 6-35. 

§0g ResEdit Preferences §0§! 

~ 
PREF PREF PREF 

FILE GNRL PAGE 

\ \ 
PREF YIEW 

PREF RUEW 

7. Pull down the File menu and choose the Save command. 
Then pull down the File menu and choose the Quit com
mand to terminate the execution of ResEdit. At this point, 
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you can throw away the copy of the ResEdit Preferences 
file. 

Before continuing, it is useful to explain what the preceding 
steps have accomplished. Because AppMaker creates quite a 
few resource types that are undefined in the version of 
ResEdit that ships with THINK C, it is necessary to provide 
ResEdit with templates that describe the various fields of 
these AppMaker-specific resources. 

If you looked inside the set of TMPL resources, you would 
find that there is a template for a Bord resource, a Pane re
source, an AETx resource, and many other resources. Each 
template describes the sizes and types of the various fields in 
the corresponding resource type. Therefore, with AppMaker's 
templates installed into ResEdit, you can inspect and modify 
the resources generated by AppMaker by looking at values in 
named fields, rather than by decoding hexadecimal values in 
ResEdit's general editor. 

AppMaker's templates have to be installed into ResEdit's 
preferences file only once. If you have occasion to modify 
AppMaker-generated resources in the future, the templates 
you have just installed can be used without following the pre
ceeding steps. 

The next series of steps will describe the exact modifications 
to the resources that AppMaker generated for the CalcWin
dow window. 

1. You should begin by duplicating the Ensemble.Jt.rsrc file 
and then launching ResEdit and opening the original 
Ensemble.7t.rsrc file. You should see a window that looks 
something like that shown in Figure 6-36. As you can see, 
a great number of different resource types are generated, 
and all of these can be edited to modify the functionality 
of the Ensemble application. In the steps that follow, we 
will be modifying only a few of these resources; however, 
in the later stages of development, we will come back to 
ResEdit to personalize the application with its own Finder 
icon and 'BNDL' resources, to make it a true stand-alone 
and unique application. 



Figure 6-36 
Ensemble.7t.rsrc 
resource file contents 

Figure 6-37 
Selecting the Bord 
resource type 
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2. With the ResEdit window open, showing the resources in 
the Ensemble.1t.rsrc file, double-click on the icon whose 
type name is Bord, as shown in Figure 6-37. Note that the 
window has been resized in this figure, to show only a few 
of the resource types. 
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Figure 6-38 
A list of the Bord 
resources in the 
Ensemble 
application 

3. Instead of double-clicking on the Bord resource, you can 
click to select it and then choose Open from ResEdit's 
File menu. In any event, once the resource category has 
been opened, you will see a list of Bord resources, as 
shown in Figure 6-38. In the next few steps, you will be 
modifying only two of these resources. 

§0 Bords from Ensemble.n.rsrc E!l~ 

!Q Size Name 

130 26 ~ 
131 26 
132 26 
133 26 
1 3'1 26 
135 26 tzy 
136 26 ~ 

4. Double-click on the Bord resource whose ID is 134 in the 
list. This is the border that corresponds to item® in Fig
ure 6-1, the wide horizontal border. We discovered the 
number corresponding to this resource by looking in the 
generated code for the zCalcWindow superclass module, 
in the IZCalcWindow method. This code is as follows: 

Rect4 = new CAMBorder; 
Rect4->IViewRes ('Bord', 134, Rect3, supervisor); 

Lists = Newlist5 (); 

List5->IViewRes ('ATbl', 137, Rect4, supervisor); 

Notice that the NewList5 (ATbl 137) element is enclosed 
by the Rect4 element in the last line of the code. This is 
proof that it is Rect4, and thus Bord 134, that we need to 
modify. Because you have installed AppMaker's TMPL 
(template) resources in ResEdit's Preferences file, you 
will be able to see all of the parameters that govern the 
position, size, appearance, functionality, and sizing for 
this resource. The settings for the Bord 134 resource are 
shown in Figure 6-39. Note that the figure shows radio 
buttons for the Boolean variables, such as Visible and 
Active, and has decimal values for the numeric parame-



Figure 6-39 
Settings for Bord 134 
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ters, such as the border's Height and Width. The two siz
ing parameters that you will need to modify are listed as 
Horlz Sizing and Vert Sizing. Change these to the values 
5 and 4, as shown in the figure. This indicates that the 
border is elastic in the horizontal direction when the win
dow is resized, but is fixed in the vertical direction. If you 
think about it, that makes sense. You want the horizontal 
border to always reach from the left to the right window 
border, but you don't want its vertical position to change 
when the window is resized. You will also need to click the 
False selection for the Wants Clicks item. Doing so dis
ables mouse clicks in this pane. After changing these val
ues, click in the window's close box. 

~:u Bord ID = 134 from Ensemble. Tl .rsrc 

Uisible @True O False 

Rctiue @True O False 

Wants Clicks OTrue @False 

Width 

Height 

Horiz 
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Horiz Sizing Is 
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Ru to @True QFalse 
Refresh 

Print Clip lo 
Thickness I 1 

Drop 
Shadow 

lo 
Length 

5. You should still have the list of Bord resources, as shown 
in Figure 6-38, on your screen. Double-click on the 
resource whose ID is 136. This is the vertical (row label 
pane) border (which you can verify by consulting the gen
erated code, as described before). Its settings are shown 
in Figure 6-40. Change the Horiz Sizing and Vert Sizing 
parameters to 4 and 5, respectively. This will allow the 
border to stretch vertically, but remain fixed horizontally. 
The settings are shown in the figure. Also, click the False 
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Figure 6-40 
Settings for Bord 136 

radio button for the Wants Clicks setting. This will dis
able mouse clicks from being recognized in this pane. 
When you have made the indicated changes, click the 
window's close box, and then click the close box of the list 
of Bord resources. You should still have the window 
showing all of the resources in the Ensemble.1t.rsrc file 
on your screen. 
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6. Scroll to the icon that shows the ATbl resource type, and 
double-click on that icon, as shown in Figure 6-41. This 
set of resources contains the parameters of all the 
CTable-oriented user interface elements. Among them are 
the two CTable panes (row and column labels), as well as 
the CArrayPane that occupies the majority of the window. 

7. When you open the ATbl resource, you will see a list of all 
the tables that have currently been defined in the Ensem
ble application. The list is shown in Figure 6-42. Note 
that in addition to the three tables we defined in the Calc
Window design, there are two additional tables in the list. 
These correspond to the Font and Size tables in the Note
book dialog design, from Chapter 3. 



Figure 6-41 
ATbl resources 
selected 

Figure 6-42 
A list of the ATbl 
resources in the 
Ensemble 
application 
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§0 RTbls from Ensemble. n .rsrc 0§ 
ill. Size Ncime 

134 76 0 
t--

135 76 
136 82 
137 76 -0 
138 76 ~ 

8. Double-click on the ATbl resource whose ID is 137 to open 
it for the purpose of changing its sizing parameters. This is 
the table that corresponds to the column labels associated 
with item ® in Figure 6-1, the table that will hold the col
umn labels for the spreadsheet displayed in the CalcWin
dow. There are a great number of parameters associated 
with an ATbl resource, so we will just focus on the sizing 
parameters, but you may want to look at all the various 
settings that are available to be modified. Change the 
Horiz Sizing and Vert Sizing parameters to match the 
settings in Figure 6-43. This will enable the column labels 
to stretch or shrink horizontally, but remain fixed verti
cally. When you have made these changes, click in the 
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Figure 6-43 
Settings for ATbl 137 

close box of the window. You should still have the list of 
ATbl resources on your screen, as shown in Figure 6-42. 
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9. Double-click (or select and then choose the Open com
mand from ResEdit's File menu) the ATbl resource whose 
ID is 138. This is the table corresponding to the vertical 
(row labels) pane, identified as item @ in Figure 6-1. The 
settings for the sizing characteristics for this table are 
shown in Figure 6-44, as 4 and 5 for the Horiz Sizing 
and Vert Sizing parameters, respectively. These settings 
enable the pane to stretch and shrink vertically, but 
remain fixed horizontally. When you are finished making 
these changes, close the window and also the list of ATbl 
resources by clicking in their respective close boxes. 

10. The next series of steps will modify the sizing characteris
tics of several Pane resources. Scroll the window showing 
the resources in the Ensemble.n.rsrc file until the icon 
with the name Pane is visible, and then double-click this 
icon to open the list of these resources, as shown in Fig
ure 6-45. 

11. A window listing the Pane resources in the Ensemble 
application should appear, as shown in Figure 6-46. 

12. Double-click on the Pane resource whose ID is 129 to 
open a window containing the settings of this resource, as 
shown in Figure 6-4 7. The figure shows the complete set 
of parameters for the Pane resources. Change the Horiz 



Figure 6-44 
Settings for ATbl 138 

Figure 6-45 
Selecting the list of 
Pane resources 
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Sizing and Vert Sizing parameters to 4 and 4, respec
tively, to force the pane to remain fixed in size and loca
tion when the window is resized. This pane corresponds 
to the "hole" at the upper left corner of the horizontal bor
der and is identified as item ® in Figure 6-1. When the 
changes have been made, close the window. 
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Figure 6-46 
A list of Pane 
resources in the 
Ensemble 
application 

Figure 6-47 
Settings for Pane 129 
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13. Double-click to open the Pane resource whose ID is 130, 
the settings of which are shown in Figure 6-48. Change 
the sizing settings for this pane to match those shown in 
the figure. The pane is shown as item ® in Figure 6-1, 
and it fits in the upper right "hole" in the horizontal bor
der. Both sizing parameters are set to 4, indicating that 
the pane is fixed horizontally and vertically in size and 
position. When you have completed these changes, close 
the window. 

14. Double-click to open the Pane resource whose ID is 131, 
the settings of which are shown in Figure 6-49. Change 
the sizing settings for this pane to match those shown in 
the figure. The pane is shown as item® in Figure 6-1, fit
ting into the "hole" at the lower left corner of the window. 
The sizing, both horizontally and vertically, should be set 
to 4, indicating that the pane is fixed in size and position. 
When you have completed the changes to this pane, click 



Figure 6-48 
Settings for Pane 130 

Figure 6-49 
Settings for Pane 131 
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the close box to dismiss the window, and also click the 
close box to dismiss the list of Pane resources. 
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15. The final change modifies the Line Width parameter of 
the EditText pane that is identified as item <D in Figure 
6-1. This is the Entry pane, represented by an AETx 
resource. Double-click on the AETx resource icon, as 
shown in Figure 6-50. 

16. When the AETx resource list is opened, a window con
taining a list of these resources is displayed, as shown in 
Figure 6-51. 

17. Double-click on the AETx resource whose ID is 135. This 
resource contains the settings for the Entry pane. We are 



164 Chapter 6> Adding a Worksheet Window 

Figure 6-50 
Opening the AETx 
resources 

Figure 6-51 
A list of AETx 
resources in the 
Ensemble 
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interested only in changing the Line Width parameter to 
the value 400, as shown in Figure 6-52. This setting will 
allow the Entry pane to scroll, after we have customized 
the code to enable scrolling for this EdiIText field. The 
value 400 is a little more than twice the width of the ele
ment, as indicated in the Width field of Figure 6-12. 

When you have completed this change, close the window, 
and also close the window containing the list of AETx 
resources, by clicking in their respective close boxes. 
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Settings for AETx 
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18. Pull down ResEdit's File menu and choose the Save com
mand, to preserve the changes that have been made to 
the resources. After saving the changes, pull down the 
File menu and choose the Quit command to terminate 
execution of the ResEdit application. 

After following the preceding steps, you can discard the copy 
of the Ensemble.n.rsrc file if all of the steps were completed 
successfully. 

1. Describe the rationale for using instances of the CTable 
class to represent the column and row labels in the work
sheet window. 

2. Explain what purpose could be served by the CPane ele
ments that were placed in the top left, top right, and bot
tom left corners of the worksheet window. (Hint: Think 
about scrolling a very large worksheet.) 

3. Explain how the various sizing parameters affect their 
corresponding elements in a window's design. For exam
ple, what would happen if the sizing characteristics of the 
column label border weren't modified? 
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4. What different techniques would have to be used to han
dle the entry of data into the worksheet if a different 
approach were used? What problems would have to be 
resolved? (Hint A Pane can overlay and obscure anything 
underneath it in a window.) 1 

1. This exercise has far-reaching consequences in the overall design of the application and 
would be an excellent extra-credit project. The goal would be to provide the means for han
dling in-cell entry and editing of worksheet data. 



Chapter 7 

Examining the CalcWindow Code 

This chapter describes the modifications to the Ensemble ap
plications code generated by AppMaker after adding the Calc
Window user interface elements. It should be apparent that 
none of the subclass files, whose names do not begin with the 
letter z, were modified. Thus, their contents are safe. Only 
the superclass files, whose names do begin with the letter z, 
have been regenerated. This is a tremendous help, as we will 
never (well ... hardly ever) have to make any changes to the 
superclass files, and they are available to be reconstructed at 
AppMaker's will. 

In the course of generating new files, after the CalcWindow 
was added to the user interface in Chapter 6, AppMaker gen
erated two new source files and their companion header files: 

•:• CalcWindow.c contains the subclass methods that over
ride and supplement the methods generated in the super
class and will also be the target file for the custom code 
that is described in Chapter 8. 

•:• CalcWindow.h contains the class declarations for the sub
classes defined in the CalcWindow.c source file. 

•:• zCalcWindow.c contains the superclass methods, that 
implement the initialization and default behavior of the 
new user interface elements. 

•:• zCalcWindow.h contains the class declarations for the 
superclasses defined in the zCalcWindow.c source file. 

All of the superclass source and header files have been regener
ated; however, we will only describe the differences in them 
brought about by the addition of the new user interface elements. 

167 
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The CalcWindow's Code Structure 

Figure 7-1 
Ensemble 
Application 
structure with 
CalcWindow added -TCLClass 

0 Generated Superclass 
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As indicated in Chapter 4, the best way to see how the newly 
generated code files are associated with the other parts of the 
Ensemble application is to look at the diagram shown in Fig
ure 7 -1 and compare it with Figure 4-1. 
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It is clear from the figure that the CCalcWindow subclass in
stance is created from the ZEnsembleDoc class-specifically, 
by the BuildWindows method. Its superclass, ZCalcWindow, 
is a subclass of the TCL's CDirector class, as is the CDocu
ment class (although that relationship isn't shown in the dia
gram). It is important to note that all subsidiary windows will 
be created from the ZEnsembleDoc class and will inherit 
their behavior from the CDirector class. The structure of all 
AppMaker-generated applications have only one window that 
is managed by the TCL's CDocument class. This implies 
that, because the document creates the CDataFile class in
stance, all windows will share a common file. If you need to 
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Generated code 
changes for the 
CalcWindow user 
interface element 
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open a different type of file for each window, it is better to de
sign the application so that it has a single window, with mul
tiple instances of that window (created by the New and Open 
commands in the application's File menu). This model is per
fect for our purposes. The modified classes and methods are 
shown in Table 7-1. 

Class Method Description 

ZEnsembleDoc BuildWindows includes code to create an 
instance of CCalcWindow and 
initialize it 

ZCalcWindow IZCalcWindow contains all the code to create 
and initialize all of the interface 
elements in the CalcWindow 
defined in AppMaker 

ZCalcWindow various methods for creating the CTable 
and CArrayPane, as well as the 
hole filler panes. Meant to be 
overridden 

CCalcWindow ICalcWindow calls the inherited IZCalcWindow 
initialization method, and con-
tains post initialization code 

CCalcWindow various methods to create, initialize and 
supply the cell text for each of the 
CTable panes (e.g., NewList5, 
IViewTemp, and GetCellText) 

CCalcWindow various creating, initialization, draw, and 
other methods for each of the hole 
filler panes (e.g., NewUser6, 
IViewTemp, and Draw) 

CCalcWindow DoEnterButton methods to handle mouse clicks 
DoCancelButton on the respective buttons 

CCalcWindow UpdateMenus calls inherited method 

CCalcWindow DoCommand recognizes mouse commands for 
the Enter and Cancel buttons 

CCalcWindow ProviderChanged intercepts ProviderChanged 
messages from the CTable and 
EditText instances 

The classes and methods listed in the table provide only the 
default appearance shown in Figure 6-32 when the generated 
code was compiled and executed. It is this default functional
tty that the following sections discuss. 
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Newly Generated Code in ZEnsembleDoc 

In the newly generated code, none of the superclass modules 
except zEnsembleDoc.c has been modified, even though the 
other modules were regenerated. There is no harm to this, 
and user interface modifications could very well affect other 
modules. 

BuildWindows Method Code 

The ZEnsembleDoc class's BuildWindows method has been 
modified to create and initialize the new CalcWindow that we 
defined. The new version of this code is as follows: 

void ZEnsembleDoc::BuildWindows (void) 

{ 
CWindow *mainWindow; 
CDirector *subWindow; 

mainWindow = new CMainWindow; 
itsWindow = mainWindow; 
( (CMainWindow *)mainWindow)->IMainWindow (this, itsData); 
itsMainPane = ((CMainWindow *)mainWindow)->itsMainPane; 

subWindow = new CCalcWindow; 
((CCalcWindow *)subWindow)->ICalcWindow (this, itsData); 

The foregoing code creates the MainWindow, in the same 
way as shown in Chapter 2, on page 34. In addition, it cre
ates a new instance of CCalcWindow and calls its initializa
tion method. 

If additional windows are added to the application, the Build
Windows method will be enhanced to create and initialize 
these as well. 

Newly Generated Code in ZCalcWindow 

The zCalcWindow.c file has been generated to contain the 
initialization method and other superclass methods that es
tablish the default appearance and functionality of the Calc
Window window. 



The IZCalcWindow 
method creates and 
initializes all the 
user interface 
elements in the 
Cale Window 
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IZCalcWindow Method Code 

The code to create and initialize all of the interface elements 
that form a part of the CalcWindow design is contained in 
the IZCalcWindow method. This is a rather large method, be
cause of all the elements we defined. The code is as follows: 

void ZCalcWindow::IZCalcWindow(CDirectorOwner *aSupervisor) 
{ 

CView *enclosure; 
CBureaucrat *supervisor; 
CSizeBox *aSizeBox; 

inherited ::I Director (aSupervisor); 
itsWindow = new CWindow; 
itsWindow->IWindow (CalcWindowlD, FALSE, gDesktop, this); 
enclosure = itsWindow; 

supervisor = this; 
Rect1 = new CAMBorder; 
Rect1->IViewRes ('Bord', 132, enclosure, supervisor); 

EntryField = new CAMEditText; 
EntryField->IViewRes ('AETx', 135, Rect1, supervisor); 

Rect3 =new CAMBorder; 
Rect3->IViewRes ('Bord', 133, enclosure, supervisor); 

Rect4 = new CAMBorder; 
Rect4->1ViewRes ('Bord', 134, Rect3, supervisor); 

List5 = Newlist5 (); 
List5->IViewRes ('ATbl', 137, Rect4, supervisor); 

User6 = NewUser6 (); 
User6->IViewRes ('Pane', 129, Rect3, supervisor); 
User? = NewUser7 (); 
User7->IViewRes ('Pane', 130, Rect3, supervisor); 
Reeta = new CAMBorder; 
Recta->IViewRes ('Bord', 135, enclosure, supervisor); 
Rect9 = new CAMBorder; 
Rect9->IViewRes ('Bord', 136, Reeta, supervisor); 
List1 O = Newlist1 0 (); 
List10->IViewRes ('ATbl', 13a, Rect9, supervisor); 
User11 = NewUser11 (); 
User11->IViewRes ('Pane', 131, Reeta, supervisor); 
Scro11Pane12 = new CScrollPane; 
Scro11Pane12->IViewRes ('ScPn', 134, enclosure, supervisor); 
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IZCalcWindow 
method.code 
(concluded) 

Note: The author 
made a list of each 
resource type and ID 
and then examined 
them with ResEdit to 
determine their 
generated settings. 

List15 = Newlist1 5 (); 
List15->IViewRes ('ATbl', 136, Scro11Pane12, supervisor); 

Scro11Pane12->lnstallPanorama (List15); 
CellNumLabel = new CAMStaticText; 
CellNumLabel->IViewRes ('AETx', 134, enclosure, supervisor); 
EnterButton =new CAMButton; 
EnterButton->IViewRes ('CtlP', 144, enclosure, supervisor); 
CancelButton = new CAMButton; 
CancelButton->IViewRes ('CtlP', 145, enclosure, supervisor); 
aSizeBox = new CSizeBox; 
aSizeBox->ISizeBox (enclosure, supervisor); 

The IZCalcWindow code creates and initializes each of the 
user interface elements in the CalcWindow. Borders are 
given names beginning with the word Reef, lists begin with 
List, and user items (such as hole .filler panes) begin with 
User. The single CScrollPane instance carries a name begin
ning with ScrollPane, and the Enter and Cancel buttons are 
named EnterButton and CancelButton, respectively. The 
CAMEditText Entry field is named EntryField, and the 
CAMStaticText item holding the words Cell Num has been 
named CellNumLabel. 

You'll notice that the elements are numbered in ascending se
quence, regardless of their types. Also, each is created from 
the parameters in a template of a particular type and re
source ID. The IViewRes method contains the type name and 
resource ID of the resource template. These correspond to the 
template type names and IDs whose sizing characteristics 
were modified in Chapter 6. 

Several of the IViewTemp methods are overridden in the 
CCalcWindow class. We'll be looking at these methods 
shortly. 

NewListt Method Code 

AppMaker generates code in the superclass to create each of 
the Listi elements. The sole purpose of generating this code is 
so that it can be overridden by the corresponding subclass 
method. Notice that the superclass method creates an in
stance of the CAMTable class while the subclass override 
method creates a new subclass of that table instance (see the 
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subclass code for NewList5 on page 177). An example of the 
superclass code is the following: 

CAMTable *ZCalcWindow::Newlist5(void) 
{ 

CAMTable *thelist; 

thelist =new CAMTable; 
return (thelist); 

This code creates the List5 element (the horizontal cell label 
CAMTable instance) and returns the instance to the caller 
(IZCalcWindow). The method is overridden in the subclass, 
as will be shown. The zCalcWindow.c module contains 
nearly identical code for the other two lists; the only differ
ence being in the creation of the List15 element, which is 
created as a CAMArrayPane object. 

NewUser1 Method Code 

The hole filler panes are created in much the same way as the 
lists. A method is provided for each, so that it can be overrid
den by the subclass if desired. 

An example of one of these methods is the following: 

CPane *ZCalcWindow::NewUser6(void) 
{ 

CPane *pane; 

pane = new CPane; 
return (pane); 

Each hole filler pane is created in a fashion identical to that 
shown in the preceding code. The pane there is initialized by 
a resource named Pane 129, which corresponds to the top 
left hole filler, shown as item ® in Table 6-1. 

Remember, the creation methods merely create the object in
stance and return it to the caller (IZCalcWindow). 
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UpdateMenus Method Code 

The default code for the UpdateMenus method merely calls 
the inherited method: 

void ZCalcWindow::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

Code is also generated in the subclass for this method; how
ever, by default, it also merely calls the inherited method, as 
we will show later. 

DoCommand Method Code 

The code for the superclass's DoCommand method, also very 
simple, is provided as a method that the subclass can ovenide: 

void ZCalcWindow::DoCommand(longtheCommand) 
{ 

switch (theCommand) 
{ 

default: 
inherited::DoCommand (theCommand); 

break; 

As is apparent, only the default case is handled, by calling 
the inherited method to handle the command. 

Newly Generated Code in CCalcWindow 

The generated code in the CalcWindow.c module provides 
very little additional functionality, but serves as a framework 
for customizing the behavior of the CalcWindow user inter
face element. Many of the methods that override or supple
ment those in the superclass merely call the inherited 
method. Thus, the default execution functionality of the win
dow is provided almost entirely by the code generated into the 
superclass. This section discusses the subclass methods, 
which will be the basis for all the custom code that will be 
added and described in Chapter 8. 
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ICalcWindow Method Code 

When the ZEnsembleDoc class's BuildWindows method first 
creates the CalcWindow instance, it calls the ICalcWindow 
method to perform the initialization for this new window. The 
code for the ICalcWindow method saves the handle to the 
CEnsembleData instance (theData), calls the inherited IZ
CalcWindow method, and sends the gDecorator a message 
to stagger the new window with respect to the other windows 
currently on the screen. 

The method also serves as a placeholder for additional cus
tom code that we will be adding in the next chapter. The code 
for the ICalcWindow method is as follows: 

void CCalcWindow::ICalcWindow(CDirector *aSupervisor, 
CEnsembleData *theData) 

itsData = theData; 
inherited::IZCalcWindow (aSupervisor); 
gDecorator->StaggerWindow (itsWindow); 
II any additional initialization for your window 

Notice that AppMaker has inserted a comment in the generated 
code, indicating where additional initialization code can be 
placed. This is one of the most useful features of the generated 
code. Such comments are sprinkled liberally throughout the 
code, to aid you in placing modifications and custom additions. 

List1 IViewTemp Method Code 

Each of the list elements is accompanied by three generated 
methods in the subclass: an IViewTemp, a GetCellText, and 
a NewList1 method. The code for the IViewTemp method is 
as follows: 

void CList5::1ViewTemp (CView *anEnclosure, 
CBureaucrat *aSupervisor, Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 
II any additional initialization for your subclass 
AddRow (4, O); II e.g., add 4 rows at the beginning of the list 
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List GetCeUText Method Code 

The GetCellText method is called by the TCL's CTable class 
whenever the contents of a list cell need to be redrawn. The 
GetCellText code for the CList5 class instance is as follows: 

void CList5::GetCellText (Cell aCell, 
short availableWidth, StringPtr itsText) 

II replace with your own code, which uses the cell coordinates 
II to access your private data structures; 
II then convert the cell data to a Str255 
switch (aCell.v) { 

case O: 
CopyPString ("\pOne", itsText); 

break; 
case 1: 

CopyPString (''\pTwo", itsText); 
break; 

case 2: 
CopyPString (''\pThree", itsText); 

break; 
default: 

CopyPString ("\plnfinity", itsText); 
break; 

Note that AppMaker has once again generated comments 
which indicate that the code included in the GetCellText 
method is only an example of what is needed and should be 
replaced with code pertinent to your application. We will be 
replacing all of this code in the next chapter. 

List NewListi Method Code 

When a new list element is created, AppMaker generates code 
to create this element both in the superclass and the sub
class, so that the code can be overridden if desired. 

The code to create a new list element is rather simple; how
ever, being able to override it allows you a lot of flexibility in 
how the list is created. It also gives you the opportunity to 
add code to perform related tasks inside the creation method. 
The code for the NewList5 method is as follows: 
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CAMTable *CCalcWindow::Newlist5(void) 
{ 

Clist5 *thelist; 
thelist = new Clist5; 
return (thelist); 

The superclass method for NewList5 creates an instance of 
CAMTable, as shown on page 1 73. The corresponding over
riding method in the subclass creates a unique class in
stance. This, in turn, is a subclass of CAMTable as 
illustrated by the following class declaration taken from the 
CalcWindow.h header file: 

class Clist5 : public CAMTable 
{ 
public: 

}; 

void IViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData); II is override 

void GetCellText(Cell aCell, 
short availableWidth, 
StringPtr itsText); II is override 

The foregoing declaration for CList5 defines it as a direct de
scendant of the AppMaker library class CAMTable, which, in 
turn, is a direct descendant of the TCL's CTable class. Gener
ating a unique class name for each list (or table) is necessary, 
so that each type of list can have its own IViewTemp and 
GetCellText methods. 

The CalcWindow.c module also contains IViewTemp, Get
CellText, and NewList1 methods for lists CListlO and 
CList15. The direct ancestor of the CList15 class is CAMAr
rayPane, rather than CAMTable. 

Incidentally, AppMaker interposes its own library classes in 
between many of its generated classes and the TCL, to pro
vide text styles for almost every element. For example, in 
Chapter 6, the text style for the main spreadsheet table 
(shown in the code as CList15) was changed to 9-point 
Geneva, rather than the System font (12-point Chicago). The 
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Draw method code 
for CUser6 class 
(beginning) 

IViewTemp method inherited from most AppMaker library 
classes initializes the text size, style, and justification of the 
corresponding elements. Therefore, when the generated code 
calls the inherited IViewTemp method first, it is allowing 
AppMaker's library method to set up the specified text style 
information from the resource template. 

User IViewTemp Method Code 

For each hole filler pane that is created, AppMaker generates 
a class beginning with the word User, with a number ap
pended to make it unique. The IViewTemp initialization 
method for one such pane is as follows: 

void CUser6::1ViewTemp (CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr view Data) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 
II any additional initialization for your subclass 

Note that AppMaker has generated a comment in this 
method, after the call to the inherited method, to the effect 
that if additional initialization is appropriate for this item, the 
code can be inserted at that location. 

User Draw Method Code 

AppMaker also generates a Draw method for User panes. The 
code shown for this method is only an example of what might 
be needed; it is benign and needn't be changed if nothing spe
cial is required to draw the contents of the element. Sample 
code for one such User element is as follows: 

void CUser6::Draw (Rect *area) 
{ 

II replace with your own code which draws the pane 
II note that 'area' is usually ignored; it has no relationship 
II to the size of the pane; it merely indicates what portion 
II (in QuickDraw coordinates) of the pane needs to be drawn 

Rect theFrame; 
PenState savePen; 



Draw method code 
for CUser6 class 
(concluded) 

GetPenState (&savePen); 
PenNormal (); 
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FrameToQDR (&frame, &theFrame); 
SetPenState (&savePen); 

The preceding code calls the GetPenState toolbox routine to 
get information on the current pen state, including the pen 
location, size, transfer mode, and pattern. The PenNormal 
toolbox call resets the pen state to the initial (default) set
tings. The FrameToQDR method (located in the CPane class) 
converts the instance variable frame (describing the top left 
and bottom right coordinates of the pane) from frame coordi
nates to Quickdraw coordinates. 

The final statement calls the SetPenState toolbox routine to 
reset the pen state to the value it had before the Draw 
method was entered. As generated, the method performs no 
useful function; however, if you wished to draw something in 
the pane, you would insert the appropriate code right after 
the call to the FrameToQDR method. We will not be modify
ing this code, as the panes are simply hole fillers at this point. 
They could serve other useful functions, however, so we 
elected to create panes, rather than just leave the corre
sponding border areas empty. 

User NewUser1 Method Code 

The final method generated for each user item creates the 
method instance and returns it to the caller. The code for the 
NewUser6 method is as follows: 

CPane *CCalcWindow::NewUser6(void) 
{ 

CUser6 *pane; 

pane = new CUser6; 
return (pane); 

Each User element is a direct descendant of the TCL's CPane 
class, as shown by the class declaration for the User6 ele
ment, taken from the CalcWindow.h module: 
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class CUser6 : public CPane 
{ 
public: 

}; 

void IViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData); II is override 

void Draw(Rect *area); II is override 

In addition to the IViewTemp, Draw, and NewUser6 methods 
generated for the User6 element, AppMaker has also gener
ated nearly identical declarations and methods for the User7 
and Userll elements. 

UpdateMenus Method Code 

AppMaker's generated code for the UpdateMenus method 
merely calls the inherited UpdateMenus method; however, if 
additional changes to the state of the menus on the screen 
are needed, then, when the CalcWindow is active, this 
method provides an appropriate place to insert the necessary 
code. 

The default-generated code is as follows: 

void CCalcWindow::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

In the next chapter, we will be enhancing this code to disable 
the Close command in the File menu when the CalcWindow 
is active. 

DoCommand Method Code 

When the user chooses a command from one of the applica
tion's menus, or if a "click command" is assigned to a button 
or other item, the DoCommand method associated with the 
current gGopher will be called with the command number 
parameter. The generated code for the CCalcWindow class's 
DoCommand method is as follows: 
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void CCalcWindow::DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdEnterButton: 
{ 

} 

DoEnterButton (); 
break; 

case cmdCancelButton: 
{ 

DoCancelButton (); 
break; 

default: 
{ 

inherited::DoCommand (theCommand); 
break; 

AppMaker assigns "click commands" to all buttons as a stan
dard procedure, so these were created for the Enter and Can
cel buttons in the resource templates for those elements. 
When the user clicks on either of these buttons, the TCL will 
generate a DoCommand message containing the command 
number of the button that is clicked. 

When the DoCommand method is called with either the 
cmdEnterButton or the cmdCancelButton command, the 
method will invoke the appropriate corresponding method. 

The default-generated code for both of these methods is as 
follows: 

void CCalcWindow::DoEnterButton (void) 
{ 
} 

void CCalcWindow::DoCancelButton (void) 
{ 
} 
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ProviderChanged 
method.code 
(beginning) 

As you can see, both methods are completely empty; however, 
we will be adding code to them in the next chapter. 

ProviderChanged Method Code 

The collaboration mechanism, defined as part of the TCL, was 
described in full in Chapter 4. This mechanism is used by a 
range of providers, including the descendants of the TCL's 
CTable class. 

As explained in Chapter 4, if a selection changes, a Broad
castChange message is sent to the list instance, which inher
its the functionality of the corresponding method in the 
CCollaborator class; however, in addition, the CBureaucrat 
class overrides this method and also sends a Provider
Changed message to the table's supervisor, which, in the 
case of our tables (main spreadsheet, row labels, and column 
labels), will cause the CCalcWindow instance's Provider
Changed method to be invoked. The message includes the 
instance handle of the provider that issued the Broad
castChange message, the reason for the broadcast, and any 
other appropriate data, which are addressed via a pointer. 

AppMaker generates a ProviderChanged method for each 
window or dialog in the application. We did not need to use 
this method in the CMainWindow class, but did in the 
CNotebook and will in the CCalcWindow class. 

The generated code for the ProviderChanged method is as 
follows: 

void CCalcWindow::ProviderChanged(CCollaborator *aProvider, 
long reason, 
void* info) 

if (aProvider == List5) { 

} 

if (List5->HasSelection ()) { 
II perhaps activate some buttons 

} else { 
II perhaps deactivate 

if (aProvider == List10) { 
if (List10->HasSelection ()) { 

II perhaps activate some buttons 
} else { 



ProviderChanged 
method.code 
(concluded) 

Exercises 

II perhaps deactivate 

} 
if (aProvider == List15) { 

if (List15->HasSelection ()) { 
II perhaps activate some buttons 

} else { 
II perhaps deactivate 

Exercises 183 

This code tests whether the aProvider parameter is one of 
the lists (List5, ListlO, or List15) and then checks whether a 
cell is selected for that table. No action code is included; how
ever, we will be customizing the method in the next chapter to 
handle selections in the main spreadsheet table (List15). 

1. Figure 7-1 shows the "chain of command" when the 
MainWindow instance is frontmost on the screen. 
Describe the "chain of command" if the CalcWindow is 
frontmost. 

2. Explain why each of the column labels, row labels, and 
main worksheet lists must be a separate subclass of the 
TCL's CTable class. 

3. Compare the features of the TCL's CTable class with the 
built-in Macintosh List Manager. 

4. What mechanism causes the GetCellText methods of the 
column, row, and worksheet lists to be invoked? 

5. Explain the rationale for having both superclass and sub
class NewListi and NewUser1 methods? (Hint Look at the 
IZCalcWindow method for a clue to this organization of 
classes and methods.) 

6. What functions are performed by the Enter and Cancel 
buttons in the worksheet window? What methods will 
need to be enhanced to implement these functions? Out
line the features of the code to do so. 
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7. The worksheet's column and row label lists are imple
mented as subclass instances of AppMaker's CAMTable 
class. In what way does the user interact with these user 
interface elements? How must the code in the Provider
Changed method, as generated by AppMaker, be modified 
to support the required interactions? (Hint Examine the 
steps for modifying the Bord resource panes that enclose 
these lists, as described in Chapter 6.) 

8. Assuming that you have decided to draw a pattern in the 
empty panes at the top left, top right, and bottom left cor
ners in the worksheet, how would you implement your 
intentions, based upon the classes and methods shown in 
this chapter? Modify the appropriate methods to do so. 1 

1. This is a relatively simple task, but it will require some thought and knowledge of the Macin
tosh toolbox routines. It could be assigned as an extra-credit project. 
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Customizing the Worksheet Code 

Table 8-1 
Customized methods 
to implement the 1/0 
for EdiIText and 
spreadsheet data 

This chapter describes the classes and methods that have 
been customized to implement the full functionality of the 
CalcWindow interface component. In the course of describ
ing the implementation of a functional spreadsheet, a great 
amount of detail was required. Such detail is justified in or
der to present the complete, step-by-step documentation of 
this nontrivial addition to the Ensemble application. 

Class Method Description 

CEnsembleData IEnsembleData Create CCluster to hold 
spreadsheet data 

CEnsembleData ReadData Rewritten to handle text and 
spreadsheet data 

CEnsembleData ReadWSEntries New method to read spread-
sheet entries 

CEnsembleData WriteData Rewritten to handle text and 
spreadsheet data 

CEnsembleData WriteWSEntries New method to write spread-
sheet entries 

CEnsembleData DisposeData Disposes of EdiIText and 
spreadsheet data entries 

CEnsembleData GetCluster Access method to return 
spreadsheet cluster instance 

Table 8-1 lists the methods and modifications that support 
input/output of both the EditText and worksheet data in a 
shared file. 

185 
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Customizing the CEnsembleData Code 

Chapter 5 contains descriptions of all of the existing methods 
in the CEnsembleData class. This class is responsible for 
performing all of the physical input/ output for the applica
tion. It contains methods to open, close, save, save as, and 
revert to a previous version of a file. It also contains methods 
to initialize the class and dispose of all the data. The CEn
sembleData class is created to support the CEnsembleDoc 
class, which contains the methods that are called by the TCL 
to create a new document, open an existing document, and 
read from and write to the application's windows. 

Because our new user interface model has two windows, each 
holding a different type of data, it becomes necessaiy to be able 
to perform all of the input/ output operations on a composite 
file. There are vecy few methods that need revision to support 
this new concept, and the modifications are straightforward. 

Modifying the Initialization code 

Because all of the input/ output for the application is carried 
out in the CEnsembleData class, it is natural for the data to 
be owned by this class. The data will need to be accessed by 
other classes, but the CEnsembleData class owns both the 
EditText and the worksheet data. 

IEnsembleData Code 

The code for initializing the CEnsembleData instance has 
been modified to create a CCluster to hold the worksheet 
data. The modified code is as follows: 

void CEnsembleData::IEnsembleData(CDocument *theDocument) 
{ 

inherited::IDataFile (); 
hasFile = FALSE; 
itsDocument = theDocument; 
II your application-specific initialization 
itsEditTextData = NULL; 
itsCluster = new CCluster; 
itsCluster->ICluster(); 
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The code is not very different from what was shown in 
Chapter 5, on page 98. The main difference is that a new in
stance variable has been defined to contain an instance of 
CCluster-a data collection class in the TCL-and the cluster 
is initialized. 

The itsCluster instance variable has been added to the CEn
sembleData class declaration in the CEnsembleData.h 
header file as a protected variable, along with the existing its
EditTextData variable. 

Modifying the Input/Output Code 

ReadData method 
code (beginning) 

Because of the addition of the new window (CalcWindow), the 
input/output code must be modified to make provision for 
storing both worksheet and text data in the same file. This is 
quite easy, and you'll find the custom code additions 
straightforward and simple. The modified methods (and new, 
custom methods) are listed in Table 8-1. The following sub
sections discuss the new code. 

ReadData Method Code 

The ReadData method has been substantially changed, to re
flect the fact that three different types of data are stored in 
the single data file owned by the CEnsembleData class. The 
three types of data are text font information (font, style, size, 
justification), text data, and worksheet cell data. 

The file format has been completely changed to make provi
sion for the existence of either or both of the text or work
sheet data. Both need not be present, but both are 
accommodated. 

The code for the new ReadData method is as follows: 

void CEnsembleData::ReadData(void) 
{ 

long textlength, WSEntryCt; 
fontinfo theFontlnfo; 

II 
II modified to handle both the EditText and Worksheet data 
II in the file. The file format is: 
II 
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ReadData method 
code (concluded) 

II char. pos. description 
II --------------
11 
II 
II 

0- 3 
4- 7 
8-15 

II 16- n 
II n + 1 - m 
II 

text length (bytes) 
worksheet cell count 
text style information 
text data bytes 
worksheet entries 

TRY 
{ 

II 
II get text and worksheet data sizes 
II 
FailOSErr (SetFPos( refNum, fsFromStart, OL)); 
ReadSome( (Ptr)&textLength, sizeof(long)); 
ReadSome((Ptr)&WSEntryCt, sizeof(long)); 
II 
II read in the EditText data 
II 
if(textLength > 0) 
{ 

} 
II 

II 
II read the font info 
II 
ReadSome((Ptr)&theFontlnfo, sizeof (fontinfo)); 
((CEnsembleDoc *) itsDocument)->theTextData 

->SetFontData (theFontlnfo); 
II 
II now, read the text 
II 
itsEditTextData = NewHandleCanFail(textLength); 
FailNIL(itsEditTextData); 
ReadSome(*itsEditTextData, textLength); 

II read in the worksheet data 
if(WSEntryCt > 0) 
{ 

ReadWSEntries(WSEntryCt); 

} 
CATCH 
{ 

ForgetHandle (itsEditTextData); 
} 
ENDTRY; 
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The comments at the beginning of this code describe the new 
file format. The file begins with two long integers. The first 
contains the length of the text portion of the file, and the sec
ond contains the number of worksheet entries in the file. Fol
lowing the long integers are the text data, if present. If so, the 
data are preceded by the style information that was applied 
to the text before it was last saved. The style information 
takes up 8 bytes and is immediately followed by the text it
self. Following the text (or immediately after the worksheet 
cell count if the text isn't present) are the individual work
sheet entries (if any). 

The code for the ReadData method is placed inside a TRY 
block, so that if an error occurs during reading of the file, the 
data can be properly disposed. The error will also be propa
gated to the error handler defined by the !Application 
method, which will show an alert, informing the user of the 
nature of the error. 

The sequence of steps taken by the ReadData method is as 
follows: 

1. The first task is to reset the file position to its beginning 
and read in the two long integer values. The contents of 
these values will determine which additional functions of 
the method will be performed. 

2. If the text length is nonzero, the text style information will 
be read. The CEnsembleDoc class's SetFontData 
method is called to store the font style information, so 
that it can be applied when the EdiIText window is 
opened. (The file is usually read before the window is 
open. The only exception is when a Revert command is 
executed.) 

3. After the text style information has been read, the text 
that follows (whose length is specified in the first long inte
ger) is read into a handle allocated to hold the data. The 
handle is stored in the itsEditTextData instance variable. 

4. If the number of worksheet cells is nonzero, a separate 
method is called to read the cell entries. This method is 
described next. 
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ReadWSEntries 
method (beginning) 

After the entire contents of the file have been read without er
ror, the text and/or worksheet data will have been filed away 
for reference by other classes and methods. 

ReadWSEntries Method Code 

The method that reads worksheet entries is called by the 
ReadData method if worksheet data are present in the input 
file. 

The ReadWSEntries method is passed only one parameter, 
indicating the number of entries to be read. Prior to display
ing the method itself, we will discuss the format of a work
sheet entry by showing its structure and expected contents. 

The worksheet entry consists of a header record that is de
fined by a structure called WSCellEntry. The header is im
mediately followed by the ASCII text of the corresponding 
cell's contents. The contents of the WSCellEntry structure 
are as follows: 

typedef struct 
{ 

Cell WSCell; 
short WSType; 
short WSSize; 

} WSCellEntry; 

In the structure, the Cell type is the same as a Point and is 
used with all of the TCL's CTable methods, instead of the 
Macintosh Point data type. The WSCell identifies the column 
and row of the cell to which the rest of the entry applies. The 
column is stored in the WSCell.h component, and the row is 
stored in WSCell.v. The WSType field identifies numeric ver
sus string entries, and the WSSize field specifies the length of 
the entry string that follows. Rather than keep a lot of non
essential data for each worksheet cell, only the entry text that 
defines the contents of the entry is stored. The code to read 
these entries is as follows: 

void CEnsembleData::ReadWSEntries (long entryCount) 
{ 

WSCellEntry anEntry; 
short index; 
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method (concluded) 
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Str255 entryData; 
CWSEntry *aWSEntry; 

for(index = O; index< entryCount; index++) 
{ 

Read Some( (Ptr)&anEntry, sizeof(WSCellEntry)); 
ReadSome( (Ptr)&entryData[1 ], (long) anEntry.WSSize); 
entryData[O] = anEntry.WSSize; 
TRY 
{ 

II 
II create a worksheet cell entry, putting the 
II entry text that was read into the entry field 
II of the worksheet cell, then set the value field 
II to 0.0. If the entry type is a value, then the 
II value will be recalculated when the worksheet is 
II displayed. Enter the worksheet cell into the Cluster. 
II 
aWSEntry = new CWSEntry; 
aWSEntry->IWSEntry (); 
aWSEntry->SetWSCell (anEntry.WSCell); 
aWSEntry->SetWSType (anEntry.WSType); 
aWSEntry->SetWSValue (0.0); 
aWSEntry->SetWSEntry (entryData); 
if(anEntry.WSType == 1) 
{ 

aWSEntry->SetWSText(entryData); II string 

else 
{ 

aWSEntry->SetWSText("\p0.00"); II value 
} 
itsCluster->Add(aWSEntry); 

} 
CATCH 
{ 

ForgetObject (aWSEntry); 
} 
END TRY; 

After the WSCellEntry header structure has been read, the 
string defining the contents of the cell is read. (Its size is 
specified by the WSSize field.) 
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WriteData method 
code (beginning) 

When the header and entry string have been read, the 
method creates a new instance of the CWSEntry class and 
initializes its instance variables by calling the access methods 
to set its cell, type, value, entry string, and text representa
tion string. If the cell is intended to hold a string, the text rep
resentation is a copy of the entry string. If the cell holds a 
value, the text representation is set to 0.0. The CWSEntry 
class will be discussed in more detail later. 

After the CWSEntry has been built, it is added to the cluster 
that was allocated by the IEnsembleData method for storage 
of the worksheet cell data. 

The process of reading a new header and its entry string, cre
ating a new CWSEntry instance, initializing the instance 
variables,' and adding the CWSEntry instance to the cluster 
is repeated until the entry count is exhausted. If an error oc
curs during this process, the CATCH block of the code will be 
executed, disposing of the entry that may have been allo
cated. The error is propagated to the error handler created by 
the IApplication method, where an error alert is posted, noti
fying the user of the problem. 

WriteData Method Code 

The WriteData method has been substantially rewritten to 
write the EditText and worksheet data in the new file format 
(defined in the ReadData method on page 187). The code for 
the WriteData method is as follows: 

Boolean CEnsembleData::WriteData(void) 
{ 

CMainWindow *theTextWindow; 
long textlength, WSEntryCt, filelength; 
fontinfo theFontlnfo; 

II 
II modified WriteData to get the TextEdit pane's Text Handle 
II and then write out the contents of that handle. 
II 
II additional modifications to handle writing out worksheet 
II cell entries into a composite file. 
II 
theTextWindow = ((CEnsembleDoc *)itsDocument) 

->GetTextWindow(); 
itsEditTextData = theTextWindow->GetEditTextHandle(); 
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textLength = GetHandleSize(itsEditTextData); 
WSEntryCt = itsCluster->GetNumltems(); 

II 
II write out the textLength & WSEntryCt values 
II 
FailOSErr (SetFPos( refNum, fsFromStart, OL)); 
WriteSome ((Ptr)&textLength, (long) sizeof(long)); 
WriteSome ((Ptr)&WSEntryCt, (long) sizeof(long)); 

II 
II now, write out the text data, if any 
II 
if(textLength > 0) 
{ 

II 

II 
II first, write out the fontinfo structure's contents 
II 
theFontlnfo = ((CEnsembleDoc *) itsDocument) 

->the TextData->GetFontData(); 
WriteSome ((Ptr)&theFontlnfo, sizeof (fontinfo)); 

II 
II now, write the text 
II 
WriteSome (*itsEditTextData, textLength); 

II finally, write out the worksheet 
II cell entries, if any 
II 
if(WSEntryCt > 0) 
{ 

WriteWSEntries (WSEntryCt); 
} 
fileLength = GetLength(); 
FailOSErr(SetEOF( refNum, filelength)); 
FailOSErr( FlushVol( NULL, volNum)); 
return (TRUE); 

The WriteData method follows essentially the same sequence 
of operations as the ReadData method, except that it writes 
data to the file, rather than reading from the file. The steps 
are as follows: 
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1. The WriteData method sends a message to the CEnsem
bleDoc's GetTextWindow method, to get a handle to the 
CMainWindow instance. It uses this handle to call the 
MainWindow's GetEditTextHandle method, to access 
the handle to the current EditText data in that window (if 
any). WriteData then calls the toolbox routine to return 
the handle size and stores this value in a long integer 
variable called textLength. 

2. A GetNumltems message is sent to the cluster (itsClus
ter) to determine the number of entries in the worksheet 
cluster. The number is stored in a long integer variable 
called WSEntryCt. 

3. The file is positioned at its start, and the contents of the 
two long integer variables' (textLength and WSEntryCt) 
are written to the file. 

4. The code tests whether the textLength variable holds a 
value greater than 0, and if so, it accesses the CEnsem
bleDoc instance's theTextData variable and sends it the 
GetFontData message, storing the result in a local vari
able called theFontlnfo. This is the following 8-byte fon
tinfo structure: 

typedef struct 
{ 

short fontNumber; 
short fontSize; 
short fontStyle; 
short fontAlign; 

} fontinfo; 

5. After acquiring the fontinfo structure, the WriteData 
method writes it out to the file. 

6. The text itself is written to the file, immediately following 
the fontinfo structure. The length of the text is contained 
in the textLength variable. 

7. The WriteData method then checks whether any work
sheet entries are present by testing the WSEntryCt value. 
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If there are entries, it calls the WriteWSEntries method 
(to be described shortly) to write these entries to the file. 

8. Before the WriteData method finishes, it gets the length 
of the file, calls the SetEOF method to set the end-of-file 
marker at that point, and then calls flushVol to write the 
contents of the buffer out to the file. 

WrlteWSEntries Method Code 

The WriteWSEntries method writes all of the worksheet en
tries in the cluster to the file, in the proper format. This 
method is fairly simple, compared with the ReadWSEntries 
code previously described. The code for WriteWSEntries is as 
follows: 

void CEnsembleData::WriteWSEntries (long entryCount) 
{ 

WSCellEntry anEntry; 
short index; 
long WSEntryCt; 
Str255 entryData; 
CWSEntry *aWSEntry; 
for(index = 1; index<= entryCount; index++) 
{ 

itsCluster->Getltem (&aWSEntry, index); 
FailNIL (aWSEntry); 
anEntry.WSCell = aWSEntry->GetWSCell(); 
anEntry.WSType = aWSEntry->GetWSType(); 
a WS Entry->GetWSEntry( entryData); 
anEntry.WSSize = entryData[O]; 
WriteSome ((Ptr)&anEntry, sizeof(WSCellEntry)); 
WriteSome ((Ptr)&entryData[1 ], (long) entryData[O]); 

All of the needed information is contained in the cluster en
tries. The method is passed a single parameter specifying the 
number of entries, and it proceeds to get each item, in turn, 
accessing the cell, type, entry string, and entry size informa
tion from the entry by calling the appropriate access meth
ods. Once acquired, these data are written out to the file. 
Each entry consists of a WSCellEntry structure (described 
on page 190), followed by the entry string itself. As previously 
indicated, the structure and the entry string are all that is re
quired to reconstitute the contents of the worksheet cell. 
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DisposeData Method Code 

The DisposeData method has been modified to handle the 
deletion of the worksheet data from memory. The method is 
called when, for example, a Revert or Close operation is per
formed. The code is as follows: 

void CEnsembleData::DisposeData(void) 
{ 

long WSEntryCt; 
long index; 

if (itsEditTextData != NULL) 
{ 

} 

DisposHandle (itsEditTextData); 
itsEditTextData = NULL; 

if (itsCluster != NULL) 
{ 

WSEntryCt = itsCluster->GetNumltems(); 
for (index= 1; index<= WSEntryCt; index++) 
{ 

itsCluster->Deleteltem (1 ); 

The method tests whether the itsEditTextData handle is 
NULL, and if not, it disposes of the handle. It also tests 
whether the itsCluster instance is NULL, and if not, it sends 
the cluster a message to delete item 1 continually, until the 
number of items has been depleted. 

Adding a New Access Method 

Other classes in the application need to access the data 
stored in the worksheet cluster, so an access method to re
turn the handle to the cluster's instance has been added. 

GetCluster Method Code 

The code for accessing the worksheet's cluster is provided as 
a public access method of the CEnsembleData class. The 
code is as follows: 
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CCluster *CEnsembleData::GetCluster (void) 
{ 

return itsCluster; 

All that this method does is return the value of the itsCluster 
instance variable. 

Summary: Customizing CEnsembleData 

The modifications to various methods in the CEnsembleData 
module described in the preceding sections were required be
cause a new file format was adopted and we needed to en
hance the ReadData and WriteData methods greatly, 
compared with their versions described in Chapter 5. It's im
portant to note, however, that although we made a significant 
change to the file format and its contents, the modifications 
to effect this change are localized in the CEnsembleData 
class. None of the methods in the CEnsembleDoc or CMain
Window classes were affected. 

The principle of keeping changes localized is a side effect (or 
natural consequence) of object-oriented design. Changes that 
affect one area of the application (one object) need only be 
made to that area. 

In order to ensure the insulation (encapsulation) of the ele
ments in one object from others, special methods to permit 
other objects to access the private data are provided. With 
these methods, we can modify the internal behavior of a given 
class without making a single change to other classes in the 
application. This principle is upheld throughout the design of 
the Ensemble application. 

Customizing the CCalcWindow Code 

The code to implement the full functionality of a capable 
worksheet is contained in the CalcWindow.c module. This 
module contains quite a few classes. To describe the custom
izing procedures, we will break this section into a number of 
appropriate subsections, each of which will discuss an aspect 
of implementing the worksheet. 
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Customizing the Lists 

Table 8-2 
Custom code 
modifications to list 
classes 

The worksheet contains three lists that implement the col
umn labels, row labels, and main worksheet cells, respec
tively. The column and row label lists work in concert with 
the main worksheet list to provide synchronized scrolling and 
autodrag selection. Although the model we've implemented 
allows only a single cell at a time to be selected, this behavior 
could be modified to allow selecting rectangular contiguous 
cells without much difficulty. 

Table 8-2 defines the classes and methods that implement 
the list handling chores for the worksheet. Recall that when 

Class Method Description 

CList5 IViewTemp Initializes column label list 

CList5 GetCellText Returns specified column label 

CList5 DrawCell Draws a column label cell 

CListlO IViewTemp Initializes row label list 

CListlO GetCellText Returns specified row label 

CListlO DrawCell Draws a row label cell 

CList15 IViewTemp Initializes main worksheet 
table 

CList15 GetCellText Returns worksheet cell text 
entry 

CList15 GetContents Extracts entry string, text 
string, value, and type from a 
cell 

CList15 Scroll Scrolls the worksheet 

CList15 SetLists Provides access methods to 
SetCluster store instances needed by the 
SetArray methods in the class. 

CList15 ProviderChanged Handles selections in the main 
worksheet table 

the Bord resources were modified, in Chapter 6, we disabled 
mouse clicks (set the Wants Clicks parameter to FALSE) for 
both the Bord 134 and Bord 136 borders (see Figure 6-39 on 
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worksheet 
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page 157 and Figure 6-40 on page 158). We did this pur
posely, because we didn't want the column and row label list 
cells to become highlighted when the mouse was clicked in
side the border. Setting the Wants Clicks field to FALSE for a 
border disables clicks for anything inside that border. 

Each of the lists has the IViewTemp and GetCellText meth
ods. The column and row label lists also have a new Draw
Cell method, which overrides that method in the TCL's 
CTable class. The main worksheet has several additional 
methods, including an override of the CTable Scroll method, 
several new access methods, and a ProviderChanged 
method to intercept the BroadcastChange messages sent by 
the CTable class in response to selection changes in the 
worksheet. 

The subsections that follow describe the individual methods 
for each of the lists and display the modified code that imple
ments the intended behavior for the method. Each of the lists 
is set up according to some definitions that we have added to 
the code, to make it fairly easy to change for different num
bers of rows or columns. The following #define statements 
establish the current settings for these parameters: 

II 
II added definitions 
II 
#define tblCellWidth 48 II worksheet cell width 
#define tblCellHeight 14 II worksheet cell height 
#define horLabWidth 48 II column label width 
#define horLabHeight 20 II column label height 
#define vertLabWidth 32 II row label width 
#define vertLabHeight 14 II row label height 
#define vertLabMargin 5 II row label margin 

#define numRows 50 II number of rows 
#define numCols 26 II number of columns 

The comments are self-explanatory. 

CList5 IViewTemp Method Code 

The CList5 class implements the column label list, which will 
be scrolled in sync with the horizontal scroll bar of the main 
worksheet. The code is as follows: 
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void CList5::1ViewTemp(CView *anEnclosure, 

CBureaucrat *aSupervisor, 

Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

II any additional initialization for your subclass 

DeleteCol(1, O); 

SetDefaults(horLabWidth, horLabHeight); 

SetColBorders(1, patCopy, black); 

AddRow(1, O); 

AddCol(numCols,O); 

When AppMaker generates the resources for the list ele
ments, it makes the assumption that you will be creating a 
single-column list with multiple rows and that you will be us
ing the default settings for the row or column height and 
width. 

The IViewTemp code for List5 (column labels) deletes the 
first column (columns and rows in lists are numbered begin
ning with 0), and then applies the new default settings for the 
column labels (horLabWidth and horLabHeight). It also sets 
column borders to I-point black lines, with a transfer mode 
of patCopy, which will overwrite anything else in that posi
tion. 

Finally, the IViewTemp method addsone row, beginning with 
row 0, and then adds the number of columns specified by the 
num.Cols definition. This sets up a horizontal table that con
sists of 1 row and 26 columns (using the specified definitions). 

The columns are 20 pixels tall and 48 pixels wide. In this ver
sion of the Ensemble application, the columns and rows have 
fixed sizes. In the next chapter, we will be adding the user in
terface features to permit the worksheet format to be modified. 

CList5 GetCellText Method Code 

The GetCellText method generated by AppMaker for the 
CList5 class has been rewritten as follows: 
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void CList5::GetCellText (Cell aCell, 
short availableWidth, 
StringPtr itsText) 

short col; 

col= aCell.h; 
CopyPString("\pA", itsText); 
itsText[1] +=col; 

This code makes provision for a maximum of 26 columns. It 
changes column numbers in the range 0-25 to A-Z and 
stores the string representation in the itsText variable. The 
method could easily be modified to handle a larger number of 
columns. 

CList5 DrawCell Method Code 

This method overrides and takes the place of the correspond
ing method in the CTable class. The code is as follows: 

void CList5::DrawCell (Cell theCell, Rect *cellRect) 
{ 

Str255 cellText; 
short availWidth, textWidth; 

availWidth = cellRect->right - cellRect->left; 
GetCellText(theCell, availWidth, cellText); 
textWidth = StringWidth(cellText); 
indent.h = (availWidth - textWidth) » 1; 

if (cellText[O] > 0) 
{ 

Move To( cellRect->left + indent.h, cellRect->top + indent.v); 
Drawstring( cellText); 

The code calculates the available width of the column (avail
Width), using its full width. It calls the GetCellText method, 
calculates the number of pixels occupied by the column label, 
and then calculates a horizontal indent.h value that will cen
ter the label in the column. If the label width is greater than 
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GetCellText 
method code 
(beginning) 

0, the column label string is drawn at the appropriate posi
tion within the cell. 

CListlO IViewTemp Method Code 

The CListlO class implements the row label table for the 
worksheet. The IViewTemp code for this class initializes the 
row label list to accommodate a single column and multiple 
rows, specified by the definitions listed earlier. The code for 
the IViewTemp method is as follows: 

void Clist1 O::IViewTemp (CView *an Enclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

II any additional initialization for your subclass 
DeleteCol(1, O); 
SetDefaults(vertlabWidth, vertlabHeight); 
SetRowBorders(1, patCopy, black); 
AddCol (1, O); 
AddRow (numRows, O); 

As was indicated for the column label list, AppMaker's im
plied single-column, multiple-row table, with default settings, 
is modified by deleting the first (only) column and then set
ting the default values for the label width and height (vertLa
bWidth and vertLabHeight) to 32 and 14 pixels, respectively. 
The row borders are set to I-point black lines, using the pat
Copy mode to overwrite anything in the border's position. 
The single column is added, followed by the number of rows 
specified by the numRows definition, whose value here is 50. 

CListlO GetCellText Method Code 

The GetCellText method for the ListlO table has been re
written to convert the row number to a string value between 1 
and 50. The code is as follows: 

void Clist1 O::GetCellText (Cell aCell, 
short availableWidth, 
StringPtr itsText) 
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method.code 
(concluded) 

short row; 

row = aCell.v+ 1; 
NumToString(row, itsText); 
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In this code, the row is increased by 1, so that we won't have 
a row 0, and then the toolbox NumToString utility is used to 
convert the number to a string in the itsText parameter. 

CListlO DrawCell Method Code 

This method overrides and replaces the corresponding 
method in the CTable class. The code is as follows: 

void Clist1 O::DrawCell (Cell theCell, Rect *cellRect) 
{ 

Str255 cellText; 
short availWidth 
short textWidth; 

availWidth = cellRect->right - cellRect->left; 
GetCellText(theCell, availWidth, cellText); 
textWidth = StringWidth(cellText); 
indent.h = availWidth - textWidth - vertlabMargin; 
if (cellText[O] > 0) 
{ 

MoveTo( cellRect->left + indent.h, cellRect->top + indent.v); 
Drawstring( cellText); 

For the row labels, we want to right-justify the row number, 
so this method calculates the available width, calls the Get
CellText method and calculates its text width, and then in
dents the text so that it is right-justified in the row, with the 
exception of a small (5-pixel) right margin (vertLabMargin). If 
the label string has a length greater than 0, the row label 
string is drawn at the calculated position. 

CList15 IViewTemp Method Code 

The CList15 class implements the body of the worksheet, 
which has 26 columns and 50 rows, by using the definitions 
described earlier. The code for the IViewTemp method initial
izes the table so that it has the proper number of cells, with 
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GetCellText 
method.code 
(beginning) 

widths and heights that correspond to the settings for the 
column and row label tables. The code for this method is as 
follows: 

void Clist15::1ViewTemp (CView *an Enclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

II any additional initialization for your subclass 
DeleteCol(1, O); 
SetDefaults(tblCellWidth, tblCellHeight); 
SetColBorders(1, patCopy, ltGray); 
SetRowBorders(1, patCopy, ltGray); 
AddRow(numRows, O); 
AddCol(numCols, O); 

The IViewTemp method for the CListl5 class follows essen
tially the same pattern as the corresponding methods in the 
CList5 and CListlO classes. The initial single column is de
leted, and the default settings are changed to the column la
bel width and the row label height, so that the cells will 
match the dimensions of the corresponding column and row 
label tables. 

In this case, we are setting I-point column and row borders, 
in light gray (ltGray) rather than black, with the patCopy 
transfer mode. Finally, the number of rows and columns 
specified by the numRows and numCols variables is allo
cated for the table. Note that although the full number of 
rows and columns is allocated, no extra storage is set aside 
for the contents of these cells. In essence, they are assumed 
empty until they are explicitly filled with values. 

CList15 GetCellText Method Code 

The code for the GetCellText method of the CList15 class is 
as follows: 

void Clist15::GetCellText (Cell aCell, short availableWidth, 
StringPtr itsText) 

double itsValue, newValue; 



GetCellText 
method code 
(concluded) 

Customizing the CCalcWindow Code 205 

short itsType, index; 
long aParam; 
Str255 itsEntry, itsCellText; 
decform aFormat; 
extended temp; 
CWSEntry *anObj; 

if((CWSEntry *)itsCluster == NULL) 
{ 

CopyPString("\p", its Text); 
return; 

} 
aParam = *(long*) &aCell; 
anObj = (CWSEntry *)itsCluster->Findltem1 (FindWSCell, aParam); 
if(anObj) 
{ 

} 

if((itsType = anObj->GetWSType()) == 2) 
{ 

index= 1; 
anObj->GetWSEntry(itsEntry); 
newValue = ((CCalcWindow *)itsSupervisor)->GetExpression 

(itsEntry, &index, O); 
itsValue = anObj->GetWSValue(); 
if (newValue != itsValue) 
{ 

aFormat.style = FIXEDDECIMAL; 
aFormat.digits = 2; 
x96tox80(&newValue, &temp}; 
num2str(&aFormat, temp, itsCellText); 
anObj->SetWSText(itsCellText); 
anObj->SetWSValue(newValue); 

} 
anObj->GetWSText(itsCellText); 
CopyPString(itsCellText, itsText); 

else 
CopyPString("\p", itsText); 

Following is an explanation of the operation of the GetCell
Text code: 

1. If the instance variable itsCluster is NULL, then an empty 
string is written into the itsText parameter and the 
method returns. This case can (and will) occur when the 
table is first initialized, because the IViewTemp method 
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FindWSCell global 
function code 

for the table will execute before the ICalcWindow method 
has an opportunity to store the handle to the cluster. 

2. The aCell parameter is cast into a long variable (aParam) 
so that the TCL's Findlteml method can be used (it 
requires a pointer to a single long variable) to search for a 
cell in the cluster whose cell number matches the one 
being sought. We have supplied a search function called 
FindWSCell, whose definition is as follows: 

Boolean FindWSCell (CObject *anEntry, long param) 
{ 

Cell eCell, pCell; 

pCell =*(Cell*) &param; 
eCell = ((CWSEntry *) anEntry)->GetWSCell(); 

if((pCell.h == eCell.h) && (pCell.v == eCell.v)) 
{ 

return TRUE; 
} 
else 
{ 

return FALSE; 

The FindWSCell function recasts the incoming param 
argument to a Cell type, placing it into the variable pCell 
(parameter cell). It then accesses the cell addressed by 
the anEntry argument, storing this cell into the variable 
eCell (entiy cell). Next, it compares the column and row 
components of the two cells, and if they match exactly, 
the function returns a result of TRUE; otherwise, it returns 
a result of FALSE. The Findlteml method continues exe
cuting, calling the FindWSCell function for each entiy in 
the cluster until a result of TRUE is returned, in which 
case it returns a handle to the matched entiy. If no cells 
match, the Findlteml method returns a NULL handle. 

3. The GetCellText method stores the object handle 
returned by the Findlteml method in a variable called 
anObj. If the handle is NULL, an empty Pascal string is 
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copied into the itsText parameter, and the GetCellText 
method returns. 

4. If the specified cell exists in the cluster, the GetCellText 
method calls the access method to get the type of entry, 
storing this in the itsType variable. There are two types 
of entries: type 1, a string, and type 2, a formula (value). 
If the type is not equal to 2, then it is a string, and the 
method accesses the text representation of the cell's con
tents, copies it to the itsText parameter, and returns. 

5. If the type of the entry is equal to 2, then the entry con
tains a formula (which may be a simple numeric value) 
that must be parsed to obtain its current value. The pars
ing operation is handled by a new method called GetEx
pression, which will be described later. This method 
takes the entry handle, a starting index that points to the 
first position of the formula string (the GetExpression 
method may be called recursively), and a nesting depth 
value, which is initially set to 0. When the method 
returns, the double-precision floating-point result is 
stored in a variable called newValue. 

6. If the existing value differs from the newValue (deter
mined by using the access method to obtain the existing 
value and then comparing the two), the cell's text must be 
updated. A format of FIXEDDECIMAL, with two digits of pre
cision after the decimal, is established, the 96-bit float
ing-point value is converted to a compatible 80-bit 
Standard Apple® Numerics Environment (SANE) extended 
value, and then the SANE num2str function is called to 
convert the value to a string. The string is stored back 
into the entry by calling the SetWSText access method, 
and the value is stored into the entry by calling the Set
WSValue access method. Finally, the code to copy the 
string (itsCellText) into the itsText parameter is exe
cuted and the method returns. 

The last step makes use of the SANE functions to convert the 
value returned by the GetExpression method to a string. The 
first step is to convert the double-precision 96-bit floating
point value to an 80-bit SANE extended type and then perform 
the conversion to a string. The ANSI sprintf function could 
have been used instead; however, this would require that the 
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Geteontents 
method.code 
(beginning) 

large ANSI library be a permanent part of the project, instead 
of the relatively small SANE routines. 

Another important point that was mentioned in passing, but 
bears some amplification, is the handling of non existent 
cells. When the GetCellText method is called by the CTable 
class's DrawCell method, it expects an existing cell, whose 
contents are to be drawn. By not storing dummy empty cells 
in the cluster for non existent cells, we have greatly reduced 
the memory requirements for the worksheet. In fact, if you 
define values for the top left and bottom right cells in the 
worksheet, only two entries will be stored in the cluster. 

CList15 GetContents Method Code 

The GetContents method is called by other methods to ac
cess the current values of a cell's instance variables. The 
method determines whether the cluster exists.If it does, the 
method uses the CCluster Findlteml method to attempt to 
locate the cell in the cluster. If the cluster doesn't exist or the 
cell can't be found, then the method stores empty strings for 
the entry and text representation and a value of 0.0. 

If the cell exists, then its entry and text strings and the cur
rent value are returned. The code for the GetContents 
method is as follows: 

void Clist15::GetContents (Cell aCell, StringPtr entry, double *its Value, 
short *itsType, StringPtr cellText) 

long aParam; 
CWSEntry *anEntry; 
aParam =*(long*) &aCell; 
if((CWSEntry *) itsCluster) 
{ 

if((anEntry = (CWSEntry *)itsCluster->Findltem1 (FindWSCell, 
aParam)) == NULL) 

} 

CopyPString ("\p", entry); 
CopyPString (''\p", cellText); 
*itsValue = 0.0; 
*itsType = -1; 

else 
{ 

anEntry->GetWSEntry (entry); 
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method code 
(concluded) 
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anEntry->GetWSText (cellText); 
*itsValue = anEntry->GetWSValue(); 
*its Type= anEntry->GetWSType(); 

else 
{ 

CopyPString (''\p", entry); 
CopyPString (''\p", cellText); 
*itsValue = 0.0; 
*itsType = -1; 

If the cell exists, the GetContents method merely accesses 
the current settings for the cell's instance variables. No at
tempt is made to parse the entry string to recompute the 
value, even if the cell type is 2 (a formula). 

CList15 SetLists Method Code 

The SetLists method is called by the ICalcWindow initializa
tion method to pass the handles of the column label and row 
label lists to the main worksheet list. The function SetLists is 
commonly called an access method, because it provides the 
means to access something that isn't normally accessible. In 
this case, access to the label lists is provided to the main 
worksheet list. The code for SetLists is as follows: 

void CList15::Setlists (CTable *hlabellist, CTable *vlabellist) 
{ 

itsHList = hlabellist; 
itsVList = vlabellist; 

As is apparent, the code merely stores the incoming parame
ters into instance variables that we've added to the CList15 
class declaration. 

CListl5 SetCluster Method Code 

The SetCluster code is also an access method used by the 
ICalcWindow code to pass a handle-for the cluster holding 
the cell entries-to the main worksheet list class. The code for 
the SetCluster method is as follows: 
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void CList15::SetCluster (CCluster *aCluster) 
{ 

itsCluster = aCluster; 

Once again, the code merely stores the incoming cluster han
dle into an instance variable for the CList15 class. This pro
vides access to the cluster from within the class. 

CListl5 SetArray Method Code 

The cluster to hold the cell entries for the main worksheet 
was allocated in the CEnsembleData class (see page 186), 
but it must be installed into the collaboration mechanism as 
the provider for the CList15 class. This is done so that 
changes to the elements of the array will cause a Broad
castChange message to be sent to the CCollaborator, which 
calls the ProviderChanged method of the CList15 class. 

In the case of the CAMArrayPane that makes up the main 
worksheet's table, the collaboration connection must be es
tablished explicitly. Once the CList15 instance is established 
as an explicit dependent of the cluster, any changes to the 
cluster will immediately be reflected by the receipt of a Pro
viderChanged message. 

The code for the method to install the cluster as the work
sheet's provider is as follows: 

void Clist15::SetArray ( CArray *anArray, Boolean fOwnership) 
{ 

itsArray = anArray; 
ownsArray = fOwnership; 
DependUpon( itsArray); 

This method is provided to override the SetArray method in 
the CArrayPane class. That method requires that the array 
contain entries for the scope of the companion table. Because 
we are handling nonexistent entries and want the entire table 
to be allocated, we must override the superclass method. The 
instance variable called ownsArray establishes ownership of 
the array by the table. We don't want this connection, so a 
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value of FALSE is passed to SetArray when it is called. The 
DependUpon method establishes the fact that the CListl5 
class depends upon itsArray. 

CListl5 ProviderChanged Method Code 

The ProviderChanged method is called in response to 
changes to the cluster holding the cell entries for the main 
worksheet. It overrides the functionality of the default 
method for two of the potential BroadcastChange messages 
sent by the array. 

Specifically, we don't want to observe the default behavior 
when elements are inserted or deleted from the array. In those 
cases, the standard behavior is to expand or shrink the table. 
Because we would like the appearance of the table to remain 
constant, these messages are ignored by our override method. 
The code for the ProviderChanged method is as follows: 

void Clist15::ProviderChanged (CCollaborator *aProvider, 
long reason, void *info) 

if (aProvider == itsArray) 
{ 

} 

switch( reason) 
{ 

case arraylnsertElement: 
II 
II handle this case as an NOP (no operation) 
II 
break; 

case arrayDeleteElement: 
II 
II handle this case as an NOP (no operation) 
II 
break; 

default: 
inherited::ProviderChanged( aProvider, reason, info); 
break; 

else 
inherited::ProviderChanged( aProvider, reason, info); 
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Note that we specifically handle the arraylnsertElement and 
arrayDeleteElement messages as do-nothing cases. For 
messages other than these, the inherited method is called. 

CList15 Scroll Method Code 

The scroll bars for the worksheet are associated with CScroll
Pane, which only covers the area of the main worksheet. 
However, when the scroll bars are used, we want the column 
and/or row label lists to scroll in synchrony with the main 
worksheet. In order to synchronize the scrolling operation, we 
have created an override for the CTable class's Scroll 
method. The following code shows a very simple method for 
synchronizing the operation of multiple lists with a single set 
of scroll bars: 

void Clist15::Scroll (long hDelta, long vDelta, Boolean redraw) 

{ 
inherited::Scroll (hDelta, vDelta, redraw); 

if(hDelta) 

{ 
itsHList->Scroll(hDelta, 0, TRUE); 

if(vDelta) 

{ 
itsVList->Scroll(O, vDelta, TRUE); 

The Scroll method requires us to include the SetLists access 
method (page 209) in the CList15 class. The inherited 
method is called to scroll the main worksheet, and, depend
ing on whether the hDelta or vDelta value is nonzero, the 
corresponding column or row (itsHList or itsVList) handle is 
used to call the Scroll method for that class. 

Customizing the CCalcWindow Code 

The bulk of the code that supports the functionality of the 
worksheet is contained in the CCalcWindow class. This class 
contains the methods that initialize the worksheet elements, 
handle the selection of cells, and process the strings and for
mula entries that constitute a cell entry's contents. 
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Defining a Cell's Contents 

In order to provide reasonable functionality, it was decided 
that cells could contain any of the following elements, in an 
appropriate order: 

•:• If the cell entry text begins with a single quote, the entry is 
assumed to be a string and the characters that follow the 
single quote are stored, as is, into the cell. 

•:• If the cell entry begins with anything other than a single 
quote, then it is assumed to be a formula. Formulas can 
contain the following elements: 

• Balanced left and right parenthesis ( ), for grouping 
terms. 

• Simple numeric constants, specified either with or with
out an embedded decimal point. All constants are con
verted to floating-point values and no scientific notation 
is allowed. Values such as 10 or 43.95 are examples of 
the acceptable notation. 

• References to other cells (e.g., Bl3, ZS, or Al). 

• Standard arithmetic operators for addition, subtraction, 
multiplication, and division, entered as +, -, *, and /, 
respectively. 

Worksheet cell formulas are evaluated in a strict left-to-right 
sequence, without regard to any implied precedence of the 
operators. When the order of evaluation is important, paren
theses can be used to enclose the terms to be evaluated be
fore a succeeding operator is applied. Examples of legal cell 
entries are shown in Table 8-3. 

Cell Cell Entry Displayed Contents 

Al This is a very long string This is a very long string 

BIO IO I0.00 

C4 BIO+ 15 25.00 

D3 (C4 + 5) I 3 •BIO 100.00 
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Table 8-4 
CCalcWlndow 
customized and new 
methods 

Class Method 

CCalcWindow ICalcWindow 

CCalcWindow UpdateMenus 

CCalcWindow ProviderChanged 

CCalcWindow DoEnterButton 

CCalcWindow DoCancelButton 

CCalcWindow ParseEntry 

CCalcWindow GetExpression 

CCalcWindow GetToken 

CCalcWindow isConst 

CCalcWindow isCell 

CCalcWindow MakeStringObj 

CCalcWindow MakeValueObj 

CCalcWindow Activate 

Description 

Initializes the window and its 
interface elements 

Disables Close command in 
File menu 

Handles selection of a cell 

Makes a cell entry 

Reverts to original cell contents 

Parses the Entry field and cre
ates a cell object of the correct 
type 

Evaluates a formula entry 

Returns the next token while 
evaluating an entry 

Determines whether a token is a 
constant 

Determines whether a token is a 
reference to another cell 

Creates a string-type cell entry 

Creates a value-type cell entry 

Refreshes the table on an acti
vate event 

Strings that exceed the width of a cell will overlap the adja
cent cells to their right. This allows you to create headings 
that span a number of cells. The entry is anchored in the be
ginning cell. You can justify string entries by inserting an ap
propriate number of spaces in between the single-quote mark 
and the first character of the string. Looking at the formulas 
in the table should give you an idea of how to construct even 
more complex forms. Parentheses can be nested to any 
depth, as desired. 

The Customized Methods 

In order to implement the functions of a worksheet in the 
CCalcWindow class, several new methods have been added 
to those generated by AppMaker. The full list of methods in 
the CCalcWindow class is shown in Table 8-4. 
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The methods shown in boldface type in the table are newly 
created. The names in plain type were generated by App
Maker, but have been customized for our purposes. 

ICalcWindow Method Code 

The ICalcWindow method is called by the BuildWindows 
method in the zEnsembleDoc module when the window is 
created. The code for the ICalcWindow method is as follows: 

void CCalcWindow::ICalcWindow (CDirector *aSupervisor, 
CEnsembleData *theData) 

Str255 theFilename; 

itsData = theData; 
inherited::IZCalcWindow (aSupervisor); 
gDecorator->StaggerWindow (its Window); 
if(((CEnsembleDoc *) aSupervisor)->itsFile != NULL) 
{ 

} 

((CEnsembleDoc *) aSupervisor)->itsFile 
->GetName(theFilename); 

itsWindow->SetTitle(theFilename); 

EntryField->SetTextString("\p"); 
TEAutoView (TRUE, EntryField->macTE); 
((Clist15 *)List15)->Setlists (List5, List1 O); 
wsCluster = theData->GetCluster(); 
( (Clist15 *) List15)->SetCluster (wsCluster); 
((Clist15 *)List15)->SetArray(wsCluster, FALSE); 
((Clist15 *)List15)->Refresh(); 

In the preceding code, the first three executable statements 
were generated by AppMaker. We have added the remaining 
code. The first statement saves the handle to the CEnsemble
Data instance in an instance variable called itsData. Next, 
the inherited IZCalcWindow method is called to create and 
initialize all the interface elements in the window. It is at this 
time that all the IViewTemp methods for the borders, lists, 
buttons, scroll pane, and user panes are called. After the IZ
CalcWindow method returns, the window and all its ele
ments have been created and initialized. The gDecorator is 
sent a message to stagger the window, with respect to the 
other windows on the screen. 
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Following the AppMaker-generated code, there are a few things 
that need to be done before the worksheet is ready for use: 

1. If a file is associated with the document, the code 
accesses its title and also writes it into the title bar of the 
Cale Window. 

2. The contents of the Entry field are set to an empty string, 
and the toolbox TEAutoView function is called with a 
handle to the TextEdit record for the Entry field, so that 
the field will scroll when a long entry is typed into the 
field. 

3. The series of access methods is called. The SetLists, Get
Cluster, SetCluster, and SetArray methods were 
described previously. The Get method accesses an exist
ing handle, and the corresponding Set method passes the 
handle to another class, when it can be stored in an 
instance variable, for easy access. 

4. The Refresh method forces the worksheet to be redrawn. 
The GetCellTe:rt method for the main worksheet 
(CList15) is called, whereupon it reevaluates the contents 
of each cell and redraws it on the screen. 

UpdateMenus Method Code 

The UpdateMenus method has been modified as follows: 

void CCalcWindow: :UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

II 
II disable Close if CalcWindow is 
II the frontmost window 
II 
gBartender->DisableCmd (cmdClose); 

A single statement has been added to the code generated by 
AppMaker. When the CalcWindow is frontmost on the 
screen, we want to disable the Close command in the File 
menu, so that the worksheet alone cannot be closed. 
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ProviderChanged Method Code 

The ProviderChanged method for the CCalcWindow class is 
called when a mouse click occurs inside the main worksheet. 
The CTable class sends a BroadcastChange message that is 
intercepted by the CBureaucrat class and sent to the table's 
supervisor as a ProviderChanged message, which in this 
case is the CCalcWindow class. Our worksheet design inter
prets a mouse click in a cell as a selection of that cell and as 
a prelude to changing or making a new entry into the cell. 
The code in the modified ProviderChanged method elimi
nates quite a bit of the superfluous code generated by App
Maker pertaining to the column and row lists (CList5 and 
ClistlO), as these lists are not operated on directly by the 
user. The modified code for the ProviderChanged method is 
as follows: 

void CCalcWindow::ProviderChanged (CCollaborator *aProvider, 
long reason, 

Str32 itsCellTitle; 
Str255 entry, cellText; 
long length; 
Cell aCell; 
short row, col, type; 
double value; 

if (aProvider == List15) 
{ 

if (List15->HasSelection ()) 
{ 

SetPt (&aCell, 0, O); 

void* info) 

List15->GetSelect (TRUE, &aCell); 
row= aCell.v; 
col = aCell.h; 
CopyPString("\pA", itsCellTitle); 
itsCellTitle[1] +=col; 
NumToString (row+ 1, entry); 
ConcatPStrings (itsCellTitle, entry); 
ConcatPStrings (itsCellTitle, "\p:"); 
CellNumlabel->SetTextString (itsCellTitle); 
((Clist15 *)List15)->GetContents (aCell, entry, &value, 

&type, cellText); 
if(type == 1) 
{ 

CopyPString("\p"', entry); 
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ProviderChanged 
method code 
(concluded) 

ConcatPStrings(entry, cellText); 

EntryField->SetTextString (entry); 

EntryField->BecomeGopher(TRU E); 

EntryField->SelectAll(TRU E); 

This code deals only with messages that relate to the CList15 
instance. All others are ignored. If a cell is selected in the list, 
then the method proceeds; otherwise, it ignores the message. 
Following are the steps taken to handle a selection: 

1. The selected cell is accessed via the GetSelect method, 
which returns the first (and only) selected cell. The com
ponents of the cell are saved as row and col variables. 

2. The next series of statements formats the col and row 
values to take on the appearance of a cell number (e.g., 
Bl3, corresponding to col=l and row=l2). The cell num
ber is written to the static text field (CellNumLabel). 

3. The next series of statements checks whether the selected 
cell holds a string (type= 1), and if so, the Entry field is 
written with a single quote appended to the front of the 
entry text; otherwise, for a formula, the entry text is cop
ied to the Entry field using the SetTextString method. 

4. Sending the BecomeGopher message to the EntryField 
allows the field to accept all subsequent events (such as 
keystrokes and mouse clicks). The SelectAll message 
causes the entire contents of the EntryField to become 
highlighted. Pressing the delete key will delete all of the 
text in the entry. Entering any other text when the entry 
is highlighted will replace the contents of the EntryField. 

Once the contents of the EntryField are changed, they can 
be stored by clicking on the Enter button. If you change your 
mind about making changes to the entry, you can click the 
Cancel button to restore the original contents of the cell to 
the EntryField. 
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DoEnterButton Method Code 

The DoEnterButton method is called by the DoCommand 
method generated by AppMaker. The latter method does not 
require any changes. The DoEnterButton method was gener
ated as an empty method by AppMaker, and we have added 
the necessary code to make it fully functional: 

void CCalcWindow::DoEnterButton (void) 
{ 

long length, param; 
Cell aCell; 
Str255 theText; 
Handle theTextHandle; 
CWSEntry *anEntry, *anObj; 

length= EntryField->GetLength(); 
if(length > 0) 
{ 

SetPt(&aCell, 0, O); 
if(List15->GetSelect(TRUE, &a Cell)) 
{ 

theTextHandle = EntryField->GetTextHandle(); 
BlockMove((*theTextHandle), &theText[1 ], length); 
theText[O] = length; 
if(anObj = ParseEntry (aCell, theText)) 
{ 

} 

param =*(long *)&aCell; 
if((anEntry = (CWSEntry *)wsCluster->Findltem1 

(FindWSCell, param)) != NULL) 

wsCluster->Remove(anEntry); 
} 
wsCluster->Add(anObj); 
List15->Refresh(); 
((CEnsembleData *) itsData)->SetDirty (TRUE); 

else 
SysBeep(30); 

The main function of the DoEnterButton code is to validate 
the entry and then store it in its corresponding cell as a valid 
string or formula entry. The code behaves as follows: 
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1. The DoEnterButton method first checks the length of the 
EntryField text string. If it is 0, then the method termi
nates. If the length of the field is greater than 0, the 
method continues executing. 

2. The cell number of the current selection is obtained by 
calling the GetSelect method for List15 (the main work
sheet table). If the selection is not NULL, the method con
tinues executing. 

3. The handle to the entxy text is accessed by calling the 
GetTextHandle method for the EntryField. The text 
string is moved to a local string variable using the toolbox 
BlockMove function, and its length byte is set. 

4. The DoEnterButton method then calls ParseEntry with 
the cell number and the entxy text. If ParseEntry returns 
a NULL object, then an error was found in the entxy and 
the SysBeep toolbox function is called. If the object is not 
NULL, then the method searches the cluster for an existing 
object with the identical cell number (row and column) 
and deletes that entxy if it is found. 

5. Whether or not an entxy existed in the cluster, the new 
object is added to the cluster, and the dirty flag is set for 
the file. This last action ensures that if the user attempts 
to quit the application or close the file without saving its 
contents, an alert will be displayed, offering the opportu
nity to save the file at that time. 

DoCancelButton Method Code 

The purpose of the Cancel button is to provide the means to 
restore the original cell contents into the EntryField if that 
field has been modified or changed and the user decides to 
make a different modification to the entxy. Recall that an en
txy is displayed when the worksheet cell is clicked. The entxy 
text is highlighted as it is stored in the EntryField. If the user 
strikes a single key at this point, the entxy text will be erased 
and replaced with the character corresponding to that key. 
The Cancel button provides the means to restore the entxy's 
original contents into the field. In truth, clicking on the same 
cell will accomplish the identical effect; however, the Cancel 
button is much closer to the user's focus at the time the entxy 
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is being made. The code for the DoCancemutton method is 
as follows: 

void CCalcWindow::DoCancelButton (void) 
{ 

Cell aCell; 
Str255 entry, cellText; 
long length; 
short type; 
double value; 

if (List15->HasSelection ()) 
{ 

SetPt (&aCell, 0, O); 
List15->GetSelect (TRUE, &aCell); 
((Clist15 *)List15)->GetContents (aCell, entry, &value, 

&type, cellText); 
if(type == 1) 
{ 

CopyPString("\p"', entry); 
ConcatPStrings( entry, cellText); 

} 
EntryField->SetTextString (entry); 

Basically, the DoCancelButton method determines whether 
there is a current selected cell and returns to the calling 
method if not. If so, it gets the cell number of the selection 
and calls GetContents to get the current values of all the 
cell's instance variables. If the cell type is a string, a single
quote character is appended to the front of the entry string; 
otherwise, the entry string is written to the EntryField with 
the SetTextString method. 

ParseEntry Method Code 

The ParseEntry method is completely new. Its purpose is to 
determine the type of entry that has been keyed in, verify its 
validity, and return an object representing the newly created 
CWSEntry object. In the course of determining the entry's 
type, if it is a formula, the ParseEntry method also calls the 
GetExpression method to evaluate the formula. If an error is 
discovered (either the object is not a string or formula, or if it 
is a formula, it is improperly formed), a NULL object is re
turned. The code for ParseEntry is as follows: 
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ParseEntry method 
code (beginning) 

CWSEntry * CCalcWindow::ParseEntry (Cell aCell, StringPtr anEntry) 
{ 

Str255 aString; 
double value; 
short token, index = 1; 
CWSEntry *anObj; 

token = GetToken (anEntry, &index, &value, aString); 
if (token == 1) 
{ 

} 

II 
II token is a string 
II 
TRY 
{ 

anObj = MakeStringObj (aCell, aString); 
} 
CATCH 
{ 

ForgetObject (anObj); 
} 
ENDTRY; 
return anObj; 

if (token== 211 token== 3) 
{ 

II 
II token is a value, so we need to 
II back up and evaluate the possible 
II expression 
II 
index= 1; 
value= GetExpression (anEntry, &index, O); 
if(index > 0) 
{ 

} 

TRY 
{ 

anObj = MakeValueObj (aCell, value, anEntry); 
} 
CATCH 
{ 

ForgetObject (anObj); 
} 
END TRY; 
return anObj; 

return NULL; 
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else 
{ 

return NULL; 

The ParseEntry method uses the exception-handling mecha
nism to guard against a situation in which there is not 
enough memory to allocate another object. If the CATCH sec
tion of the TRY-CATCH block is entered, it will ensure that the 
object is disposed of. The error is also propagated to the ap
plication, where the user is informed of it. 

ParseEntry begins by calling a method called GetToken, 
which returns the type of the token that occurs next in the 
input string. GetToken is called with a pointer to the entry 
string, a pointer to an index value (initialized to 1), which it 
increments as it evaluates the string, and pointers to a value 
field and a string field. It returns a numeric integer that iden
tifies the type of the token that is found. The following token 
types are defined: 

1 Identifies a single-quote token 

2 Identifies a value token 

3 Identifies a left-parenthesis token 

4 Identifies a right-parenthesis token 

10 Identifies a + operator token 

11 Identifies a - operator token 

12 Identifies a * operator token 

13 Identifies a / operator token 

An unidentified token is returned as type 99. The GetToken 
method is unaware of the context in which these symbols are 
found; it merely registers the fact that they have the charac
teristics of a valid token. This method is what is commonly 
referred to as a lexical analyzer in discussions of compiler 
and interpreter applications. 

If the GetToken method returns a token of 1, then the entry 
is assumed to be a string (because its first character is a sin-
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Figure 8-1 
state transitions of 
GetExpression 
parser 

gle quote). In this case, the ParseEntry method creates a 
string object by calling the MakeStringObj method and re
turns its handle. 

If the GetToken method returns a token of 2 (a value) or 3 (a 
left parenthesis), then the entry is assumed to be a formula, 
and the GetExpression method is called to evaluate the for
mula. If the evaluation is successful (i.e., the value of the in
dex variable is nonzero upon return), then the ParseEntry 
method creates a value object by calling the MakeValueObj 
method and returns its handle. 

If none of the foregoing are found, or if a failure occurs, a 
NULL object will be returned. 

GetExpression Method Code 

The GetExpression method is a miniature expression parser 
that uses a state transition scheme to evaluate the result of 
an expression. The diagram in Figure 8-1 shows approxi
mately how the parser responds to tokens and how the entry 
formula is parsed. The parser begins with the index to the en-

initial conditions 
state= 0 
level= 0 

return result 

token== 4 
right paren I token == other 

level< 1 
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try string positioned at the first byte in the string. The level 
argument is set to zero on first entry. The following steps de
scribe how the parser works: 

1. The value and result values are set to 0.0 on each entry, 
and the state variable is set to 0. The parser calls Get
Token to get the next token. It then operates with this 
token according to the current state. If the state is 0, then 
the parser expects either a numeric value or a left-paren
thesis token. If neither of these is returned, the index is 
set to 0, indicating that an error has occurred, and the 
parser returns to the ParseEntry method. If the token is 
a value, the result variable is set to the value and the 
state is advanced to 1. If the token is a left parenthesis, 
the GetExpression method is called recursively, using 
the current index value, and the level argument is 
advanced by 1. 

2. In state 1, the parser is looking for an operator, a right 
parenthesis, or the end of the entry. If the next token is 
an operator, the parser immediately saves it and 
advances the state to 2. If the token is a right parenthesis 
and the level is greater than 0, then the parser immedi
ately returns the current value of the result variable. 
Execution of the parser will continue in the step in which 
the parser called itself to processes the parenthetical 
group. If the token is the end-of-entry token (-1) and the 
level is greater than 0, the parser immediately returns 
the result, resuming execution right after the point at 
which it called itself. Any other token or condition will 
result in the index value being set to 0 and a result of 0.0 
being returned. 

3. In state 2, the parser is looking for a left parenthesis or a 
value. If the next token is a left parenthesis, the parser 
calls itself using the current index value and advances 
the level by 1. If the next token is a value, then the 
parser computes the result of the current value of the 
result variable and the value. by applying the saved 
operator. Addition, subtraction, multiplication, and divi
sion are allowed. The computed value is stored into the 
result variable, and the state is set to 1. Any other token 
or condition will result in an error, the index being set 
to 0, and a result of 0.0 being returned. 
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Beginning of 
GetExpression 
method.code 

The code for the GetExpression method is as follows: 

double CCalcWindow::GetExpression (StringPtr anEntry, short *index, short 
level) 
{ 

double value = 0.0, result = 0.0; 
short token, state=O, operator; 
Str255 aString; 

while (TRUE) 
{ 

token = GetToken (anEntry, index, &value, aString); 
switch (state) 
{ 

case 0: II initial case 
{ 

} 

if(token == 2) II token is a value 
{ 

} 

result = value; 
state= 1; 
break; 

if(token == 3) //token is left paren '(' 
{ 

} 

result= GetExpression (an Entry, index, level+ 1 ); 
if(*index == 0) 
{ 

return (0.0); 
} 
state= 1; 
break; 

else 
{ 

*index= O; 
return 0.0; 

case 1 : II looking for an operator or EOF 
{ 

if(token >= 10 && token <= 13) II token is operator 
{ 

} 

operator= token; 
state= 2; 
break; 

if(token == 4) II token is right paren ')' 
{ 



GetExpression 
method code 
(continued) 

} 

} 

if(level < 1 ) 
{ 

*index= O; 

Customizing the CCalcWindow Code 227 

return (0.0); II error 

return result; 

if(token == -1 ) 
{ 

} 

II 
II end of entry 
II 
if(level > 0) 
{ 

return (result); II valid EOF 
} 
return result; 

else 
{ 

II 
II error 
II 
*index= O; 
return (0.0); II error 

case 2: II looking for 2nd value 
{ 

if(token == 3) 
{ 

} 

value = GetExpression (an Entry, index, level+ 1 ); 
if(*index == 0) 
{ 

return (0.0); 

if(token == 2 II token == 3) II token is value 
{ 

switch{operator) 
{ 

case 10: II'+' 
{ 

} 

result += value; 
break; 

case 11: II'-' 
{ 

result -= value; 
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GetExpression 
method.code 
(concluded) 

GetToken method 
code (beginning) 

} 

} 

break; 

case 12: II '*' 
{ 

} 

result*= value; 
break; 

case 13: II '/' 
{ 

result I= value; 
break; 

state= 1; 
break; 

else 
{ 

*index= O; 
return (0.0); II error 

GetToken Method Code 

The GetToken method is commonly referred to as a lexical 
scanner in the literature on compilers and interpreters. It 
scans the input, gets the next sequence of characters accord
ing to preset rules, and presents this to the parser as a token 
of a particular type and value. 

The code for the GetToken method is as follows: 

short CCalcWindow::GetToken (StringPtr anEntry, short *index, 
double *value, StringPtr entry) 

char ch; 
Cell aCell; 
short length, numchars, type; 
Str255 cellText; 

length = anEntry[O]; 
if(*index > length) 
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return (-1); II end of entry 
} 
while (*index <= length) 
{ 

if(anEntry[*index] ==' ') 
{ 

} 

(*index)++; 
continue; 

if(anEntry[*index] == '\") 
{ 

} 

II 
II entry is a string 
II 
numchars = length - *index; 
BlockMove(&anEntry[*index+ 1 ], &entry[1 ], numchars); 
entry[O] = numchars; 
*value = 0.0; 
*index= length; 
return (1); II token is string 

if(anEntry[*index] == '(') 
{ 

(*index)++; 
return (3); II left parenthesis'(' 

} 
if(anEntry[*index] == ')') 
{ 

(*index)++; 
return (4); II right parenthesis')' 

} 
if(isConst(anEntry, index, value)) 
{ 

return (2); II token is value 
} 
if(isCell(anEntry, index, &aCell)) 
{ 

II 
II token is a cell address 
II 
( (CList15 *)List15)->GetContents (aCell, entry, value, &type, 

cellText); 
if(type == -1 ) 
{ 

*value = 0.0; 
*index= length; 
return (99); II error 
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GetToken method 
code (concluded) 

} 

} 

else 
{ 

II 
II token is an existing cell 
II 
return (2); II value 

if(anEntry[*index] == '+') 
{ 

(*index)++; 
return (10); II addition 

} 
if(anEntry[*index] == '-') 
{ 

(*index)++; 
return ( 11 ) ; 11 subtraction 

} 
if(anEntry[*index] == '*') 
{ 

(*index)++; 
return (12); II multiplication 

} 
if(anEntry[*index] == '/') 
{ 

(*index)++; 
return (13); II division 

} 
else 
{ 

*index= length; 
return (99); II error 

return(-1); llendotentry 

The GetToken method for our worksheet is very straightfor
ward. It contains a series of sections that test for various 
types of data in the entry string. The entry text is passed in 
as a string called anEntry, and the index variable is passed 
as a pointer whose associated value is updated as the method 
scans the string. Space characters are ignored between to
kens. The steps taken by the method are as follows: 

1. The method first tests for a single-quote (apostrophe) 
character, which signals the beginning of a string token. 
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If one is found, then the remainder of the entry is copied 
to the parameter called entry, the value parameter is set 
to 0.0, and a token type of 1 is returned. 

2. If the next nonblank character is a left parenthesis, a 
token type of 3 is returned. 

3. If the next nonblank character is a right parenthesis, a 
token type of 4 is returned. 

4. If the character is none of the preceding, then a method 
called isConst is called to determine whether the charac
ters that follow are a numeric constant value. If so, then 
the isConst method returns TRUE, the updated index 
value, and the value of the constant. In this case, the 
GetToken method returns a token type of 2. If the char
acters that follow are not a numeric constant, the method 
continues. 

5. If the entry didn't contain a constant, a method called 
isCell is called, to determine whether the entry holds a 
valid worksheet cell designation (e.g., Bl3) as its next 
token. If so, isCell returns TRUE, the updated index 
value, and the number of the cell. The GetContents 
method is then called, and if the cell is nonempty, the 
value of its contents and a token type of 2 are returned. If 
the isCell method returns FALSE, the GetToken method 
continues. 

6. Finally, GetToken tests for the operator values (+, -, * 
and /). If any of these is found, the corresponding opera
tor token type (10, 11, 12, or 13) is returned. 

7. If none of the preceding tests discovers a valid token, a 
token type of -1 is returned. 

isConst Method Code 

The isConst method is responsible for examining the charac
ters in the entry string, beginning at the current position of 
the index variable and continuing until a valid constant or an 
invalid combination of characters is found. The code classi
fies the input as a valid constant if it appears in one of the 
following forms: 
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isConst method 
code (beginning) 

1234.567 
567 

.891 
0.123 

As is apparent, constants must be unsigned, may have only 
an integral part, only a fractional part, or a combination of in
tegral and fractional parts. The code for the isConst method 
is as follows: 

Boolean CCalcWindow::isConst (StringPtr anEntry, short *index, 
double *value) 

short saved = *index, length, state = O; 
unsigned char ch, ch1, ch2, ch3; 
double result = 0.0, fraction = 0.0; 
short numFrac = 0, i; 
Boolean intVal = FALSE, fracVal = FALSE; 
length = anEntry[O]; 
while (TRUE) 
{ 

switch (state) 
{ 

case 0: II looking for integral value 
{ 

} 

ch = anEntry[*index]; 
if( ch >= 'O' && ch <= '9') 
{ 

} 

intVal =TRUE; 
result= (ch - 'O'); 
(*index)++; 
state = (*index> length) ? 5 : 1; 
continue; 

else 
{ 

} 

state= 2; 
continue; 

break; 

case 1: II get integral value 
{ 

ch = anEntry[*index]; 
if (ch>= 'O' && ch<= '9') 
{ 
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code (continued) 

} 

} 
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result= result• 10.0 + (ch - 'O'); 
(*index)++; 
if(*index > length) state = 5; 
continue; 

else 
{ 

state= 2; 
continue; 

} 
break; 

case 2: II check whether decimal 
{ 

ch = anEntry[*index]; 
if(ch == '.') 
{ 

} 

(*index)++; 
state = (*index > length) ? 5 : 3; 
continue; 

else 
{ 

} 

state = 5; 
continue; 

break; 

case 3: II verify digit following decimal 
{ 

ch = anEntry[*index]; 
if( ch >= 'O' && ch <= '9') 
{ 

} 

fracVal =TRUE; 
numFrac++; 
fraction =(ch - 'O'); 
(*index)++; 
state = (*index > length) ? 5 : 4; 
continue; 

else 
{ 

state = 5; 
continue; 

} 
break; 

case 4: II collect fraction 
{ 
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isConst method 
code 
(concluded) 

ch = anEntry[*index]; 
if( ch >= 'O' && ch <= '9') 
{ 

fraction =fraction * 10.0 +(ch - 'O'); 
numFrac++; 
(*index)++; 
if(*index > length) state = 5; 
continue; 

else 
{ 

state = 5; 
continue; 

break; 

case 5: II create composite constant 
{ 

if(fracVal) 
{ 

} 

for(i=O; i < numFrac; i++) 
{ 

fraction I= 10.0; 

if(intVal II fracVal) 
{ 

*value = result + fraction; 
return TRUE; 

*index= saved; 
*value = 0.0; 
return FALSE; 

The coding approach for analyzing the entry string to deter
mine whether the next token is a numeric constant uses a 
state transition table design. The first character is guaran
teed not to be a blank (because blanks were passed over by 
the GetToken method). The code starts with state set to 0, 
the result and fraction variables set to 0.0, and the num
Frac variable set to 0. The initial value in the index variable 
is saved. The steps for each state are as follows: 
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o. The next character is tested to determine whether it is 
numeric. If so, the result is set to the binary value of the 
digit, the intVal Boolean variable is set to TRUE, and the 
index is advanced and tested against the length of the 
entry. If it is greater than the length, state is set to 5. 
Otherwise, state is set to 1. If the character is not 
numeric, state is set to 2. 

1. The character at the index is tested to see whether it is 
numeric. If so, the previous result is multiplied by 10, 
and the binary value of the digit is added to that result. 
The index is advanced, and if it exceeds the length of the 
entry, state is set to 5. Otherwise, state remains the 
same. If the digit is not numeric, state is set to 2. 

2. The character at the index is tested to see whether it is a 
decimal point. If so, the index is advanced. If it exceeds 
the length of the entry, state is set to 5. Otherwise, state 
is set to 3. If the character is not a decimal point, state is 
set to 5. 

3. The character at the index is tested to determine whether 
it is numeric. If it is, the fraction variable is set to the 
binary value of the digit, the fracVal variable is set to 
TRUE, the numFrac variable is advanced by 1, and the 
index is advanced and tested against the length of the 
entry. If it exceeds the length, state is set to 5. Otherwise, 
state is set to 4. 

4. The character at the index is tested to determine whether 
it is numeric. If so, the previous fraction value is multi
plied by 10 and the binary value of the digit is added to 
the fraction variable. Then the numFrac counter is 
advanced by 1, and the index is advanced. If the index 
exceeds the length of the entry, state is set to 5. Other
wise, state remains the same. 

5. If the fracVal boolean variable is TRUE, the value of the 
fraction variable is successively divided by 10, according 
to the count in the numFrac variable. If either the intVal 
or fracVal Boolean variable is TRUE, the final value is 
computed to be the sum of the result and fraction vari
able's values. In this case, the isConst method returns a 
TRUE value, along with the value of the result and the 
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isCell method code 
(beginning) 

updated index value. Otherwise, the index is set back to 
the value saved upon entry to the method, the value is set 
to 0.0, and the method returns a FALSE value. 

isCell Method Code 

The isCell method is relatively straightforward. The intention 
is to determine whether the next token in the entry string is a 
valid cell number. Valid cells consist of a single alphabetic 
character (either upper- or lowercase), followed by a numeric 
value. Upon entry, the code saves the current value of the in
dex variable, so that it can be restored if a valid cell isn't 
found. Next, the first character is tested to determine 
whether it is alphabetic. If not, the method restores the saved 
index value and returns a FALSE result. Then the column 
number is computed from the character value (A=O, B= 1, 
etc.). If the next character is numeric, it and the digits.follow
ing it are converted to a binary row value minus 1. If the col
umn and row values don't exceed the numCols and 
numRows constants, respectively, the (row, col) value of the 
cell and a TRUE result are returned. Otherwise, the saved in
dex value is restored and FALSE is returned. The code for the 
isCell method is as follows: 

Boolean CCalcWindow::isCell (StringPtr anEntry, short *index, Cell *aCell) 
{ 

unsigned char ch; 
short row= 0, col= 0, saved, length; 

saved = *index; 
length= anEntry[O]; 
if(*index <= length) 
{ 

ch = anEntry[*index]; 
if((ch >='A' && ch<= 'Z') II (ch>= 'a' && ch<= 'z')) 
{ 

col = (ch & -Ox20) - 'N; 
(*index)++; 
if(*index <= length) 
{ 

ch = anEntry[*index]; 
if(ch >= 'O' && ch<= '9') 
{ 

for (row = O; ch >= 'O' && ch <= '9' && (*index <= length); ) 
{ 

row= row* 10 +(ch - 'O'); 
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(concluded) 

Customizing the CCalcWindow Code 237 

(*index)++; 
ch= anEntry[*index]; 

row--; 
if (row >= 0 && row <= numRows && col >= O && 

col<= numCols) 

aCell->h = col; 
aCell->v = row; 
return TRUE; 

*index = saved; 
return FALSE; 

MakeStringObj Method Code 

When the ParseEntry method discovers that the entry string 
contains a string value, it calls the MakeStringObj method 
to create a string object, whose handle it will store in the 
cluster, as shown in the following code: 

CWSEntry * CCalcWindow::MakeStringObj (Cell aCell, StringPtr aString) 
{ 

CWSEntry *aCellEntry; 
TRY 
{ 

aCellEntry = new CWSEntry; 
aCellEntry->IWSEntry (); 
aCellEntry->SetWSCell (aCell); 
aCellEntry->SetWSType (1); II string 
aCellEntry->SetWSText (aString); 
aCellEntry->SetWSEntry (aString); 
aCellEntry->SetWSValue (0.0); 

} 
CATCH 
{ 

ForgetObject (aCellEntry); 
} 
ENDTRY; 
return aCellEntry; 
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The MakeStringObj method creates a new instance of the 
CWSEntry object, initializes the object, sets its instance vari
ables to the cell number, sets the type code (1), sets both the 
text and entcy variables to the entcy string, and sets the value 
to 0.0. If successful, MakeStringObj returns the object's 
handle; otherwise, it calls ForgetObject. In case of failure, 
the error is propagated up to the application, where an alert 
informs the user of the error. The object's access methods are 
used to set its instance variable's values. 

MakeValueObj Method Code 

When the ParseEntry method discovers that the entcy string 
contains a value (formula), it calls GetExpression to return 
the result of evaluating the formula. It then calls the 
MakeValueObj method to create an object whose handle will 
be stored in the worksheet cluster. The code for MakeValue
Obj is as follows: 

CWSEntry * CCalcWindow::MakeValueObj (Cell aCell, double value, 
StringPtr aString) 

CWSEntry 
Str255 
decform 
extended 
TRY 

*aCellEntry; 
dispStr; 
aFormat; 
temp; 

{ 
aCellEntry = new CWSEntry; 
aCellEntry->IWSEntry (); 
aCellEntry->SetWSCell (aCell); 
aCellEntry->SetWSType (2); II type =value 
aCellEntry->SetWSValue (value); 
aCellEntry->SetWSEntry (aString); 

aFormat.style = FIXEDDECIMAL; II convert value to string 
aFormat.digits = 2; II and store into cell 
x96tox80(&value, &temp); 
num2str(&aFormat, temp, dispStr); 
aCellEntry->SetWSText( dispStr); 

} 
CATCH 
{ 

ForgetObject (aCellEntry); 
} 
ENDTRY; 

return aCellEntry; 
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Activate Method Code 

The Activate method is an override of the same method in
herited from the CDirector class. It calls the inherited 
method and then sends a Refresh message to the Listl5 
(main worksheet) pane. This forces the worksheet to be re
drawn when the window is activated. In the process of re
drawing the window, each of the cell values will be 
recalculated. The code for the Activate method is as follows: 

void CCalcWindow::Activate (void) 

{ 
inherited: :Activate(); 

if(List15 != NULL) 

{ 
List15->Refresh(); 

Adding the CWSEntryClass and Methods 

In order to support the storage of information for each work
sheet cell, and also provide methods to access that informa
tion, we have defined a new class, called CWSEntry. This 
class contains instance variables that define the contents of a 
cell's entry. 

If you refer to the MakeStringObj (page 237) or MakeValue
Obj (page 238) method in the CCalcWindow class, you will 
see some of the access methods of the CWSEntry class being 
used to set the values of a CWSEntry object. In addition, the 
GetCellText and GetContents methods of the CList15 class 
(see pages 204 and 208, respectively) refer to some of the 
CWSEntry access methods to retrieve the contents of the 
cell's instance variables. 

By encapsulating the data and methods for a cell entry into a 
separate class, the definition of the class is completely hidden 
from the rest of the code. It can then be modified at will. As 
long as the current access methods remain supported, the 
nature and contents of the cell entry can be changed without 
regard to the remainder of the code. The declaration for the 
CWSEntry class is as follows: 



240 Chapter 8 ~Customizing the Worksheet Code 

class CWSEntry : public CCollaborator 
{ 
protected: 

Cell 
short 
Str255 
Str255 
double 

itsCell; 
its Type; 
itsString; 
its Text; 
its Value; 

public: 
void IWSEntry(void); 
Cell GetWSCell(void); 
short GetWSType(void); 
void GetWSEntry(StringPtr aString); 
void GetWSText(StringPtr aString); 
double GetWSValue(void); 

void SetWSCell(Cell aCell); 
void SetWSType(short a Type); 
void SetWSEntry(StringPtr aString); 
void SetWSText(StringPtr aString); 
void SetWSValue(double aValue); 

}; 

Notice that the instance variables are all declared as pro
tected. This will prevent classes other than direct descen
dants of CWSEntry from directly accessing these variables. 
Access methods are provided to get and set each variable, as 
is an initialization method to initialize an instance when it is 
created. 

IWSEntry Method Code 

This method performs initialization of a newly created 
CWSEntry instance. The code is as follows: 

void CWSEntry::IWSEntry (void) 
{ 

SetPt (&itsCell, 0, O); 
its Type= -1; 
itsString[O] = O; 
itsText[O] = O; 
itsValue = 0.0; 



SetWS access 
metlwdcode 
(beginning} 

Customizing the CCalcWindow Code 241 

CWSEntry Get Access Method Code 

Each of the following access methods returns the corre
sponding instance variable value: 

Cell CWSEntry::GetWSCell (void) 
{ 

return itsCell; 

short CWSEntry::GetWSType (void) 
{ 

return itsType; 

void CWSEntry::GetWSEntry (StringPtr aString) 
{ 

CopyPString (itsString, aString); 

void CWSEntry::GetWSText(StringPtr aString) 
{ 

CopyPString (itsText, aString); 

double CWSEntry::GetWSValue (void) 
{ 

return itsValue; 

Although the above methods are extremely simple, it is im
portant to stress the advantage of using them so that you will 
have the freedom to redesign the cell entries to incorporate 
new variables and features without affecting your current 
code. 

CWSEntry Set Access Method Code 

Each of the following access methods sets the value of its cor
responding instance variable to the value passed as a param
eter to the method: 

void CWSEntry::SetWSCell (Cell aCell) 
{ 

itsCell = aCell; 
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SetWS access 
method code 
(concluded) 

void CWSEntry::SetWSType (short a Type) 

{ 
itsType = aType; 

void CWSEntry::SetWSText (StringPtr aString) 

CopyPString (aString, itsText); 

void CWSEntry::SetWSEntry (StringPtr aString) 

CopyPString (aString, itsString); 

void CWSEntry::SetWSValue (double aValue) 

itsValue = aValue; 

Viewing the Customized Results 

Exercises 

After all the customizing has been applied to the modules, as 
described in this chapter, the Ensemble application can be 
recompiled and executed. The final result of all these efforts 
can be seen in Figure 8-2, which shows the Ensemble appli
cation with both windows containing appropriate sample con
tents. The Ediffext window is currently active in the figure. 

1. Explain why you think a CCluster object was chosen to 
hold the references to worksheet cell instances. Why 
wouldn't a CList or CArray work as well? 

2. In the DisposeData method of the CEnsembleData class, 
the code continues to delete the first item in the cluster. Is 
this a typographical error? Shouldn't the code advance 
through the number of cells in the cluster, incrementing 
the item number each time? 



Figure 8-2 
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Richard 0. Parker 
President 

3. Suggest what changes would have to be made to the vari
ous methods in the CalcWindow module to support more 
than 26 columns of data. Implement your suggestions. 

4. Explain why the CList15 GetCellText method converts 
the value associated with a cell to an "extended" data 
type. What is gained by this approach? Explain the bene
fits of using the Macintosh SANE library functions. 
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5. How does the worksheet display keep track of changes to 
its cells? What fundamental mechanism of the TCL is 
used to implement this synchronization of the cluster and 
the worksheet display? 

6. Describe the interaction of the column, row, and work
sheet lists when the scroll bars are clicked or when either 
thumb is moved in the main worksheet pane. How are the 
entries scrolled in unison? What happens when the 
mouse is clicked and dragged through a set of entries in 
the main worksheet? How do the column and row lists 
reflect the range of visible cells when a drag selection is in 
progress? 

7. Why was the ProviderChanged method in the CList15 
class written to override the standard behavior of that 
method in the CTable class? Why are we disregarding the 
arraylnsertElement and arrayDeleteElement mes
sages? Explain what would have happened in our appli
cation if we had not overridden the method. 

8. What modifications would be necessary to handle the 
selection of a contiguous series of cells in the worksheet, 
instead of the single selection now allowed? What benefits 
would result if this were implemented? 

9. What modifications would be necessary to support the 
selection and operation of the worksheet with noncontigu
ous cell ranges? What benefit, if any, would this provide?1 

10. Modify the worksheet code to add functions (such as sum 
and average) to the formula entry syntax. (Hint Assign a 
new numeric token to represent each function, and then 
modify the GetToken lexical analyzer and the Parse
Entry and GetExpression methods to parse and evaluate 
the new syntax.) 

1. This question can best be answered in the context of the graphing facility, which is yet to be 
described; however, many spreadsheets on the market provide noncontiguous cell selections 
for other reasons. A very extensive extra-credit project or the subject could be undertaken 
either at this point or after the full application has been developed. 
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11. If the CalcWindow interface is modified to allow in-cell 
entry and editing of data, what methods would need to 
change? keeping in mind that provisions for entering, 
editing, canceling, and deleting an entry would be needed, 
how would the worksheet implementation have to be 
altered to provide these capabilities?1 If selection of con
tiguous or noncontiguous entries, were allowed, how 
would these modifications affect the in-cell editing 
approach, if at all? 

1. This could also be a very extensive extra-credit project. Bear in mind that a single pane can 
overlay a cell to obscure its current contents. The pane would have to be created "on the fly" 
and be sized to correspond exactly to the target cell size. It would also have to be placed in 
the correct position to appear to be applicable to the associated cell. 



Chapter 9 

Adding a Format Worksheet Dialog 

This chapter describes the step-by-step method for adding a 
Format Worksheet dialog to Ensemble's user interface. In ad
dition, after the dialog has been defined, a new command will 
be added to the Format menu, to allow the dialog to be 
opened. 

There are several objectives to be met in the design of this di
alog. The most important of these are: 

•:• The contents of worksheet cells should be representable in 
any font, size, style, or alignment. 

•:• Cell, column, and row styles should be selectable. In the 
case of columns and rows, the selected style should apply 
to eve:ry subsequent cell defined in that column or row. 

•:• Worksheet column widths and row heights should be indi
vidually adjustable. 

•:• The format of numeric cells must allow for the number of 
decimal digits specified by the user and the inclusion of 
commas or dollar signs, as desired. 

Rather than apply the Format Notebook dialog to satisfy the 
first of these items and a completely different dialog for the 
remaining items, it was decided to design a single dialog that 
combines these functions. The following section describes the 
step-by-step procedure for creating the Worksheet dialog. 

Creating the Worksheet Dialog 

Creation of the Worksheet dialog is relatively straightfor
ward. AppMaker's tools should be familiar by now, and given 

247 
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Figure 9-1 
Appearance of final 
Worksheet dialog 

the desired appearance and the location and size of some of 
the important elements, it should be relatively easy to repli
cate the final dialog, shown in Figure 9-1. 

Font 
one 
two 
three 
infinity 

Size 

ee 
infi 
nity 

' !font I !size I 
D Change TeHt Style 

r;··~;;; ................... ! Cell: cellNum 

I 0 Row I Height: I height 

! .. ~ ... ~.~.~.~-~.~ .... ..! Width: I width 

Style 

OBold 
D Italic 

Justification r®·i;11 .......................... 1 

! O Center I 
lo Right I 
l O Force Left ! 
L ............................................... J 

D Underline 
D Outline 
D Shadow 
D Condense 
D EHtend 

I~:~~~~:~::::::::::::::::::::::::::: I 
Options-------, 

Decimal Digits: I digits I 
D Dollars $ 999999.99 

D Commas 99,999,999 

Cancel ([ OK )J 
• 

Notice that the top portion of the dialog contains essentially 
the same elements as the previously defined Notebook dialog 
(although the height of the scrolling lists has been reduced to 
minimize the size of the dialog pane). While it might be tempt
ing to copy and paste these elements into the current dialog, 
this is not recommended, as AppMaker will not provide 
unique identifiers for the individual elements (it will copy 
them exactly) which will lead to multiply defined variable 
compiler errors. 

The completed dialog shown in Figure 9-1 is 296 pixels tall by 
432 pixels wide. These dimensions allow it to fit on a compact 
Macintosh screen, although it will take up most of the 512-
by-342-pixel screen area. 

You should begin the process of creating the dialog by dou
ble-clicking on the Ensemble.1t.rsrc resource file that was 
created in Chapter 6. This will serve as the basis for the new 
additions to the Ensemble application's user interface. By 
double-clicking on this file, you will launch AppMaker. The 
steps to create the dialog are as follows: 



Figure 9-2 
Create Dialog 
information window 

Figure 9-3 
Worksheet dialog in 
AppMaker's 
selection list 
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1. Pull down the Select menu and choose the Dialogs command. 

2. Create a new dialog by pulling down AppMaker's Edit 
menu, and choose the Create Dialog command. 

3. When the Create Dialog command is chosen, AppMaker 
will place a dialog information window on the screen. You 
should type the word Worksheet into the Name field, and 
type anything you like into the Title field. An example of 
the completed window is shown in Figure 9-2. Notice that 
we have not checked the Visible at Start-up selection. 
When the information has been entered, click the OK 
button, as shown. 

Name:J • ID:J2001 

Title: J Format Worksheet 
i{g 
J [Cancel) 

goog~ 
ZoomDoo NoGrowDoo ZoomNoGrow Document RDoo 

CIOII::J. D ~ 
D Hi~s C!oH~ boH 
D IJisible at Startup 

ProclD: J._1_~ 

4. Figure 9-3 shows that the new Worksheet dialog, with 
ID=2001, appears in AppMaker's dialog selection list. 

§D~ Ensemble. n .rs re ~t!]§ 
2 Dialogs: 

Notebook, ID = 2000 
Worksheet, ID = 2001 
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Figure9-4 
Item Info settings for 
Font CScrollPane 

Now that the dialog has been created, double-click it in App
Maker's selection list to make it active. At this point, you'll 
want to resize it so that it will be large enough to hold all the 
elements that we will be entering in the next series of steps. If 
you hold a ruler up to your screen and make the dialog ap
proximately 6 inches wide by 4 inches tall, it will be just 
about the right size. The next series of steps covers adding 
some of the more complex elements to the dialog: 

5. Add the Font table by pulling down the View menu and 
selecting View Tools as Text. Then, choose the CScroll
Pane tool and position the cursor (which is in the shape 
of a cross) at the approximate location of the top left cor
ner of the Font list shown in Figure 9-1. Drag down and 
to the right to create a CScrollPane element that appears 
to be approximately the right size. 

6. Pull down the View menu and choose Item Info, which 
will cause AppMaker to display a window containing the 
location and sizing information for the selected element. 
Adjust the settings for the CScroUPane element to match 
those in Figure 9-4. 

Item Info 

Item 21 

Top:~ 
Left: EJ 

Scroll Pane 

Height: @!] 
Width: ~ 

@ Enabled O Disabled 

Class: I CScrollPane 

7. The next step involves placing a border inside the blank 
area of the Font scroll pane. Pull down the Tools menu 
and choose the CBorder tool. Position the center of the 
cross hairs of the cursor on top of the top left corner of 
the Font scroll pane, and drag down and to the right to 
enclose the blank portion of the scrollpane completely. 
The Item Info window should still be open. Change the 
settings to correspond with those shown in Figure 9-5. 



Figure 9-5 
Item Info settings for 
Font CAMBorder 

Figure 9-6 
Item Info settings for 
Font CTable 
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Item Info 

Item 23 

Top: §,] 
Left: Li 

Rectangle 

Height: ~ 
Width: @D 

@ Enabled O Disabled 

C:lass: I C:RMBorder 

8. The final construction step for the Font table is the 
installation of the CTable element, inside the border that 
was just installed. Pull down the Tools menu and select 
the CTable tool. Click just inside the top left corner of the 
table's border, and drag down and to the right almost to 
the bottom right corner of the border. The Item Info set
tings for the CTable element are shown in Figure 9-6. 

Item Info 

Item 24 List 

Top: ~ Height: ~ 
Left: Li Width: ~ 

@ Enabled O Disabled 

Class: l ..... c_T_a_b_le _____ ~ 

9. The Size table is constructed in the next series of steps. 
The first step is to choose the CScrollPane tool, and click 
and drag the mouse so that the scroll pane is the approx
imate size and position shown in Figure 9-1. The final 
Item Info settings for the Size table's CScrollpane ele
ment are shown in Figure 9-8. Change the settings in 
AppMaker's Item Info window to correspond with those 
in the figure. 

10. The next step is to place a border around the blank area 
of the scroll pane. Choose the CBorder tool, position the 
cursor's cross hairs at the top left corner of the CScroll-
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Figure 9-7 
Item Info settings for 
Size CScrollPane 

Figure 9-8 
Item Info settings for 
SizeCAIVIBorder 

Item Info 

I tern 23 Scroll Pane 

Top: ~ Height: ~ 
Left: @D Width: ~ 

@ Enabled O Disabled 

Class: I CScrollPane 

Pane element, and drag down and to the light to enclose 
the blank portion of the scroll pane completely. The Item 
Info settings are shown in Figure 9-8. 

Item Info 

Item 25 

Top:~ 
Left:~ 

Rectangle 

Height: §] 
Width: ~ 

@ Enabled O Disabled 

Class: I CRMBorder 

11. The final step in the construction of the Size table is the 
placement of the CTable element inside the border. 
Choose the CTable tool, and then click the mouse cursor 
just inside the top left corner of the CBorder element that 
was installed in the previous step. Drag down and to the 
light, almost to the bottom light corner of the border. The 
Item Info settings for the CTable element are shown in 
Figure 9-9. Creation of the remaining elements is rela
tively straightforward. The Item Info settings for several 
of the less familiar elements are shown in the next few 
steps. 

12. Create the column of checkbox items for the style set
tings by choosing the CCheckbox tool, clicking, and typ
ing each checkbox's name, as shown in Figure 9-1. It 



Figure 9-9 
Item Info settings for 
Size CTable 

Figure 9-10 
Item Info settings for 
CRadioGroupPane 
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Item Info 

Item 26 List 

Top: ~ Height: ~ 
left: ~ Width: ~ 

® Enabled 0 Disabled 

Class: ._I c_T_a_b_le _____ __, 

should be relatively easy to approximate the appearance 
shown in the figure. 

13. The group of radio buttons used to select the justification 
of worksheet cell entries is assembled by creating a CRa
dioGroupPane item, whose Item Info settings are shown 
in Figure 9-10. This pane groups all of the radio buttons 

Item Info 

Item 16 

Top: ~ 
Left:§!:] 

Radio Group 

Height: ~ 
Width: ~ 

@ Enabled O Disabled 

Class: I CRadioGroupPane 

into a single collection that works as a unit. The TCL 
ensures that one and only one button in the group is 
active. When the user selects an inactive button, the one 
that's currently active is deactivated and the new button 
is made active. 

14. After the CRadioGroupPane has been installed and 
adjusted according to the indicated settings, choose the 
CRadioControl tool, click, and type in the names of the 
justification buttons, as shown in Figure 9-1. Make sure 
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Figure 9-11 
Item Info settings for 
CLabeledGroup 

that all of the buttons are inside the CRadioGroupPane 
element. 

15. The next element is a CLabeledGroup, so choose that 
tool. This creates another group of items, which are iden
tified by a rectangular border, and an optional label. In 
this case, the label given to the group is Options. Position 
the cursor at the approximate top left corner of the group, 
and drag down and to the right until a group that is 
approximately the correct size has been created. Type the 
name Options into the top left (label) area of the group, 
and then change the Item Info settings to match those 
shown in Figure 9-11. 

Item Info 

Item 35 

Top:~ 
Left:~ 

Labeled Group 

Height: ~ 
Width: ~ 

@ Enabled O Disabled 

Class: I ClabeledGroup 

16. Choose the appropriate tools for creating the items inside 
the Options labeled group. The phrase Decimal Digits is 
a CStaticText item, and the text box associated with that 
is a CDialogText item. The two checkboxes that specify 
Dollars and Commas were created with the CCheckbox 
item. 

17. Choose the CDialogText tool and create the font, size, 
and sample text boxes below the font list, size list, and 
justification group, respectively. Make these approxi
mately the sizes shown in Figure 9-1. 

18. Select the CCheckbox tool and create the single checkbox 
called Change Text Style below the font selection list. 
Just click and type the indicated name, as shown in Fig
ure 9-1. This item provides the user the ability to bypass 
changing the text style and merely change a column 
width or row height if only that change is desired. 



Figure 9-12 
Item Info settings for 
Cell, Row, Column 
CRadioGroupPane 
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19. The final set of items allows the selection of the indicated 
cell, its associated column, or its associated row, to which 
the changes will be applied. The Cell, Row, and Column 
radio buttons are organized into a CRadioGroupPane, so 
choose that tool, create the pane, and then match its set
tings to those shown in Figure 9-12. The radio buttons 
are created with the CRadioControl tool. 

Item Info 

Item 31 

Top:~ 
Left: EJ 

Radio Group 

Height: ~ 
Width: ~ 

@ Enabled O Disabled 

Class: I CRadioGroupPane 

20. Create the items adjacent to the Cell, Row, and Column 
radio buttons as follows: 

• The Cell, Height, and Width labels are created with the 
CStaticText tool, as is the cellNum text adjacent to the 
Cell label. 

• The text boxes adjacent to the Height and Width labels 
are created as CDialogText items. 

When the preceding steps are completed, the dialog should 
have the appearance shown in Figure 9-1. There are a lot of 
items in this dialog, and the contents are somewhat cramped, 
but it is sized to allow it to fit on the screen of a classic Mac
intosh and contain all of the relevant settings to modify the 
appearance of the worksheet. 

As with the Notebook dialog, the text font, size, style, and 
justification can be changed for any worksheet cell, row, or 
column. If the style is changed (the Change Text Style 
checkbox is checked), the change applies only to the selected 
cell, row, or column of the worksheet. 

The Options settings allow the number of digits appearing af
ter a decimal point in numeric values to be specified. For nu-
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meric items, you can elect to have the digits grouped, with 
commas inserted at the appropriate places and with an op
tional leading dollar sign. If you enter 0 as the number of dec
imal digits, no decimal point will be displayed. 

In the final customized code, a particular cell may have corre
sponding row and column styles. In this case, the column 
style will take precedence. If a style has been applied to an in
dividual cell, then that style will take precedence over any ex
isting or future row or column styles. This effect of applying 
the worksheet dialog will be fully realized in the code pre
sented in Chapter 11. 

Creating the Worksheet Menu Item 

Figure 9-13 
Format Worksheet 
menu command 
added 

In the next series of steps, you will construct a new menu 
item in the Format menu. This will add the ability to open 
the dialog for formatting worksheet cells: 

1. Pull down the Select menu and choose the Menus command. 

2. Double-click on the MainMenu entry in AppMaker's 
selection window, and then click on the Format menu 
entry on the menu bar that is displayed. 

3. Click below the Notebook entry and type Worksheet ... 
(three periods follow the name). with a command number 
of 2001, as shown in Figure 9-13. This completes the 
steps for adding the Worksheet command to the Format 
menu. When the command name and command number 
have been added to the menu, press the Enter key to 
indicate to AppMaker that the menu is complete. 

. -D MainMenu E!]-
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Generating the Format Worksheet Code 

Figure 9-14 
AppMaker's 
Generate dialog 

After the preceding elements have been added to the user in
terface, you need to generate code that implements the de
fault behavior for the elements. The next series of steps leads 
you through the process of generating code for the user inter
face changes you have just made: 

1. Choose the Generate command from the File menu. App
Maker will display a dialog containing the names of all the 
files it intends to generate, as shown in Figure 9-14. 
Notice that there are four new file names in the list: Work
sheet.c, Worksheet.h, zWorksheet.c, and zWork
sheet.h. These files implement the default functionality of 
the Worksheet dialog. Click the Generate button, as 
shown, to generate new source code for all the listed files. 

Generate 

Generate which modules? 
Zc.11.'lic:111u1 c:nJJ I' . ._. 0 119 

zEnsembleRpp.h 
zEnsembleDoc.c 

Language: 
THINK C 5.0 

zEnsembleDoc.h 
zMainlllindow.c: 

with Class Library 

zMainWindow.h 
zCalcWindow.c: 
zCalcWindow.h 
zNotebook.c: 
zNotebook.h Cancel 
zWorksheet.c: 
zWorksheet.h 
Worksheet.c: 
lllorksheet.h 
Resourc:eDefs.h m 

2. After the files have been generated, pull down the File 
menu and choose the Save command, and then pull it 
down again and choose the Quit command to terminate 
execution of AppMaker. Notice that all new versions of the 
superclass files (whose names begin with the letter z) 
have been generated, in addition to the new Worksheet.c 
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Figure 9-15 
Ensemble files, as 
seen in the Finder 

and Worksheet.h subclass files. The complete set of files 
in the Ensemble folder is shown in Figure 9-15. 

[il Ensemble.'J1 

~ EnsembleMain.c 

~ Ensemble App .c 

~ Ensemb leDa1a .c 

~ Ensemb leDoc .c 

~ F on\Da\a .c 

~ Ensemble .11.rsro 

~ Resource-Defs.h 

~ EnsembleApp.h 

~ Ensemb leDa\a .h 

~ Ensemb l•Doo .h 

~Fon\Da\a.h 

~ Main'vlindow .c ~ Main'w'indow .h 

~ No\ebook .o ~ Notebook .h 

~CalcWindow.o ~CalcWindow.h 

~ Workshee1.c ~ Workshee\.h 

~ zEnsembleApp.c 

~ zEnsembleDoc.c 

~ zMain'vlindow .c 

~ zNo\ebook .c 

~ zCaloWindow.c 

~ zWorkshee\.c 

~ zEnsemb le App .h 

~ zEnsemb leDoc .h 

~ zMainWindow .h 

~ zNo\ebook .h 

~ zCalcWindow .h 

~ zWorkshee\.h 

The next series of steps discusses how these files are added 
and recompiled in the THINK C project. 

After the files have been generated, it is necessary to add any 
new files to the existing Ensemble.7t project and recompile 
the application to see its new default behavior. It is important 
to mention that all of the previously implemented capabilities 
are still present in the application, and only the additional 
Format menu command and Worksheet dialog will exhibit 
default behavior. 

The necessary steps to bring the project up to date are very 
similar to those presented in Chapter 6: 

1. Launch the THINK C application by double-clicking on 
the Ensemble.1t project file, and then choose the Add 
command from the Source menu. 

2. When the Add command is selected, THINK C will display 
a dialog in its upper portion listing any files in the current 
project that have not yet been added. This is shown in 
Figure 9-16. Notice that only the ·.c' files are shown. Their 
corresponding '.h' header files will also be added, auto
matically, to the project. Click the Add All button, as 
shown in the figure. 



Figure 9-16 
Adding the new files 
to the Ensemble 
project 

Figure 9-17 
Selecting Done after 
adding all the new 
files 
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lei Ensemble #4 default ""I 
[) Worksheet.c ~ =Dianne 
[) zWorksheet.c 

Desktop 

Done 

..... -............................................... , ____ , ..................................................................................................... .. 

~ 
~ fldd , 
111aa1111" 
[ flemm•<l ) 

3. After all the files have been added, their names will 
appear in the bottom portion of the dialog. Click the Done 
button, as shown in Figure 9-1 7. 

lei Ensemble #4 default ""I 
~ =Dianne 

Eject 

[ Desktop 

wn.ntM 
( Cancel ] 

................................................................................. ,,_,_ ·-·---.. -· .. --··--·---·-.. ··· 
Worksheet.c 
zWorksheet.c 

~n n<1<1 n 
Add All 

4. Notice that all of the files have been added to the Ensem
ble.n project file, as shown in Figure 9-18. 

5. The next step is to compile the files that need recompila
tion. This is accomplished by pulling down the Source 
menu and choosing the Make command. It is necessary 
to use the Make command, rather than the Bring Up To 
Date command from the Project menu, because, as far 
as THINK C is concerned, none of the existing files has 
been modified. 
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Figure 9-18 
All files added to 
Ensemble.Jr project 

Figure 9-19 
Click Use Disk to 
check for modified 
files 

Ensemble.n 
li:Name 
• CalcW'indow.c 
• EnsembleApp.c 
• EnsembleData.c 
• EnsembleDoc.c 
• EnsembleMain.c 
• F ontData .c 
• MainW'indow .c 
• Notebook .c 
• Yor-ksheet.c 
• z:CalcW'indow.c 
• z:Ensemb le App .c 
• z:Ensemb leDoc .c 
• z:MainW'indow .c 
• z:Notebook .c 
• z:Yor-ksheet.c 

obj siz:e 
6756 0 

336 r-

50 
252 
428 

2432 
0 

1118 
596 

1242 "'°" 012j 

6. When the Make command is chosen, TIHNK C will dis
play the dialog shown in Figure 9-19. You should click 
the Use Disk button, as shown in the figure, to force 
THINK C to examine the modification dates of the files 
and determine which ones have really been changed since 
it executed the last compilation of the project. As long as 
you modify files while inside the THINK C environment, it 
will keep track of which ones need to be recompiled. 
When you modify files outside the environment, you have 
to tell THINK C explicitly to look for modified files. 

Source files to compile: 0 
[ Check Rll 

Libraries to load: 0 
( Check Rll .c ) 

&alc'Window _c 
~ Ensemblel\pp.c ( [ hec:l: Nooe J 

Ensemblel>ata.c " EasembleDoc.c !·: ........ ,. ___ ............... 
EnsembleHain.c H11 

• 111·1-a Fontoata.c ~ I 

HainVindow .c ~· 181 Quick Scan 
Notebook.c 

"°" 
M<ike ( Don't Make ]) Cancel 

7. THINK C will scan the disk, looking for files that have 
been modified since its last update of the project, and will 



Figure 9-20 
Clicking Make to 
recompile the 
modified files 

Figure 9-21 
Revised Ensemble 
application running 
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place check marks next to their names in the dialog. It 
will also highlight the Make button at this point. You 
should click Make to instruct THINK C to compile the 
marked files, as shown in Figure 9-20. 

Source files to compile: 1 O 

Libraries to load: 

./CalcYindov .c 

./Ensemble App .c 

./EnsembleData.c 

./EnsembleDoc.c 

./EnsembleMain.c 

./FontData.c 

./MainVindov .c 

./Notebook.c 

0 

(- (Don't Make J 

' s File Edit Format 

(Untitled) 

Cell Num: 

[ Check All J 

[ Check All .c J 

[ Check None J 

Use Disk 

18] Quick Scan 

Cancel 

H 

,, ,24 CD ~ ' 
Ensemble. Tl 

• C4111cYindow .c 

• EnsembleApp.c 
• Ensemb 1e0411h .c 
+ Ensemble Doc .c 

• EnsembleH41in .c 
• Font0411h.c 
• HainYindov .c 
• Notebook .c 
• YorkshHt.c 
• zC411JcYindow .c 
• zEnsembleApp.c 

• zEnsembleDoc.c 

Data 

obj size 
6756 0 

336 i-
1940 

480 

so 
252 

428 

2432 
1068 

'!!:to 
894 r-

EnsembleMain.c 

t~::::i~:~dl~I 
! ex tern CAppl ic:ati on *gAp~ 
! void main () 

8. THINK C will recompile all the modified files and will 
update the project with the latest code. The application is 
ready to run inside the THINK C environment at this 
point. To execute the application, pull down the Project 
menu and choose the Run option. 
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Figure 9-22 
Choosing 
Ensemble's 
Worksheet 
command 

Figure 9-23 
Ensemble's default 
Worksheet dialog 

9. Figure 9-21 shows the revised application running, along 
with THINK C's project and debugging windows. 

10. To verify that AppMaker has generated code to enable the 
Worksheet dialog, pull down the Format menu and 
choose the Worksheet command, as shown in Figure 9-22. 

11. The default appearance of the Worksheet dialog that the 
application displays is shown in Figure 9-23. 

Font 
One 
TWO 
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Infinity 

Size 
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D Change TeHt Style 

0 Cell 

QRow 

®Column 

Cell: cellNum 

Height: I height 

Width: I width 

Style 

DBold 
D Italic 
D Underline 
D Outline 
0Shadow 
D Condense 
D EHtend 

Justification 

®Left 

O Center 

0 Right 

O Force Left 

I sample 

Options-------. 

Decimal Digits: I digits I 
D Dollars $ 999999.99 

D Commas 99,999,999 

Cancel ([ OK ll 

As you can see from the preceding steps, the full functionality 
of the Ensemble application has been retained and the Work
sheet dialog has been added. The next chapter will discuss 
the newly generated code resulting from these additions, and 
the chapter after that will describe the custom code additions 
that fully implement the Worksheet dialog's functionality. 
This is a good place to stop and take stock of the major 
changes that have been added to the application with ve:ry lit
tle effort. 
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1. Modify the style of the individual text items in the column 
of Style checkboxes to conform to the style names that 
they suggest. (Hint Look at AppMaker's Text Style dialog 
for an example of this.) 

2. Explain why the Change Text Style checkbox is neces
sary in the Worksheet dialog. 

3. Explain why names such as font and size are typed into 
the Ediffext fields when, in fact, they are defined inside 
AppMaker. What is the result if these fields are left blank? 

4. Determine what changes would be necessary to "interna
tionalize" the Worksheet dialog. 1 Implement these 
changes. 

1. Creating an international version of an application has far-reaching consequences. There are 
numerous features of the Ensemble application, such as its menus, that would need to be 
changed. Examining this topic as a standard part of a course in software development is 
highly recommended. 
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Examining the Format Worksheet 
Code 

This chapter examines the code generated by AppMaker in 
response to the added user interface elements described in 
Chapter 9: a Worksheet dialog and a new Worksheet com
mand in the Format menu. These additions have resulted in 
AppMaker's generation of four new files, which have been 
added to the Ensemble application project in the steps de
scribed in that chapter. The function of each file is as follows: 

•:• Worksheet.c contains the subclass methods for the Work
sheet dialog. It is the file that we will be customizing to a 
great extent. The generated code, to be described shortly, 
provides us with an extremely good skeletal module to 
which our custom code will be applied. 

•:• Worksheet.h contains the class declarations for the sub
class definitions generated into the Worksheet.c file. We 
will be examining the generated class declarations in it and 
adding new declarations when we customize the code. 

•:• zWorksheet.c contains the superclass methods for the 
Worksheet dialog. It contains the important code for creat
ing and initializing each of the user interface elements in 
the dialog. As with all superclass files, we will not be mak
ing any changes to this code. 

•:• zWorksheet.h contains the declarations for the superclass 
methods contained in the zWorksheet.c file. We will not be 
modifying any of these declarations. 

In addition to the new code included in the foregoing files, a 
few methods are affected in the preexisting superclass files. 

265 
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Table 10-1 
Customized methods 
to implement the 1/0 
for EditText and 
spreadsheet data 

Table 10-1 shows the generated code to be described in this 
chapter. 

Class Method Description 

ZEnsembleDoc UpdateMenus Enables Worksheet command 

ZEnsembleDoc DoCommand Handles Worksheet command 

ZWorksheet IZWorksheet Initialize worksheet dialog items 

ZWorksheet various misc. Lists creation methods and 
UpdateMenus Update Menus method 

Worksheet.c Do Worksheet Subclass method to manage the 
global function Worksheet dialog 

CList24 various Initializes and gets cell text 

CList28 various Initializes and gets cell text 

CWorksheet IWorksheet Initializes Worksheet dialog 

CWorksheet UpdateMenus Updates related menus 

CWorksheet DoCommand Handles worksheet-related 
commands 

CWorksheet ProviderChanged Handles BroadcastChange mes-
sages in the Worksheet dialog 

It is worthwhile to continue to emphasize that although App
Maker generates new code for all of the superclass files, it will 
never touch the code in any of the subclass files. 

Because the Worksheet.c and Worksheet.h files did not pre
viously exist, they were generated to contain routines that 
will be modified when we customize the Ensemble application 
to implement the worksheet styling features fully. In future 
code-generation sessions, however, AppMaker will refrain 
from modifying the subclass files. 

The New Ensemble Application Structure 

After the code has been generated (and with some license 
with regard to the point of connection of the Worksheet dia-
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log), the new code structure for the Ensemble application ap
pears as depicted in Figure I 0-1. 

main 
function ..... : 

f 

Chain of \ 

Command ••• ••• 

·· ............. ,,,_ _____ 
gGopher •• •••• ..__ __ _, ~---
Chainof •• ---. 

Command 

Although the generated code appears to attach the creation of 
the CWorksheet instance to the ZEnsembleDoc class, this is 
not how the CWorksheet instance will eventually be con
nected. The figure shows the state of the application with the 
CalcWindow active, and in that state, the gGopher variable 
points to the CCalcWindow instance. It is within the DoCom
mand method of the CCalcWindow class that the Worksheet 
dialog will be invoked. 

Examining the ZEnsembleDoc Code Changes 

Management of the document's windows is a responsibility of 
the CEnsembleDoc and ZEnsembleDoc classes. When a 
command is added to one of the document-related menus, 
the responsibility for any needed management and action as
sociated with that command is properly vested in the ZEn
sembleDoc class. 
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.DoCommand 
method code 
(beginning) 

In most cases, AppMak.er will automatically generate the ap
propriate code. If necessaiy, the generated code can be over
ridden in a corresponding method in the subclass file. In the 
case of the Worksheet dialog and its corresponding menu 
command, the generated code located in the ZEnsembleDoc 
superclass is just fine. The newly generated code for the Up
dateMenus method is as follows: 

void ZEnsembleDoc::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 
gBartender->EnableCmd (cmdNotebook); 
gBartender->EnableCmd (cmdWorksheet); 

In this code, AppMak.er has genemted an additional message 
to the gBartender instance to enable the Worksheet com
mand in the Format menu. This behavior will be slightly 
modified in the custom code, but only in the UpdateMenus 
method for the subclass. 

When the Worksheet command is chosen by the user from 
the Format menu, the Bartender sends a DoCommand mes
sage, with the command code, to the current instance held in 
the gGopher variable. If the CalcWindow window is active, 
the message will first be passed to the DoCommand method 
in the CCalcWindow module. If that method does not handle 
the message, it will eventually be passed on until it arrives in 
the DoCommand method in the ZEnsembleDoc superclass. 
We will provide code for handling this message in the custom
ized version of the code, presented in the next chapter. Al
though the generated code for this message will never be 
executed, it is worthwhile to examine it: 

void ZEnsembleDoc::DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdNotebook: 
DoNotebook (this); 

break; 
case cmdWorksheet: 

DoWorksheet (this); 
break; 
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method code 
(concluded) 
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default: 
inherited::DoCommand (theCommand); 

break; 

AppMaker has no information to the effect that the Work
sheet command isn't intended for use with the main docu
ment (as is the case with the Notebook command), so it 
generates code to invoke the dialog in the ZEnsembleDoc su
perclass. 

It happens that we will override the Notebook command in 
the CEnsembleDoc subclass and will handle the Worksheet 
command in the CCalcWindow class, but this is just an ap
propriate decision for the Ensemble application. 

Examining the Generated Code for ZWorksheet 

IZWorksheet 
method code 
(beginning) 

Mainly through its initialization method, the superclass code 
for the Worksheet dialog is responsible for creating the work
sheet window and all of its associated user interface elements 
(lists, checkboxes, radio buttons, etc.). In addition, the super
class contains an UpdateMenus method to forward the Up
dateMenus message to its CDirector ancestor in the TCL. 

The code for initializing the Worksheet dialog is quite 
lengthy, as there are quite a number of user interface ele
ments to instantiate and initialize. Nevertheless, we show it 
in its entirety: 

void ZWorksheet::IZWorksheet(CDirectorOwner *aSupervisor) 
{ 

CView *enclosure; 
CBureaucrat *supervisor; 

inherited:: IAMDialog Director (Worksheet ID, aSupervisor); 

enclosure = itsWindow; 
supervisor = itsWindow; 

OKButton = new CAMButton; 
OKButton->IViewRes ('CtlP', 146, enclosure, supervisor); 
CancelButton = new CAMButton; 
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IZWorksheet 
method code 
(continued) 

CancelButton->IViewRes ('CtlP', 147, enclosure, supervisor); 

Fontlabel = new CAMStaticText; 
Fontlabel->IViewRes ('AETx', 136, enclosure, supervisor); 

Sizelabel = new CAMStaticText; 
Sizelabel->IViewRes ('AETx', 137, enclosure, supervisor); 

Stylelabel = new CAMStaticText; 
Stylelabel->IViewRes ('AETx', 138, enclosure, supervisor); 

BoldCheck = new CAMCheckBox; 
BoldCheck->IViewRes ('CtlP', 150, enclosure, supervisor); 

ltalicCheck = new CAMCheckBox; 
ltalicCheck->IViewRes ('CtlP', 151, enclosure, supervisor); 
UnderlineCheck = new CAMCheckBox; 
UnderlineCheck->IViewRes ('CtlP', 152, enclosure, supervisor); 
OutlineCheck = new CAMCheckBox; 
OutlineCheck->IViewRes ('CtlP', 153, enclosure, supervisor); 

ShadowCheck = new CAMCheckBox; 
ShadowCheck->IViewRes ('CtlP', 154, enclosure, supervisor); 

CondenseCheck = new CAMCheckBox; 
CondenseCheck->IViewRes ('CtlP', 155, enclosure, supervisor); 

ExtendCheck = new CAMCheckBox; 
ExtendCheck->IViewRes ('CtlP', 156, enclosure, supervisor); 

Justificationlabel =new CAMStaticText; 
Justificationlabel->IViewRes ('AETx', 139, enclosure, supervisor); 

fontField = new CAMDialogText; 
fontField->IViewRes ('ADTx', 131, enclosure, supervisor); 

sizeField = new CAMDialogText; 
sizeField->IViewRes ('ADTx', 132, enclosure, supervisor); 

Group16 = new CRadioGroupPane; 
Group16->IViewRes ('Pane', 132, enclosure, supervisor); 
CenterRadio =new CAMRadioControl; 
CenterRadio->IViewRes ('CtlP', 157, Group16, Group16); 
RightRadio =new CAMRadioControl; 
RightRadio->IViewRes ('CtlP', 158, Group16, Group16); 
ForceleftRadio =new CAMRadioControl; 
ForceleftRadio->IViewRes ('CtlP', 159, Group16, Group16); 
LeftRadio = new CAMRadioControl; 
LeftRadio->IViewRes ('CtlP', 160, Group16, Group16); 
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Scro11Pane21 = new CScrollPane; 
ScrollPane21->IViewRes ('ScPn', 137, enclosure, supervisor); 

Rect23 = new CAMBorder; 
Rect23->IViewRes ('Bord', 139, Scro11Pane21, supervisor); 

List24 = Newlist24 (); 
List24->IViewRes ('ATbl', 141, Rect23, supervisor); 

Scro11Pane21->lnsta11Panorama (List24); 

Scro11Pane25 =new CScrollPane; 
ScrollPane25->IViewRes ('ScPn', 138, enclosure, supervisor); 

Rect27 = new CAMBorder; 
Rect27->IViewRes ('Bord', 140, Scro11Pane25, supervisor); 

List28 = Newlist28 (); 
List28->1ViewRes ('ATbl', 142, Rect27, supervisor); 

Scroll Pane25-> Install Panorama (List28); 

sampleField = new CAMDialogText; 
sampleField->IViewRes ('ADTx', 133, enclosure, supervisor); 

Heightlabel = new CAMStaticText; 
Heightlabel->IViewRes ('AETx', 148, enclosure, supervisor); 

Widthlabel =new CAMStaticText; 
Widthlabel->IViewRes ('AETx', 149, enclosure, supervisor); 

Celllabel = new CAMStaticText; 
Celllabel->IViewRes ('AETx', 150, enclosure, supervisor); 

heightField = new CAMDialogText; 
heightField->IViewRes ('ADTx', 140, enclosure, supervisor); 

widthField =new CAMDialogText; 
widthField->IViewRes ('ADTx', 141, enclosure, supervisor); 

Group35 = new CRadioGroupPane; 
Group35->IViewRes ('Pane', 135, enclosure, supervisor); 
RowRadio = new CAMRadioControl; 
RowRadio->IViewRes ('CtlP', 171, Group35, Group35); 
CellRadio =new CAMRadioControl; 
CellRadio->IViewRes ('CtlP', 172, Group35, Group35); 
ColumnRadio = new CAMRadioControl; 
ColumnRadio->IViewRes ('CtlP', 173, Group35, Group35); 
OptionsGroup = new CLabeledGroup; 
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IZWorksheet 
method code 
(con.eluded) 

OptionsGroup->IViewRes ('LGrp', 128, enclosure, supervisor); 

DecimalDigitsLabel = new CAMStaticText; 
DecimalDigitsLabel->IViewRes ('AETx', 147, OptionsGroup, 

supervisor); 

digitsField = new CAMDialogText; 
digitsField->IViewRes ('ADTx', 138, OptionsGroup, supervisor); 

Dollars99999999Check = new CAMCheckBox; 
Dollars99999999Check->IViewRes ('CtlP', 169, OptionsGroup, 

supervisor); 
Commas99999999Check = new CAMCheckBox; 
Commas99999999Check->IViewRes ('CtlP', 170, OptionsGroup, 

supervisor); 

cellNumLabel = new CAMStaticText; 
cellNumLabel->IViewRes ('AETx', 151, enclosure, supervisor); 

ChangeTextStyleCheck =new CAMCheckBox; 
ChangeTextStyleCheck->IViewRes ('CtlP', 174, enclosure, 

supervisor); 

The first action of the IZWorksheet method is to call the IAM
DialogDirector method, which is supplied in a library pro
vided with the AppMaker product. IAMDialogDirector 
creates a new dialog window, with the location and size spec
ified in the Ensemble.7t.rsrc resource file. 

When the IAMDialogDirector method returns, a new dialog 
window will have been established, to which the current IZ
Worksheet method can add instances of all the user interface 
elements. AppMaker automatically generates code to create 
instances of every user interface element and then initializes 
each element from its corresponding resource template set
tings (calling the IViewTemp) method. Each item is named 
according to its stated name (e.g., Font, which results in the 
creation of a C.AMStaticText field with the name FontLabel) 
or by the type of object it represents (e.g., borders are named 
beginning with the word Rect and lists with the word List). 

We have typed names into all the CDialogText fields, so that 
AppMaker will give them those names when it generates 
code. For example, the font name text field, which will show 
the name of the currently selected font, was named font 
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when we created the dialog. AppMaker's generated code for 
this element names it fontField. If you fail to type a name 
into these CDialogText fields, AppMaker will give them 
names like Fieldl, Field2, etc. 

When the IZWorksheet method completes execution, all of 
the user interface elements will have been created and placed 
into the dialog's window. The code to display the dialog is 
contained in the DoWorksheet function, which will be dis
cussed later in the chapter. 

Two additional routines that are involved with the creation of 
the user interface elements are generated in the ZWorksheet 
class. These are the NewList24 and NewList28 methods, 
whose code is as follows: 

II The only purpose of this function is so that you can override it 
II to create the list as your subclass of CAMTable 
CAMTable *ZWorksheet::Newlist24(void) 
{ 

CAMTable *thelist; 

thelist = new CAMTable; 
return (thelist); 

/*----------*I 
II The only purpose of this function is so that you can override it 
II to create the list as your subclass of CAMTable 
CAMTable *ZWorksheet::Newlist28(void) 
{ 

CAMTable *thelist; 

thelist =new CAMTable; 
return (thelist); 

Note that AppMaker has also generated comments that indi
cate the purpose of generating these functions in the super
class module. Their only purpose is to be overridden in the 
subclass module. You will also find that the subclass imple
mentation creates a subclass of these lists, in order to over
ride their GetCellText method (as required by the TCL). The 
IViewTemp method is also overridden in the subclass, so 
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that special initialization code can be added for these tables. 
This will all be covered later. 

The remaining method, generated into the ZWorksheet class, 
is UpdateMenus, whose code is as follows: 

void ZWorksheet::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

As is readily apparent, the UpdateMenus method merely 
calls its inherited UpdateMenus method. This allows the TCL 
to handle enabling or disabling any menu commands at the 
higher level. 

It is important to point out that most methods call an inher
ited method before they perform any unique, special func
tions. This is to allow the TCL to perform its intended 
functions before more detailed, context-sensitive functions 
are performed. Because each call to the inherited method oc
curs first, the highest level of the TCL is the first to perform 
any actions on the specified object. When it completes its in
tended functions, control reverts to the next lower level, and 
so forth, down to the lowest subclass method in the calling 
hierarchy. The lowest subclass always has the last word. This 
is a very powerful feature of object-oriented programming. 

Examining the Code for the Worksheet Subclass 

CWorksheet class 
declaration 
(beginning) 

All of the remaining generated code, related to the new Work
sheet menu command and its associated dialog, is contained 
in the Worksheet.c and Worksheet.h files. The latter con
tains the class declarations for the CWorksheet, CList24, 
and CList28 classes, as well as a prototype for the DoWork
sheet global function. The declaration for the CWorksheet 
class is as follows: 

class CWorksheet : public ZWorksheet 
{ 
public: 

virtual void IWorksheet(CDirectorOwner *aSupervisor); 
void UpdateMenus(void); II is override 
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declaration 
(concluded) 

Do Worksheet 
method code 
(beginning} 
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void DoCommand (long theCommand); II is override 

protected: 
void ProviderChanged(CCollaborator *aProvider, 

CAMTable 
CAMTable 

long reason, 
void* info); 

*Newlist24(void); 
*Newlist28(void); 

II is override 
II is override 
II is override 

The declaration provides three public methods, callable by 
any class method, and three protected methods, callable only 
by methods in the CWorksheet class or its subclasses. 

In addition to the CWorksheet class declaration, there are 
declarations for the CList24 and CList28 classes. These will 
be shown later. Of immediate concern is the DoWorksheet 
global function, which is called in the DoCommand method 
of the ZEnsembleDoc class, as shown on page 268. 

The generated code for the DoWorksheet function is respon
sible for creating the CWorksheet object, initializing the user 
interface elements contained in the dialog, and managing the 
execution of the dialog, indicating to the program in which 
manner the user chose to terminate the dialog's execution (ei
ther by clicking the OK or the Cancel button). The code is as 
follows: 

void DoWorksheet(CDirectorOwner *aSupervisor) 
{ 

CWorksheet *dialog; 
long dismisser; 

dialog = NULL; 
TRY 
{ 

dialog = new CWorksheet; 
dialog->IWorksheet (aSupervisor); 

/*initialize dialog panes *I 

dialog->BeginDialog (); 
dismisser= dialog->DoModalDialog (cmdOK); 

if (dismisser== cmdOK) 
{ 
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Do Worksheet 
method.code 
(concluded) 

CList24and 
CList28 class 
declarations 
(beginning} 

/*extract values from dialog panes*/ 

dialog->Dispose (); 
} 
CATCH 
{ 

ForgetObject (dialog); 
} 
ENDTRY; 

The first action of the DoWorksheet function is to create an 
instance of the CWorksheet object and then store this into a 
local variable called dialog. The function then calls the sub
class !Worksheet method for that object, which in turn calls 
the IZWorksheet method that was displayed in the code list
ing beginning on page 269. After the initialization is com
plete, the generated code suggests, via a comment, that you 
perform any custom initialization of the dialog's user inter
face elements. Following this, the generated code calls the 
BeginDialog and DoModalDialog methods, to show and op
erate the dialog, respectively. The variable dismisser con
tains either the value cmdOK or cmdCancel upon return 
from operating the dialog. The generated code suggests, via a 
comment, that you place the code to extract values from the 
dialog panes after it has been determined that the user dis
missed the dialog by clicking the OK button. The DoWork
sheet function sends a Dispose message to the dialog prior 
to returning to the caller. In the event that an error is de
tected, the code in the CATCH block will be executed. 

Each of the lists (font and size) in the dialog is represented by 
a custom class definition. The Worksheet.h file contains the 
declarations for these classes, as follows: 

class CList24 : public CAMTable 
{ 
public: 

void IViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData); II is override 

void GetCellText (Cell aCell, 
short availableWidth, 
StringPtr itsText); II is override 

}; 
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(concluded) 

IViewTemp and 
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method code 
(begiJUling) 
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class Clist28 : public CAMTable 
{ 
public: 

void IViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData); II is override 

void GetCellText(Cell aCell, 
short availableWidth, 
StringPtr itsText); II is override 

}; 

Note that for each of these two class declarations an IView
Temp and GetCellText method is defined. Each of these is 
an override of the corresponding method in the TCL. It is nec
essaiy to override the TCL to perform the appropriate initial
ization and return the correct cell text value. 

The code for the corresponding CList24 and CList28 meth
ods is identical. The code for the IViewTemp and GetCell
Text methods for CList24 is as follows: 

void CList24::1ViewTemp (CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

II any additional initialization for your subclass 
AddRow (4, O); II e.g., add 4 rows at the beginning of the list 

voidCList24::GetCellText (Cell aCell, 
short availableWidth, 
StringPtr itsText) 

II replace with your own code which uses the cell coordinates 
II to access your private data structures, 
II then convert the cell data to a Str255 
switch (aCell.v) { 

case O: 
CopyPString ("\pOne", itsText); 

break; 
case 1: 

CopyPString ("\pTwo", itsText); 
break; 

case 2: 
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IViewTemp wui 
GetCellText 
methDdcode 
(concluded) 

}; 

CopyPString (''\pThree", itsText); 
break; 

default: 
CopyPString ("\plnfinity", itsText); 

break; 

This code is very similar to the corresponding code shown for 
the Notebook dialog's list classes, beginning on page 79. 
AppMaker initializes each list with four rows of cells, and the 
template is already initialized to create a single column of 
data. All of this code in both methods is intended as an exam
ple only. It will be completely replaced in our custom code 
that is described in Chapter 11. 

The code for the CList28 class's IViewTemp and GetCell
Text methods is identical to what has been generated for the 
CList24 class, except that the class name in the method def
inition headers is CList28. 

The CWorksheet subclass contains several methods that 
complete the picture of the added functionality. The first of 
these is the !Worksheet method, which was called by the 
DoWorksheet function (page 275), to perform any special ini
tialization of the dialog's elements. The code for !Worksheet 
is as follows: 

void CWorksheet::IWorksheet(CDirectorOwner *aSupervisor) 
{ 

inherited:: IZWorksheet ( aSupervisor); 

II any additional initialization for your dialog 

As is apparent, the generated code merely calls the inherited 
IZWorksheet code, which was shown on page 269. We will be 
adding further initialization code to !Worksheet as shown in 
the next chapter. 

The code to override the creation of the two list objects (CList24 
and CList28) is identical with the exception of the class names. 
The code to create the CList24 object is as follows: 
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CAMTable *CWorksheet::Newlist24 (void) 
{ 

Clist24 *thelist; 

thelist = new Clist24; 
return (thelist); 

For the CList24 and CList28 objects, new instances are cre
ated. Both of these are subclasses of AppMaker's CAM:Table 
library class. 

The CWorksheet class also contains an UpdateMenus 
method, which merely calls the inherited method. The gener
ated code is as follows: 

void CWorksheet:: UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

Two particularly important methods complete the code gener
ation for the CWorksheet subclass. The first of these is the 
DoCommand method, whose code is fairly lengthy: 

voidCWorksheet::DoCommand(longtheCommand) 
{ 

switch (theCommand) { 
case cmdBoldCheck: 

/* DoBoldCheck ();*I 
break; 

case cmdltalicCheck: 
/* DoltalicCheck ();*/ 

break; 
case cmdUnderlineCheck: 

/* DoUnderlineCheck ();*/ 
break; 

case cmdOutlineCheck: 
/* DoOutlineCheck ();*/ 

break; 
case cmdShadowCheck: 

/* DoShadowCheck ();*/ 
break; 

case cmdCondenseCheck: 
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DoCommand 
method code 
(concluded) 

/* DoCondenseCheck ();*/ 
break; 

case cmdExtendCheck: 
/* DoExtendCheck ();*/ 

break; 
case cmdCenterRadio: 

/* DoCenterRadio ();*/ 
break; 

case cmdRightRadio: 
/* DoRightRadio ();*/ 

break; 
case cmdForceleftRadio: 

/* DoForceleftRadio ();*/ 
break; 

case cmdleftRadio: 
/* DoleftRadio ();*/ 

break; 
case cmdRowRadio: 

/* DoRowRadio ();*/ 
break; 

case cmdCellRadio: 
/* DoCellRadio ();*/ 

break; 
case cmdColumnRadio: 

/* DoColumnRadio ();*/ 
break; 

case cmdDollars99999999Check: 
/* DoDollars99999999Check ();*/ 

break; 
case cmdCommas99999999Check: 

/* DoCommas99999999Check ();*/ 
break; 

case cmdChangeTextStyleCheck: 
/* DoChangeTextStyleCheck ();*/ 

break; 
default: 

inherited::DoCommand (theCommand); 
break; 

The default-generated code for the DoCommand method pro
vides the ability to take action whenever a checkbox or radio 
button is clicked, while the user is operating the dialog. This 
gives us the opportunity to change the appearance of the dia
log items when these events occur. The DoCommand method 
is called for these actions because the resource templates for 
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the checkbox and radio button objects contain "click com
mands," which are transparently assigned when the object's 
IViewTemp method is called. We will be enhancing DoCom
mand in the next chapter to provide visible changes to the di
alog when these commands are dispatched. 

The final method, one that provides very powerful "hooks" for 
processing user-created events, is called ProviderChanged. 
This method is called whenever a user interface element 
sends a BroadcastChange message to the TCL. The gener
ated code for this method is also fairly long: 

void CWorksheet::ProviderChanged(CCollaborator *aProvider, 
long reason, 
void* info) 

if (aProvider == fontField) { 

} 

if (fontField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == sizeField) { 

} 

if (sizeField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == List24) { 

} 

if (List24->HasSelection ()) { 
II perhaps activate some buttons 

} else { 
II perhaps deactivate 

if (aProvider == List28) { 

} 

if (List28->HasSelection ()) { 
II perhaps activate some buttons 

} else { 
II perhaps deactivate 

if (aProvider == sampleField) { 
if (sampleField->Getlength () == 0) { 

II text is empty 
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ProviderChanged 
method code 
(concluded) 

Exercises 

} else { 
II there is some text 

} 
if (aProvider == heightField) { 

} 

if (heightField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == widthField) { 
if (widthField->Getlength () == 0) { 

II text is empty 
} else { 

II there is some text 

if (aProvider == digitsField) { 
if (digitsField->Getlength () == 0) { 

II text is empty 
} else { 

II there is some text 

The ProviderChanged method is called whenever a keystroke 
occurs in one of the TextEdit fields or when any of the font or 
size list elements is selected. We will be enhancing its code to 
provide visual feedback when the list selections occur. The 
code relating to the text fields will be deleted. 

1. Examine Figure 10-1 and note the difference between the 
ancestors of the CMainWindow and CCalcWindow 
classes. Explain why these differ and in what ways they 
are the same. (Hint Examine the class hierarchy in the 
THINK C Browser window.) 

2. Describe the similarities in the generated code for the 
Notebook dialog and the Worksheet dialog. Explain in 
what way these similarities are beneficial to the develop-
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ment of large applications that include many dialog boxes 
in their user interface designs. 

3. Explain the need for the NewLislj_ methods, for each of 
the lists, in both the superclass and subclass files. What 
is the distinction between the two methods? 

4. Explain the purpose of the unusable code generated into 
the GetCellText methods. In what way does this aid in 
the future customizing of these methods? 

5. At this point in the Ensemble application's development, 
what customization would be needed for the DoCom
mand method in the CWorksheet class. Don't peek into 
the next chapter to formulate your answer. 

6. What sort of customization would be needed for the 
CWorksheet class's ProviderChanged method? Why is 
code generated to handle empty text fields and fields that 
contain text? What purpose could handling an empty text 
field serve? 



Chapter 11 

Customizing the Format Worksheet 
Code 

This chapter describes the additions and modifications to the 
source files that implement the Ensemble application, with 
the intent of showing how the Worksheet menu and dialog 
box functionality are fully implemented. The changes concern 
a limited number of (both source and header) files in the ap
plication, including CEnsembleData, CalcWindow, and 
Worksheet. In addition, we will create entirely new source 
and header files called CellData.c and CellData.h. These im
plement a new class of data describing the style characteris
tics of a row, column, or cell instance. 

Because we wish to save the style information associated 
with the worksheet rows, columns, and cells, we will be mod
ifying the ReadData, WriteData, ReadStyles, WriteStyles, 
ReadWSEntries, and WriteWSEntries methods in the CEn
sembleData class. Of course, this will make any existing 
spreadsheet files incompatible with the new format; however, 
to convert the existing files, we first modified only the Write
Data and WriteWSEntries methods, then added the Write
Styles method, and, finally, wrote out the existing file that 
had been read with the older ReadData method. We then 
added the changes to the ReadData and ReadWSEntries 
methods and then coded the ReadStyles method so that the 
new format could be read. 

This book examines the development of a single application 
version (albeit in an evolutionary manner). and it does not be
hoove us to have subsequent files be compatible with files 
written in an earlier format. If this were necessary, we would 
make provisions to ease the transition from one version to 
another. For example, we could easily add a code at the be
ginning of the file to indicate the version of the application 

285 
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with which it was written and then add the necessary code in 
the 1/0 methods to handle the differences between the vari
ous versions. 

Adding a CCellData Class 

We continue our practice of encapsulating new data entities 
(as with the FontData class) by creating a new class to hold 
the distinctive information for the Worksheet styles. The 
header file, containing the declarations of the CCellData 
class, is as follows: 

/* CellData.h -- CCellData class*/ 
#define _H_CellData 
#include <CObject.h> 

II 
II cell info structure definition 
II 
typedef struct 
{ 

short isDefault; 
short cellMetric; 
short fontNumber; 
short fontSize; 
short fontStyle; 
short fontAlign; 
short decimalDigits; 
short commas; 
short dollars; 

} celllnfo; 

class CCellData : public CObject 
{ 
public: 

celllnfo cellData; 
void ICellData(celllnfo stylelnfo); 

}; 

The CCellData class contains a single instance variable, 
which is a structure holding all the important style informa
tion associated with a row, column, or cell. The fields of the 
structure are initialized by the ICellData method, and these 
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fields are public to facilitate their modification by methods in 
the other classes. The ICellData method code is as follows: 

void CCellData::ICellData{celllnfo stylelnfo) 

cellData.isDefault = stylelnfo.isDefault; 

cellData.cellMetric = stylelnfo.cellMetric; 

cellData.fontNumber = stylelnfo.fontNumber; 

cellData.fontSize = stylelnfo.fontSize; 

cellData.fontStyle = stylelnfo.fontStyle; 

cellData.fontAlign = stylelnfo.fontAlign; 

cellData.decimalDigits = stylelnfo.decimalDigits; 

cellData.commas = stylelnfo.commas; 

cellData.dollars = stylelnfo.dollars; 

Basically, the intention is that the method creating the CCell
Data instance will supply the initial values for the structure's 
fields. We will be illustrating how this is done in a number of 
different circumstances. 

For example, if a CCellData instance is being created (for a 
newly created cell entry). and no style information currently 
exists for the cell, row, or column, then the style information 
must be obtained by querying the CTable instance to deter
mine the default font, style, size, and alignment and also to 
provide default settings for the Options (decimal digits, com
mas, and dollar sign). 

If the newly created CCellData instance is associated with a 
cell, column, or row for which style information is already 
available, then the appropriate existing style information is 
passed to the initialization method. 

In all cases, if a cell style already exists, it takes precedence 
over a column style, which, in turn, takes precedence over a 
row style. A style can be applied to a cell without previously 
creating an entry for that cell. In that case, a dummy entry is 
created that shows up as a blank cell in the worksheet. 
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Customizing the CEnsembleData Code 

Table 11-1 
Customized methods 
to implement text 
styles for the 
worksheet data 

As previously stated, the modifications to the CEnsemble
Data class, to implement the new styled text worksheet en
tries, are limited to the methods shown in Table 11-1. 

Class Method Description 

CEnsembleData IEnsembleData Provides new lists for row & col-
umn styles 

CEnsembleData WriteData Writes text and worksheet docu-
mentdata 

CEnsembleData WriteStyles Writes style data 

CEnsembleData WriteWSEntries Writes worksheet entries 

CEnsembleData ReadData Reads text and worksheet docu-
mentdata 

CEnsembleData ReadStyles Reads style data 

CEnsembleData ReadWSEntries Reads worksheet entries 

CEnsembleData GetHList Accesses column and row style 
GetVList lists from other classes 

Modifying the Initialization Code 

The existing initialization code for the CEnsembleData class 
provides for the creation of a CCluster object to hold the 
worksheet array data. The revised IEnsembleData method 
must also make provision for storing style information per
taining to entire rows or columns of the worksheet. 

We decided to create two new CList objects, called itsHList 
and itsVList, to contain the column and row style informa
tion, respectively. The handles to these lists will also be 
passed to the CalcWindow code when requested, to provide 
access to the style information in that class. As has been our 
practice from the beginning, ownership of all the data is 
vested in the CEnsembleData class. 
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IEnsembleData Method Code 

The new version of the IEnsembleData method is as follows: 

voidCEnsembleData::IEnsembleData{CDocument*theDocument) 
{ 

inherited::IDataFile {); 
hasFile =FALSE; 
itsDocument = theDocument; 
itsEditTextData =NULL; 

II 
II allocate the main worksheet cluster and the 
II H-Label & V-Label lists and initialize them 
II 
itsCluster = new CCluster; 
itsCluster-> I Cluster{); 
itsHList = new Clist; 
itsHList->IList(); 
itsVList = new Clist; 
itsVList->IList{); 

The CList class was chosen to contain the row and column 
style data because this "container class" provides ordered 
storage of the data. To locate the entry for the ith row or col
umn. the code will be able to use a direct, random-access 
method. We will keep an entry in the list for every row and 
column. This requires that we maintain only 76 entries with 
the current dimensions of our worksheet (26 columns + 50 
rows). 

Modifying the Input/Output Code 

Table 11-1 shows the input/output methods that require 
modification for reading and writing the worksheet style en
tries. Before presenting the modified methods, it will be use
ful to show the modified file format. so that the code used in 
the methods will make more sense. 

The file format has been changed only to support the addition 
of the row and column style entries. The worksheet entries 
themselves are also larger than in the previous implementa
tion, to include style information for individual cells. The eas-
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Figure 11-1 
Ensemble file format 

iest way to present the new format is to show a layout 
diagram for the file (Figure 11-1). 

Text Size Worksheet Entries Text Style Data MainWlndow Text (tt any) 

J (I bytes) 

+4 +8 +16 

cots rows col styles row styles Worl<sheet Entries (ff any) 
(c bytes) (r bytes) (wbytes) 

16+t 16+t+2 16+t+4 16+t+4+c 16+t+4+c+r 16+t+4+c+r+w 

The file begins with two 4-byte integers, which define the 
length of the text in the MainWindow and the number of 
worksheet entries. If no text is present, then the text length 
will be 0, and no Text Style Data or MainWindow Text will 
follow. Instead, the worksheet-related data (if any) will follow. 
If no worksheet data are present, then the Ensemble file will 
contain only the two 4-byte integer values (each of which will 
be 0). 

The Text Style Data, if present, consists of the font, size, 
style, and alignment information for the text to be displayed 
in the MainWindow. The MainWindow Text is the actual 
text to be displayed. 

The worksheet-related data, if present, consists of two 2-byte 
integer values that indicate the number of columns and rows, 
respectively, in the worksheet. These values are written to the 
file to make allowances for different-size worksheet defini
tions. Following the column and row sizes are the col styles 
and row styles entries, which specify the styles of each of the 
(currently defined) 26 columns and 50 rows. 

The Worksheet Entries are last. The initial 4-byte worksheet 
entry count specifies how many entries are contained in this 
last section of the file. 

WriteData Method Code 

The first section of code in the new version of the application 
is the main WriteData method. This has been modified only 
slightly, to allow writing the worksheet style data to the file. 
The code for this method is almost identical to that for the 
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version described in Chapter 8, except for the addition of the 
call to the WriteStyles method. The new code is as follows: 

Boolean CEnsembleData::WriteData(void) 
{ 

CMainWindow *theTextWindow; 
long textLength, WSEntryCt, fileLength; 
fontinfo the Fontinfo; 

theTextWindow = ((CEnsembleDoc *)itsDocument)->GetTextWindow(); 
itsEditTextData = the TextWindow->GetEditTextHandle(); 
textLength = GetHandleSize(itsEditTextData); 
WSEntryCt = itsCluster->GetNumltems(); 
FailOSErr (SetFPos( refNum, fsFromStart, OL)); 
WriteSome ((Ptr)&textLength, (long) sizeof(long)); 
WriteSome ((Ptr)&WSEntryCt, (long) sizeof(long)); 
if(textLength > 0) 
{ 

} 

theFontlnfo = ((CEnsembleDoc *) itsDocument)->theTextData 
->GetFontData(); 

WriteSome ((Ptr)&theFontlnfo, sizeof (fontinfo)); 
WriteSome (*itsEditTextData, textLength); 

if(WSEntryCt > 0) 
{ 

} 

WriteStyles (); 
WriteWSEntries (WSEntryCt); 

fileLength = GetLength(); 
FailOSErr(SetEOF( refNum, fileLength)); 
FailOSErr( FlushVol( NULL, volNum)); 
return (TRUE); 

The first action of the WriteData method is to send a mes
sage to the CEnsembleDoc class to get a handle to the text 
window instance (GetTextWindow). Once the text window 
handle is returned, the WriteData method can access the 
text itself, by sending the window a GetEditTextHandle mes
sage. The handle to the Ediffext data is stored into the in
stance variable itsEditTextData. Getting the size of this 
handle into the local 4-byte (long) textLength variable tells 
us how many bytes of text must be written. 

Getting the number of worksheet entries is much easier and 
is accomplished by sending a GetNumltems message to the 
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itsCluster instance and storing the returned value in the 4-
byte (long) WSEntryCt variable. 

When the previous actions are complete, we know whether 
the file will contain text and/ or worksheet data. The method 
proceeds by setting the file position to the beginning of the 
file and then writing the contents of the two 4-byte variables. 

The next section of code tests whether the textLength is 
greater than 0, and if so, the text style data are retrieved from 
the document and written to the file, followed by the text it
self. If the textLength is 0, then nothing is written in this 
section of the file. 

The section that follows tests whether the WSEntryCt value 
is greater than 0, and if so, it calls the WriteStyles method, 
followed by the WriteWSEntries method. If no worksheet en
tries exist, then nothing is written in this section of the file. 

The final section of the code gets the length of the file, sets 
the logical end-of-file marker to the point corresponding to 
the length, and calls the FlushVol method to ensure that any 
data remaining in the file's buffer have been written out to 
the disk. 

WriteStyles Method Code 

The WriteStyles method is responsible for writing the row 
and column style entries if worksheet entries are present in 
the current worksheet window. In the present implementa
tion, we first write out the number of columns and rows in 
the worksheet and then write the style entries for the col
umns and rows. An entry is written for each column and row, 
for a total of 76 entries (26 columns and 50 rows). The cols 
and rows values allow for a different number of columns and 
rows, enabling files to be interchanged between two users 
who employ different worksheet sizes. The code for the Wrlte
Styles method is as follows: 

void CEnsembleData::WriteStyles(void) 
WriteStyles method { 
code (beginning) CCellData *aStyle; 

short cols, rows; 
short index; 
cols = itsHList->GetNumltems(); 
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code (concluded) 

WriteWSEntries 
method code 
(beginning) 
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rows= itsVList->GetNumltems(); 
WriteSome( (Ptr)&cols, sizeof(short)); 
WriteSome( (Ptr)&rows, sizeof( short)); 
for(index=O; index< cols; index++) 
{ 

aStyle = (CCellData *)itsHList->Nthltem (index+ 1 ); 
WriteSome((Ptr)&index, sizeof(short)); 
WriteSome( ( Ptr)&aStyle->cell Data, sizeof( cell Info)); 

for(index=O; index< rows; index++) 
{ 

aStyle = (CCellData *)itsVList->Nthltem (index+ 1 ); 
WriteSome( (Ptr)&index, sizeof(short)); 
WriteSome( (Ptr)&aStyle->cellData, sizeof( cell Info)); 

The WriteStyles code first accesses the number of columns 
and rows in the spreadsheet, by sending each corresponding 
list a GetNumltems message, and then writes the returned 
values to the file as 2-byte (short) integers. Following this, a 
loop is used to write out each of the column style entries, fol
lowed by a loop to write out each of the row style entries. The 
entries are accessed from their corresponding lists, in order, 
by column or by row. 

WriteWSEntries Method Code 

The WriteWSEntries method has been modified to write out 
the style information for each cell, in addition to the cell's en
try string, as was described on page 195. The revised code is 
as follows: 

void CEnsembleData::WriteWSEntries (long entryCount) 
{ 

WSCellEntry 
short 
long 
Str255 
CWSEntry 

anEntry; 
index; 
WSEntryCt; 
entryData; 
*aWSEntry; 

for(index = 1; index<= entryCount; index++) 
{ 

itsCluster->Getltem (&aWSEntry, index); 
FailNIL (aWSEntry); 
anEntry.WSCell = aWSEntry->GetWSCell(); 
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WriteWSEntries 
method code 
(concluded) 

anEntry.WSType = aWSEntry->GetWSType(); 

anEntry.WSStyle = aWSEntry->GetWSStyle(); 
aWSEntry->GetWSEntry( entryData); 
anEntry.WSSize = entryData[O]; 
WriteSome ((Ptr)&anEntry, sizeof(WSCellEntry)); 
WriteSome ((Ptr)&entryData[1], (long) entryData[O]); 

The difference between the new and the previous code is the 
call to the new GetWSStyle access method and the storage of 
the data from the style instance into the WSCellEntry struc
ture. The new definition of the WSCellEntry structure is con
tained in the EnsembleData.h file and has been enhanced 
from the version shown on page 190. The new format of the 
WSCellEntry structure is as follows: 

typedef struct 
{ 

Cell WSCell; 
short WSType; 
celllnfo WSStyle; 
short WSSize; 

} WSCellEntry; 

Note that the only difference between the two structure defi
nitions is the inclusion of the WSStyle field in the one and its 
absence in the other. 

The WriteWSEntries method accesses the style information 
for the cell and then stores it into the WSCellEntry structure, 
to be written out along with the other descriptive data. As be
fore, the WSSize field specifies the length of the entry string 
that follows the structure in the file. 

ReadData Method Code 

The ReadData method is the mirror image of the WriteData 
method. It must read the data in the same format in which 
the data were written, so it has been modified only slightly, to 
account for the style information that is now contained in the 
file. The code for the ReadData method is as follows: 
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voidCEnsembleData::ReadData(void) 
{ 

long textlength, WSEntryCt; 
fontinfo theFontlnfo; 

TRY 
{ 

FailOSErr (SetFPos( refNum, fsFromStart, OL)); 
ReadSome( (Ptr)&textlength, sizeof(long)); 
ReadSome( (Ptr)& WSEntryCt, sizeof(long)); 

if(textlength > 0) 
{ 

ReadSome((Ptr)&theFontlnfo, sizeof (fontinfo)); 
((CEnsembleDoc *) itsDocument)->theTextData 

->SetFontData (theFontlnfo); 

itsEditTextData = NewHandleCanFail(textlength); 
FailNIL(itsEditTextData); 
ReadSome(*itsEditTextData, textlength); 

if(WSEntryCt > 0) 
{ 

ReadStyles(); 
ReadWSEntries(WSEntryCt); 

} 
CATCH 
{ 

ForgetHandle (itsEditTextData); 
} 
ENDTRY; 

The only difference between this code and the equivalent code 
described in Chapter 8 is the inclusion of the call to Read
Styles in the section following the test for a nonzero WSEn
tryCt value. 

ReadStyles Method Code 

The ReadStyles method is the mirror image of the corre
sponding WriteStyles method, shown on page 292. The code 
is entirely new in this version of the Ensemble application: 
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void CEnsembleData::ReadStyles (void) 
{ 

cell Info cellStyle; 
short cols, rows; 
short index, rowCol; 
CCellData *aStyle; 

ReadSome ((Ptr)&cols, sizeof(short)); 
ReadSome ((Ptr)&rows, sizeof(short)); 
for(index=O; index< cols; index++) 
{ 

ReadSome((Ptr)&rowCol, sizeof(short)); 
ReadSome( ( Ptr)&cellStyle, sizeof( cell Info)); 
aStyle = new CCellData; 
aStyle->ICellData(cellStyle); 
itsHList->lnsertAt(aStyle, rowCol+ 1 ); 

for(index=O; index< rows; index++) 
{ 

ReadSome( (Ptr)&rowCol, sizeof(short)); 
ReadSome((Ptr)&cellStyle, sizeof(celllnfo)); 
aStyle = new CCellData; 
aStyle-> I Cell Data( cellStyle); 
itsVList->lnsertAt(aStyle, rowCol+ 1 ); 

According to the file format shown in Figure 11-1, the Read
Styles method must first read in the cols and rows values, 
which determine how many column and row style entries fol
low. After these values are accessed from the file, two loops 
that input the column style entries, followed by the row style 
entries, complete the method. 

To store the style entries, a new instance of class CCellData 
is created, and the instance is initialized with the style data 
read from the file. This is the reason that the ICellData 
method (page 287) takes a celllnfo argument. When the 
CCellData instance has been initialized, it is inserted into the 
corresponding list (itsHList or itsVList), as appropriate. 

ReadWSEntries Method Code 

The ReadWSEntries method is only changed slightly, as was 
the WriteWSEntries, to make provision for the inclusion of 
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the WSStyle field in the WSCellEntry structure shown on 
page 294. The revised code for the ReadWSEntries method is 
as follows: 

void CEnsembleData::ReadWSEntries (long entryCount) 
{ 

WSCellEntry 
short 

an Entry; 
index; 

Str255 
CWSEntry 

entry Data; 
*aWSEntry; 

for(index = O; index< entryCount; index++) 
{ 

ReadSome( (Ptr)&an Entry, sizeof(WSCell Entry)); 
ReadSome((Ptr)&entryData[1], (long) anEntry.WSSize); 
entryData[O] = anEntry.WSSize; 

TRY 
{ 

aWSEntry = new CWSEntry; 
aWSEntry->IWSEntry (); 
aWSEntry->SetWSCell (anEntry.WSCell); 
aWSEntry->SetWSType (anEntry.WSType); 
aWSEntry->SetWSStyle (anEntry.WSStyle); 
aWSEntry->SetWSValue (0.0); 
aWSEntry->SetWSEntry (entryData); 
if(anEntry.WSType == 1) 
{ 

aWSEntry->SetWSText(entryData); II string 
} 
else 
{ 

aWSEntry->SetWSText("\p0.00"); II value 
} 
itsCluster->Add(aWSEntry); 

} 
CATCH 
{ 

ForgetObject (aWSEntry); 
} 
END TRY; 

The ReadWSEntries method is nearly the same as the 
method shown on page 190, except that it uses a new access 
method, SetWSStyle, to store the style information into the 
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CWSEntry worksheet entry instance. After an entry has been 
constructed, it is added to the main worksheet cluster. 

DisposeData Method Code 

The DisposeData method has been enhanced in this version 
of the Ensemble application by adding code to dispose of the 
entries in the column and row lists, in addition to the text 
and worksheet data. The new code is as follows: 

void CEnsembleData::DisposeData(void) 
{ 

long WSEntryCt, index; 

if (itsEditTextData != NULL) 
{ 

} 

DisposHandle (itsEditTextData); 
itsEditTextData = NULL; 

if (itsCluster != NULL) 
{ 

} 

WSEntryCt = itsCluster->GetNumltems(); 
for (index= 1; index<= WSEntryCt; index++) 
{ 

itsCluster->Deleteltem (1 ); 

if (itsHList != NULL) 
{ 

} 

WSEntryCt = itsHList->GetNumltems(); 
for (index= 1; index<= WSEntryCt; index++) 
{ 

itsHList->Deleteltem (1 ); 

if (itsVList != NULL) 
{ 

WSEntryCt = itsVList->GetNumltems(); 
for (index= 1; index<= WSEntryCt; index++) 
{ 

itsVList->Deleteltem (1 ); 
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GetHList and GetVList Methods 

Two new access methods have been added to the CEnsem
bleData class to provide the means for other classes to ac
cess the column and row list instances. The code for the 
GetHList and GetVList methods is as follows: 

CList *CEnsembleData::GetHList (void) 
{ 

return itsHList; 

Clist *CEnsembleData::GetVList (void) 
{ 

return itsVList; 

As is apparent, all that these methods do is return the value 
of the corresponding instance variable, which contains a 
handle to the list instance. 

Customizing the CWorksheet Code 

The newly generated code to implement the Worksheet dialog 
was described in Chapter 10. This section describes the cus
tom additions to the code in the CWorksheet subclass that 
implements the full functionality of the dialog. 

The subclass is always the code that is modified when you 
implement the full functionality of a new user interface fea
ture. In the case of the Worksheet dialog, although App
Maker generates the entire code to create the dialog and 
respond to the user's actions when a button or checkbox is 
clicked, we must add the code that makes each of these ac
tions functional. 

The code modifications in the CWorksheet class are fairly 
comprehensive. We need to take deliberate actions to show vi
sual feedback when the user selects a font or size from the 
associated list, or when a font style or justification selection 
is made. In addition, when a row is selected for modification, 
the column information is irrelevant and should not be 
shown. Conversely, when a column is selected, the row infor
mation is of no value. When an individual cell is selected, 
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Table 11-2 
Customized methods 
to implement the 
Worksheet dialog 

neither the row nor column settings are shown. The methods 
that have been modified or added are listed in Table 11-2. 

Class Method Description 

global Do Worksheet Main Worksheet dialog function 

CWorksheet !Worksheet Initializes the CWorksheet 

CWorksheet DoCommand Handles click commands 

CWorksheet ProviderChanged Handles list events 

CWorksheet DrawSample Draws sample text 

CWorksheet CellToString Converts cell # to string 

CWorksheet GetSettings Gets style data for selected row, 
column, or cell 

CWorksheet ComparePStrings Compares two Pascal strings 

CLlst24 MewTemp Initializes font list instance 

CList24 GetCellText Returns font name string 

CList28 IViewTemp Initializes font size list instance 

CList28 GetCellText Returns font size string 

DoWorksheet Function Code 

The DoWorksheet code is a global function that can be called 
by any method in the application. As you will see in a later 
section, the function is called by the DoCommand method in 
the CCalcWindow class. The existing call contained in the ZE
nsembleDoc generated code is not disturbed (as the rule for 
never modifying the superclass code dictates), but is never ex
ecuted because the menu command is first sent to the method 
in the CCalcWindow class, as is shown in Figure 10-1. 

The DoWorksheet function is responsible for creating the 
Worksheet dialog, initializing its user interface elements, 
running the dialog so that the user can make different selec
tions, and collecting the results after the user has dismissed 
the dialog by clicking the OK button. If the Cancel button is 
clicked, the previous settings must be left intact. The code for 
the DoWorksheet function is as follows: 
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void DoWorksheet(CDirectorOwner *aSupervisor) 
{ 

CWorksheet 
long 

*dialog; 
dismisser, value; 
aString; Str255 

short a Choice; 

dialog= NULL; 

TRY 
{ 

dialog = new CWorksheet; 
dialog->IWorksheet (aSupervisor); 

II 
II get the settings and initialize the dialog pane 
II 
dialog->GetSettings( cCellRadioViewlD); 

II 
II "Cell" is initially selected, 
II so disable the row and column fields. 
II 
dialog->HeightLabel->Hide(); 
dialog->WidthLabel->Hide(); 
dialog->heightField->Hide(); 
dialog->widthField->Hide(); 

II 
II now, show the dialog 
II 
dialog->BeginDialog (); 
II 
II start running the dialog event loop 
II 
dismisser= dialog->DoModalDialog (cmdOK); 
if (dismisser== cmdOK) 
{ 

II 
II save the style and measurement values, 
II as well as the new prospective cell, 
II so that the caller can alter the 
II worksheet. 
II 
dialog->theStatus.modified =TRUE; 
dialog->theCellData->cellData = dialog->thelnfo; 
( ( CCalcWindow *)aSupervisor)->SetCellData( dialog->theCell Data); 
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Do Worksheet 
function code 
(concluded) 

( (CCalcWindow *)aSupervisor)->SetCellStatus( dialog->theStatus); 
} 
dialog->Dispose (); 

} 
CATCH 
{ 

ForgetObject (dialog); 
} 
ENDTRY; 

The code for the DoWorksheet function is divided into three 
sections. The first section creates and initializes the dialog, 
the second section "runs" the dialog, and the third section 
saves the settings so that the DoCommand method in the 
CCalcWindow class can make the necessary modifications to 
the worksheet's appearance. 

The first section of the code begins as generated by App
Maker. The CWorksheet instance is created, and the !Work
sheet method is called to initialize the instance. As the code 
in Chapter 10 shows (see page 278), the first action of the 
!Worksheet method is to call its inherited IZWorksheet 
method in the ZWorksheet superclass. This is also true of 
the revised code, though we will perform some additional ini
tialization in the !Worksheet method, after the Worksheet di
alog elements have been created. When the !Worksheet 
method returns, the DoWorksheet function calls a new 
method (GetSettings) to access the settings associated with 
the current cell, row, or column selection. Because the Cell 
radio button is initially selected, the DoWorksheet function 
calls the GetSettings method with an identifier of cCellRa
dioViewID, which is the resource ID of the Cell radio button, 
as defined in our code. After the settings for the current cell 
have been accessed and placed into the appropriate user in
terface elements, the row height and column width fields are 
hidden by calling the TCL to hide them. When this is done, 
the BeginDialog method is called to show the dialog. This is 
the end of the first section of the function. 

The second section merely calls the DoModalDialog method. 
The TCL takes care of interacting with the user, accepting the 
key and mouse events, and sending messages to the appro
priate DoCommand or ProviderChanged methods in the 
CWorksheet class when an event affects one of the user in-



IWorksheet method 
code 
(beginning) 

Customizing the CEnsembleData Code 303 

terface elements. Although taking part in the execution of the 
second section, the DoCommand and ProviderChanged 
methods will be discussed later. When the user selects a font 
name, a message is sent to the ProviderChanged method to 
handle the selection. Similarly, when a font style or justifica
tion selection is made, the DoCommand method is called. 
The second section of the DoWorksheet function terminates 
when the user dismisses the dialog, by clicking either the OK 
or Cancel button. 

The third section of the DoWorksheet function will execute 
only if the OK button was clicked. This section is responsible 
for saving the user's selections. When the dialog is dismissed 
by clicking on the OK button, the function uses two access 
methods in the CCalcWindow class (SetCellData and Set
CellStatus) to save the style and status data associated with 
the user's actions. (These access methods will be described 
later in the chapter.) After the style data and status have been 
saved, if the user cancels the dialog, the dialog is disposed of, 
which also disposes all of its user interface elements. 

The DoWorksheet function is also organized into TRY and 
CATCH blocks, which provide a failure recovecy mechanism in 
case an error occurs when the dialog is being created or oper
ated. As with other THINK C code, if the CATCH block is exe
cuted, the failure will propagate to the TCL, which will display 
a dialog to the user, indicating the nature of the failure. 

!Worksheet Method Code 

As previously indicated, the !Worksheet method is called by 
the DoWorksheet function after the CWorksheet instance is 
created. The purpose of the !Worksheet method is to create 
the Worksheet dialog and instantiate all of its user interface 
elements. In addition, any special initialization not included 
in the generated code is added to the method. The code for 
!Worksheet is as follows: 

void CWorksheet::IWorksheet(COirectorOwner*aSupervisor) 
{ 

inherited:: IZWorksheet (aSupervisor); 

II any additional initialization for your dialog 
CenterRadio->10 = cCenterRadioViewlO; 
RightRadio->10 = cRightRadioViewlO; 
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IWorksheet method 
code 
(concluded) 

Worksheet dialog 
radio button viewID 
definitions 

ForceleftRadio->ID = cForceleftRadioViewlD; 
LeftRadio->ID = cleftRadioViewlD; 

RowRadio->ID = cRowRadioViewlD; 
CellRadio->ID = cCellRadioViewlD; 
ColumnRadio->ID = cColumnRadioViewlD; 

fontField->SetTextString (''\pSystem"); 
sizeField->SetTextString (''\p12); 

The generated code calls the inherited IZWorksheet method 
to create the dialog and its elements. This code is generated 
into the ZWorksheet superclass and is not modified. The 
custom initialization code added to this method consists of 
assigning "view IDs" to the radio buttons in the dialog. These 
IDs are arbitrary, but are stored in an instance variable asso
ciated with the view, providing a method of identifying a par
ticular element to use for enabling a specific button in a 
group. We have added definitions for these buttons in our 
Worksheet.h header file to allow references to the IDs to be 
symbolic. The definitions are as follows: 

en urn 

}; 

cCenterRadioViewlD= 157, 
cRightRadioViewlD, 
cForceleftRadioViewlD, 
cleftRadioViewl D 

en urn 

}; 

cRowRadioViewlD= 171, 
cCellRadioViewlD, 
cColumnRadioViewlD 

Although these definitions are arbitrary (as far as the TCL is 
concerned), we have chosen to use the 'CtlP' resource ID 
numbers for them, as shown in the IZWorksheet method 
code beginning on page 269. In addition to initializing the 
view IDs, the code writes an initial valid font name and size 
into the corresponding EdiIText fields. 
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DoCommand Method Code 

Each of the checkbox and radio button elements in the dialog 
is assigned an associated click command in the associated 
resource template created by AppMaker. When the element is 
created and its IViewTemp method is executed, its click 
command is sent to the TCL. Whenever the user clicks the 
mouse in one of these controls, the appropriate click com
mand is sent to the DoCommand method for the element's 
supervisor, which, in this case, is the CWorksheet class. 

The DoCommand method is passed a long integer that speci
fies the command that is to be handled. This could just as 
easily be a menu command as a click command; when it is 
received by the DoCommand method, there is no difference 
at that point. If it is ever necessary to install a menu when a 
dialog is invoked, selection of a menu command will also gen
erate a message to the dialog's DoCommand method. In our 
case, only the checkbox and radio buttons have associated 
commands. The code for the DoCommand method is quite 
lengthy: 

void CWorksheet::DoCommand (long theCommand) 
{ 

short style = -1 00; 
short align= -100; 

switch (theCommand) 
{ 

case cmdBoldCheck: 
{ 

} 

style= bold; 
break; 

case cmdltalicCheck: 
{ 

} 

style = italic; 
break; 

case cmdUnderlineCheck: 
{ 

} 

style = underline; 
break; 

case cmdOutlineCheck: 
{ 
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DoCommand 
method code 
(continued) 

} 

style= outline; 
break; 

case cmdShadowCheck: 
{ 

} 

style = shadow; 
break; 

case cmdCondenseCheck: 
{ 

} 

style = condense; 
break; 

case cmdExtendCheck: 
{ 

} 

style= extend; 
break; 

case cmdCenterRadio: 
{ 

} 

align = teCenter; 
break; 

case cmdRightRadio: 
{ 

} 

align = teFlushRight; 
break; 

case cmdForceleftRadio: 
{ 

} 

align = teFlushDefault; 
break; 

case cmdleftRadio: 
{ 

} 

align = teFlushleft; 
break; 

case cmdRowRadio: 
{ 

} 

GetSettings(cRowRadioViewlD); 
Width label-> Hide(); 
widthField->Hide(); 
Heightlabel->Show(); 
heightField->Show(); 
theStatus.rowColCell = O; II row 
break; 

case cmdCellRadio: 
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} 

} 
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GetSettings( cCellRadioViewlD); 
Heightlabel->Hide(); 
Widthlabel->Hide(); 
heightField->Hide(); 
widthField->Hide(); 
theStatus.rowColCell = 2; II cell 
break; 

case cmdColumnRadio: 
{ 

} 

GetSettings(cColumnRadioViewlD); 
Heightlabel->Hide(); 
heightField->Hide(); 
Widthlabel->Show(); 
widthField->Show(); 
theStatus.rowColCell = 1; 
break; 

case cmdDollars99999999Check: 
{ 

} 

thelnfo.dollars = Dollars99999999Check->GetValue(); 
break; 

case cmdCommas99999999Check: 
{ 

} 

thelnfo.commas = Commas99999999Check->GetValue(); 
break; 

case cmdChange TextStyleCheck: 
{ 

theStatus.changeStyle = ChangeTextStyleCheck->GetValue(); 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 
break; 

if(style != -100) 
{ 

} 

sampleField->SetFontStyle( style); 
thelnfo.fontStyle "=style; 
DrawSample(); 

if(align != -100) 
{ 

sampleField->SetAlignment(align); 
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DoCommand 
method code 
(concluded) 

thelnfo.fontAlign =align; 

DrawSample(); 

The first portion of the DoCommand method mimics the be
havior of the corresponding method in the CNotebook class, 
as shown beginning on page 119. Initial values are assigned 
to the style and align variables, and if one of the buttons as
sociated with the style or justification control was clicked, the 
associated variable will be updated with a new value. When 
the method reaches its end, the style and align variables are 
tested to determine whether they hold something other than 
the default values. If so, the appropriate style or alignment 
changes are made. 

Following the sections of code that handle style or alignment 
events is a section that handles events when the Row, Col
umn, or Cell button is clicked. The function of this code is to 
get the style settings for the chosen row, column, or cell and 
modify the dialog's displayed values to correspond with these 
settings. The GetSettings method is used to perform the ap
propriate changes. Incidentally, if the Row button is selected, 
then the column width is hidden, if the Column button is se
lected, the row height is hidden, and if the Cell button is se
lected, both the row height and column width are hidden. 

Finally, before the code that changes the text style or justifi
cation is executed are sections of code that handle clicks on 
the Dollars, Commas, and Change Text Style checkboxes. 
These "cases" in the method merely save the current value of 
the associated control, so that its status can affect the work
sheet text in an appropriate manner after the dialog has been 
dismissed. 

ProviderChanged Method Code 

The ProviderChanged method is invoked whenever one of 
the Worksheet dialog's lists or EditText fields has been 
changed. The classes that manipulate those elements in the 
TCL send BroadcastChange messages up the hierarchy, 
these messages are intercepted by the CBureaucrat class, 
and the ProviderChanged method is called for the "owner" of 
the element (i.e., the CWorksheet class). 
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The default-generated code for the ProviderChanged method 
was shown beginning on page 281. This code provided a 
framework for the custom code that we have added, to pro
cess the messages sent by the list and text field elements. In 
customizing this method, we have changed the code to elimi
nate both outcomes of the conditional tests; however, the 
code is essentially the same: 

void CWorksheet::ProviderChanged(CCollaborator *aProvider, 

short index; 
Str255 theText; 
long value; 
Cell a Cell; 

if (aProvider == fontField) 
{ 

} 

if (fontField->Getlength () != 0) 
{ 

DrawSample(); 

if (aProvider == sizeField) 
{ 

} 

if (sizeField->Getlength () != 0) 
{ 

DrawSample(); 

if (aProvider == List24) { 
if (List24->HasSelection ()) 
{ 

long reason, 
void* info) 

II store selection in EditText field 
if(List24->GetChoice( &index)) 
{ 

} 

Getltem(((Clist24 *)List24)->fontMenu, index+ 1, the Text); 
fontField->SetTextString(the Text); 
DrawSample(); 

if (aProvider == List28) 
{ 

if (List28->HasSelection()) 
{ 
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ProviderChanged 
method.code 
(concluded) 

} 

II store selection in EditText field 
if(List28->GetChoice( &index)) 
{ 

index = (index « 1 ) + 1 ; 
theText[O] = 2; 
theText[1] = ((CList28 *) List28)->typeSizes[index++]; 
theText[2] = ((CList28 *) List28)->typeSizes[index++]; 
sizeField->SetTextString(the Text); 
DrawSample(); 

if (aProvider == heightField) 
{ 

} 

if (heightField->Getlength () != 0) 
{ 

heightField->GetTextString(theText); 
StringToNum(theText, &value); 
theStatus.cellHeight = value; 

if (aProvider == widthField) 
{ 

} 

if (widthField->Getlength () != 0) 
{ 

widthField->GetTextString(the Text); 
StringToNum(theText, &value); 
theStatus.cellWidth =value; 

if (aProvider == digitsField) 
{ 

if (digitsField->Getlength () I= 0) 
{ 

digitsField->GetTextString(theText); 
StringToNum(theText, &value); 
thelnfo.decimalDigits = value; 

The ProviderChanged method deals only with events that oc
cur with regard to the EditText and list user interface ele
ments. For example, when a different font is selected from the 
font list, the method copies its name into the EditText field 
below the list and also causes the Sample field to be redrawn 
using the new font. A new size selection causes a similar ac-
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tion to be taken. If the contents of the heightField, width
Field, or digitsField are changed by the user, then the 
associated value is saved into the appropriate structure, for 
subsequent access by the DoCommand method in the 
CCalcWindow class (from where the Worksheet dialog was 
invoked). 

DrawSample Method Code 

Several of the sections of code in the ProviderChanged 
method make use of a method called DrawSample, whose job 
it is to draw the sample text in the specified font, size, style, 
and justification. The code for DrawSample is as follows: 

void CWorksheet::DrawSample(void) 
{ 

short fontNum; 
long fontSize, strlength; 
Str255 theFontText, theSizeText, theSampleText; 
strlength = fontField->Getlength(); 
if(strlength > 0) 
{ 

fontField->GetTextString(theFontText); 
if(EqualString(theFontText, "\pSystem")) 
{ 

fontNum = systemFont; 
} 
else if(EqualString(theFontText, "\pApplication")) 
{ 

fontNum = applFont; 
} 
else 
{ 

GetFNum(theFontText, &fontNum); 

} 
else 
{ 

fontNum = systemFont; 
} 
strlength = sizeField->Getlength(); 
if(strlength > 0) 
{ 

sizeField->GetTextString(theSize Text); 
StringToNum(theSizeText, &fontSize); 

} 
else 
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DrawSample 
method code 
(concluded) 

fontSize = 12; 
CopyPString("\pSample", theSampleText); 
sampleField->SetTextString(theSampleText); 
sampleField->SetFontNumber(fontNum); 
sampleField->SetFontSize(fontSize); 
thelnfo.fontNumber = fontNum; 
thelnfo.fontSize = fontSize; 

The purpose of the DrawSample method has already been 
explained. The method takes a few steps to avoid trying to 
draw in a font that doesn't exist, but will use any font size 
you specify. If the font is too large or too small, the sample 
text will simply not be readable. There's no harm in this prac
tice: It may be important for the user to key in a font size that 
isn't supported in the list of sizes. In this case, the method 
dutifully uses the size specified by the user. If the font isn't 
the System or Application font, then the toolbox GetFNum 
routine is used to return the font number of a specified font. 
If the font does not exist, GetFNum will return 0, the System 
font number. 

CellToString Method Code 

The CellToString method is used to convert a binary cell 
value to its string equivalent, for display in the Worksheet di
alog box. The code is "hard wired" to the notion that there is a 
maximum of 26 columns in our worksheet; however, this 
could be modified if the worksheet size is expanded. The code 
for CellToString is as follows: 

void CWorksheet::CellToString (Cell aCell, StringPtr aString) 
{ 

Str15 Col, Row; 
Col[O) = 1; 
Col[1) = (aCell.h +'A'); 
NumToString (aCell.v + 1, Row); 
CopyPString(Col, aString); 
ConcatPStrings(aString, Row); 

The preceding code merely adds the character 'A' to the col
umn value and then converts the row+ 1 value to a string and 
concatenates the two. 
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GetSettings Method Code 

The GetSettings method is a major addition to the Work
sheet module. The method is responsible for changing the 
settings when the user chooses to modify the Row, Column, 
or Cell style. Because the existing font, size, style, alignment, 
and options can be totally different for each of these choices, 
the GetSettings method must maintain the current values of 
each of these possibilities. This provides the user with instant 
feedback on the current settings for each choice. The work
sheet cell objects contain these settings for individual cells, 
and the corresponding row and column lists maintain the set
tings for the row and column corresponding to the selected 
cell. The function of the GetSettings method is to use the in
coming parameter (which specifies one of the three radio but
tons selecting a Row, Column, or Cell) and reset the dialog's 
parameters to match the corresponding settings for the se
lected choice. The code to implement this feature is as follows: 

void CWorksheet::GetSettings (short viewlD) 
{ 

short sizeSelect; 
short fontlndex; 
short size Index; 
short radio ID; 
Str255 aString; 
Str255 listName; 

switch (viewlD) 
{ 

case cCellRadioViewlD: 
{ 

} 

theCellData = ((CCalcWindow *)itsSupervisor)->GetCellData(); 
break; 

case cColumnRadioViewlD: 
{ 

} 

theCellData = ((CCalcWindow *)itsSupervisor)->GetColData(); 
break; 

case cRowRadioViewlD: 
{ 

theCellData = ((CCalcWindow *)itsSupervisor)->GetRowData(); 
break; 
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(continued) 

Group35->SetStationlD(viewlD); 
thelnfo = theCellData->cellData; 
theStatus = ((CCalcWindow *)itsSupervisor)->GetCellStatus(); 
CellToString(theStatus.itsCell, aString); 
cellNumlabel->SetTextString( aString); 
Num ToString(theStatus.cellHeight, aString); 
heightField->SetTextString(aString); 
Num ToString(theStatus.cellWidth, aString); 
width Field->SetTextString(aString); 
NumToString(thelnfo.decimalDigits, aString); 
digitsField->SetTextString(aString); 
Dollars99999999Check->SetValue(thelnfo.dollars); 
Commas99999999Check->SetValue(thelnfo.commas); 

GetFontName (thelnfo.fontNumber, aString); 
if (aString[O] == 0) 
{ 

CopyPString ("\pSystem", aString); 
} 
for (fontlndex = 1; fontlndex <= ((Clist24 *)List24)->numFonts; 

fontlndex++) 

} 

Getltem(((Clist24 *)List24)->fontMenu, fontlndex, listName); 
if (EqualString (listName, aString)) 
{ 

fontlndex--; 
break; 

if (fontlndex > ((Clist24 *)List24)->numFonts) 
{ 

fontlndex = O; 
} 
fontField->SetTextString (aString); 

NumToString (thelnfo.fontSize, aString); 
if (aString[O] == 1) 
{ 

aString[2] = aString[1 ]; 
aString[1] = ''; 
aString[O] = 2; 

for (sizelndex = 1; sizelndex <= 24; sizelndex+=2) 
{ 

if (((Clist28 *)List28)->typeSizes[sizelndex+O] == aString[1] 
&& ( (Clist28 *)List28)->typeSizes[sizelndex+ 1] == aString[2]) 
{ 

sizelndex »= 1; 
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break; 

if (sizelndex > 12) 
{ 

sizelndex = 3; 
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CopyPString ("\p12", aString); 
} 
sizeField->SetTextString (aString); 
List24->SetChoice (fontlndex); 
List28->SetChoice (sizelndex); 

BoldCheck->SetValue(thelnfo.fontStyle & bold); 
ltalicCheck->SetValue(thelnfo.fontStyle & italic); 
UnderlineCheck->SetValue(thelnfo.fontStyle & underline); 
OutlineCheck->SetValue(thelnfo.fontStyle & outline); 
ShadowCheck->SetValue(thelnfo.fontStyle & shadow); 
CondenseCheck->SetValue(thelnfo.fontStyle & condense); 
ExtendCheck->SetValue(thelnfo.fontStyle & extend); 

if(thelnfo.fontAlign == teFlushleft) 
{ 

radiolD = cleftRadioViewlD; 
} 
else if(thelnfo.fontAlign == teCenter) 
{ 

radiolD = cCenterRadioViewlD; 
} 
else if(thelnfo.fontAlign == teFlushRight) 
{ 

radiolD = cRightRadioViewlD 
} 
else 

radiolD = cForceleftRadioViewlD; 
Group16->SetStationlD(radiolD); 
sampleField->SetTextString("\pSample"); 
sampleField->SetFontNumber(the Info. fontNumber); 
sampleField->SetFontSize(thel nfo. fontSize); 
sampleField->SetFontStyle(thelnfo.fontStyle); 
sampleField->SetAlignment(the Info. fontAlign); 
Change TextStyleCheck->SetValue(O); 

As is apparent, the code for GetSettings is quite lengthy. The 
method begins by determining which viewlD was selected 
and then calls the appropriate access method in the CCalc
Window class to acquire either the row, column, or cell style 
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data. Once armed with the data, it reconstructs the dialog's 
fields, controls, lists, and selections to correspond with the 
previously specified values. 

Because only the simple binary values of the font, size, style, 
and alignment, along with the decimal digits, commas, and 
dollars settings are stored, the method must create the ap
propriate settings from these basic data. The process, though 
somewhat laborious, saves us from having to store a great 
deal of data for each defined worksheet cell, not to mention 
the corresponding settings for each row and column in the 
worksheet. 

It is believed that the trade-off of some extra code for a sub
stantial savings in worksheet storage is justified. In addition, 
the file size is minimized when the data are saved to disk. 

CList24 IViewTemp and GetCellText Methods 

The CList24 class implements the font name list. There are 
two methods generated in this class. The initialization 
method, called IViewTemp, specifies the size of the list, 
based on the number of fonts in the user's open resource 
files. The GetCellText method returns the contents of a font 
name string to the TCL's CTable class when the entry must 
be redrawn. The code for the IViewTemp and GetCellText 
methods is as follows: 

void CList24::1ViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 
II get the font menu handle and initialize the table 
fontMenu = GetMHandle(FontlD); 
numFonts = CountMltems(fontMenu); 
AddRow (numFonts, O); 

voidCList24::GetCellText(Cell 
short 

short index; 

aCell, 
availableWidth, StringPtritsText) 

II get font names from "fontMenu" and insert in list 
index = aCell.v; 
Getltem(fontMenu, index+ 1, its Text); 
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The IViewTemp and GetCellText methods depend upon the 
fontMenu that was built in the SetUpMenus method of the 
CEnsembleApp class, shown on page 92. The FontID re
source number used to retrieve the menu is defined in the 
ResourceDefs.h header file. 

The IViewTemp method sets up the list to contain the num
ber of rows corresponding to the number of available fonts, 
and the GetCellText method, when called with a cell num
ber, uses the vertical component (the row) to determine which 
name string to return in the itsText argument. 

CList28 IViewTemp and GetCellText Methods 

As with the CList24 class, the CList28 class implements a 
list, which in this case is the font size list. The IViewTemp 
method creates a list with 12 rows, corresponding to the 12 
fixed font sizes that we have defined. The GetCellText 
method returns the string value of the selected size when 
called by the TCL's CTable class. The code for the CList28 
class's IViewTemp and GetCellText methods is as follows: 

void CList28::1ViewTemp(CView 

CBureaucrat 

Ptr 

*an Enclosure, 

*aSupervisor, 

viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

CopyPString("\p 8 910121416182024283236'', typeSizes); 

AddRow (12, O); 

void CList28::GetCellText(Cell 

short 

a Cell, 

available Width, 

StringPtr itsText) 

short strlndex = (aCell.v « 1) + 1; 

*its Text++= 2; 

*its Text++= typeSizes[strlndex++]; 

*its Text = typeSizes[strlndex]; 
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Customizing the CCalcWindow Code 

Customizing the Lists 

Table 11-3 
List class custom code 
modifications 

The CCalcWindow module provides support for all of the 
worksheet-oriented operations. Because support for row, col
umn, and cell styles has been added, several of the classes 
and their methods have been further customized, based on 
the operational worksheet model presented in Chapter 8. 
Many of the classes and methods described in that chapter 
remain unchanged. This section covers only the classes and 
methods that have been modified to support styled worksheet 
cells. 

As indicated in Chapter 8, the worksheet uses three visible 
lists that contain the column labels, row labels, and main 
body of the worksheet. The modified and new methods are 
listed in Table 11-2. The boldfaced names specify newly cre
ated methods. 

Class Method Description 

CListlO DrawCell Draws row label cell 

CListl5 GetCellText Returns main worksheet cell text 

CListl5 DrawCell Draws worksheet cell contents 

CList15 GetCellStyle Accesses cell style information 

CListl5 DrawWSCell Draws styled text cell entry 

CListl5 SetStyleLists Saves instance handle for row 
and column style lists 

The table indicates that only two of the existing list methods 
were modified, and that four additional methods have been 
added. This speaks well for the modularity of the object-ori
ented design of the Ensemble application. When new func
tionality is provided, it is always a good sign if the existing 
code doesn't have to be scrapped to make way for features of 
the new implementation. 
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CListlO DraWCell Method Code 

The first list method to be changed is the DrawCell method 
for the CListlO instance. This list holds the row labels. Be
cause it wasn't anticipated at the outset that the user would 
need to change the row height, the row label was being writ
ten at a standard vertical offset in the cell. Now that the 
Worksheet dialog offers the ability to change the height of any 
row, the DrawCell method for the row labels must center the 
row label vertically in the row. The modified code is as follows: 

void Clist1 O::DrawCell (Cell theCell, Rect *cellRect) 

{ 
Str255 cellText; 

short availWidth, textWidth, availHeight; 

availWidth = cellRect->right - cellRect->left; 

availHeight = cellRect->bottom - cellRect->top; 
GetCellText(theCell, availWidth, cellText); 

textWidth = StringWidth(cellText); 

indent.h = availWidth - textWidth - vertlabMargin; 

indent.v = ((availHeight-12) » 1) + 12; 

if (cellText[O] > 0) 

{ 
Move To( cellRect->left + indent.h, cellRect->top + indent.v); 

Drawstring( cellText); 

The modified DrawCell code takes advantage of the available 
cell height to center the row label vertically. If the cell is too 
short for the label to fit, its baseline is set 12 pixels from the 
top of the cell. It is possible that the label will not entirely 
show. The label font and size are not adjustable, and the la
bel's height above the baseline is a constant 12 pixels. 

CList15 GetCellText Method Code 

The CList15 class implements the main worksheet list. It 
contains methods to manipulate the individual cells of the 
worksheet. The GetCellText method has been modified to 
provide for a variable number of decimals and for commas in 
numeric values. The modified code is as follows: 
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CListl5 
GetCellText 
method code 
(beginning} 

void CList15::GetCellText(Cell aCell, 
short availableWidth, 
StringPtr itsText) 

double itsValue, newValue; 
short itsType, index, num, dee; 
long aParam; 
Str255 itsEntry, itsCellText; 
deeform aFormat; 
extended temp; 
CWSEntry *anObj; 
eelllnfo eellStyle; 

if((CWSEntry *)itsCluster ==NULL) 
{ 

} 

CopyPString("\p", itsText); 
return; 

aParam =*(long*) &aCell; 
anObj = (CWSEntry *)itsCluster->Findltem1 (FindWSCell, aParam); 
if(anObj) 
{ 

if((itsType = anObj->GetWSType(}) == 2) 
{ 

index= 1; 
anObj->GetWSEntry(itsEntry); 
newValue = ((CCaleWindow *)itsSupervisor) 

->GetExpression (itsEntry, &index, O); 
itsValue = anObj->GetWSValue(); 
eellStyle = anObj->GetWSStyle(); 
GetCellStyle (aCell, &eellStyle); 
aFormat.style = FIXEDDECIMAL; 
aFormat.digits = eellStyle.deeimalDigits; 
x96tox80(&newValue, &temp); 
num2str(&aFormat, temp, itsCellText); 
if(eellStyle.eommas) 
{ 

num = itsCellText[O]; 
dee = eellStyle.deeimalDigits; 
dee= (dee> 0) ? dee : -1; 
index= num - dee - 3; 
while (index > 1) 
{ 

BloekMove( &itsCellText[index], its Entry, num-index+ 1); 
itsCellText[index] = ','; 
BloekMove(itsEntry, &itsCellText[index+ 1 ], num-index+ 1); 
index-= 3; 
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GetCellText 
method code 
(concluded) 
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num++; 

itsCellText[O] = num; 

if{cellStyle.dollars) 

{ 
CopyPString {"\p$ ", itsEntry); 

ConcatPStrings {itsEntry, itsCellText); 

CopyPString (itsEntry, itsCellText); 

anObj->SetWSText(itsCellText); 

anObj->SetWSValue(newValue); 

anObj->GetWSText(itsCellText); 

CopyPString(itsCellText, itsText); 

else 

CopyPString{"\p", itsText); 

The modifications shown to the GetCellTe:x:t method are con
cerned with the number of decimal digits in formatting nu
meric values and the inclusion of commas at the appropriate 
places if indicated. The method produces a string that repre
sents the value to be drawn for the cell. The string is format
ted and returned to the DrawCell method, which is located in 
the CTable class, but which we have overridden in this ver
sion of the application to provide for styled text in any cell. 
The override version of the DrawCell method is presented 
next. 

CList15 DrawCell Method Code 

The CTable class in the TCL contains a generic DrawCell 
method, which we have been using up to this point. It pro
vides for writing the string returned by the GetCellText 
method in a standard font, size, and style. Our new override 
of this method provides complete control over the appearance 
of a cell. In this regard, a cell's font, size, style, and justifica
tion can be modified via the Worksheet dialog. The code for 
the new method is as follows: 
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CList15 
GetCellStyle 
method code 
(beginning) 

void Clist15::DrawCell (Cell theCell, Rect *cellRect) 
{ 

CWSEntry *anEntry; 
celllnfo cellStyle; 
long aParam; 

aParam =*(long*) &theCell; 
if((CWSEntry *) itsCluster) 
{ 

if((anEntry = (CWSEntry *)itsCluster->Findltem1 (FindWSCell, 
aParam)) == NULL) 

return; 
} 
cellStyle = anEntry->GetWSStyle(); 
GetCellStyle (theCell, &cellStyle); 
DrawWSCell (theCell, cellRect, cellStyle); 

The code attempts to optimize the drawing of cells by handling 
only the first portion of the task. It determines whether the cell 
has been defined, and if not, it simply returns, drawing noth
ing in the process. If the cell does exist, the DrawCell method 
accesses the style data for the cell and then calls the GetCell
Style method to determine whether the individual cell style or 
that of the corresponding row or column should be used. It 
then calls the DrawWSCell method to perform the task of set
ting the style attributes and to draw the cell's contents. 

CList15 GetCellStyle Method Code 

The GetCellStyle method is responsible for determining 
whether the input cell style information should be used for <... 

drawing a given cell or wither the cell's corresponding column 
or row style data should be used. The code for this method is 
as follows: 

voidCList15::GetCellStyle (Cell theCell, celllnfo *cellStyle) 
{ 

CCellData*aColStyle, *aRowStyle; 

if(cellStyle->isDefault) 
{ 

aColStyle = (CCellData *)itsHStyle->Nthltem((long)theCell.h+ 1 ); 
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GetCellStyle 
method code 
(concluded) 

CListl5 
DrawWSCell 
method code 
(beginning) 
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if(aColStyle->cellData.isDefault) 
{ 

aRowStyle = (CCellData *)itsVStyle->Nthltem((long)theCell.v+ 1 ); 
if( aRowStyle->cell Data. is Def au It) 
{ 

return; 

else 
{ 

*cellStyle = aRowStyle->cellData; 

else 
{ 

*cellStyle = aColStyle->cellData; 

The GetCellStyle method immediately returns if the cell for
mat is not the default value (i.e., if it has been changed with 
the Worksheet dialog). If the individual cell still reflects its 
default format, then the method checks whether the column 
style reflects its default style. If not, then the column style is 
used. If the column style still contains the default settings, 
then the row style is checked. If this still contains its default 
settings, then the method simply returns, using the cell's de
fault style; otherwise, the row style is used. This method re
flects a priority that has been established for all worksheet 
styles: The individual cell style takes precedence, followed by 
the column style, and, finally, by the row style. The method is 
called by both the GetCellText and the DrawCell methods. 

CList15 DrawWSCell Method Code 

The code that performs the final font, size, style, and justifi
cation settings and draws the cell text is encapsulated in this 
method. The code is as follows: 

void Clist15::DrawWSCell (Cell theCell, Rect *cellRect, 
celllnfo cellStyle) 

short 
short 
Style 
Str255 

curFont; 
curSize; 
curStyle; 
cellText; 
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CListl5 
DrawWSCell 
method code 
(continued) 

Fontinfo 
short 
short 
short 

flnfo; 
availWidth, availHeight; 
textWidth, textHeight; 
hlndent, vlndent; 

availWidth = cellRect->right - cellRect->left; 
availHeight = cellRect->bottom - cellRect->top; 
GetCellText( theCell, availWidth, cellText); 
if (cellText[O] > 0) 
{ 

curFont = macPort->txFont; 
curSize = macPort->txSize; 
curStyle = macPort->txFace; 

TextFont (cellStyle.fontNumber); 
TextSize (cellStyle.fontSize); 
TextFace (cellStyle.fontStyle); 

GetFontlnfo (&flnfo); 
textWidth = StringWidth(cellText); 
textHeight = flnfo.ascent + flnfo.descent; 
switch (cellStyle.fontAlign) 
{ 

case teCenter: 
{ 

} 

indent.h = (availWidth - textWidth) » 1; 
break; 

case teFlushRight: 
{ 

} 

indent.h = availWidth - textWidth; 
break; 

case teFlushLeft: 
{ 

} 

indent.h = O; 
break; 

case teFlushDefault: 
{ 

indent.h = O; 
break; 

} 
default: 
{ 

indent.h = O; 
break; 
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} 
if (textHeight > availHeight) 
{ 

indent.v = availHeight - 2; 

else 
{ 

indent.v = ((availHeight - textHeight) » 1) + flnfo.ascent; 

Move To( cellRect->left + indent.h, cellRect->top + indent.v); 
Drawstring( cellText); 

TextFont (curFont); 
TextSize (curSize); 
TextFace (curStyle); 

The DrawWSCell method begins by computing the cell's 
available width and height and then calls the GetCellText 
method to get the string it must draw. The method is also 
called with a cellStyle argument that specifies the font, size, 
style, and justification settings for the cell text to be written. 
If the length of the cell text is greater than 0, the method con
tinues; otherwise, it simply returns, drawing nothing. 

The current settings for the macPort's txFont, txSize, and 
txFace are saved, and then the new values for this cell are in
stalled by calling the toolbox TextFont, TextSize, and Text
Face routines, with the cellStyle settings. 

The GetFontlnfo toolbox routine is called to get the metric 
settings for the new font. We are primarily interested in the 
ascent (distance above the baseline of the tallest character) 
and the descent (distance below the baseline for the charac
ter with the lowest descender) measurements. Following this, 
we also get the width of the character string that we intend to 
draw, using the toolbox StringWidth routine and placing this 
measurement into our textWidth variable. The textHeight is 
computed as the sum of the ascent and descent measure
ments of the font. 

Armed with this information, we can commence the task of 
computing the horizontal position, indent.h, of the first char-
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acter of the text. Different methods are used, depending on 
whether the selected setting is for left-justified, centered, or 
right-justified text. Following this, the vertical offset, in
dent.v, from the top of the cell is computed to center the text 
vertically within the cell. The final section of code moves the 
pen to the appropriate horizontal and vertical positions 
within the cell and then draws the string. When the operation 
is complete, the previous font, size, and style (face) are re
stored from the saved values. 

CList15 SetStyleLists Method Code 

This method is called by the IcalcWindow method, described 
later in the chapter. The entire purpose of the SetStyleLists 
method is to pass the handles to the row and column style 
lists from the main CCalcWindow module to the CList15 
class, where they need to be accessed. The code for the 
method is as follows: 

void CList15::SetStyleLists(CList *aHList, CList *aVList) 

itsHStyle = aHList; 

itsVStyle = aVList; 

Customizing the CCalcWindow Methods 

The CCalcWindow class implements the main behavior of the 
worksheet. It contains all the algorithms for accepting new 
entries, making changes to existing entries, and invoking the 
Worksheet dialog when that command is chosen.The new 
and modified methods for the class are shown in Table 11-2. 

As is our custom, the entirely new methods are shown in 
boldface type, while existing methods are in plain type. It is 
important to point out that in no case was an existing method 
entirely scrapped and completely rewritten. In most cases, 
the modifications to existing methods are rather slight, and 
the entirely new methods consist of one or two lines of code, 
to provide access to the new style data. 
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Class Method Description 

CCalcWindow ICalcWindow Initializes worksheet window 

CCalcWindow MakeStringObj Creates string object 

CCalcWindow MakeValueObj Creates value object 

CCalcWindow UpdateMenus Enables/disables menu com-
mands 

CCalcWindow DoCommand Handles menu commands 

CCalcWindow GetCellData Gets and sets cell style data-
SetCellData access methods 

CCalcWindow GetCeUStatus Gets and sets cell status data-
SetCellStatus access methods 

CCalcWindow GetCoIData Gets column and row style data-
GetRowData access methods 

CCalcWindow InitCeUStyle Initializes new cell style 

ICalcWindow Method Code 

The ICalcWindow method has been modified to create default 
entries in the row and column style lists if these lists are 
empty. If the window is opened as a result of opening a file and 
reading prewritten worksheet data, then the lists are not dis
turbed. The code for the ICalcWindow method is as follows: 

void CCalcWindow::ICalcWindow(CDirector *aSupervisor, 

Rect 
Str255 
long 
CCellData 
celllnfo 

aRect; 
theFilename; 
index; 
*aStyle; 
cell Style; 

CEnsembleData *theData) 

itsData = theData; 
inherited::IZCalcWindow (aSupervisor); 
gDecorator->StaggerWindow (itsWindow); 

II 
II put the file name into the CalcWindow's title 
II and set the min and max window sizes 
II 
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I Cale Window 
method.code 
(continued) 

SetRect(&aRect, minWinHSize, minWinVSize, maxWinHSize, 
maxWinVSize); 

if(((CEnsembleDoc *) aSupervisor)->itsFile !=NULL) 
{ 

} 

((CEnsembleDoc *) aSupervisor)->itsFile->GetName(theFilename); 
itsWindow->SetTitle(theFilename); 

itsWindow->SetSizeRect(&aRect); 
itsWindow->ChangeSize(minWinHSize, minWinVSize); 
((CAMEditText *)EntryField)->SetTextString(''\p"); 

II 
II turn on TEAutoView to enable scrolling the Entry field 
II 
TEAutoView (TRUE, ((CAMEditText *) EntryField)->macTE); 

II 
II send handles to the various lists to the "main worksheet" 
II table (List15), so that it can access their contents 
II 
( (Clist15 *)List15)->Setlists (Lists, List1 O); 
wsCluster = theData->GetCluster(); 
itsHList = theData->GetHList(); 
itsVList = theData->GetVList(); 
((Clist15 *)List15)->SetStylelists (itsHList, itsVList); 
( (Clist15 *)List15)->SetCluster (wsCluster); 
((Clist15 *)List15)->SetArray(wsCluster, FALSE); 

II 
II if the column and row label lists are empty, 
II then fill them with default list entries. 
II Otherwise, set the appropriate column widths 
II and row heights. 
II 
lnitCellStyle(&cellStyle); 
TRY 
{ 

if(itsHList->GetNumltems() <= O) 
{ 

for(index=O; index< numCols; index++) 
{ 

} 
else 
{ 

cellStyle.cellMetric = List15->GetCo1Width (index); 
aStyle = new CCellData; 
aStyle->ICell Data( cellStyle); 
itsHList->lnsertAt(aStyle, index+ 1 ); 
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method cod 
(concluded) 

} 
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for(index=O; index< numCols; index++) 
{ 

aStyle = (CCellData *)itsHList->Nthltem (index+ 1 ); 
cellStyle = aStyle->cellData; 
List15->SetColWidth (index, cellStyle.cellMetric); 
List5->SetColWidth (index, cellStyle.cellMetric); 

if(itsVList->GetNumltems() <= 0) 
{ 

for(index=O; index< numRows; index++) 
{ 

else 
{ 

cellStyle.cellMetric = List15->GetRowHeight (index); 
aStyle = new CCellData; 
aStyle->ICellData(cellStyle); 
itsVList->lnsertAt(aStyle, index+ 1 ); 

for(index=O; index< numRows; index++) 
{ 

aStyle = (CCellData *)itsVList->Nthltem (index+ 1 ); 
cellStyle = aStyle->cellData; 
List15->SetRowHeight (index, cellStyle.cellMetric); 
List10->SetRowHeight (index, cellStyle.cellMetric); 

} 
CATCH 
{ 

ForgetObject (aStyle); 
} 
END TRY; 
((Clist15 *)List15)->Refresh(); 

Comparing this code with the version shown of ICalcWindow 
on page 215, we see that the major changes consist of send
ing the style list handles to the CListl5 class and creating 
default entries for the row and column style lists if they are 
empty. The creation of the default list entry code is placed in
side a TRY block, just in case there isn't enough memory to 
create all of the list entries. The CATCH block will receive con
trol if an error is detected, and then will pass the error on to 
the TCL to display a dialog indicating the source of the prob-
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lem. Although the new initialization method is fairly long, the 
additional code is quite straightforward. 

MakeStringObj Method Code 

The code for the MakeStringObj method has been changed 
merely to provide for the additional style information that is 
stored in the workeheet cells. The code for this method is as 
follows: 

CWSEntry *CCalcWindow::MakeStringObj (Cell aCell, StringPtr aString) 
{ 

CWSEntry *aCellEntry; 
celllnfo cellStyle; 

TRY 
{ 

lnitCellStyle (&cellStyle); 
aCellEntry = new CWSEntry; 
aCellEntry->IWSEntry (); 
aCellEntry->SetWSCell (aCell); 
aCellEntry->SetWSType (1 );//string 
aCellEntry->SetWSText (aString); 
aCellEntry->SetWSEntry (aString); 
aCellEntry->SetWSValue (0.0); 
aCellEntry->SetWSStyle (cellStyle); 
return aCellEntry; 

} 
CATCH 
{ 

ForgetObject (a Cell Entry); 
return NULL; 

} 
ENDTRY; 

The only change to the method from what was presented on 
page 237 is the calls to lnitCellStyle and SetWSStyle for the 
cell entcy. Each cell is initialized with a default style, which 
can be changed by the user through the application of the 
Worksheet dialog. 

MakeValueObj Method Code 

The MakeValueObj method has also been modified from the 
version presented on page 238, to include cell style informa
tion. The modified version of this code is as follows: 
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CWSEntry *CCalcWindow::MakeValueObj (Cell aCell, double value, 
StringPtr aString) 

CWSEntry 
Str255 
decform 
extended 
celllnfo 

TRY 
{ 

*aCellEntry; 
dispStr; 
aFormat; 
temp; 
cellStyle; 

lnitCellStyle (&cellStyle); 
aCellEntry =new CWSEntry; 
aCellEntry->IWSEntry (); 
aCellEntry->SetWSCell (aCell); 
aCellEntry->SetWSType (2);// value 
aCellEntry->SetWSValue (value); 
aCellEntry->SetWSEntry (aString); 
aCellEntry->SetWSStyle (cellStyle); 
aFormat.style = FIXEDDECIMAL; 
aFormat.digits = cellStyle.decimalDigits; 
x96tox80(&value, &temp); 
num2str(&aFormat, temp, dispStr); 
a Cell Entry->SetWSText( dispStr); 
return aCellEntry; 

} 
CATCH 
{ 

ForgetObject (aCellEntry); 
return NULL; 

} 
ENDTRY; 

As with the MakeStringObj method, MakeValueObj deviates 
from its previous implementation only by the addition of calls 
to the InitCellStyle and SetWSStyle methods, with the 
number of decimal digits changed to the default value in the 
cellStyle structure. 

UpdateMenus Method Code 

The UpdateMenus method has been modified to handle dis
abling the Notebook command when the CalcWindow is 
frontmost, and enabling or disabling the Worksheet com-
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DoCommand 
method.code 
(beginning) 

mand, depending on whether a cell is selected or not, respec
tively. The modified code is as follows: 

void CCalcWindow::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

gBartender->DisableCmd (cmdClose); 
gBartender->DisableCmd (cmdNotebook); 
if(List15->HasSelection()) 
{ 

gBartender->EnableCmd (cmdWorksheet); 
} 
else 
{ 

gBartender->DisableCmd (cmdWorksheet); 

DoCommand Method Code 

Although the code for the DoCommand method wasn't 
shown in Chapter 8, it was mentioned there that it wasn't 
necessacy to make any changes to the generated code for that 
version of the Ensemble application. In the new version, we 
must implement the invocation of the Worksheet command 
and the subsequent actions, based on the user's actions 
when interacting with the dialog. Therefore, quite a bit of 
code has been added to the DoCommand method. Because 
this code is not used in any other place, it made sense to 
have it in-line, for ease of reference. The new DoCommand 
method is as follows: 

void CCalcWindow::DoCommand (long theCommand) 
{ 

Cell 
short 
short 
short 
celllnfo 
celllnfo 
CWSEntry 
long 

aCell; 
height; 
width; 
changeStyle; 
style Info; 
oldStyle; 
*an Entry; 
param; 

switch (theCommand) 
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case cmdEnterButton: 
{ 

} 

DoEnterButton (); 
break; 

case cmdCancelButton: 
{ 

} 
II 

DoCancelButton (); 
break; 

II added case 
II 
case cmdWorksheet: 
{ 

if(List15->HasSelection()) 
{ 

SetPI (&aCell, 0, O); 
List15->GetSelect (TRUE, &aCell); 
itsSelectedCell = aCell; 
param =*(long *)&aCell; 
lnitCellStyle(&stylelnfo); 
theRowStyle = (CCellData *)itsVList->Nthltem((long)aCell.v+ 1 ); 
theColStyle = (CCellData *)itsHList->Nthltem((long)aCell.h+ 1 ); 
if((anEntry = (CWSEntry *)wsCluster->Findltem1 

(FindWSCell, param)) != NULL) 

stylelnfo = anEntry->GetWSStyle(); 
} 
itsCellData = new CCellData; 
itsCellData->ICellData( style Info); 
itsCellStatus.itsCell = aCell; 
itsCellStatus.cellHeight = List15->GetRowHeight(aCell.v); 
itsCellStatus.cellWidth = List15->GetColWidth (aCell.h); 
itsCellStatus.rowColCell = 2; II cell 
itsCellStatus.changeStyle = O; 
itsCellStatus.modified =FALSE; 
DoWorksheet (this); 
if(itsCellStatus.modified) 
{ 

((CEnsembleData *) itsData)->SetDirty (TRUE); 
II 
II parameters that affect this cell 
II may have been modified. We have 
II to check it out. 
II 
height = itsCellStatus.cellHeight; 
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DoCommand 
method code 
(continued) 

width= itsCellStatus.cellWidth; 
changeStyle = itsCellStatus.changeStyle; 
switch (itsCellStatus.rowColCell) 
{ 

case O: // row 
{ 

} 

List15->SetRowHeight(aCell.v, height); 
List10->SetRowHeight(aCell.v, height); 
oldStyle = theRowStyle->cellData; 
oldStyle.cellMetric = height; 
theRowStyle->cellData = oldStyle; 
if( changeStyle) 
{ 

} 

itsCellData->cellData.isDefault = O; 
stylelnfo = itsCellData->cellData; 
stylelnfo.cellMetric = height; 
theRowStyle->cellData = stylelnfo; 

break; 

case 1 : II col 
{ 

} 

List15->SetColWidth(aCell.h, width); 
List5->SetColWidth( a Cell. h, width); 
oldStyle = theColStyle->cellData; 
oldStyle.cellMetric =width; 
theColStyle->cellData = oldStyle; 
if( changeStyle) 
{ 

itsCellData->cellData.isDefault = O; 
stylelnfo = itsCellData->cellData; 
stylelnfo.cellMetric =width; 
theColStyle->cellData = stylelnfo; 

} 
break; 

case 2: II cell 
{ 

if( changeStyle) 
{ 

itsCellData->cellData.isDefault = O; 
stylelnfo = itsCellData->cellData; 
param =*{long *)&aCell; 
if((anEntry = (CWSEntry *)wsCluster 

->Findltem1 (FindWSCell, param)) !=NULL) 

an Entry->SetWSStyle( style Info); 
} 
else 
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(concluded) 

} 

} 
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anEntry = MakeStringObj (aCell, "\p"'); 
anEntry->SetWSStyle(stylelnfo); 
wsCluster->Add(anEntry); 

break; 

its Cell Data->Dispose(); 
} 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 
break; 

There is quite a bit of code in the modified DoCommand 
method. It is necessary to set things up prior to calling the 
DoWorksheet method: We must access the row, column, and 
cell styles, as well as the row height and column width set
tings for the selected cell. The dialog is initialized to provide 
the user with the settings for the selected cell; however, as 
the description of the GetSettings method (page 313) indi
cates, the user has the privilege of modifying the correspond
ing row and column settings, instead of the selected cell 
settings. 

After the Worksheet dialog has been dismissed, the code 
must determine whether the settings were modified. This is 
reflected in the modified field of the itsCellStatus structure, 
which is updated at the conclusion of running the dialog. 

If the user clicked the OK button to dismiss the dialog, then 
the modified field will be set to TRUE. If the Cancel button 
was used to dismiss the dialog, then the code in the DoCom
mand method will dispose of the new cell entry it created and 
exit. 

If the settings were modified, then the DoCommand method 
determines whether a row, column, or cell style was affected. 
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If it was a row style, then the cellMetric field will hold the 
new row height value, which is changed for both the main 
worksheet and the row label lists. 

In addition, if the changeStyle flag is set, the row style is up
dated to reflect the change. Similar code is used to handle 
changes to the column style. In this case, the cellMetric field 
holds the column width, which is installed in both the main 
worksheet and the column label lists. If the changeStyle flag 
is set, then the column style is updated to reflect the associ
ated change. 

Finally, if the specific selected cell was modified, then it is de
termined whether the cell has already been defined. If not, 
then a dummy, empty string object is constructed, the cell 
style is applied to that, and the instance is entered into the 
main worksheet list. If the cell already exists, then the Set
WSStyle method is called to change its style. In any case, 
whether or not changes were made, the created CCellData 
object is disposed of. 

GetCellData and SetCellData Methods 

The GetCellData and SetCellData methods provide access to 
the font, size, style, and justification data kept for the current 
cell, for use by the Worksheet dialog. The code for both meth
ods is as follows: 

CCellData*CCalcWindow::GetCellData () 

{ 
return itsCellData; 

void CCalcWindow::SetCellData (CCellData *aCellData) 

itsCellData->cellData = aCellData->cellData; 

GetCellStatus and SetCellStatus Methods 

These methods are also used only by the Worksheet dialog, 
to access the status data associated with the currently se
lected cell. The code for them is as follows: 
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cellStatus CCalcWindow::GetCellStatus {void) 

{ 

return itsCellStatus; 

void CCalcWindow::SetCellStatus {cellStatus aStatus) 

itsCellStatus = aStatus; 

GetCoIData and GetRowData Methods 

The Worksheet dialog also needs access to the column and 
row style settings. GetColData and GetRowData provide the 
capability for the dialog to acquire the column and row style 
data through the use of these access methods. 

Note that there are no corresponding SetColData or SetRow
Data methods, because the selected row or column style data 
are stored into the itsCellData instance variable using the 
SetCellData method when the dialog is dismissed. The code 
for the GetCoIData and GetRowData methods is as follows: 

CCellData *CCalcWindow::GetColData{) 

{ 
return theColStyle; 

CCellData *CCalcWindow::GetRowData{) 

{ 

return theRowStyle; 

InitCellStyle Method Code 

Whenever a new cell is created, it is given a set of default set
tings that reflect the style of the main worksheet as a whole. 
The InitCellStyle method is called from a number of other 
methods in the CCalcWindow class. The code for InitCell
Style is as follows: 
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void CCalcWindow::lnitCellStyle (celllnfo *cellStyle) 
{ 

TextlnfoRec textlnfo; 
( (CTextEnvirons *)List15->itsEnvironment)->GetTextlnfo (&textlnfo ); 
cellStyle->isDefault = 1 ; 
cellStyle->cellMetric = O; 
cellStyle->fontNumber = textlnfo.fontNumber; 
cellStyle->fontSize = textlnfo.theSize; 
cellStyle->fontStyle = textlnfo.theStyle; 
cellStyle->fontAlign = teFlushLeft; 
cellStyle->decimalDigits = 2; 
cellStyle->commas = O; 
cellStyle->dollars = O; 

Adding New CWSEntry Methods 

In order to support the additional style data that are stored in 
worksheet cell entries, two new methods have been added. 
These methods support the retrieval and setting of the data 
in the CWSEntry class. Both methods are relatively trivial, 
but reflect our desire to insulate the programmer from having 
to access these fields directly. 

GetWSStyle & SetWSStyle Method Code 

These methods provide access to the cellinfo style structure 
for an individual worksheet cell entry, as shown on page 286, 
pertaining to the CCellData header file declarations. The 
code for the new GetWSStyle and SetWSStyle methods is as 
follows: 

celllnfo CWSEntry::GetWSStyle (void) 
{ 

return cellData; 
} 
void CWSEntry::SetWSStyle (celllnfo theCellData) 
{ 

cellData = theCellData; 

This concludes the description of the customized code imple
mented for the new Worksheet dialog. Although there were a 
considerable number of modified and added methods, we 



Figure 11-2 
Appearance of the 
Ensemble 
application with 
styles applied to the 
worksheet rows, 
columns, and cells 
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were able to sc:ve almost every line of code that was previ
ously written. This is an important consideration when de
signing a fairly substantial application, as this is. When the 
number of statements that you have to discard and rewrite 
becomes large, it is an indication that the initial design was 
not amenable to evolutionary development. 

As a final salute to the power of the new worksheet capabili
ties, we offer the following screen shot, showing the Ensemble 
application, in all its glory, running with a modified set of 
worksheet entries. The new appearance of the Macintosh 
screen is shown in Figure 11-2. 
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Notice that the main title, Amazing Widgets Company, has 
been set in 18-point Palatino italic type, that the subhead is 
set in 12-point Helvetica type, and that the row and column 
headings inside the worksheet have been set in Helvetica type 
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and have also been centered. The dollar figures are shown 
with no decimals, contain commas, and are right justified. 
The row headings are left justified and the column has been 
widened to accommodate the longer headings. The illustra
tion you see was read in, just as pictured, from a file contain
ing the worksheet and notebook data, after the data had been 
styled and saved. 

Summary of the Changes to Ensemble 

This and the preceding two chapters have focused on the ad
dition of styling information to the main worksheet. This was 
accomplished by adding a new dialog and a corresponding 
menu command to invoke the dialog. Additional changes in
clude the following: 

•>The cell entries were enhanced to accommodate the addi
tion of the style information. 

•:• Two new lists, to hold row and column styles, were added 
and taken into account in the Worksheet dialog. 

•:•Seven existing methods were modified and 12 new meth
ods were added. 

•> The input/ output methods were enhanced to provide a 
new file format that permits saving and restoring the full 
appearance of a styled worksheet, as well as the styled 
notebook data. 

As a result of the foregoing changes, the main worksheet has 
a greatly extended capability. The widths of columns and the 
heights of rows are adjustable, and individual cells or entire 
columns or rows can be assigned independent fonts, sizes, 
styles, justifications, numbers of decimal digits, and commas 
within them. 

The next three chapters will discuss the addition of a graph
ing capability to the Ensemble application. This may be a 
good time to step back and reflect on the incredible evolution 
of the Ensemble application up to now. 
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1. Explain why a new CCellData class was added to the 
application. What is the rationale for defining a separate 
class to encapsulate data pertaining to a worksheet cell, 
especially if there is only a single method in the associ
ated class declaration? 

2. Describe the purpose of the itsHList and itsVList lists 
that are defined in the IEnsembleData method of the 
CEnsembleData class. Why are instances of CList used 
in this case, rather than CCluster or CArray? 

3. What information is being written for the worksheet 
entries in the new file format? (Hint Look in the WriteWS
Entries method in the CEnsembleData class.) Why is 
this information sufficient to reconstruct each of the 
entries? 

4. Examine the code for the Worksheet dialog. Describe in 
what way the dialog reacts to the selection of Row, Col
umn, or Cell radio buttons. What information is pertinent 
to each of these selections? 

5. Describe the purpose of the GetSettings method in the 
CWorksheet class. What function does this method 
serve? What other methods call this method, and for what 
reason? 

6. Describe the dynamics in the operation of the DoCom
mand and ProviderChanged methods for the Worksheet 
dialog. In what way do these methods modify the dialog's 
appearance? 

7. Explain the purpose of the new DrawCell method in the 
CListlO class. Why was it necessary to modify this 
method from the implementation shown in Chapter 8? 

8. In the main worksheet list class, CList15, what was 
added to the GetCellText method to implement the fea
tures of the Worksheet dialog? 
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9. Why has a DrawCell method been added to the CList15 
class? What primary feature of object-oriented program
ming does it illustrate? 

10. Describe the operation of the DrawWSCell method in the 
CList15 class. What features of the Worksheet dialog 
does this method implement? 

11. Describe the operation of the ICalcWindow method in the 
CCalcWindow class. What purpose does each section of 
the code serve? 

12. Describe the operation of the DoCommand method in the 
CCalcWindow class. How does this method react to 
changes made in the Worksheet dialog? 

13. If the Ensemble application is modified to provide for mul
tiple contiguous or discontiguous cell selections, how will 
the changes need to be reflected in the Worksheet dia
log?1 Also, in what way does this dialog relate to multiple 
selections? 

14. If the Ensemble application is modified to support in-cell 
entry and editing, how would these features be imple
mented for multiple cell selections? Is it appropriate to do 
so? How does in-cell editing relate to the Worksheet dia
log's design and implementation. 2 

1. The proposed modifications to the Worksheet are described in the exercises for Chapter 8. 
Modifying the worksheet to provide useful functionality if multiple cells are selected is a 
very complex task. It could be assigned as an extra-credit project. 

2. In-cell entry and editing were first introduced as a user interface concept in the exercises for 
Chapter 6. Carrying through the design and implementation of these features to include their 
impact on the design of the Worksheet dialog is an ongoing and complex task that could be 
assigned as an extra-credit project. 
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Adding a Graph Window to Ensemble 

This chapter describes how a third simple window is added to 
the Ensemble application to support graphs that we will cre
ate using data from the worksheet window. 

The window design for displaying graphs is quite simple. It 
consists merely of a blank window-much like the worksheet 
window-that contains a scroll pane, with both horizontal 
and vertical scroll bars, and a panorama to contain the 
graphic displays. 

In addition to the window, we will also present the design of a 
dialog box for selecting the graph type, its labels (if any), and 
its scaling settings. 

The addition of the dialog will also require that a third com
mand be added to the Format menu. We will be call this com
mand Chart, which when chosen will cause a dialog box 
containing parameters for the graph window to be shown. 

The remainder of this chapter discusses the step-by-step 
technique for creating the window, dialog, and menu items 
within AppMaker. In addition, default code will be generated, 
added to the THINK C project, and compiled. The two chap
ters that follow this will, in turn, describe the generated code 
for the graph window additions and explain all the custom 
additions that make the window fully functional. 

Creating the GraphWindow with AppMaker 

Adding the graph window, which we will call GraphWindow, to 
the Ensemble application is a simple matter. To give you an 
idea of how the window will look, it is shown in Figure 12-1. 

343 
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Figure 12-1 
Completed 
Graph Window 
appearance 
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Notice that the basic window does not have a close box, as 
was the case with the worksheet window. It does have both 
horizontal and vertical scroll bars, and a panorama in which 
the graphs are drawn. The step-by-step approach for creating 
this window is as follows: 

1. Launch AppMaker by double-clicking on the Ensemble 
resource file. 

2. Select the Tools as Text option from the View menu, and 
then pull down the Select menu and choose the Win
dows command. 

3. Pull down the Edit menu and select the Create Window 
command. This will create a new window. Its initial size is 
not too important, as it can be readily resized by the user, 
and will be staggered with respect to the other windows 
when it is created at run time. The window will have the 
characteristics shown in Figure 12-2. 

4. Select the ZoomDoc window type, but uncheck the "Has 
Close box" option and leave the "Visible at Startup" option 
checked. Name the window GraphWindow, and give it a 
title of (Untitled), as shown. Then, click OK to dismiss 
the new window dialog. 



Figure 12-2 
Graph Window 
features 

Figure 12-3 
Plain GraphWindow 
appearance 
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5. When the window's features have been defined, it will 
have the appearance shown in Figure 12-3. Make the 

(Untitled) 

window large enough so that you can add the new ele
ments in the following steps. 

6. Pull down the Tools menu and select the CScrollPane 
tool. 

7. Position the cross hairs at the upper left corner of the 
blank portion of the window (below the title bar), and drag 
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Figure 12-4 
GraphWindow with 
the CScrollPane 
installed 

down and to the right until the bottom right corner of the 
window is reached. Release the mouse. You will have cre
ated a scroll pane that has a vertical scrollbar only. We 
will be adding the horizontal scroll bar in the next step. 
Although most graphs will fit in a modest size window, 
the provision exists to create much larger graphs. 

8. To add the horizontal scroll bar, choose the CScrollbar 
tool, and then position the cross hairs right at the bottom 
of the window border, in its middle, but while the cursor 
still retains the shape of a cross hair. Click once. App
Maker will construct a horizontal scroll bar that exactly 
fills the width of the panorama. If you don't succeed on 
your first try, delete the imperfect scroll bar and try 
again. The completed window with the scroll pane and 
both scroll bars installed has the appearance shown in 
Figure 12-4. 
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9. After the scroll pane is installed, we need to add a pan
orama, which is a pane that can be arbitrarily large, to 
hold very large images or data. In our case, we will be cus
tomizing this pane to be the size of a letter-sized page of 
paper; however, that step will be undertaken in 
Chapter 14 when we discuss the custom code additions to 
the GraphWindow class. We don't have to specify the 
eventual size of the panorama at the time it is designed 



Figure 12-5 
Graph Window with 
CPanorama installed 
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within AppMaker. To create the panorama pane, pull down 
the Tools menu and choose the CPanorama command. 

10. Once again, to create the panorama, you position the cur
sor's cross hairs at the upper left of the blank portion of 
the window, within the scroll pane, and drag down and to 
the right until you reach the intersection of the left edge 
of the vertical scrollbar and the top edge of the horizontal 
scroll bar. The result of installing the panorama is shown 
in Figure 12-5. 

The panorama appears with a gray border within AppMaker; 
however, the border will not show in the running application. 
Figure 12-5 is identical in appearance to the completed win
dow shown in Figure 12-1. 
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Adding the Format Chart Menu Command 

The next series of steps shows how the new menu item is 
added to the Ensemble application. This procedure is identi
cal to the steps that you have already followed in construct
ing Format menu items in Chapters 5 and 9. 

1. Pull down the Select menu and choose Menus. 
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Figure 12-6 
Format Chart menu 
command added 

2. Double-click on the MainMenu entry in the list of menu 
bars at the right of your screen. This will show the main 
menu bar for the Ensemble application. 

3. Click on the Format menu to drop down the menu's 
entries, and create a new entry by clicking below the 
Worksheet command. Enter the information for the 
Chart command, as shown in Figure 12-6. 

Note that the Chart command has been given a command 
number of 2002, which is one larger than the previous entry. 
When you use the TCL, you must choose command numbers 
that are larger than 1024. Starting with 2000 is a completely 
safe approach. 

Adding the Format Chart Dialog 

The Format Chart dialog is a fairly complex addition to the 
application. The individual dialog elements are quite simple; 
however, there are more than a few that need to be created. 

At this point in the development of the application, you have 
doubtless had quite a bit of experience working with App
Maker's tools, so we will present only the completed appear
ance of this dialog and describe a few of its features in more 
detail. The final dialog is shown in Figure 12-7. 

Notice that the upper left quadrant of the dialog contains a 
labeled group (CLabeledGroup) with the label Chart Type. 
This group includes three radio buttons (CRadioControl) 



Figure 12-7 
Completed Chart 
dialog 

Figure 12-8 
Chart Type labeled 
group Item Info 
settings 
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that enable the user to select the type of chart to be pro
duced. The choices include both horizontal and vertical bar 
charts and an X-Y Chart (one that plots points at the inter
section of horizontal and vertical coordinate values) option. 
The Item Info settings for the Chart Type group are shown 
in Figure 12-8. The radio buttons can be installed inside the 
group, visually, by inspection of the figure. 
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Class: I CLabeledGroup 

Immediately below the Chart Type group is an Ediffext field 
(CEditText), to allow the user to type in a title for the chart. 
Immediately above that field is the static text (CStaticTe:x:t) 
label called Title. 
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Figure 12-9 
Scaling Choices 
labeled group Item 
Info settings 

Because the dialog must allow for both X and Y data ranges 
(in the case of the X-Y Chart option), we provide static text la
bels of Horizontal Data and Vertical Data, with appropriate 
dialog text fields to their right (CDialogText). 

In addition, depending on the type of chart, the user will have 
the option of supplying a cell or data range holding the title 
for the horizontal or vertical title axis of the chart. To imple
ment the optional fields, checkbox items (CCheckBox) la
beled h-label range and v-label range have been added. To 
their immediate right, we have also added corresponding dia
log text (CDialogText) fields to hold the label ranges. 

Almost the entire right half of the dialog is taken up with an
other labeled group that specifies the chart's scaling options. 
The Item Info settings for this interface element are shown 
in Figure 12-9. Note that the two radio buttons that select 
Automatic Scaling or Manual Scaling are placed inside 
their own radio group (CRadioGroup) pane. 
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The remaining fields in the Scaling Choices group are the 
static text labels hMin, hMax, vMin, and vMax, with dialog 
text fields to their right in which the scale values are entered. 

The automatically provided OK and Cancel buttons complete 
the dialog. It is important for you to note that we have typed 
names into each of the EditText and DialogText fields. These 
names will be used by AppMaker in the generated code to re
fer to the corresponding user interface elements. If you fail to 
type in the names, then AppMaker will invent names that will 
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not correspond to the code that is presented in subsequent 
chapters. 

When you create the Title CEditText field, take a moment to 
click inside the field and type title as its name. In a similar 
fashion, type in the names for the horizontal and vertical data 
range fields, as well as the label range fields. These are shown 
in Figure 12-7 as hRange, vRange, hLabRng, and vLabRng, 
respectively. 

On the right side of the dialog, the scale fields are similarly 
named by typing the field names inside the dialog text ele
ments after they have been created. The names horizMin, 
horizMax:, vertMin and vertMax: will be used for these ele
ments in the generated code. 

Generating the New Code 

After the GraphWindow, the Format Chart command, and 
the Chart dialog have been created, you will need to generate 
the code to implement these user interface features. To do so, 
pull down the File menu and choose the Generate com
mand. You will see the dialog shown in Figure 12-10. Click 
the Generate button, as shown in the figure. 

Figure 12-10 shows eight new files, in addition to the files for 
the various superclass modules. Four of the new files are 
ZGraphWindow.h, ZGraphWindow.c, GraphWindow.h, and 
GraphWindow.c. These files implement the GraphWindow 
class and its methods. The other four files, ZChart.h, 
ZChart.c, Chart.h, and Chart.c, implement the Chart dia
log's functionality. After the code has been generated, quit 
AppMaker and proceed to the next step. 

Compiling the Generated Code 

After the new versions of the existing superclass files, as well 
as the newly generated files, have been written, you need to 
add the new files to your THINK C project and compile them. 
The following steps will lead you through this process: 

1. Launch THINK C by double-clicking on the Ensemble.1t 
project file, and then pull down the Source menu and 
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Figure 12-10 
AppMaker's 
Generate dialog 
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select the Add command. THINK C will present a dialog 
box that lists the new files that aren't currently part of the 
project, as shown in Figure 12-11. Click the Add All but
ton, as shown in the figure. 

2. After clicking the Add All button, the four source files will 
move to the lower pane in the dialog. The next step is to 
click the Done button, as shown in Figure 12-12. After 
this button is clicked, all four files will be added to the 
first segment of the existing project file. 

3. The completed project file will list all the files for the 
Ensemble project in the first segment, as shown in Figure 
12-13. Because code segments are limited in size to 32 
kilobytes, we are going to have to move some files, which 
we will do in the next few steps. 

4. If we tried to compile the project at this point, the seg
ment would not exceed the 32 kilobyte limit; however, 
because it will exceed that limit when we add the custom 
code that is described in Chapter 14, it is useful to move 



Figure 12-11 
Selecting Add All in 
the THINK C Add 
dialog 

Figure 12-12 
Clicking the Done 
button in the 'TIIINK 
CAdd dialog 
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some of the files to a new segment. This process is a bit 
awkward, but straightforward. It requires four steps: 
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Figure 12-13 
All files added to the 
first Ensemble.7t 
project segment 
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a. We have decided to move the code for the three sub
class files that implement the functionality of the 
MainWindow, CalcWindow, and GraphWindow to 
their own segment. We commence this procedure by 
clicking on the CCalcWindow.c file and dragging it 
below the bottom of the list. By holding down the 
mouse button, the list will scroll downward. Continue 
holding down the button until the bottom of the list is 
exposed. There will be a gray dividing line that shows 
the bottom of the last segment. Release the button 
when the outline of the CCalcWindow.c file's rectan
gle is just below that line, as shown in Figure 12-14. 
The CalcWindow.c file will be in a new segment, by 
itself, at this point. 

b. If you hold down the Option key, and then click and 
drag a file in the project window, the entire segment 
containing the file will be moved. In this step, press 
and hold down the Option key, and then click the 



Figure 12-14 
CalcWindow.c 
moved into a new 
segment 

Ensemble.TI' 
Name obj size 
CM1Border_c 0 0 

iE=· m 
CllMEditText.c 
CllMlconPane_c 
CllMlntegerText_c 
CllMPopupMenu_c 
CllMPopupPane_c 
C llMRadioContro J _c 
C llMStat;c Text .c 
CllMStyleText_c 
CllMTable_c 
CGrayline_c 
CLabeledGroup_c 
CMumstate_c o ~ 

... ~!i..!i.~.!.!.'.:.~ ........................................................... I:! .. h:;-
CalcYindow _c 0 <)> :r ........ -............................................................................... ~ 
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mouse button with the cursor on the CCalcWindow.c 
file and drag the file back up above the top of the list. 
The list will scroll back toward the top. Continue to 
hold down the Option key and position the mouse 
above the list, so that it will continue to scroll. When 
the list reaches the top, and the rectangle that repre
sents the CalcWindow.c file exactly straddles the 
dividing line between the first and second segment, as 
shown in Figure 12-15, release the mouse button and 
then the Option key. A segment containing just the 
CCalcWindow.c file will be moved to the position indi
cated by the outline. 

c. The new segment will appear in the project list as 
shown in Figure 12-16. We could have just used the 
new segment at the bottom of the list, as shown in 
Figure 12-15; however, it is easier to keep track of the 
files that are unique to the current project if they are 
together. 

d. The last step involves moving the MainWindow.c and 
GraphWindow.c files to the new segment by clicking 
on each of them and dragging them, one by one, so 
that they overlap the CCalcWindow.c file in the 
project window. This will cause them to be placed in 
that segment when the mouse button is released. Do 
Not hold down the Option key for this step, as the 
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Figure 12-15 
Dragging the file 
until the rectangle 
straddles the first 
and second segments 

Figure 12-16 
New segment 
containing just the 
CCalcWindow.c file 
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entire first segment would be moved into the new sec
ond segment, and the first would automatically be 
deleted, leaving us back where we started. After mov
ing the other two files to the new segment, the project 
list will have the appearance shown in Figure 12-17. 

5. Now that the files are rearranged, you can compile the 
project to update the object files to correspond to the 
newly generated versions and also compile the new files 



Figure 12-17 
All three window files 
moved Into the 
second segment 

Figure 12-18 
THINKCMake 
dialog, Use Disk 
selected 
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Ensemble.TI 
Name 
EnsembleData.c 
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EnsembleMain.c 
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LongCoordinates .c 

0 
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for which no object files currently exist. This is accom
plished by pulling down the Source menu and choosing 
the Make option. When you do so, THINK C will display 
the dialog shown in Figure 12-18. Click the Use Disk but
ton, as shown. 

Source files to compile: 4 

Libraries to load: o 

CalcYindow .c 
Ce11Data.c 

v'Chart.c 
Ensemble App .c 
Ensemble Data .c 
Ensemble Doc .c 
Ensemb leMain .c 
FontData.c 

Check Rll 

Check Rll .c 

( Check None J 

Use lJisk 

181 Quick Scan 

~'Oii[ _._M .. a .. ke_._lii'J ( Don't Make J [ __ c_a_nc_e1~) 

6. Clicking the Use Disk button forces THINK C to reexam
ine the modification dates of the project's files. In the pro
cess of doing this for the Ensemble.n project, it will find 
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Figure 12-19 
Clicking the Make 
button to recompile 
the project's files 

that most of the files unique to the project will need to be 
recompiled. 

7. When one or more files are found to require recompila
tion, the Make button is enabled. Click this button, as 
shown in Figure 12-19. 

Source files to compile: 18 

Libraries to load: 

v'CalcYindow _c 

Ce11Data_c 

v'Chart_c 

v' Ensemble App _c 

v' Ensemb leData _c 

v' Ensemble Doc _c 

v' Ensemb leMain _c 

FontData_c 

0 
Check All 

( Check All .c ) 

( Check None ) 

Use Disk 

('8J Quick Scan 

Make ( Don't Make ) ( Cancel J 

After the Make button has been clicked, THINK C will begin 
compiling all the files that have changed since the last time 
the project was built. When the compilation is complete, you 
can run the application to see what it looks like with the ad
dition of the new window. Pull down the Project menu and 
choose the Run command. THINK C will display the debugger 
windows at this point. Click the Go button in the debugger's 
source window, and the application will begin execution. The 
new windows will appear. 

You can move and resize these windows, as shown in Figure 
12-20. In this figure, the worksheet window is on top, the text 
window is on the bottom, and the chart window is at the right. 
Both the text and chart windows have a similar appearance; 
however, the text window lacks a horizontal scroll bar, while 
the graph window has both horizontal and vertical scroll bars. 
To see the new dialog that we have just constructed, pull 
down the Format menu and choose the Chart command. The 
default version of the dialog is shown in Figure 12-21. 



Figure 12-20 
Default version of 
Ensemble running 
with 3 windows 

Figure 12-21 
Default appearance 
of Format Chart 
dialog 
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(Untitledl 

.-- Chart Type .-- Scaling Choices 

@ Horizontal Bar @ Rutomatic Scale 

O Uertical Bar 0 Manual Scale 

0 H-Y Chart 
hUiltA@ihMJ hMin: 

Title: 

I title 
hMaH: horizMaH I 
uMin: uertMin I 

Horizontal Data: hRange uMaH: uertMaH I 
Uertical Data: uRange 

D h-label range: hlabRng 

n JI ( l Cancel OK 
D u-label range: ulabRng 

The default version of the dialog shows all the fields and con
trols enabled. This complicates the appearance of the dialog. 
The custom code that is described in Chapter 14 will disable 
some of the controls and hide various fields, depending on 
what type of chart and whether automatic or manual scaling 
has been chosen. The set of files that comprise the Ensemble 
application is shown in Figure 12-22, as these files appear in 
the Finder. 
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Figure 12-22 
Ensemble 
application's files as 
seen in the Finder 
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~Chart.h 

~ zEnsemb lo App .c ~ zEnsomb le App .h 
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~ zNotobook .c ~ zNotobook .h 
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~ zChart.c ~ zChart.h 

The next chapter will describe the newly generated code for 
the GraphWindow and its accompanying Chart dialog. 

1. Explain why an instance of the CPanorama class was 
chosen for inclusion in the ScrollPane in the new Graph
Window? 

2. What kind of information would be required if the Chart 
dialog made provision for pie charts? 

3. What other types of charts might be useful? Describe the 
applications where these charts would be used and 
describe the user interface modifications that would be 
necessary to support them. 

4. Redefine the Chart dialog's user interface to support the 
implementation of pie charts. 1 

5. Describe why it was necessary to create a new segment to 
hold the "window" classes. Would it make any difference if 
some other classes were placed in this segment instead? 

1. Implementing pie charts is a fairly complex task. Making appropriate provisions for just the 
labeling of the pie slices is a very involved problem. Therefore, this exercise should be 
treated as an extra-credit project. 
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Examining the GraphWindow Code 

1bis chapter describes the newly generated code that adds a graph 
window and associated dialog box to the Ensemble application. 

As has been the case in all additions to the Ensemble appli
cation, none of the existing custom code has been modified 
by AppMaker when it generates new code. Only the super
class modules, whose names begin with the letter z, are re
generated. In addition, new modules are generated to 
implement the added functions. The modules that we will ex
amine in this chapter are as follows: 

•:• GraphWindow.c contains the subclass methods to over
ride and supplement the methods generated in its super
class. This will be the file in which the majority of the 
custom additions to support drawing the various graphs 
will be implemented. 

•:• GraphWindow.h contains the class declarations for the 
subclasses defined in the GraphWindow.c file. 

•:• zGraphWindow.c contains the superclass methods that 
initialize the default behavior of the graph window. 

•:• zGraphWindow.h contains the declarations for the classes 
and methods defined in the zGraphWindow.c module. 
Many of the methods declared in zGraphWindow.h are 
intended to be overridden by corresponding subclass 
methods declared in GraphWindow.h. 

•:• Chart.c contains the subclass methods to override and sup
plement the methods generated in the zChart.c superclass. 

•:• Chart.h contains the declarations for the methods defined 
in the Chart.c source file. 

361 
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•:• zChart.c contains the superclass methods that establish 
the default behavior of the Chart dialog. 

•:• zChart.h contains the superclass declarations for the 
methods contained in the zChart.c file. 

The preceding modules contain all of the default-generated 
code to implement both the GraphWindow and its associated 
Form.at Chart dialog box. 

The following section describes the classes and methods that 
provide the basis for the graphing functions to be added to 
the Ensemble application. 

The Final Structure of the Ensemble Application 

When the new files were generated for the Graph Window fea
tures, all of the superclass source and header files were re
generated as well. The new structure of the application, with 
the addition of the new window and dialog, is shown in Figure 
13-1. This is the final structure of the Ensemble application. 

You can see from looking at the figure that all of the windows 
are created from within the ZEnsembleDoc module-specifi
cally, from within the BuildWindows method. This method 
has been modified in the newly generated code to create the 
CGraphWindow instance, which inherits its default appear
ance from the methods in the ZGraphWindow class. 

The new version of the ZEnsembleDoc module also contains 
code in its DoCommand method to create an instance of the 
CChart dialog. We will leave this code alone, as we did for the 
code to create the Worksheet dialog. 

Instead of invoking the dialog, as indicated in its superclass 
method, we will add code to do so in the CGraphWindow 
module's DoCommand method. This method will completely 
override the other. The diagram in Figure 13-1 shows the Do
Chart function being called from within the CGraphWindow 
module. This is the intended structure of the application, so 
the figure depicts what will be, rather than what is at the 
time AppMaker generates the code for the new additions to 
the application. 
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Instance 

Although the application's structure is complete as shown in 

Figure 13-1, the code is not complete. We will discuss the 
custom additions to make the charting function fully opera
tional in the next chapter. In a subsequent chapter, we will 
discuss the addition of code to enable the contents of all 
three windows to be printed. That feature will round out the 
functionality of the Ensemble application. 

In the sections that follow, we will describe the newly gener
ated code, what features it provides, and what will need to be 
modified to make it fully functional. The classes and methods 
that comprise the important functions of this code are shown 
in Table 13-1. We will be describing each of these in the re
mainder of the chapter. 
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Table 13-1 Class Method Description 

Generated code 
ZEnsembleDoc BuildWindows Creates all window instances 

changes for the 
GraphWindow and ZGraphWindow IZGraphWindow Creates and initializes the 
Chart interface GraphWindow instance 

ZGraphWindow NewUser4 Method to create a CPanorama 

ZGraphWindow DoCommand Method meant to be overridden 
in the subclass 

CGraphWindow NewUser4 Override to create a User4 
instance 

CGraphWindow !Graph Window Further window initialization 

CGraphWindow UpdateMenus Override method in which to 
place code to enable and disable 
menu commands 

CGraphWindow DoCommand Method in which a call to the 
DoChart method will be created 

CGraphWindow ProviderChanged Override of ancestor method 

CUser4 IViewTemp Initializes User4 Panorama 

CUser4 Draw Draws graph method 

GraphWindow.c DoChart Creates the CChart instance, 
global function initializes and runs the Chart 

dialog 

ZChart IZChart Initializes the Chart dialog's 
user interface elements 

ZChart UpdateMenus Method to be overridden in 
CC hart 

CC hart I Chart Additional dialog initialization 

CChart UpdateMenus Overrides method in ZChart 

CC hart DoCommand Handles click commands for 
dialog items 

CC hart ProviderChanged Handles BroadcastChange mes-
sages for text fields in dialog 

Newly Generated Code in ZEnsembleDoc 

The principal change in the ZEnsembleDoc module is the ad
dition of code to create the new CGraphWindow instance in 
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the BuildWindows method. 

BuildWindows Method Code 

This method is responsible for creating all of the windows in 
the application. Each is managed by the CEnsembleDoc 
class, and each has that class as its supervisor. When we 
want to send a command to the CEnsembleDoc instance 
from within any of the windows, we can do so by referring to 
itsSupervisor, which is an instance variable for all window 
instances. The new code for the BuildWindows method is as 
follows: 

void ZEnsembleDoc::BuildWindows(void) 
{ 

CWindow*mainWindow; 
CDirector*subWindow; 

mainWindow = new CMainWindow; 
itsWindow = mainWindow; 
((CMainWindow *)mainWindow)->IMainWindow (this, itsData); 
itsMainPane = ((CMainWindow *)mainWindow)->itsMainPane; 
subWindow = new CCalcWindow; 
((CCalcWindow *)subWindow)->ICalcWindow (this, itsData); 
subWindow = new CGraphWindow; 
((CGraphWindow *)subWindow)->IGraphWindow (this, itsData); 

Notice that the new BuildWindows method creates instances 
of all three windows. This is in contrast to the code shown on 
page 170, in which only the CMainWindow and CCalc
Window instances are created. The CCalcWindow and 
CGraphWindow instances are known as directors. They, 
along with the TCL's CDocument class, are immediate sub
classes of the CDirector class, which is an abstract class 
that implements a window that can handle commands. A di
rector manages the communication between the application 
and the window. 

Figure 13-1 shows that when the GraphWindow is active, the 
gGopher variable points to the CGraphWindow class. This 
will be the first class to receive commands in its DoCom
mand method. If the command is not handled in that 
method, it is passed up the chain of command to the first di
rector able to perform the desired action. 
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Newly Generated Code in ZGraphWindow 

The generated code for the ZGraphWindow class consists of three 
major methods: IZGraphWindow, NewUser4, and DoCommand. 

IZGraphWindow Method Code 

When the BuildWindows method executes, it creates an in
stance of the CGraphWindow class, whose IGraphWindow 
method is called. The first action of the IGraphWindow 
method is to call the inherited IZGraphWindow method to 
create the window. The code for IZGraphWindow is as follows: 

void ZGraphWindow::IZGraphWindow(CDirectorOwner *aSupervisor) 
{ 

CView 
CBureaucrat 
CSizeBox 

*enclosure; 
*supervisor; 
*aSizeBox; 

inherited::IDirector (aSupervisor); 

itsWindow = new CWindow; 
itsWindow->IWindow (GraphWindowlD, FALSE, gDesktop, this); 

enclosure = itsWindow; 
supervisor = this; 
Scroi1Pane1 =new CScrollPane; 
ScrollPane1->IViewRes ('ScPn', 139, enclosure, supervisor); 

User4 = NewUser4 (); 
User4->IViewRes ('Pano', 128, Scro11Pane1, supervisor); 

Scro11Pane1->lnsta11Panorama (User4); 

aSizeBox = new CSizeBox; 
aSizeBox->ISizeBox (enclosure, supervisor); 

The method first calls its inherited !Director method and 
then creates a new instance of the CWindow class and ini
tializes it. The itsWindow instance variable for the CGraph
Window class will contain the handle to the new window. 
Following the creation of the window, the IZGraphWindow 
method installs an instance of the CScrollPane class and a 
new instance of User4, which is AppMaker's autonaming 
convention for items of class CPanorama. 
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NewUser4 Method Code 

To create the CPanorama, AppMaker generates code to call a 
method named NewUser4, which is as follows: 

CPanorama*ZGraphWindow::NewUser4(void) 

{ 
CPanorama *pane; 

pane = new CPanorama; 

return (pane); 

The NewUser4 method will be completely overridden by the 
subclass method of the same name. It is generated into the 
superclass file so that the version in the subclass can over
ride its functions. Following the creation of the User4 in
stance, it is initialized and installed into the scroll pane as 
the panorama for the ScrollPanel instance. 

DoCommand Method Code 

One other method is generated into the superclass and 
meant to be overridden. This is the DoCommand method, 
whose code is as follows: 

void ZGraphWindow::DoCommand(long theCommand) 

{ 

switch (theCommand) 

{ 
default: 

inherited::DoCommand (theCommand); 

break; 

Newly Generated Code in CGraphWindow 

The CGraphWindow class is the director for the graph win
dow and contains methods that override and provide addi
tional functionality for other methods in the Ensemble 
application. 
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NewUser4 Method Code 

The first new method is NewUser4, which is an override of 
the method of the same name in the ZGraphWindow class. 
The code for NewUser4 is as follows: 

CPanorama*CGraphWindow::NewUser4(void) 
{ 

CUser4 *pane; 

pane = new CUser4; 
return (pane); 

The method returns a pane that is a subclass of CPanorama. 
Creating a subclass of CPanorama is necessary to override 
its methods-in particular, the IViewTemp and Draw meth
ods (discussed later). 

IGraphWindow Method Code 

In the discussion of the BuildWindows method of the ZEn
sembleDoc class, we mentioned that when the CGraphWin
dow instance was created, its IGraphWindow method was 
called. The code for that method is as follows: 

void CGraphWindow::IGraphWindow( CDirector *aSupervisor, 
CEnsembleData *theData) 

itsData = theData; 
inherited::IZGraphWindow (aSupervisor); 
gDecorator->StaggerWindow (its Window); 

II any additional initialization for your window 

The IGraphWindow method saves the reference to the CEn
sembleData instance into its itsData instance variable and 
then calls the superclass IZGraphWindow method, which we 
have previously examined. When that method returns, it will 
have created the window and all its contents. The IGraph
Window method can call the gDecorator to size and position 
the window, staggering it with respect to the other windows 
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on the screen. We will be customizing IGraphWindow to per
form some additional initialization in the next chapter. 

UpdateMenus Method Code 

The CGraphWindow class also contains an UpdateMenus 
method, which, in its generated form, merely calls the inher
ited method. We will be modifying that method to enable and 
disable menu commands when we discuss the custom code 
changes in the next chapter. The generated code for the Up
dateMenus method is as follows: 

void CGraphWindow::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

DoCommand Method Code 

AppMaker also generates a DoCommand method to handle 
any commands sent to the GraphWindow, when it is active. 
The code for this method is as follows: 

void CGraphWindow::DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

default: 
inherited::DoCommand (theCommand); 

break; 

As generated, the DoCommand method merely passes on 
each command to its inherited method. We will be customiz
ing DoCommand to call the DoChart function when the For
mat Chart command is selected. 

ProviderChanged Method Code 

The last method generated into the CGraphWindow class is 
called ProviderChanged. The intention of this method is to 
handle the ProviderChanged messages created by the CBu
reaucrat class, in response to a window item that sends a 
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BroadcastChange message. The ProviderChanged method 
is essentially empty, and we will not be modifying it for the 
Ensemble application: 

void CGraphWindow::ProviderChanged(CCollaborator *aProvider, 
long reason, 
void* info) 

II empty method 

Newly Generated Code for CUser4 

The GraphWindow module also contains two important 
methods that pertain to the User4 class. Recall that the 
NewUser4 method of the CGraphWindow class created an 
instance of the User4 class to represent the panorama for the 
window's scroll pane. The User4 instance is initialized with a 
'Pano' resource; however, we will be modifying the IView
Temp method to set the bounds of the panorama when we 
discuss the custom graph code modifications in the next 
chapter. 

IViewTemp Method Code 

The generated code for the IViewTemp method is as follows: 

void CUser4::1ViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 

II any additional initialization for your subclass 

Note that the generated code merely calls the inherited 
IViewTemp method. 

Draw Method Code 

The most important of the User4 class methods is the Draw 
method. As generated, the method does nothing visible; how
ever, we will be adding a great deal of code to draw the se-
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lected graph when the method is called. The generated code 
for the Draw method is as follows: 

void CUser4::Draw(Rect *area) 
{ 

II replace with your own code, which draws the pane. 
II Note that 'area' is usually ignored; it has no relationship 
II to the size of the pane; it merely indicates what portion 
II (in QuickDraw coordinates) of the pane needs to be drawn 

Rect theFrame; 
PenState savePen; 

GetPenState (&savePen); 
PenNormal (); 
FrameToQDR (&frame, &theFrame); 

II place any drawing commands here 

SetPenState (&savePen); 

Notice that AppMaker has included comments that provide 
instructions regarding this method. The generated code saves 
the current pen characteristics by calling the toolbox Get
PenState routine, resets the pen's characteristics using the 
PenNormal routine, and then converts the bounds of the 
window's frame (which is an instance variable for every pane) 
from Frame to QuickDraw coordinates, saving the result into 
the local Rect variable theFrame. 

Any code to perform drawing functions within the panorama 
would immediately follow the FrameToQDR call. When all 
drawing operations are complete, the pen state is restored to 
the initial value by calling the SetPenState toolbox routine 
with the contents of the savePen variable. 

Newly Generated Code for DoChart 

The DoChart function is global and accessible to any method 
in the application. The AppMaker-generated code calls the 
DoChart function from within the ZEnsembleDoc class's Do
Command method when the Format Chart command has 
been selected. We intend for this command to be recognized 
only when the GraphWindow is active, so we have shown in 
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Figure 13-1 that the DoChart function is called from the 
CGraphWindow module (which will be the case after the cus
tom code modifications are complete). The generated code for 
the DoChart function is as follows: 

void DoChart(CDirectorOwner *aSupervisor) 
{ 

CChart *dialog; 
long dismisser; 

dialog = NULL; 
TRY 
{ 

dialog = new CChart; 
dialog->IChart (aSupervisor); 

/* initialize dialog panes *I 

dialog->BeginDialog (); 
dismisser= dialog->DoModalDialog (cmdOK); 

if (dismisser== cmdOK) 
{ 

/* extract values from dialog panes *I 

dialog->Dispose (); 
} 
CATCH 
{ 

ForgetObject (dialog); 
} 
ENDTRY; 

The DoChart function contains comments that indicate 
where code should be added to initialize the dialog panes and 
also where code should be added to extract the final settings 
as a result of the user's interaction with the dialog. 

The first act of the DoChart function is to create an instance 
of CChart and then send the !Chart message to it. The 
!Chart method immediately sends the IZChart message to 
perform the creation and initialization of the chart dialog, 
within the superclass method. The superclass methods are 
described in the next section. 
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After the dialog has been initialized, the DoChart function 
calls the BeginDialog and DoModalDialog methods to dis
play the dialog and cause it to begin accepting user events. 
When the user clicks one of the dismisser buttons, the Do
Chart function tests whether what was clicked was the OK 
button and suggests that code be added to extract the dia
log's settings. In any case, the dialog is disposed of and the 
function returns to its caller. 

Newly Generated Code for ZChart 

IZChart method 
(beginning) 

Table 13-1 shows two methods that are generated into the 
ZChart class. Of these, the more important one is the IZ
Chart method, which initializes the dialog's fields and con
trols. In effect, the method creates the appearance of the 
dialog. 

IZChart Method Code 

The code for this method is as follows: 

void ZChart::IZChart(CDirectorOwner *aSupervisor) 
{ 

CView *enclosure; 
CBureaucrat *supervisor; 
inherited::IAMDialogDirector (ChartlD, aSupervisor); 
enclosure = itsWindow; 
supervisor = itsWindow; 

OKButton =new CAMButton; 
OKButton->IViewRes ('CtlP', 175, enclosure, supervisor); 
CancelButton =new CAMButton; 
CancelButton->IViewRes ('CtlP', 176, enclosure, supervisor); 

ChartTypeGroup = new CLabeledGroup; 
ChartTypeGroup->IViewRes ('LGrp', 129, enclosure, supervisor); 

HorizontalBarRadio =new CAMRadioControl; 
HorizontalBarRadio->IViewRes ('CtlP', 177, ChartTypeGroup, 

ChartTypeGroup); 
VerticalBarRadio = new CAMRadioControl; 
VerticalBarRadio->IViewRes ('CtlP', 178, ChartTypeGroup, 

ChartTypeGroup); 
XYChartRadio = new CAMRadioControl; 
XYChartRadio->IViewRes ('CtlP', 179, ChartTypeGroup, 

ChartTypeGroup); 
ScalingChoicesGroup = new CLabeledGroup; 
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IZChart method 
code 
(continued) 

ScalingChoicesGroup->IViewRes ('LGrp', 130, enclosure, 
supervisor); 

hMinlabel = new CAMStaticText; 
hMinlabel->IViewRes ('AETx', 152, ScalingChoicesGroup, 

supervisor); 
hMaxlabel = new CAMStaticText; 
hMaxlabel->IViewRes ('AETx', 153, ScalingChoicesGroup, 

supervisor); 
horizMinField = new CAMDialogText; 
horizMinField->IViewRes ('ADTx', 142, ScalingChoicesGroup, 

supervisor); 
horizMaxField = new CAMDialogText; 
horizMaxField->IViewRes ('ADTx', 143, ScalingChoicesGroup, 

supervisor); 
vMinlabel = new CAMStaticText; 
vMinlabel->IViewRes ('AETx', 154, ScalingChoicesGroup, 

supervisor); 
vMaxlabel = new CAMStaticText; 
vMaxlabel->IViewRes ('AETx', 155, ScalingChoicesGroup, 
supervisor); 

vertMinField = new CAMDialogText; 
vertMinField->IViewRes ('ADTx', 144, ScalingChoicesGroup, 

supervisor); 
vertMaxField = new CAMDialogText; 
vertMaxField->IViewRes ('ADTx', 145, ScalingChoicesGroup, 

supervisor); 

Group16 = new CRadioGroupPane; 
Group16->IViewRes ('Pane', 136, ScalingChoicesGroup, supervisor); 
AutomaticScaleRadio = new CAMRadioControl; 
AutomaticScaleRadio->IViewRes ('CtlP', 180, Group16, Group16); 
ManualScaleRadio = new CAMRadioControl; 
ManualScaleRadio->IViewRes ('CtlP', 185, Group16, Group16); 

Titlelabel = new CAMStaticText; 
Titlelabel->IViewRes ('AETx', 156, enclosure, supervisor); 
titleField = new CAMDialogText; 
titleField->IViewRes ('ADTx', 146, enclosure, supervisor); 

vlabelRangeCheck = new CAMCheckBox; 
vlabelRangeCheck->IViewRes ('CtlP', 184, enclosure, supervisor); 
hRangeField = new CAMDialogText; 
hRangeField->IViewRes ('ADTx', 147, enclosure, supervisor); 
hlabelRangeCheck = new CAMCheckBox; 
hlabelRangeCheck->IViewRes ('CtlP', 183, enclosure, supervisor); 
vRangeField = new CAMDialogText; 
vRangeField->IViewRes ('ADTx', 148, enclosure, supervisor); 
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(concluded) 

The Final Structure of the Ensemble Application 375 

hlabRngField = new CAMDialogText; 
hlabRngField->IViewRes ('ADTx', 149, enclosure, supervisor); 
vlabRngField =new CAMDialogText; 
vlabRngField->IViewRes ('ADTx', 150, enclosure, supervisor); 

HorizontalDatalabel = new CAMStaticText; 
HorizontalDatalabel->IViewRes ('AETx', 157, enclosure, supervisor); 
VerticalDatalabel = new CAMStaticText; 
VerticalDatalabel->IViewRes ('AETx', 158, enclosure, supervisor); 

Each of the dialog elements is created as an instance of an 
appropriate class and then is initialized from the specified re
source generated by AppMaker (e.g., in the last line of the 
code, the VerticalDataLabel field is initialized with an 'AETx' 
resource number 158). The field and control names are taken 
from the labels assigned to them when we designed the dialog 
box. 

When the IZChart method is complete, all of the user inter
face elements have been created and placed into the dialog 
window. The final step of showing the window and operating 
the dialog is performed by the DoChart function. 

UpdateMenus Method Code 

The ZChart module also contains an UpdateMenus method 
that is intended to be overridden during the course of the ap
plication's execution. The generated code for this method is 
as follows: 

void ZChart::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

As is apparent, the UpdateMenus method calls its inherited 
method, thereby passing on the responsibility for handling 
any menu updates. 

Newly Generated Code for CChart 

The generated code for the CChart class consists of four ma
jor methods: !Chart, UpdateMenus, DoCommand, and Pro
viderChanged. We will be customizing all of these methods in 
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DoCommand 
method code 
(beginning) 

the next chapter. For now, we show the generated code to 
which the custom additions will be applied. 

IChart Method Code 

The IChart method overrides and supplements the initializa
tion of the IZChart method shown beginning on page 373. 
The generated code for IChart is as follows: 

void CChart::IChart (CDirectorOwner *aSupervisor) 
{ 

inherited:: IZChart ( aSupervisor); 
II any additional initialization for your dialog 

Although the generated code simply calls the inherited 
method, we will be supplementing the code with some addi
tional initialization steps. 

UpdateMenus Method Code 

The generated code for the UpdateMenus method needs no 
modification. It simply passes on the message to its super
class to handle. The code is as follows: 

void CChart::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 

DoCommand Method Code 

The DoCommand method is generated to handle the click 
commands assigned to all the controls in the dialog. We will 
be modifying the method heavily as generated by AppMaker; 
however it is as follows: 

void CChart::DoCommand(long theCommand) 
{ 

switch (theCommand) { 
case cmdHorizontalBarRadio: 

/* DoHorizontalBarRadio ();*/ 
break; 

case cmdVerticalBarRadio: 
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method code 
(concluded) 
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/* DoVerticalBarRadio ();*/ 
break; 

case cmdXYChartRadio: 
/* DoXYChartRadio ();*/ 

break; 
case cmdAutomaticScaleRadio: 

/* DoAutomaticScaleRadio ();*/ 
break; 

case cmdManualScaleRadio: 
/* DoManualScaleRadio () ;*/ 

break; 
case cmdvlabelRangeCheck: 

/* DovlabelRangeCheck ();*/ 
break; 

case cmdhlabelRangeCheck: 
/* DohlabelRangeCheck ();*/ 

break; 
default: 

inherited::DoCommand (theCommand); 
break; 

The code anticipates that you will be writing methods or 
functions to handle each of the command cases, so it sug
gests the naming conventions to use when any of these com
mands occurs. The DoCommand method is invoked when a 
click command (assigned from the resource for each of the 
controls when it is initialized) is generated. Clicking on a 
checkbox, for example, will generate a click command that in
vokes the DoCommand method. The TCL will take care of 
checking and unchecking the checkbox; however, you will 
have to write the code that performs any special functions 
that are required as a result of the click. We will show a 
greatly enhanced version of DoCommand in the next chapter. 

ProviderChanged Method Code 

The final method in the CChart module is called Provider
Changed. This method is invoked as a result of entries into 
any of the text fields in the dialog. 

The CAMDialogText classes send a BroadcastChange mes
sage when a keystroke changes the contents of a text field. As 
previously described, the CBureaucrat class overrides this 
method and sends a ProviderChanged message to the super-
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ProviderChanged 
method.code 
(beginniilg) 

visor of the element making the broadcast. For our charts, 
the supervisor is the CChart class. For any of the dialog's 
fields, AppMaker generates code to respond to the Provider
Changed messages. The generated code is as follows: 

void CChart::ProviderChanged(CCollaborator *aProvider, 
long reason, 
void* info) 

if (aProvider == horizMinField) { 

} 

if (horizMinField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == horizMaxField) { 

} 

if (horizMaxField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == vertMinField) { 

} 

if (vertMinField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == vertMaxField) { 

} 

if (vertMaxField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == titleField) { 

} 

if (titleField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == hRangeField) { 
if (hRangeField->Getlength () == O) { 

II text is empty 
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method code 
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Exercises 

} else { 
II there is some text 

if (aProvider == vRangeField) { 
if (vRangeField->Getlength () == O) { 

II text is empty 
} else { 

II there is some text 

if (aProvider == hlabRngField) { 

} 

if (hlabRngField->Getlength () == 0) { 
II text is empty 

} else { 
II there is some text 

if (aProvider == vlabRngField) { 
if (vlabRngField->Getlength () == 0) { 

II text is empty 

else 

II there is some text 

Exercises 379 

AppMaker's generated code tests the provider handle passed 
to the method against each of the field handles to determine 
to which field the message pertains. Once the field that has 
changed is found, the code tests if the field is empty or 
whether it contains one or more characters of data. We will 
make significant changes to this method, as described in the 
custom code modifications in the next chapter. 

1. Assuming that Figure 13-1 shows the universe of objects 
that have been created, how many actual object instances 
exist in the completed application? (Bear in mind that 
only one dialog object can exist at a given instant.) 
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2. Examine the IZChart method in the ZChart class and 
describe its similarity to the generated code in the 
IZNotebook and IZWorksheet methods for their corre
sponding dialogs. Explain how these similarities are use
ful in the development of large applications. 

3. Describe in what way the DoCommand method of the 
CChart class should be customized. Explain your reason
ing for each expected custom code addition. 

4. Describe the customization that will need to be applied to 
the ProviderChanged method in the CChart class. Is it 
possible to eliminate any of the code blocks generated for 
the various providers? If so, which ones, and why? 

5. Develop a methodology for validating the contents of each 
of the text fields in the Chart dialog. What measures 
must be taken to ensure that when the user dismisses 
the dialog, each of the fields contains a valid entry? 
Describe how you would go about verifying the data 
ranges entered into the fields that support those entries. 

6. Assuming that you have defined a methodology for vali
dating the input data in the Chart dialog, how would this 
be implemented so that it would prevent the dialog from 
being dismissed when one or more of the fields contain 
inconsistent or invalid data? (Hint Look into the class 
hierarchy for the dialog, and see if there is any way to 
prevent a dialog from being dismissed after the OK button 
has been pressed.) 
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Customizing the Graphing Code 

This chapter describes the custom code modifications we will 
make to the modules that implement the GraphWindow and 
Chart dialogs. The methods will be separated into two sets, 
with those pertaining to the Chart dialog being presented 
first. 

There are a great number of changes to both the Chart and 
GraphWindow modules. Each of these modules has a major 
role in providing the ability to construct graphs from the ex
isting worksheet data. 

The Chart module is responsible for running the dialog in 
which the chart type, data range, label range, and scaling 
choices are made. Once selected, the choices are retained, so 
that they can easily be changed. 

The GraphWindow module is responsible for performing all 
of the drawing functions. This is accomplished in the panora
ma's Draw method, which gains control when an Update 
event occurs. 

The new, custom code for each of the methods in the two 
modules is detailed in the sections that follow. Note that be
cause the graphing function works on the existing worksheet 
data, there are no changes to the file format or any of the 1/0 
methods in the CEnsembleData module for this version of 
the Ensemble application. 

The chapter contains a great deal of detailed discussion of the 
particular algorithms involved in creating horizontal bar, ver
tical bar, and scatter plot charts. It is important to show the 
applicable methods and discuss their operation for two rea
sons: First, the material is germane to charting practices in 
general, and second, leaving it out would omit important de-

381 
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tails of the application that we have so carefully constructed 
and documented. 

Customizing the CEnsembleDoc Code 

Two new methods have been added to the CEnsembleDoc 
class to facilitate access to the CCalcWindow class's methods 
from other classes. 

SetCalcWindow Method Code 

The code for this method is as follows: 

void CEnsembleDoc::SetCalcWindow(CCalcWindow *theWindow) 
{ 

itsCalcWindow = theWindow; 

The SetCalcWindow method is called by the ICalcWindow 
method in the CCalcWindow class when that instance is ini
tialized. The window is saved in a new instance variable 
called itsCalcWindow in the CEnsembleDoc class. 

GetCalcWindow Method Code 

The code for this method is as follows: 

CCalcWindow *CEnsembleDoc::GetCalcWindow(void) 
{ 

return itsCalcWindow; 

The GetCalcWindow method is called by the various charting 
methods in the GraphWindow module. These methods re
quire access to the worksheet window, so that the window's 
new access methods can be referenced. 

Customizing the CCalcWindow Code 

In order to support the inquiries of charting methods in the 
CGraphWindow module, two new methods have been added 
to the CCalcWindow class. 
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GetValueString Method Code 

This method accepts a cell number and returns the entry 
string associated with that cell if the cell has been defined in 
the worksheet. If it has not been thus defined, the method re
turns an empty string: 

void CCalcWindow::GetValueString (Cell aCell, StringPtr aString) 
{ 

long param; 
CWSEntry *anEntry; 

param =*(long *)&aCell; 
if((anEntry = (CWSEntry *)wsCluster->Findltem1 (FindWSCell, 

param)) != NULL) 
{ 

} 
an Entry->GetWSText( aStri ng); 

else 
{ 

CopyPString("\p", aString); 
} 

GetValueValue Method Code 

The GetValueValue m€thod accepts a cell number and re
turns the double-precision floating-point value associated 
with the cell if the cell has been defined in the worksheet. If it 
has not been thus defined, the method returns a value of 0.0. 
The code for the method is as follows: 

void CCalcWindow::GetValueValue (Cell aCell, double *aValue) 
{ 

long param; 
CWSEntry *anEntry; 

param =*(long *)&aCell; 
if((anEntry = (CWSEntry *)wsCluster->Findltem1 (FindWSCell, 

param)) != NULL) 

*aValue = anEntry->GetWSValue(); 
} 
else 
{ 

*aValue = 0.0; 



384 Chapter 14~Customizing the Graphing Code 

Both the GetValueString and GetValueValue methods re
quire a cell as their input value. The horizontal component of 
the cell identifies the worksheet column, and the vertical 
component identifies the worksheet row. 

The charting methods (described later in this chapter) must 
access the worksheet values and strings for two reasons: The 
values are used to determine the range of data and individual 
data values to be charted, while the strings are used to pro
vide annotation of the charts with worksheet labels. In both 
cases, the CWSEntry class's methods are used to access the 
corresponding fields in the worksheet entry if it is found to be 
defined. 

Customizing the Format Chart Dialog 

Table 14-1 
Customized methods 
to implement the 
Format Chart dialog 

In order for a graph to be drawn, the user must specify its 
type and at least the range of data to be graphed. The specifi
cation of the graph type and its parameters is performed in 
the Format Chart dialog. The custom code modifications to 
implement the full functionality of this dialog are listed in Ta
ble 14-1. The single new method, Validate, is shown in bold
face type. 

Class Method Description 

Chart.c global Do Chart Function to create and manage 
function the chart dialog 

CC hart I Chart Initializes view IDs 

CC hart DoCommand Handles click commands 

CC hart ProviderChanged Handles changes in text fields 

CC hart Validate Validates dialog entries 

Customizing the DoChart Code 

The global DoChart function is called from within the Do
Command method of the GraphWindow module when the 
user selects the Chart command from the Format menu. The 
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function is responsible for creating and managing the Chart 
dialog, and it does so by creating an instance of the CChart 
class, initializing the instance, running the dialog, and then 
extracting the modified data when the user clicks on the OK 
button. If the Cancel button is clicked, the function does not 
update the saved dialog settings. The original code for this 
function was presented in the previous chapter (see 
page 372). The modifications to the code are substantial. The 
original dialog is quite busy, with a lot of different fields and 
selections. One purpose of the modified code is to hide por
tions of the dialog, as it is first presented to the user, so that 
only the previous settings are visible and active. The initial 
settings for the dialog are established by the IGraphWindow 
method in the GraphWindow module. The custom code for 
the DoChart function is as follows: 

void DoChart(CDirectorOwner *aSupervisor) 
{ 

CC hart 
long 
chart Info 

*dialog; 
dismisser; 
aSetting; 

dialog= NULL; 
TRY 
{ 

dialog = new CChart; 
dialog->IChart (aSupervisor); 

II 
II initialize the dialog with its last (or first) settings 
II 
dialog->theChartlnfo = ((CGraphWindow *)aSupervisor) 

->GetChartlnfo(); 
dialog->theSettings = dialog->theChartlnfo->GetChartlnfo(); 
dialog->theSettings.modified = O; 
aSetting = dialog->theSettings; 
dialog->Group 18->SetStation ID( aSetti ng .scalingType); 
dialog->horizMinField->SetTextString(aSetting.hMinScale); 
dialog->horizMaxField->SetTextString( aSetti ng. hMaxScale); 
dialog->vertMin Field->SetTextString( a Setting. vMinScale); 
dialog->vertMaxField->SetTextString(aSetting. vMaxScale); 
if(aSetting.scalingType == cAutomaticScaleViewlD) 
{ 

dialog->horizMinField->Hide(); 
dialog->horizMaxField->Hide(); 
dialog->vertMinField->Hide(); 
dialog->vertMaxField->Hide(); 
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DoChart 
fimction code 
(continued) 

} 
switch(aSetting.chartType) 
{ 

} 

case cHorizontalBarViewlD: 
{ 

} 

II deactivate the horizontal stuff 
dialog->Horizontal Datalabel->Hide(); 
dialog->hlabelRangeCheck->Deactivate(); 
dialog->hlabRngField->Hide(); 
dialog->hRangeField->Hide(); 
dialog->vertMinField->Hide(); 
dialog->vertMaxField->Hide(); 
if(aSetting.vlabelCheck == 0) 
{ 

dialog->vlabRngField->Hide(); 
} 
break; 

case cVerticalBarViewlD: 
{ 

II deactivate the vertical stuff 
dialog-> VerticalDatalabel->Hide(); 
dialog->vlabelRangeCheck->Deactivate(); 
dialog->vlabRngField->Hide(); 
dialog->vRangeField->Hide(); 
dialog->horizMinField->Hide(); 
dialog->horizMaxField->Hide(); 
if(aSetting.hlabelCheck == 0) 

dialog->hlabRngField->Hide(); 
break; 

dialog->ChartTypeGroup->SetStation ID( aSetting.chartType); 
dialog->titleField->SetTextString(aSetting.title); 
dialog->h RangeField->SetTextString( a Setting. hDataRange); 
dialog->vRangeField->SetT extString( aSetting. vDataRange); 
dialog->hlabRngField->SetTextString(aSetting.hlabelRange); 
dialog->hlabelRangeCheck->SetValue(aSetting.hlabelCheck); 
dialog->vlabRngField->SetTextString(aSetting.vlabelRange); 
dialog->vlabelRangeCheck->SetValue(aSetting.vlabelCheck); 

II 
II start running the dialog 
II 
dialog->BeginDialog (); 
dismisser= dialog->DoModalDialog (cmdOK); 
if (dismisser== cmdOK) 
{ 

I* extract values from dialog panes*/ 
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aSetting = dialog->theSettings; 
aSetting.modified = 1; 
dialog->theChartlnfo->SetChartlnfo(aSetting); 

} 
dialog->Dispose (); 

} 
CATCH 
{ 

ForgetObject (dialog); 
} 
ENDTRY; 

The DoChart function begins by creating an instance of the 
CChart class. Then it calls the IChart method to initialize the 
instance. As was shown in the last chapter, the IChart 
method calls the IZChart method to create and initialize each 
of the user interface items in the dialog. When control re
turns to the DoChart function, the dialog has been created 
and initialized. The next series of steps in the function are re
sponsible for setting the state of all the controls and fields to 
their previous values. 

We have created a new module that defines a class called 
CChartlnfo which contains methods to initialize an object of 
that class and access its contents. This class is described later, 
in conjunction with the GraphWindow module methods; how
ever, it is useful for purposes of understanding the DoChart 
initialization code. Accordingly, we present the structure and 
contents of the data element that contains the settings that 
this code references. The settings are kept in a structure 
whose type is defined as chartinfo. This structure contains all 
of the information needed to reconstruct the settings in the 
Chart dialog. The chartinfo structure is as follows: 

typedef struct 
chartirifo structure { 
declaration 
(beginning) 

short 
short 
short 
Str9 
Str9 
Str9 
Str9 
Str255 

modified; 
chart Type; 
scaling Type; 
hMinScale; 
hMaxScale; 
vMinScale; 
vMaxScale; 
title; 
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chartlnjo structure 
declaration 
(concluded) 

Str9 hDataRange; 
Str9 vDataRange; 
short hLabelCheck; 
Str9 hLabelRange; 
short vLabelCheck; 
Str9 vLabelRange; 

} chartlnfo; 

The very first field in the structure is used to keep track of 
whether the control settings or fields were modified by the 
user. The field is set to 0 at the beginning of the DoChart 
function, and its value is set to 1 if the user clicks the OK 
button-which carries the implicit assumption that some
thing has been modified. 

Each of the controls has a short integer that contains its 
saved state. Each of the dialog fields is contained in a string 
variable of an appropriate size. The access methods provided 
with the CChartlnfo class translate the string variable values 
to appropriate corresponding binary values when called upon 
to do so. 

The DoChart function sets the appropriate scaling selection, 
loads the horizontal and vertical scale settings into their cor
responding fields, and then checks whether automatic scal
ing was selected. If so, it hides the corresponding minimum 
and maximum scale values. 

After handling the appearance of the scaling section of the di
alog, the DoChart function checks what type of chart has 
been selected. Depending on whether a horizontal bar, verti
cal bar, or X-Y chart was selected, the function hides their
relevant data entry fields. 

Regardless of whether the data entry fields are hidden or visi
ble, the DoChart function loads these fields with their previ
ous values. Once that is complete, the BeginDialog and 
DoModalDialog methods are executed. At this point, the user 
is in full control of the dialog. If the chart type is changed, by 
clicking one of the other chart type buttons, a click command 
is sent to the DoCommand method to signal that fact. Simi
larly, if the user keys a new value into one of the text fields, 
that fact is noted by sending a message to the Provider
Changed method. These methods will be described shortly. 
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After the user dismisses the dialog, if the OK button was 
clicked, the current settings that have been updated locally 
with each change are saved by calling the SetChartlnfo ac
cess method. If Cancel was clicked, all changes are dis
carded. In any case, the dialog is disposed of. 

Customizing the CChart Code 

The CChart class contains several methods that require 
changes to implement the full functionality of the Format 
Chart command. These methods are listed in Table 14-1. 
Each is discussed in the subsections that follow. 

IChart Method Code 

The IChart method is called by the DoChart function to ini
tialize the Chart dialog. The first action of the method is to 
call the inherited IZChart method to create and initialize all 
the user interface elements in the dialog. 

The code for the IZChart method is shown beginning on 
page 373. After the IZChart method returns, we need to as
sign a "view ID" to each of the radio buttons in the dialog, so 
that we can refer to these in the other methods. The code for 
the IChart method is as follows: 

void CChart::IChart(CDirectorOwner *aSupervisor) 
{ 

inherited::IZChart (aSupervisor); 

II 
II initialize the ViewlDs 
II 
HorizontalBarRadio->ID = cHorizontalBarViewlD; 
VerticalBarRadio->ID = cVerticalBarViewlD; 
XYChartRadio->ID = cXYChartViewlD; 

AutomaticScaleRadio->ID = cAutomaticScaleViewlD; 
ManualScaleRadio->ID = cManualScaleViewlD; 

TEAutoView (TRUE, titleField->macTE); 

The values for the viewID instance variables (common to all 
descendants of the CView class) were arbitrarily chosen to be 



390 Chapter 14 .. Customizing the Graphing Code 

DoCommand 
method code 
(beginning) 

the same as each radio button's resource ID. The declara
tions for the values associated with the view ID mnemonics 
are as follows: 

enum 

}; 

cHorizontalBarViewlD = 177, 
cVerticalBarViewlD, 
cXYChartViewlD 

enum 
{ 

}; 

cAutomaticScaleViewlD = 180, 
cManualScaleViewlD = 185 

Assigning a view ID to each radio button allows us to refer to 
the button by name and also allows us to store its value into 
the settings structure. When the DoChart function is called 
again, the view ID can be used to initialize the dialog with the 
appropriate button selected. 

DoCommand Method Code 

The DoCommand method is responsible for responding to 
click commands associated with each of the radio button and 
checkbox controls. When the user clicks one of these but
tons, a DoCommand message, identifying the control, is sent 
to the CChart class. The DoCommand code for our revised 
method is rather lengthy: 

void CChart: :DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdHorizontalBarRadio: 
{ 

theSettings.chartType = cHorizontalBarViewlD; 
VerticalDatalabel->Show(); 
vRangeField->Show(); 
vlabelRangeCheck->Activate(); 
HorizontalDatalabel->Hide(); 
hRangeField->Hide(); 
hlabelRangeCheck->Deactivate(); 
hlabRngField->Hide(); 
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} 
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if(theSettings.scalingType == cManualScaleViewlD) 
{ 

} 

vertMinField->Hide(); 
vertMaxField->Hide(); 
horizMinField->Show(); 
horizMaxField->Show(); 

if(theSettings.vlabelCheck == O) 
{ 

vlabRngField->Hide(); 
} 
else 
{ 

vlabRngField->Show(); 
} 
break; 

case cmdVerticalBarRadio: 
{ 

} 

theSettings.chartType = cVerticalBarViewlD; 
Horizontal Datalabel->Show(); 
h RangeField->Show(); 
hlabelRangeCheck->Activate(); 
VerticalDatalabel->Hide(); 
vRangeField->Hide(); 
vlabelRangeCheck->Deactivate(); 
vlabRngField->Hide(); 
if(theSettings.scalingType == cManualScaleViewlD) 
{ 

} 

horizMinField->Hide(); 
horizMaxField->Hide(); 
vertMinField->Show(); 
vertMaxField->Show(); 

if(theSettings.hlabelCheck == O) 
{ 

hlabRngField->Hide(); 
} 
else 
{ 

hlabRngField->Show(); 
} 
break; 

case cmdXYChartRadio: 
{ 

theSettings.chartType = cXYChartViewl D; 
Vertical Datalabel->Show(); 
vRangeField->Show(); 
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DoCommand 
met1wdcode 
(continued) 

} 

vlabelRangeCheck->Activate(); 
if(theSettings.vlabelCheck == 0) 
{ 

vlabRngField->Hide(); 
} 
else 
{ 

vlabRngField->Show(); 
} 
HorizontalDatalabel->Show(); 
hRangeField->Show(); 
hlabelRangeCheck->Activate(); 
if(theSettings.hlabelCheck == O) 
{ 

hlabRngField->Hide(); 

else 
{ 

hlabRngField->Show(); 
} 
if(theSettings.scalingType == cManualScaleViewlD) 
{ 

horizMinField->Show(); 
horizMaxField->Show(); 
vertMinField->Show(); 
vertMaxField->Show(); 

} 
break; 

case cmdAutomaticScaleRadio: 
{ 

} 

theSettings.scalingType = cAutomaticScaleViewlD; 
horizMinField->Hide(); 
horizMaxField->Hide(); 
vertMinField->Hide(); 
vertMaxField->Hide(); 
break; 

case cmdManualScaleRadio: 
{ 

theSettings.scalingType = cManualScaleViewlD; 
switch(theSettings.chartType) 
{ 

case cHorizontalBarViewlD: 
{ 

vertMinField->Hide(); 
vertMaxField->Hide(); 
horizMinField->Show(); 
horizMaxField->Show(); 



DoCommand 
method code 
(concluded) 

} 

} 
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break; 
} 
case cVerticalBarViewlD: 
{ 

horizMinField->Hide(); 
horizMaxField->Hide(); 
vertMinField->Show(); 
vertMaxField->Show(); 
break; 

} 
default: 
{ 

horizMinField->Show(); 
horizMaxField->Show(); 
vertMinField->Show(); 
vertMaxField->Show(); 
break; 

break; 

case cmdvlabelRangeCheck: 
{ 

theSettings.vlabelCheck = vlabelRangeCheck->GetValue(); 
if(theSettings.vlabelCheck == 0) 

vlabRngField->Hide(); 
else 

vlabRngField->Show(); 
break; 

} 
case cmdhlabelRangeCheck: 
{ 

theSettings.hlabelCheck = hlabelRangeCheck->GetValue(); 
if(theSettings.hlabelCheck == 0) 
{ 

hlabRngField->Hide(); 
} 
else 
{ 

hlabRngField->Show(); 
} 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 
break; 



394 Chapter 14 >Customizing the Graphing Code 

ProviderChanged 
method code 
(beginning} 

The code for the DoCommand method consists of a big 
switch statement that has a case for each of the controls in 
the dialog. When the user clicks one of the radio button con
trols, we need to change the appearance of the dialog to re
flect the requirements of the new selection. For example, if 
the Horizontal Bar chart radio button is clicked, we need to 
show the vertical data range and vertical label fields, but hide 
the corresponding horizontal data range and label fields. In 
addition, if manual scaling is selected, we need to hide the 
vertical minimum and maximum scale fields. Each of the ra
dio buttons and checkboxes has an associated click com
mand and code in the DoCommand method to modify the 
appearance of the dialog box according to the selection. 

ProviderChanged Method Code 

The ProviderChanged method is invoked by the CBureau
crat class, in response to a BroadcastChange message from 
one of the dialog's text entry fields. When the user enters, 
changes, or deletes text in any of the text fields, the TCL's 
CEditText, CDialogText, and CAbstractText classes con
tain methods that send BroadcastChange messages. The 
CBureaucrat class's BroadcastChange method, in addition 
to passing on the message to the CCollaborator class, sends 
a ProviderChanged message to the supervisor of the in
stance that sent the original message. In the case of the 
Chart dialog, the supervisor is the CChart class. The modi
fied code for the ProviderChanged method is as follows: 

void CChart::ProviderChanged(CCollaborator *aProvider, 
long reason, 
void* info) 

if (aProvider == horizMinField) 
{ 

horizMinField->GetTextString(theSettings.hMinScale); 
} 
if (aProvider == horizMaxField) 
{ 

horizMaxField->GetTextStri ng (theSetti ngs. h Max Scale); 
} 
if (aProvider == vertMinField) 
{ 

vertMi n Field->GetTextString(theSettings. vMinScale); 



ProviderChanged 
method.code 
(concluded) 
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if (aProvider == vertMaxField) 
{ 

vertMaxField->GetTextString (theSettings. vMaxScale); 
} 
if (aProvider == titleField) 
{ 

titleField->GetTextString(theSettings. title); 
} 
if (aProvider == hRangeField) 
{ 

h RangeField->GetTextString(theSettings. hDataRange); 
} 
if (aProvider == vRangeField) 
{ 

vRangeField->GetTextString(theSettings. vDataRange); 
} 
if (aProvider == hLabRngField) 
{ 

hLabRngField->GetTextString(theSettings. hLabel Range); 
} 
if (aProvider == vLabRngField) 
{ 

vLabRngField->GetT extString(theSettings. vLabelRange); 

The ProviderChanged method tests the identity of the &Pro
vider argument. For each of the text fields, when the associ
ated provider is matched, the current contents of the field are 
saved into the appropriate field of the theSettings structure 
(an instance variable of the CChart class). In this way, the 
current settings are constantly updated with the latest con
tents of all the fields. 

Validate Method Code 

When the user clicks the OK button, the TCL calls an initially 
empty Validate method, which can return a TRUE or FALSE re
sponse. If the response is TRUE, the TCL allows the dialog to 
stop running and returns control to the DoChart function, 
immediately after the DoModalDialog statement. If the re
sponse is FALSE, the dialog is not dismissed. While the default 
method always returns TRUE, it is possible to provide an over
ride method that performs custom validation of the fields and 
settings in the dialog. This is what we have done in the case 
of the Chart dialog. The custom code for the Validate over
ride method is quite lengthy and is as follows: 
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Validate 
method code 
{beginning) 

Boolean CChart::Validate (void) 
{ 

minMax aScale; 
Rect aRange1; 
Rect aRange2; 
CChartlnfo *aDummy; 
Boolean result; 
short v1 Length, h1 Length; 
short v2Length, h2Length; 

II 
II validate the fields of the Format Chart dialog 
II to ensure consistency with the worksheet and 
II avoid problems later when we build the chart. 
II 
TRY 
{ 

result= TRUE; 
aDummy = new CChartlnfo; 
aDummy->IChartlnfo(); 
aDummy->SetChartlnfo (theSettings); 
switch (theSettings.chartType) 
{ 

case cHorizontalBarViewlD: 
{ 

aRange1 = aDummy->GetVData(); 
if(aRange1 .left< 0) 
{ 

} 

II 
II invalid data range 
II 
result = FALSE; 

if(aRange1 .left== aRange1 .right) 
{ 

v1 Length= aRange1 .bottom - aRange1 .top; 
} 
else if(aRange1 .bottom== aRange1 .top) 
{ 

v1 Length= aRange1 .right - aRange1 .left; 
} 
else 
{ 

v1 Length = -1 ; 
} 
if(v1 Length <= 0) 
{ 



Validate 
method code 
(continued) 

} 

Customizing the Format Chart Dialog 397 

result = FALSE; 
} 
if(theSettings.vLabelCheck != 0) 
{ 

} 

aRange1 = aDummy->GetVLabel(); 
if(aRange1 .left< O) 
{ 

} 

II 
II invalid label range 
II 
result = FALSE; 

if(aRange1 .left== aRange1 .right) 
{ 

v2Length = aRange1 .bottom - aRange1 .top; 
} 
else if(aRange1 .bottom== aRange1 .top) 
{ 

v2Length = aRange1 .right - aRange1 .left; 
} 
else 
{ 

v2Length = -1 ; 
} 
if(v2Length <= 0 11 v2Length != v1 Length) 
{ 

result = FALSE; 

if(theSettings.scalingType == cManualScaleViewlD) 
{ 

aScale = aDummy->GetHScale(); 
if (aScale.max <= aScale.min) 
{ 

II 
II invalid scale 
II 
result = FALSE; 

} 
break; 

case cVerticalBarViewlD: 
{ 

aRange1 = aDummy->GetHData(); 
if(aRange1 .left < 0) 
{ 

II 
II invalid data range 
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Validate 
method code 
(continued) 

II 
result = FALSE; 

} 
it(aRange1 .left == aRange1 .right) 
{ 

h1 Length= aRange1 .bottom - aRange1 .top; 
} 
else if(aRange1 .bottom == aRange1 .top) 
{ 

h1 Length= aRange1 .right - aRange1 .left; 
} 
else 
{ 

h1 Length= -1; 
} 
it(h1 Length <= 0) 
{ 

result = FALSE; 
} 
if(theSettings.hLabelCheck != 0) 
{ 

} 

aRange1 = aDummy->GetHLabel(); 
if(aRange1 .left < 0) 
{ 

} 

II 
II invalid label range 
II 
result = FALSE; 

it(aRange1 .left == aRange1 .right) 
{ 

h2Length = aRange1 .bottom - aRange1 .top; 
} 
else if(aRange1 .bottom == aRange1 .top) 
{ 

h2Length = aRange1 .right - aRange1 .left; 

else 
{ 

h2Length = -1 ; 
} 
if(h2Length <= O II h2Length != h1 Length) 
{ 

result = FALSE; 

if(theSettings.scalingType == cManualScaleViewlD) 
{ 

aScale = aDummy->GetVScale(); 



Validate 
method.code 
(continued) 

} 

} 
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if (aScale.max <= aScale.min) 
{ 

II 
II invalid scale 
II 
result= FALSE; 

break; 

case cXYChartViewlD: 
{ 

aRange1 = aDummy->GetHData(); 
if(aRange1 .left < 0) 
{ 

} 

II 
II invalid data range 
II 
result= FALSE; 
break; 

if(aRange1 .left== aRange1 .right) 
{ 

v1 Length = aRange1 .bottom - aRange1 .top; 
} 
else if(aRange1 .bottom == aRange1 .top) 
{ 

v1 Length = aRange1 .right - aRange1 .left; 
} 
else 
{ 

v1 Length= -1; 
} 
if(v1 Length < 0) 
{ 

} 

result = FALSE; 
break; 

if(theSettings.hLabelCheck != 0) 
{ 

aRange1 = aDummy->GetHLabel(); 
if(aRange1 .left< O) 
{ 

} 

II 
II invalid label range 
II 
result = FALSE; 

if(aRange1 .left == aRange1 .right) 
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Validate 
method.code 
(continued) 

} 

v2Length = aRange1 .bottom - aRange1 .top; 
} 
else if(aRange1 .bottom== aRange1 .top) 
{ 

v2Length = aRange1 .right - aRange1 .left; 
} 
else 
{ 

v2Length = -1 ; 
} 
if(v2Length < 0) 
{ 

result = FALSE; 

if(theSettings.scalingType == cManualScaleViewlD) 
{ 

} 

aScale = aDummy->GetVScale(); 
if (aScale.max <= aScale.min) 
{ 

II 
II invalid scale 
II 
result = FALSE; 

aRange2 = aDummy->GetVData(); 
if(aRange2.left < 0) 
{ 

} 

II 
II invalid data range 
II 
result = FALSE; 

if(aRange2.left == aRange2.right) 
{ 

h1 Length = aRange2.bottom - aRange2.top; 
} 
else if(aRange2.bottom == aRange2.top) 
{ 

h1 Length = aRange2.right - aRange2.left; 
} 
else 
{ 

h1Length = -1; 
} 
if(h1 Length< 0) 
{ 



Validate 
method.code 
(continued} 
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result= FALSE; 
} 
if(theSettings.vLabelCheck != 0) 
{ 

} 

aRange2 = aDummy->GetVLabel(); 
if(aRange2.left < 0) 
{ 

} 

II 
II invalid label range 
II 
result= FALSE; 

if(aRange2.left == aRange2.right) 
{ 

h2Length = aRange2.bottom - aRange2.top; 
} 
else if(aRange2.bottom == aRange2.top) 
{ 

h2Length = aRange2.right - aRange2.left; 
} 
else 
{ 

h2Length = -1 ; 
} 
if(h2Length < O) 
{ 

result = FALSE; 

if(theSettings.scalingType == cManualScaleViewlD) 
{ 

} 

aScale = aDummy->GetHScale(); 
if (aScale.max <= aScale.min) 
{ 

II 
II invalid scale 
II 
result = FALSE; 

if(v1 Length != h1 Length) 
{ 

} 

II 
II must have same number of X-Y points 
II 
result= FALSE; 

break; 
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Validate 
method code 
(concluded) 

default: 
{ 

result = FALSE; 

} 
CATCH 
{ 

ForgetObject (aDummy); 
result = FALSE; 

} 
ENDTRY; 

if(result == FALSE) 
{ 

SysBeep(30); 
} 
aDummy->Dispose(); 
return result; 

The code in the Validate method is broken up into cases that 
apply to each of the potential chart types. The switch state
ment jumps to the validation code for the case that is associ
ated with the currently selected chart type. In the code for 
each case, each of the fields that participate in setting param
eters for the chart is tested to ensure that it is valid. In addi
tion, each is tested to ensure that it is consistent with other 
related parameters for that chart type. If any of the tests fail, 
the method plays the selected "system beep" sound and re
turns FALSE to the TCL. A TRUE result is returned only if all 
the validation checks are successful. Basically, the validation 
consists of the following steps: 

1. A dummy instance of the CChartlnfo object is created, 
and the current settings are placed into its instance vari
able. (This is done so that we can use the access methods 
in the CChartlnfo object to convert the string variables to 
cell ranges and binary numeric values.) 

2. If the chart type is a horizontal or vertical bar chart, Vali
date calls the GetVData or GetHData access method to 
acquire the worksheet's cell range for the chart data. If 
the range was specified improperly. or if the ending cell 
has a value that is not greater than the value of the begin
ning cell, a FALSE result is returned. The validation proce-
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dure continues by determining whether a label range has 
been specified. If so, the GetVLabel or GetHLabel access 
method is called to return the worksheet cell range occu
pied by the labels. If an invalid range was specified, then 
if the number of label cells does not equal the number of 
data cells, a FALSE result is returned. Finally, if the man
ual scaling option is chosen, the GetHScale or GetVScale 
access method is called to return the appropriate mini
mum and maximum values. If these are invalid, a FALSE 

result is returned. Only if all of these checks are success
ful is TRUE returned. 

3. If the chart type is an X-Y chart, the checks for both hori
zontal and vertical cell ranges, label ranges, and scaling 
are performed. Only if all the values are valid and consis
tent with one another is a TRUE result returned to the 
TCL. 

Although the code for the Validate method is rather long, it is 
quite straightforward and easy to follow. 

Customizing the GraphWindow Code 

This section describes the custom code modifications made to 
the routines in the GraphWindow module. The methods for 
which new custom code has been written are shown in bold
face type in Table 14-2. Methods which have only been modi
fied are shown in plain type in the figure. 

Customizing the CGraphWindow Methods 

Table 14-2 shows a number of methods in the CGraphWin
dow class that have been modified to complete the function
ality of the graphing features in the Ensemble application. In 
general, each of these methods is concerned only with the 
window and its commands, although two new access meth
ods have been provided. 

IGraphWindow Method Code 

The IGraphWindow method is responsible for calling the 
IZGraphWindow method in the superclass to create and in
stall the window, its scroll pane, and its panorama and then 
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Table 14-2 
Customized methods 
in the GraphWindow 
module to implement 
the selected chart 
types 

IGraphWindow 
method code 
{beginning) 

Class 

CGraphWindow 

CGraphWindow 

CGraphWindow 

CGraphWindow 

CGraphWindow 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

CUser4 

global 

Method Description 

IGraphWindow Initializes GraphWindow 

UpdateMenus Enables and disables menu items 

Do Command Handles menu commands 

GetCalcWindow Access method for worksheet 

GetChartlDfo Access method for chart settings 

IViewTemp Initializes drawing panorama 

Draw Draws panorama contents 

DrawBBarChart Draws horizontal bar chart 

DrawVBarChart Draws vertical bar chart 

DrawXYChart Draws X-Y chart 

GetBarThlckness Determines optimum bar size 

GetLabelMax Determines width of longest label 

GetDat•MfnMax Determines mfnimum and maxi
mum data values for chart 

DrawChartFrame Draws frame for chart 

DrawHorizTicks 

DrawVertTicks 

GetFormat 

loglOx, explOx, 
RoundDown, 
RoundUp, lookUp, 
lookDown 

Draws horizontal axis annotation 

Draws vertical axis annotation 

Determines annotation format 

Miscellaneous global functions to 
support the calculation of auto
matic scaling and selection of 
appropriate axis annotation values. 

perform any additional initialization. The code for IGraph
Window is as follows: 

void CGraphWindow::IGraphWindow(CDirector 

CEnsembleData 

Str255 theFilename; 

itsData = theData; 

*aSupervisor, 
*the Data) 



IGraphWindow 
metfwdcode 
(concluded) 
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inherited::IZGraphWindow (aSupervisor); 
gDecorator->StaggerWindow (itsWindow); 

II 
II create a new CChartlnfo instance 
II 
itsChartlnfo = new CChartlnfo; 
itsChartlnfo->IChartlnfo(); 

II 
II Put the window's name in the title 
II 
if(((CEnsembleDoc *) aSupervisor)->itsFile !=NULL) 
{ 

( (CEnsembleDoc *) aSupervisor)->itsFile->GetName(theFilename); 
itsWindow->SetTitle(theFilename); 

After control returns from the superclass's IZGraphWindow 
method, the IGraphWindow method sends the gDecorator a 
message to stagger the window with respect to the others on 
the screen. Then IGraphWindow creates a new instance of 
the CChartlnfo class to hold the chart settings and writes 
the title of the existing document (if there is any) into the win
dow's title bar. 

UpdateMenus Method Code 

The UpdateMenus method has been revised to enable only 
the Chart command in the Format menu when the Graph
Window is frontmost on the screen. The code for the updated 
version of UpdateMenus is as follows: 

void CGraphWindow::UpdateMenus(void) 
{ 

inherited::UpdateMenus (); 
II 
II disable Close, Format Notebook, Format Worksheet, enable 
II Format Chart if GraphWindow is the frontmost window 
II 
gBartender->DisableCmd (cmdClose); 
gBartender->DisableCmd ( cmdNotebook); 
gBartender->DisableCmd ( cmdWorksheet); 
gBartender->EnableCmd (cmdChart); 
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Note that in addition to disabling the Notebook and Work
sheet commands, the method also disables the Close com
mand in the File menu. The windows can be closed only 
when the Notebook window is frontmost on the screen. 

DoCommand Method Code 

The primruy addition to the DoCommand method is the code 
that recognizes the Chart command. 

Although the Chart command is recognized in the zEnsem
bleDoc class's re-generated DoCommand method, by inter
cepting it in the CGraphWindow class, we can respond to it 
first, and allow it only to be enabled in the Format menu 
when the CGraphWindow is frontmost on the screen. 

The revised code for the DoCommand method is as follows: 

void CGraphWindow::DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdChart: 
{ 

DoChart(this); 
if(itsChartlnfo->chartSettings.modified) 
{ 

User4->Refresh(); 
} 
break; 

} 
default: 
{ 

inherited::DoCommand (theCommand); 
break; 

Any command other than cmdChart will be handled by the 
default case, which calls the inherited DoCommand method. 

GetCalcWindow Method Code 

The GetCalcWindow method is responsible for providing ac
cess to the worksheet from other methods. It is called from 
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the various chart-drawing methods in the CUser4 class. The 
method makes use of the fact that the CEnsembleDoc class 
is the supervisor of the CGraphWindow class, which calls the 
document's GetCalcWindow method to retrieve the handle to 
the worksheet instance. The code for GetCalcWindow is as 
follows: 

CCalcWindow *CGraphWindow::GetCalcWindow() 
{ 

return ((CEnsembleDoc *) itsSupervisor)->GetCalcWindow(); 

GetChartlnfo Method Code 

When the CChartlnfo instance was created in the IGraph
Window method, the initialization message sent to that in
stance created the default settings for the chart. When the 
DoChart function is called by the DoCommand method, it 
calls the GetChartlnfo method to retiieve the handle to the 
current CChartlnfo instance. The code for the GetChartlnfo 
access method is as follows: 

CChartlnfo *CGraphWindow::GetChartlnfo(void) 
{ 

return itsChartlnfo; 

Customizing the CUser4 Methods 

IViewTemp 
method code 
(beginning} 

All of the drawing operations for the GraphWindow take 
place with respect to its panorama element, for which App
Maker has created a new class named CUser4. The new and 
customized methods in that class are covered in this section. 

IViewTemp Method Code 

The modified code for the lviewTemp method is as follows: 

void CUser4::1ViewTemp(CView *anEnclosure, 
CBureaucrat *aSupervisor, 
Ptr viewData) 

LongRect itsBounds; 



408 Chapter 14>-Customizing the Graphing Code 

MewTemp 
method.code 
(concluded) 

Draw method code 
(beginning) 

inherited::IViewTemp (anEnclosure, aSupervisor, viewData); 
SetLongRect (&itsBounds, OL, OL, 540L, 720L); 
SetBounds (&itsBounds); 

The IViewTemp method first calls its inherited method and 
then sets the bounds of the rectangle enclosing the pan
orama. In this case, bounds values of 540 and 720 pixels cor
respond to a 7.5- by 10.0-inch image area. 

Draw Method Code 

The Draw method is called by the TCL whenever the panora
ma's contents need to be redrawn. The generated code for 
this method has made the right preparations for the code 
that we have added (see page 371). The customized code is as 
follows: 

void CUser4::Draw(Rect *area) 
{ 

Rect 
PenState 
short 
short 
Style 

theFrame; 
savePen; 
curFont; 
curSize; 
curStyle; 

GetPenState (&savePen); 
PenNormal (); 
FrameToQDR (&frame, &theFrame); 

II 
II save font settings 
II 
curFont = macPort->txFont; 
curSize = macPort->txSize; 
curStyle = macPort->txFace; 

itsChartlnfo = ((CGraphWindow *)itsSupervisor)->GetChartlnfo(); 
if(itsChartlnfo->chartSettings.modified == 1) 
{ 

switch(itsChartlnfo->chartSettings.chartType) 
{ 

case cHorizontalBarViewlD: 
{ 

DrawHBarChart(theFrame); 
break; 



Draw method code 
(concluded) 

II 
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case cVerticalBarViewlD: 
{ 

DrawVBarChart(theFrame); 
break; 

case cXYChartViewlD: 
{ 

DrawXYChart(theFrame); 
break; 

II restore port font info 
II 
TextFont (curFont); 
TextSize (curSize); 
TextFace (curStyle); 

SetPenState (&savePen); 

After the current settings for the port have been saved and 
the PenNormal toolbox call has reset the default pen state, 
the current window's frame coordinates are converted from 
the long coordinates in which they are kept into standard 
QuickDraw coordinates. 

The port's font, size, and style settings are saved, and then 
the chart settings are accessed via the GetChartlnfo access 
method in the CGraphWlndow class. 

Using the settings, the Draw method determines whether the 
chart settings have been modified (which will occur only if the 
user has filled in and dismissed the Chart dialog with the OK 
button). If the settings have not been modified, the draw 
method restores the font and port settings and returns con
trol to its caller. If the settings have been modified, the Draw 
method determines what type of chart has been requested 
and calls the appropriate method to produce the chart. 

The bulk of the code to draw the various charts is contained 
in new methods that we have defined, called DrawHBar
Chart, DrawVBarChart, and DrawXYChart. The amount of 
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DrawHBarChart 
method.code 
(sectfDn 1) 

code in each of these routines is large; thus, it is presented 
over several sections. 

DrawHBarChart Method Code 

The DrawHBarChart method is responsible for drawing a 
horizontal bar chart, using the specifications from the re
cently completed Chart dialog. The code in this method must 
deal with accessing the worksheet data and label cells, per
form automatic scaling of the data (if requested), and draw a 
bar chart that will fit within the existing window frame (if pos
sible). For reasons of simplicity, all axis annotations are cre
ated on the basis that the axis (horizontal in this case) will be 
divided into five segments, each of which will be annotated. 
In theory, the axis can be divided into any number of seg
ments, depending on the range of the data values to be por
trayed; however, this would just add complexity to an already 
complicated task. The first section of DrawHBarChart is as 
follows: 

void CUser4::DrawHBarChart(Rect theFrame) 
{ 

CCalcWindow *theWorksheet; 
chartlnfo settings; 
minMax hScalelnfo; 
Rect vDataRange, vLabelRange, chartBorder; 
short deltaY, deltaX, frameHeight, frameWidth; 
short numBars, barHeight, chartWd, chartHt; 
short leftMargin, topMargin; 
short labelMaxWid, labelDX, labelDY; 
double minValue, maxValue, valueDiff, xDiff; 
decform theFormat; 

II 
II access the chart settings, get the data range 
II information, and compute the number of bars. 
II 
theWorksheet = ((CGraphWindow *)itsSupervisor)->GetCalcWindow(); 
settings = itsChartlnfo->chartSettings; 
vDataRange = itsChartlnfo->GetVData(); 
deltaX = deltaY = O; 
if(vDataRange.left == vDataRange.right) 
{ 

numBars = vDataRange.bottom - vDataRange.top + 1; 
deltaY = 1; 

} 
else 



DrawHBarChart 
method code 
(section 1, continued) 

DrawHBarChart 
method code 
(section 2) 
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numBars = vDataRange.right - vDataRange.left + 1 ; 
deltaX = 1; 

The first section of the DrawllBarChart contains the function 
definition, its local variable definitions, and some initializa
tion code. The variable theWorksheet is set to hold the han
dle to the CCalcWindow instance, and the variable called 
settings is set to hold the Chart dialog settings. Following 
this, the code acquires the cell values for the vertical data 
range setting and determines whether the range is specified 
as a horizontal row or vertical column of cells. It also calcu
lates the number of bars that will be produced. 

II 
II calculate the frame settings, so that we can 
II generate a graph that fills the active window. 
II 
frameHeight = theFrame.bottom - theFrame.top; 
frameWidth = theFrame.right - theFrame.left; 
barHeight = GetBarThickness (numBars, frameHeight - TOPMARGIN 

- BOTMARGIN); 
chartHt = numBars * (barHeight + BARSPACING); 
leftMargin = LHTMARGIN; 
labelMaxWid = O; 
labelDX = labelDY = O; 
if(settings.vlabelCheck) 
{ 

vlabelRange = itsChartlnfo->GetVLabel(); 
if(vlabelRange.left == vlabelRange.right) 

labelDY = 1; 
else 

labelDX= 1; 
labelMaxWid = GetlabelMax (theWorksheet, vlabelRange); 

} 
if(settings.scalingType == cAutomaticScaleViewlD) 
{ 

} 

GetDataMinMax (theWorksheet, vDataRange, &minValue, 
&maxValue, &xDiff); 

else 
{ 

hScalelnfo = itsChartlnfo->GetHScale(); 
minValue = hScalelnfo.min; 
maxValue = hScalelnfo.max; 
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DrawHBarChart 
metlwdcode 
(sectiDn 2, continued) 

DrawHBarChart 
metlwdcode 
(sectiDn 3) 

xDiff = (maxValue - minValue) I 5.0; II constant number of intervals 
} 
valueDiff = maxValue - minValue; 
theFormat = GetFormat (xDiff); 

The second section of the DrawHBarChart method calculates 
the dimensions of the window frame, sets up the appropriate 
bar thickness (using the GetBarThickness method), and cal
culates the left margin width. It checks to see whether a label 
range was specified, and if so, it calculates the width of the 
longest label by using the GetLabelMax method. Following 
this, if automatic scaling was selected, DrawHBarChart calls 
the GetDataMinMax method to ascertain the minimum, 
maximum, and rounded xDiff value in the worksheet data 
values. If manual scaling was specified, the minimum and 
maximum values are specified explicitly, and the xDiff value 
is calculated using a constant of five divisions in the horizon
tal axis. Finally, the valueDiff value is calculated as the dif
ference between the minimum and maximum values. Using 
xDiff (the division difference), the GetFormat method 
chooses an appropriate format for the axis annotation. 

II 
II if everything looks okay, get ready to 
II draw the chart, complete with labels. 
II 
if(maxValue > minValue) 
{ 

Rect 
Point 
short 
double 
short 
Str255 

barRect; 
dataCell, labelCell; 
index, labelH, labelV; 
data Value; 
barLength, labelWidth, totalWidth; 
label; 

chartBorder.left = leftMargin + labelMaxWid + VLABSPACE; 
chartBorder.right = frameWidth - RHTMARGIN; 
chartWd = chartBorder.right - chartBorder.left; 
chartBorder.top = TOPMARGIN; 
chartBorder.bottom = chartBorder.top + chartHt; 
DrawChartFrame (chartBorder); 

II 
II draw title if specified 
II 
if(settings.title[O) > 0) 
{ 
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method code 
(section 3, continued) 

DrawHBarChart 
method.code 
(section 4) 
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totalWidth = chartBorder.right - LHTMARGIN; 
TextFont (O); II use system font 
TextSize (14); II use 14-point type 
TextFace (O); II use plain labels 
labelWidth = StringWidth (settings.title); 
labelCell.h = LHTMARGIN + (totalWidth - labelWidth) I 2; 
labelCell.v = TOPMARGIN I 2; 
MoveTo (labelCell.h, labelCell.v); 
Drawstring (settings.title); 

barRect.top = chartBorder.top + BARSPACING; 
barRect.left = chartBorder.left; 
barRect.bottom = chartBorder.top + barHeight; 
dataCell.h = vDataRange.left; 
dataCell.v = vDataRange.top; 

The third section of the DrawHBarChart method is con
cerned with drawing the chart border and title (if specified). 
The border consists of the horizontal and vertical axis lines 
only. If the title is specified, it is drawn using the system font, 
in its 14-point size, centered within the frame. Finally, the lo
cation of the first bar to be drawn and the location of the 
worksheet cell corresponding to the first bar are initialized. 

At this point, we are almost ready to begin drawing the bars 
and their corresponding labels (if specified). The only remain
ing operations are to set the text font, size, and style for 
drawing the labels and to specifythe location of the first label 
to be drawn. 

II 
II set label font 
II 
TextFont (O); 
TextSize (12); 
TextFace (O); 

II use system font 
II use 12-point type 
II use plain labels 

labelH = leftMargin; 
labelV = barRect.top + barHeighV2; 
labelCell.h = vlabelRange.left; 
labelCell.v = vlabelRange.top; 
for(index=O; index< numBars; index++) 
{ 

theWorksheet->GetValueValue (dataCell, &dataValue); 
barlength = ((dataValue - minValue) I valueDiff) * chartWd; 
barRect.right = barRect.left + barlength; 
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DrawHBarChart 
method code 
(section 4, 
concluded) 

} 

II 
II draw the bar 
II 
FillRect (&barRect, ltGray); 
FrameRect (&barRect); 
II 
II draw the label 
II 
if( settings. vlabelCheck) 
{ 

theWorksheet->GetValueString (labelCell, label); 
MoveTo (labelH, labelV); 
DrawString(label); 

} 
II 
II update the settings for the next bar 
II 
barRect. top 
barRect.bottom 
dataCell.h 
dataCell.v 
labelV 
labelCell.h 
labelCell.v 

+= (barHeight + BARSPACING); 
+= (barHeight + BARSPACING); 
+=deltaX; 
+=deltaY; 
+= (barHeight + BARSPACING); 
+= labelDX; 
+= labelDY; 

DrawHorizTicks (chartBorder, minValue, maxValue, theFormat); 

The last section of the DrawllBarChart method contains the 
loop that draws each of the horizontal bars and its corre
sponding label, if one was specified. As previously indicated, 
prior to entering the loop, the label font, size, and style and 
the location of the first label are initialized. 

The loop will draw the number of bars (and labels) specified 
in the numBars variable. For each bar, the double-precision 
floating-point value of the indicated worksheet cell is ac
quired, and the length of the bar is computed by using the ra
tio of the current value to the overall value range, scaled by 
the chart width in pixels and stored as an integer value. Once 
the bar's length has been computed, its right-hand coordi
nate can be computed, and the bar is drawn as a filled and 
outlined rectangle. Only a single shade of light gray is used 
for all bars. After the bar has been drawn, its corresponding 
label is also drawn, using the prespecified font, size, and 



Figure 14-1 
Sample horizontal 
bar chart 

Customizing the Graph Window Code 415 

style. The location of the next bar and label are computed at 
the bottom of the loop. The next data and label worksheet 
cells are also computed. 

When the loop is complete, we call the DrawHorizTicks 
method to annotate the horizontal axis with the values asso
ciated with each of the five horizontal divisions of the chart. A 
typical chart has the appearance shown in Figure 14-1. 

SauedData BJ 
Second Quarter Profits (By Month) ~ 

Apr 

May 

Jun 

2600 3080 3560 4040 4520 5000 

The values for creating the chart in Figure 14-1 were taken 
directly from the worksheet shown in Figure 14-2. This work
sheet expands on the previously entered data for the ficti
tious Amazing Widgets Company. The data were 
automatically scaled and plotted using a vertical data range 
of CS .. ES and a label range of C3 .. E3. The data values 
charted in this instance are 3345, 3506, and 4375. 

DrawVBarChart Method Code 

The DrawVBarChart method is very similar to the Draw
HBarChart method, except that the bars are vertical, instead 
of horizontal. The code for both methods could probably be 
combined for efficiency of storage, but the combined code 
would be more complex to describe. Therefore, each method 
is self-contained, except for the common methods that each 
calls. 
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Figure 14-2 
Sample worksheet 
window from which 
valu es for charts are 
taken 

DrawVBarChart 
method code 
(section 1) 
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As with the code for DrawHBarChart, the DrawVBarChart 
method is presented in several sections. The first section con
tains the method declaration, the declaration of local vari
ables used throughout the method, and the code to acquire 
the worksheet handle and data range information. The code 
for this section is as follows: 

void CUser4::DrawVBarChart(Rect theFrame) 
{ 

CCalcWindow 
chartlnfo 
minMax 
Rect 
short 
short 
short 
short 
double 
decform 

II 

*the Worksheet; 
settings; 
vScalelnfo; 
hDataRange, hlabelRange, chartBorder; 
deltaY, deltaX, frameHeight, frameWidth; 
numBars, barSize, chartWd, chartHt; 
leftMargin, topMargin; 
labelMaxWid, labelDX, labelDY, ticklabelWd ; 
minValue, maxValue, valueDiff, yDiff; 
the Format; 

II access the chart settings, get the data range 
II information, and compute the number of bars. 
II 
theWorksheet = ((CGraphWindow *)itsSupervisor)->GetCalcWindow(); 
settings = itsChartlnfo->chartSettings; 
hDataRange = itsChartlnfo->GetHData() ; 
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metlwdcode 
(section 1, continued) 

DrawVBarChart 
method code 
(section 2) 
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deltaX = deltaY = O; 
if(hDataRange.left == hDataRange.right) 
{ 

numBars = hDataRange.bottom - hDataRange.top + 1; 
deltaY = 1; 

else 
{ 

numBars = hDataRange.right - hDataRange.left + 1; 
deltaX = 1; 

The first section of code is responsible for acquiring the work
sheet instance handle, getting the horizontal data range, and 
calculating whether the data are stored in a column or row 
orientation. The number of bars to be drawn is also deter
mined here. 

II 
II calculate the frame settings, so that we can 
II generate a graph that fills the active window. 
II 
frameHeight = theFrame.bottom - theFrame.top; 
frameWidth = theFrame.right - theFrame.left; 
barSize = GetBarThickness (numBars, frameWidth - LHTMARGIN 

- RHTMARGIN); 
chartWd = numBars * (barSize + BARSPACING); 
leftMargin = LHTMARGIN; 
labelMaxWid = O; 
labelDX = labelDY = O; 

if(settings.hlabelCheck) 
{ 

hlabelRange = itsChartlnfo->GetHLabel(); 
if(hlabelRange.left == hlabelRange.right) 
{ 

labelDY = 1; 
} 
else 
{ 

labelDX = 1; 
} 
labelMaxWid = GetlabelMax (theWorksheet, hlabelRange); 

} 
ticklabelWd = GetlabelMax (theWorksheet, hDataRange); 

if(settings.scalingType == cAutomaticScaleViewlD) 
{ 
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DrawVBarChart 
method code 
(section 2, continued) 

DrawVBarChart 
method code 
(section 3) 

GetDataMinMax (theWorksheet, hDataRange, &minValue, 
&maxValue, &yDiff); 

else 
{ 

} 

vScalelnfo = itsChartlnfo->GetVScale(); 
minValue = vScalelnfo.min; 
maxValue = vScalelnfo.max; 
yDiff = (maxValue - minValue) I 5.0; II constant number of intervals 

valueDiff = maxValue - minValue; 
theFormat = GetFormat (yDiff); 

The second section of code is responsible for calculating the 
dimensions of the frame, the chart width, and the thickness 
of the bars (by calling the GetBarThick.ness method), as well 
as for determining whether labels have been specified and ac
cessing the label range if so. In addition, if automatic scaling 
is selected, the GetDataMinMax method is used to determine 
appropriate minimum and maximum values, as well as yDiff, 
the value associated with each division on the vertical axis. If 
manual scaling is selected, the specified values are acquired 
from the settings by using the GetVScale access method, and 
then the yDiffvalue is computed, based on a constant five di
visions on the y-axis. Finally, the total difference between the 
minimum and maximum values is calculated, and the format 
for displaying the y-axis annotations is determined by calling 
the GetFormat method. 

II 
II if everything looks okay, get ready to 
II draw the chart, complete with labels. 
II 
if(maxValue > minValue) 
{ 

Rect 
Point 
short 
double 
short 
Str255 

barRect; 
dataCell, labelCell; 
index, labelH, labelV; 
data Value; 
barlength, labelWidth, totalWidth; 
label; 

chartBorder.lett = lettMargin + ticklabelWd + VLABSPACE; 
chartBorder.right = chartBorder.lett + chartWd; 
chartBorder.top = TOPMARGIN; 
chartBorder.bottom = frameHeight - BOTMARGIN; 
chartHt = chartBorder.bottom - chartBorder.top; 
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method code 
(section 3, continued) 
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DrawChartFrame (chartBorder); 

II 
II draw title if specified 
II 
if(settings.title[O] > 0) 
{ 

totalWidth = chartBorder.right - LHTMARGIN; 
TextFont (O); II use system font 
TextSize (14); II use 14-point type 
TextFace (O); II use plain labels 
labelWidth = StringWidth (settings.title); 
labelCell.h = LHTMARGIN + (totalWidth - labelWidth) I 2; 
labelCell.v = TOPMARGIN I 2; 
MoveTo (labelCell.h, labelCell.v); 
Drawstring (settings.title); 

barRect.bottom = chartBorder.bottom + 1 ; 
barRect.left = chartBorder.left + BARSPACING; 
barRect.right = chartBorder.left + barSize; 
dataCell.h = hDataRange.left; 
dataCell.v = hDataRange.top; 

II 
II set label font 
II 
TextFont (O); 
TextSize (12); 
TextFace (O); 

II use system font 
II use 12-point type 
II use plain labels 

labelH = barRect.left + barSizel2 - 1 ; 
labelV = barRect.bottom + (BOTMARGIN I 2); 
labelCell.h = hlabelRange.left; 
labelCell.v = hlabelRange.top; 

The third section of code begins the actual drawing of the 
chart. After calculating the final dimensions of the chart, it 
calls the DrawChartFrame method to draw the horizontal 
and vertical axes of the chart. In addition, if a title was speci
fied, it is drawn in the 14-point system font. After the title is 
drawn, the text font, size, and style are changed to prepare 
for drawing the labels in the final section of the code. The 12-
point version of the system font is used for this purpose. The 
final set of statements calculates the position of the first label 
if one is to be drawn. 
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DrawVBarChart 
method code 
(section 4, 
concluded) 

for(index=O; index< numBars; index++) 
{ 

} 

theWorksheet->GetValueValue (dataCell, &dataValue); 
barlength = ((dataValue - minValue) I valueDiff) * chartHt; 
barRect.top = barRect.bottom - barlength; 

II 
II draw the bar 
II 
FillRect (&barRect, ltGray); 
FrameRect (&barRect); 

II 
II draw the label 
II 
if(settings.hlabelCheck) 
{ 

theWorksheet->GetValueString (labelCell, label); 
MoveTo (labelH - (StringWidth(label)l2), labelV); 
DrawString(label); 

} 
II 
II update the settings for the next bar 
II 
barRect.left 
barRect. right 
dataCell.h 
dataCell.v 
labelH 
labelCell.h 
labelCell.v 

+= (barSize + BARSPACING); 
+= (barSize + BARSPACING); 
+= deltaX; 
+= deltaY; 
+= (barSize + BARSPACING); 
+= labelDX; 
+= labelDY; 

DrawVertTicks (chartBorder, minValue, maxValue, theFormat); 

The last section of code contains the main loop that draws 
each of the specified number of bars and their labels. The 
bars are drawn with the FillRect and FrameRect toolbox 
calls, and the labels, if selected, are drawn using the Draw
string toolbox routine. After each bar and label are drawn, 
the location for the next bar and label is computed, in prepa
ration for the next iteration of the loop. Finally, after all the 
bars and labels have been drawn, the DrawVertTicks method 
is called to annotate the vertical axis. A sample vertical bar 
chart, drawn with DrawVBarChart is shown in Figure 14-3. 



Figure 14-3 
Sample vertical bar 
chart 
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SauedData 

Second Quarter Sales Trend 
20000 

17400 

14800 

12200 

9600 

7000 

The data for the vertical bar chart shown in the figure were 
taken directly from the worksheet range C4 .. E4, and the la
bels come from the range C3 .. E3. The scaling is automatic, 
and the data values depicted by the bars are 15700, 16125, 
and 18500, as shown in the worksheet depicted in Figure 
14-2. 

DrawXYChart Method Code 

The DrawXYChart method uses portions of the same logic as 
both the horizontal and vertical bar chart methods. However, 
with it, the data points are plotted at the intersection of the x
axis and y-axis values. For the points, we have chosen to use 
the'•' character (Option-8), which is available in the system 
font. 

The DrawXYChart method is quite different from the previ
ous methods with respect to drawing the chart labels. In this 
case, the label is not associated with an individual data point, 
but rather, serves as an axis title. If a range is given for the 
label, each cell is taken to be a word in the label and will be 
displayed with an automatically appended space character 
prior to displaying the subsequent word. The horizontal label 
is displayed on the x-axis, and the vertical label is displayed, 
vertically, on the y-axis. 
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DrawXYChart 
method.code 
(sectiDn 1) 

As with horizontal and vertical bar charts, the data values (in 
this case, both horizontal and vertical values are required in
puts) may be either automatically or manually scaled. The 
code for this method is quite long and is shown in several 
sections, beginning as follows: 

void CUser4::DrawXYChart (Rect theFrame) 
{ 

CCalcWindow 
chartlnfo 
Rect 
Rect 
short 
short 
short 
short 
short 
Str255 
short 
minMax 
double 
double 
decform 

II 

*theWorksheet; 
settings; 
hDataRange, vDataRange, chartBorder; 
hlabelRange, vlabelRange; 
chartWidth, chartHeight; 
numHPoints, hDeltaX, hDeltaY; 
numVPoints, vDeltaX, vDeltaY; 
hlabPoints, hlabDx, hlabDy; 
vlabPoints, vlabDx, vlabDy; 
hlabel, vlabel, tlabel; 
vAxislabelWd, index, temp; 
hScalelnfo, vScalelnfo; 
hMin, hMax, hDiff, hValueRange; 
vMin, vMax, vDiff, vValueRange; 
hFormat, vFormat; 

II get the worksheet reference and the initial 
II horizontal and vertical data settings 
II 
theWorksheet = ((CGraphWindow *)itsSupervisor)->GetCalcWindow(); 
settings = itsChartlnfo->chartSettings; 
hDataRange = itsChartlnfo->GetHData(); 
hDeltaX = hDeltaY = O; 
if(hDataRange.left == hDataRange.right) 
{ 

} 

numHPoints = hDataRange.bottom - hDataRange.top + 1; 
hDeltaY = 1; 

else 
{ 

} 

numHPoints = hDataRange.right- hDataRange.left + 1; 
hDeltaX = 1; 

vDataRange = itsChartlnfo->GetVData(); 
vDeltaX = vDeltaY = O; 
if(vDataRange.left == vDataRange.right) 
{ 

numVPoints = vDataRange.bottom - vDataRange.top + 1 ; 



DrawXYChart 
method.code 
(section 1, continued) 

DrawXYChart 
method code 
(section 2) 
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vDeltaY = 1; 
} 
else 
{ 

} 

numVPoints = vDataRange.right - vDataRange.left + 1; 
vDeltaX = 1; 

vAxislabelWd = GetlabelMax (theWorksheet, vDataRange); 
chartBorder.top = theFrame.top + TOPMARGIN; 
chartBorder.bottom = theFrame.bottom - (BOTMARGIN 

+ BOTMARGIN I 2); 
chartBorder.left = theFrame.left + LHTMARGIN + vAxislabelWd 

+ VLABSPACE; 
chartBorder.right = theFrame.right - RHTMARGIN; 
chartWidth = chartBorder.right - chartBorder.left; 
chartHeight = chartBorder.bottom - chartBorder.top; 

The first section of the DrawXYChart method contains the 
method declaration and the declaration of the local variables. 
In addition, it has code to access the worksheet's instance 
handle, the settings from the Chart dialog, and the horizontal 
and vertical data range specifications. It also determines 
whether each of the horizontal and vertical data ranges is 
stored in a row or column orientation. The number of points 
in each range is computed as well. Finally, the dimensions of 
the chart are computed, based upon the height and width of 
the window frame. 

II 
II get any horizontal or vertical axis label information 
II 
hlabDx = vlabDx = hlabDy = vlabDy = O; 
if(settings.hlabelCheck) 
{ 

hlabelRange = itsChartlnfo->GetHLabel(); 
if(hlabelRange.left == hlabelRange.right) 
{ 

} 

hlabPoints = hlabelRange.bottom - hlabelRange.top + 1; 
hlabDy = 1; 

else 
{ 

hlabPoints = hlabelRange.right - hlabelRange.left + 1; 
hlabDx = 1; 

} 
if(settings.vlabelCheck) 
{ 
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DrawXYChart 
method.code 
(section 2, continued) 

II 

vLabelRange = itsChartlnfo->GetVLabel(); 
if(vLabelRange.left == vLabelRange.right) 
{ 

vLabPoints = vLabelRange.bottom - vlabelRange.top + 1; 
vLabDy = 1; 

else 
{ 

vLabPoints = vLabelRange.right - vLabelRange.left + 1; 
vLabDx = 1; 

II scale the horizontal and vertical data 
II 
if(settings.scalingType == cAutomaticScaleViewlD) 
{ 

GetDataMinMax (theWorksheet, hDataRange, &hMin, &hMax, 
&hDiff); 

GetDataMinMax (theWorksheet, vDataRange, &vMin, &vMax, 
&vDiff); 

} 
else 
{ 

} 

hScalelnfo = itsChartlnfo->GetHScale(); 
hMin = hScalelnfo.min; 
hMax = hScalelnfo.max; 
hDiff = (hMax - hMin) I 5.0; 

vScalelnfo = itsChartlnfo->GetVScale(); 
vMin = vScalelnfo.min; 
vMax = vScalelnfo.max; 
vDiff = (vMax - vMin) I 5.0; 

hValueRange = hMax - hMin; 
vValueRange = vMax-vMin; 

The second section of the DrawXYChart method determines 
whether horizontal or vertical labels were specified and, if so, 
accesses their cell ranges and orientations. 

If the chart is intended to be automatically scaled, the code 
calls the GetDataMinMax method to calculate the minimum 
and maximum values, and the value per division of both the 
x-axis and y-axis data ranges. 



DrawXYChart 
method code 
(section 3) 
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If manual scaling was selected, the code accesses the specified 
minimum and maximum values and then calculates the value 
per division for both axes. The difference between the mini
mum and maximum values in each range is also calculated. 

It is important to emphasize that each of the settings has 
been validated before the Chart dialog is dismissed. In the 
case of the X-Y chart, the number of data values in the hori
zontal and vertical ranges must be equal, and the label 
ranges must specify a pair of cell values, even though the cell 
numbers are equal (e.g., A3 . .A3) 

II 
II draw title if specified 
II 
if(settings.title[O] > 0) 
{ 

II 

short totalWidth, labelWidth; 
Point labelCell; 

totalWidth = chartBorder.right - LHTMARGIN; 
TextFont (O); II use system font 
TextSize (14); II use 14-point type 
TextFace (O); II use plain labels 
labelWidth = StringWidth (settings.title); 
labelCell.h = LHTMARGIN + (totalWidth - labelWidth) I 2; 
labelCell.v = TOPMARGIN I 2; 
MoveTo (labelCell.h, labelCell.v}; 
Drawstring (settings.title); 

II draw the border, horizontal and vertical labels 
II 
DrawChartFrame (chartBorder); 
if(settings.hlabelCheck) 
{ 

Point labelCell; 
short labelWidth, labelH, labelV; 

labelCell.h = hlabelRange.left; 
labelCell.v = hlabelRange.top; 
theWorksheet->GetValueString (labelCell, hlabel); 
for(index=1; index< hlabPoints; index++) 
{ 

labelCell.h += hlabDx; 
labelCell.v += hlabDy; 
ConcatPStrings (hlabel, "\p "); 
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DrawXYChart 
method code 
(section 3, continued) 

} 

} 

theWorksheet->GetValueString (labelCell, tLabel); 
ConcatPStrings (hLabel, tLabel); 

TextFont (O); II use system font 
TextSize (12); II use 12-point type 
TextFace (O); II use plain labels 
labelWidth = StringWidth (hLabel); 
labelH = chartBorder.left + (chartWidth/2) - (labelWidth/2); 
labelV = chartBorder.bottom + BOTMARGIN; 
MoveTo (labelH, labelV); 
Drawstring (hLabel); 

if( settings. vLabelCheck) 
{ 

Point labelCell; 
Fontinfo fi; 
short labelHeight, labelH, labelV; 
labelCell.h = vLabelRange.left; 
labelCell.v = vLabelRange.top; 
theWorksheet->GetValueString (labelCell, vLabel); 
for(index=1; index < vLabPoints; index++) 
{ 

} 

labelCell.h += vLabDx; 
labelCell.v += vLabDy; 
ConcatPStrings (vLabel, "\p "); 
theWorksheet->GetValueString (labelCell, tLabel); 
ConcatPStrings (vLabel, tLabel); 

TextFont (O); II use system font 
TextSize (12); II use 12-point type 
TextFace (O); II use plain labels 
GetFontlnfo(&fi); 
labelHeight = (fi.ascent+fi.descent) * vLabel[O]; 
labelH = theFrame.left + (LHTMARGIN/2); 
labelV = chartBorder.top + (chartHeight/2) - (labelHeight/2); 
for(index=1; index<= vLabel[O]; index++) 
{ 

MoveTo (labelH - (CharWidth (vLabel[index])/2), labelV); 
DrawChar (vLabel[index]); 
labelV += (ti.ascent+ ti.descent); 

The third section of the DrawXYChart method is responsible 
for drawing the chart border, the title (if specified), and the 
horizontal and vertical axis labels (if specified). The title is 
drawn in the 14-point system font, while the labels are drawn 
in the 12-point system font. The title is centered in the frame, 
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at the top of the graph. The horizontal axis label, if specified, 
is drawn inside the bottom margin of the frame, also centered 
within the frame. The vertical axis label is drawn inside the 
left margin of the frame, and not only is it vertically centered 
in the frame, but each character is centered with respect to 
the others. 

II 
II draw the axis ticks and scaling labels 
II 
hFormat = GetFormat (hDiff); 
vFormat = GetFormat (vDiff); 
DrawHorizTicks (chartBorder, hMin, hMax, hFormat); 
DrawVertTicks (chartBorder, vMin, vMax, vFormat); 

II 
II finally, plot the data points 
II 
if(numHPoints > 0) 
{ 

plot It; char 
Point 
double 
short 

charloc, hData, vData; 
hValue, vValue; 
charWd, deltaH, deltaV; 

TextFont (O); 
TextSize (12); 
TextFace (O); 
plotlt = '•'; 

II set system font 
II set 12-point size 
II set plain style 

charWd = CharWidth(plotlt)l2; 
hData.h = hDataRange.left; 
hData.v = hDataRange.top; 
vData.h = vDataRange.left; 
vData.v = vDataRange.top; 
for(index=O; index< numHPoints; index++) 
{ 

theWorksheet->GetValueValue (hData, &hValue); 
theWorksheet->GetValueValue (vData, &vValue); 
deltaH = ((hValue - hMin)lhValueRange) * chartWidth; 
deltaV = ((vValue - vMin)lvValueRange) * chartHeight; 
charloc.h = chartBorder.left + deltaH - charWd; 
charloc.v = chartBorder.bottom - deltaV - charWd; 
MoveTo (charloc.h, charloc.v); 
DrawChar (plotlt); 
hData.h += hDeltaX; 
hData.v += hDeltaY; 
vData.h += vDeltaX; 
vData.v += vDeltaY; 
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DrawXYChart 
method.code 
(section 4, 
concluded) 

Figure 14-4 
Sample X-Y chart 

The final section of the DrawXYChart method performs the 
function of drawing the axis annotations, followed by drawing 
the individual data points. The annotation values for the axes 
are determined by calling the GetFormat method for both 
the horizontal and vertical axis, using the value difference 
computed for each of the five divisions in each axis. 

The horizontal and vertical axes are annotated by calling the 
DrawHTicks and DrawVTicks methods, respectively. 

After annotation of the axes is complete, the loop to draw the 
individual data points is entered .. The '•'character is plotted, 
with its center located at the junction of the horizontal and 
vertical data positions to which it corresponds. After each 
point is plotted, the cell coordinates for both the horizontal 
and vertical data ranges are incremented to the location of 
the next point. After the last point has been plotted, the chart 
is complete. A sample X-Y chart is shown in Figure 14-4. 
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As with the other sample charts, the data values for the chart 
shown in Figure 14-4 are taken directly from the sample 
worksheet depicted in Figure 14-2. In this case, the pairs of 
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data values being plotted are (3345, 15700). (3506, 16125). 
and (4375, 18500). This is clearly an upward trend for our 
fictitious company. 

GetBarThickness Method Code 

The GetBarThickness method is called by both the horizon
tal and vertical bar chart methods to determine the appropri
ate width, or thickness, of the bars. The thickness is 
computed on the basis of the number of bars and the size of 
the horizontal or vertical space in which they must fit. The 
code is as follows: 

short CUser4::GetBarThickness (short numBars, short frameSize) 
{ 

short height; 
short barSize; 

barSize = (frameSize - numBars * BARSPACING) I numBars; 
if (barSize < MINBARSIZE) 
{ 

return MINBARSIZE; 
} 
if (barSize > MAXBARSIZE) 
{ 

return MAXBARSIZE; 
} 
return barSize; 

The code uses a few predefined constants that specify the 
minimum and maximum thickness of bars to be drawn. The 
values for these constants in the current implementation are 
set to 9 and 36 pixels, respectively. The desired thickness is 
first computed and then compared against the MINBARSIZE 

and MAXBARSIZE constants. It is clipped to either the mini
mum or maximum value if it is not within the specified range. 
The BARSPACING constant ensures that bars are spaced from 
one another by a standard amount. The default value for this 
constant is 5 points (i.e., five pixels at 72 dots per inch). 

GetLabelMax Method Code 

The GetLabelMax method is responsible for finding the 
length of the longest label in the specified label range. The 
code for this method is as follows: 
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short CUser4::GetlabelMax (CCalcWindow *theWorksheet, 
Rect labelRange) 

short deltaX, deltaY, num, i, maxWidth, labelWidth; 
Point labelCell; 
Str255 label; 
deltaX = deltaY = O; 
maxWidth = -1 ; 
if(labelRange.top == labelRange.bottom) 
{ 

deltaX = 1; 
num = labelRange.right - labelRange.left + 1 ; 

} 
else 
{ 

deltaY = 1; 
num = labelRange.bottom - labelRange.top + 1; 

} 
TextFont (O); II use system font 
TextSize (12); II use 12-point type 
TextFace (O); II use plain style 
SetPt(&labelCell, labelRange.left, labelRange.top); 
for(i=O; i < num; i++) { 

} 

theWorksheet->GetValueString (labelCell, label); 
labelWidth = StringWidth(label); 
if(labelWidth > maxWidth) 

maxWidth = labelWidth; 
labelCell.h += deltaX; 
labelCell.v += deltaY; 

return maxWidth; 

The GetLabelMax method accomplishes its task by using the 
handle to the worksheet and the specified label range to ac
cess each label and calculate its width, based upon its being 
drawn on the screen with 12-point plain type in the system 
font. The StringWidth toolbox method is used to calculate 
each label's width. GetLabelMax returns the largest width. 

GetDataMtnMax Method Code 

The GetDataMinMax method is called by all the charting 
methods when automatic scaling is selected. The purpose of 
this method is to select minimum and maximum values that 
best fit the data to be charted, as well as to calculate the 
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value corresponding to each division of the chart. The code 
for this method is as follows: 

void CUser4::GetDataMinMax (CCalcWindow *theWorksheet, 
Rect dataRange, double *minValue, 
double *maxValue, double *xDiff) 

short deltaX, deltaY, num, i; 
double min, max, value, diff; 
Cell dataCell; 

min = 9.9e999; 
max= -9.9e999; 
deltaX = deltaY = O; 
if(dataRange.top == dataRange.bottom) 
{ 

deltaX = 1; 
num = dataRange.right - dataRange.left + 1 ; 

else 
{ 

deltaY = 1; 
num = dataRange.bottom - dataRange.top + 1; 

} 
SetPt(&dataCell, dataRange.left, dataRange.top); 
for(i=O; i < num; i++) 
{ 

} 

theWorksheet->GetValueValue (dataCell, &value); 
if(value < min) 
{ 

min= value; 
} 
if(value > max) 
{ 

max= value; 
} 
dataCell.h += deltaX; 
dataCell.v += deltaY; 

min = RoundDown (min); 
max = RoundUp (max); 
diff = RoundUp ((max - min) I 5.0); 
*minValue = min - diff; 
*maxValue = max; 
*xDiff = diff; 
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The GetDataMinMax method computes the approprtate min
imum and maximum values by accessing each worksheet cell 
in the specified data range, calculating the actual minimum 
and maximum values, calling the RoundDown function to 
calculate a new minimum value, and then calling the 
Roundup function to calculate a new maximum value. These 
functions use a table of logarithms to aid in rounding the val
ues to the nearest lesser or greater value, as will be descrtbed 
later. After the new minimum and maximum values are com
puted, the difference between these is divided by five and 
then rounded up, using the same RoundUp function. A new 
minimum value is then computed to be the previous 
(rounded-down) minimum value less the value of the differ
ence per division. Thus, the displayed minimum value will al
ways be less than the actual minimum value, which 
guarantees that a bar or point for that value will always ap
pear within the chart and not be drawn on the corresponding 
axis. In particular, in a horizontal or vertical bar chart, the 
bar will have a nonzero length. The newly computed mini
mum and maximum values, and the difference per division 
are stored into the variables to which their pointer arguments 
refer. 

DrawChartFrame Method Code 

The DrawChartFrame method is responsible for drawing the 
frame for all three types of charts. The frame consists of lines 
that represent the horizontal and vertical axes of the corre
sponding chart. The code for this method is as follows: 

void CUser4::DrawChartFrame (Rect chartBorder) 
{ 

Move To ( chartBorder. left, chartBorder. top); 
LineTo (chartBorder.left, chartBorder.bottom); 
LineTo (chartBorder.right, chartBorder.bottom); 

The method takes a Rect as an argument and draws the axes 
using standard Quickdraw commands. 

DrawHorizTicks Method Code 

The DrawHorizTicks method is responsible for drawing the 
tick marks and numertcal annotations for the horizontal axis 
of a chart. The code is as follows: 
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void CUser4::DrawHorizTicks (Rect chartBorder, double min, 
double max, decform format) 

short 
short 
extended 
double 
Str32 

tickH, tickV, tickHt; 
index, width; 
start; 
range, chartWidth, delta, value; 
label; 

chartWidth = chartBorder.right - chartBorder.left; 

II 
II draw the tick marks and axis labels 
II based on a constant 5 ticks I chart 
II 
range= max - min; 
delta = range I 5.0; 
value= min; 
tickH = chartBorder.left; 
tickV = chartBorder.bottom; 
tickHt = 3; 
for(index=O; tickH <= chartBorder.right; index++) 
{ 

Move To (tickH, tickV - tickHt); 
Line To (tickH, tickV + tickHt); 
x96tox80 (&value, &start); 
num2str (&format, start, label); 
width= StringWidth (label); 
MoveTo (tickH - (width» 1), tickV + 15); 
DrawString(label); 
value += delta; 
tickH = chartBorder.left + (((value - min) I range)* chartWidth); 

The DrawHorizTicks method takes the chart border and the 
minimum and maximum values, and the specified data for
mat and draws each tick mark and label on the horizontal 
axis, according to the value associated with each horizontal 
division of the chart. 

DrawVertTicks Method Code 

The DrawVertTicks method is similar to the previous 
method, but draws tick marks and annotations on the verti
cal, rather than the horizontal, axis. The code is as follows: 
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void CUser4::DrawVertTicks (Rect chartBorder, double min, 
double max, decform format) 

short 
extended 
double 
Str32 

tickH, tickV, tickWd, index, width; 
start; 
range, chartHeight, delta, value; 
label; 

chartHeight = chartBorder.bottom - chartBorder.top; 

II 
II draw the tick marks and axis labels 
II based on a constant 5 ticks I chart 
II 
range = max - min; 
delta = range I 5.0; 
value= min; 
tickH = chartBorder.left; 
tickV = chartBorder.bottom; 
tickWd = 3; 
for(index=O; tickV >= chartBorder.top; index++) 
{ 

MoveTo (tickH - tickWd, tickV); 
Line To (tickH + tickWd, tickV); 
x96tox80 (&value, &start); 
num2str (&format, start, label); 
width= StringWidth (label); 
MoveTo (tickH - width - VLABSPACE, tickV); 
DrawString(label); 
value += delta; 
tickV = chartBorder.bottom - (((value - min) I range)* chartHeight); 

The DrawVertTicks method uses the chart border Rect and 
the minimum and maximum values, and the annotation for
mat as input. It calculates the delta value by computing the 
difference between the minimum and the maximum values 
and then divides this by five (divisions). The tick marks are 
drawn at the delta interval, accompanied by the correspond
ing axis values formatted according to the specified format. 

GetFormat Method Code 

The GetFormat method is responsible for determining how 
many decimal digits will be displayed for the axis annotation 
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values when these are drawn in the DrawHorizTicks and 
DrawVertTicks methods. 

The intention is to show only as many decimals as are neces
sary to guarantee that the axis annotations are each unique 
within the minimum and maximum data ranges. For exam
ple, if the data range is between 0.00 and 0.08, then it would 
be important to display at least two decimal digits in the an
notations. By contrast, if the data range is 3,000 to 6,000, 
then it is not necessary to show any decimal digits, as the 
distinction between values would be difficult to discriminate 
visually to that degree of resolution. Therefore, the code for 
this method adopts a simple precept. It calculates the base-
10 logarithm of the valueDiff argument and saves its integral 
portion into the local digits variable for comparison. If digits 
is 0, then one decimal digit is included in the format re
turned. If the digits value is greater than 0, then the format 
will be set to zero decimal digits. If the digits value is nega
tive, then the negative of that value (a positive number) 
plus 1 is used for the number of decimal digits. 

decform CUser4::GetFormat (double valueDiff) 
{ 

decform aFormat; 
short digits; 
digits = (short)log1 Ox (valueDiff); 
if(digits >= O) 
{ 

} 

if (digits > O) 
{ 

digits= O; 
} 
else 
{ 

digits= 1; 

else 
{ 

digits = -digits + 1 ; 
} 
aFormat.style = FIXEDDECIMAL; 
aFormat.digits = digits; 
return aFormat; 
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The preceding code creates a display format that shows a sin
gle decimal digit for a value range of 1 to 9, no decimal digits 
for values larger than that, and one additional decimal digit 
for fractional value ranges less than 1. 

Global Functions Used by the CUser4 Class Methods 

The CUser4 class methods just presented refer to several 
routines that are coded as global functions. These routines 
are used only by the CUser4 methods, but are defined to be 
global by the nature of the functions that they perform. 

loglOx Function Code 

The loglOx function computes the base-10 logarithm of the 
input value and returns this result as a double-precision 
floating-point value. The function uses the SANE library func
tion for the natural logarithm and the formula 

log (x) = ln (x) log (e) 

to calculate the base-10 logarithm. The base-10 logarithm 
of e is precomputed as a constant value. The code for the 
loglOx function is as follows: 

#define LOG1 OE 0.4342944819032518278L 

double log1 Ox (double x) 

{ 
double dLog1 Ox; 

extended eLogx, eLog10e; 

x96tox80 (&x, &eLogx); 

eLogx =log (eLogx); 
x80tox96 (&eLogx, &dLog1 Ox); 

return (dLog1 Ox * LOG1 OE); 

In order to use the SANE library functions, the incoming dou
ble-precision floating-point value must be converted to a 10-
byte extended format value using the x96tox80 SANE func
tion. The natural logarithm of this value is taken, and then it 
is converted back to a 12-byte double-precision value. The re
sult returned is the product of the natural logarithm of the 
input and the common logarithm of the value e. 
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explOx Function Code 

The explOx function computes the value of 10 raised to the 
value of the input parameter. It uses the SANE library function 
exp and the formula 

Hf = eln (IO)x 

to compute the result. The code for this function is as follows: 

#define LOGe 1 O 2.3025850929940456840L 

double exp1 Ox (double x) 

{ 
extended temp; 
double result; 

result= x * LOGe1 O; 
x96tox80 (&result, &temp); 

temp= exp (temp); 

x80tox96 (&temp, &result); 

return result; 

The code first calculates the product of the input value and 
the natural logarithm of 10. It then converts this product to a 
10-byte SANE extended value and uses the exp function to 
calculate the exponential. The result of that calculation is 
converted back to a 12-byte double-precision value and is re
turned to the calling routine. 

Lookup Tables for Global Functions 

The remaining global functions (Roundup, RoundDown, 
lookUp, and lookDown) refer to a set of tables of logarithms 
to accomplish their tasks. Two sets of tables have been pre
defined for this purpose. The first set contains the common 
logarithms for values between 1 and 10, the other set for val
ues between 0.1 and 1.0. 

These tables apply equally well to even larger and smaller 
positive quantities. Negative values are handled by the logic 
of the functions that use the tables. The contents of the two 
sets of tables are as follows: 
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Tables of integral 
and fractional 
logartthms 

RoundDown 
junction code 
(beginning) 

II 
II tables of logarithms for computing 
II ranges of the data being charted. 
II 

double posLogsD = 
{ 

O.OOOOOOOOOOOOOOOOOOOL, II 
0.3010299956639811952L, II 
0.477121254719662437 4L, II 
0.6020599913279623904L, II 
0.6989700043360188048L, II 
0. 7781512503836436326L, II 
0.8450980400142568306L, II 
0.9030899869919435856L, II 

1.0 
2.0 
3.0 
4.0 
5.0 
6.0 
7.0 
8.0 

0.95424250943932487 47L, II 9.0 
1.0000000000000000000 II 10.0 

}; 
double negLogsD = 
{ 

-1.0000000000000000000L, II 0.1 
-0.6989700043360188046L, II 0.2 
-0.5228787 452803375624L, II 0.3 
-0.3979400086720376094L, II 0.4 
-0.3010299956639811952L, II 0.5 
-0.2218487 496163563672L, II 0.6 
-0.1549019599857 431684L, II 0.7 
-0.0969100130080564141 L, II 0.8 
-0.045757 4905606751252L, II 0.9 
O.OOOOOOOOOOOOOOOOOOOL II 1.0 

}; 

Round.Down Function Code 

The RoundDown function is called by the GetDataMln.Max 
method to round a minimum value down to the nearest value 
appropriate to its magnitude. The code for this method is as 
follows: 

double RoundDown (double x) 
{ 

double logX, fracX, intX; 
if(x < 0.0) 

return (-RoundUp (-x)); 
logX = log10x (x); 
intX = ((short) logX); 
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jimcti.on code 
(concluded) 

fracX = logX - intX; 
if(fracX < 0) 
{ 
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fracX = lookDown (fracX, negLogs); 
if (fracX == -1.0) 
{ 

else 
{ 

fracX = 0.0; 
intX -= 1.0; 

fracX = lookDown (fracX, posLogs); 

logX = intX + fracX; 
return (exp1 Ox (logX)); 

The RoundDown function first determines whether the value 
to be rounded is positive or negative. If it is negative, we want 
it to be more negative, so we call the Roundup function with 
the input value negated and then return the negation of that 
result. If the input value is positive, we calculate its common 
logarithm and then compute its integer and fractional parts. 
If the fractional part is negative, then the input value was less 
than 1.0. In this case, we call the lookDown function to find 
the first logarithm in the negLogs table that has a lower 
value. If the one that was found has a value of -1.0, then we 
set the fractional component of the result to 0.0 and reduce 
the integral part of the logarithm by 1. 

If the fractional part is positive, then we call the lookDown 
function to find the next lower valued logarithm in the 
posLogs table and use that as the new fractional part of the 
result. The final action combines the new integer and frac
tional parts and returns the exponential function's value as 
the final result. 

Roundup Function Code 

The Roundup function is called by the GetDataMinMax 
method to find the next higher value for the corresponding in
put value, according to its magnitude. The code for this func
tion is as follows: 
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double Roundup (double x) 
{ 

double logX, fracX, intX; 

if(x < 0.0) 
{ 

return (-RoundDown (-x)); 
} 
logX = log10x (x); 
intX = ((short) logX); 
fracX = logX - intX; 
if(fracX < O) 
{ 

} 

fracX = lookUp (fracX, neglogs); 
if (fracX == 0.0) 
{ 

intX += 1.0; 

else 
{ 

} 

fracX = lookUp (fracX, poslogs); 
if (fracX == 1.0) 
{ 

fracX = 0.0; 
intX += 1.0; 

logX = intX + fracX; 
return (exp10x (logX)); 

The RoundUp function is essentially the mirror image of the 
RoundDown function. If the input value is negative, we call 
the RoundDown function with the negation of the input 
value and then return the negation of the result. If the input 
value is positive, then we compute its common logarithm and 
separate it into its integral and fractional parts. 

If the fractional part is negative, we call the lookUp function, 
using the negLogs table, to find the first logarithm whose 
value is larger than the input fraction. 

If the return fraction is 0.0, then we increment the integral 
portion of the resulting logarithm. If the fractional part is pos
itive, we call the lookUp function, using the posLogs table, to 
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find the first logarithm whose value is larger than the input 
fraction. 

If the result that is returned has the value 1.0, then we set its 
fractional part to 0.0 and increment its integral part by 1. 
The final step is to combine the new integral and fractional 
components and take the value returned by the exponential 
function as our final result. 

lookup Function Code 

The lookUp function searches the specified table of loga
rithms from beginning to end, looking for the first value that 
is larger than the input value. The value found is returned. 
The code for the lookUp function is as follows: 

double lookUp (double log, double *table) 
{ 

short index; 

for (index=O; index< 10; index++) 
{ 

} 

if(log <= table[index]) 
{ 

return table[index]; 

return table[9]; 

lookDown Function Code 

The lookDown function searches the specified table of loga
rithms from end to beginning, looking for the first entry that 
has a smaller value than the input parameter. The code for 
this function is as follows: 

double lookDown (double log, double *table) 
{ 

short index; 
for (index=9; index>= O; index--) 
{ 

if(log >= table[index]) 
{ 

return table[index]; 
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lookDown 
function code 
(concluded) return table[O]; 

This concludes the description of the additions and changes 
we have made to the GraphWindow module. The next section 
describes the new Chartlnfo support class. 

Adding New Chartlnfo Code 

In order to keep an object that contains the current settings 
for the Chart dialog and also support access to its informa
tion, we have created new source files called Chartlnfo.c and 
Chartlnfo.h. These new source files define a class called 
CChartlnfo, that inherits its behavior from the TCL class 
CObject. The class declaration taken from the Chartlnfo.h 
header file is as follows: 

class CChartlnfo : public CObject 
{ 
public: 

chartlnto chartSettings; 
void IChartlnfo(void); 
chartlnfo GetChartlnfo(void); 
void SetChartlnfo (chartlnfo theData); 
min Max GetHScale(void); 
min Max GetVScale(void); 
Rect GetHData(void); 
Rect GetVData(void); 
Rect GetHLabel(void); 
Rect GetVLabel(void); 
Rect Range2Rect(StringPtr range); 
unsigned char GC (StringPtr s, short *index, short len); 

}; 

In the class declaration, there is a single instance variable 
called chartSettings that is of type chartlnfo. This is a 
structure that is also defined in the chartlnfo.h file, whose 
contents are shown on page 387. A new data type called min
Max has also been specified: 



typedef struct 
{ 

double min; 
double max; 

minMax; 

Defining the New CChartlnfo Methods 
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The CChartlnfo class implements the access methods shown 
in the preceding class declaration. These methods are used 
by both the Chart dialog and the various charting methods in 
the GraphWindow module. 

IChartlnfo Method Code 

The IChartlnfo method is responsible for initializing a new 
instance of the CChartlnfo class. The initialization consists 
of storing default values into each of the fields of the chart
Settings instance variable. The code is as follows: 

void CChartlnfo::IChartlnfo(void) 
{ 

chartSettings.modified = O; 
chartSettings.chartType = 177; 
chartSettings.scalingType = 180; 
chartSettings.hMinScale[O] = O; 
chartSettings.hMaxScale[O] = O; 
chartSettings.vMinScale[O] = O; 
chartSettings.vMaxScale[O] = O; 
chartSettings.title[O] = O; 
chartSettings.hDataRange[O] = O; 
chartSettings.vDataRange[O] = O; 
chartSettings.hLabelCheck = O; 
chartSettings.hLabelRange[O] = O; 
chartSettings.vLabelCheck = O; 
chartSettings.vLabelRange[O] = O; 

II unmodified to start with 
II cHorizontalBarViewlD 
II cAutomaticScaleViewlD 
II no contents 
II no contents 
II no contents 
II no contents 
II no contents 
II no contents 
II no contents 
II not checked 
II no contents 
II not checked 
II no contents 

In the foregoing code, the modified field is initialized to 0, in
dicating that the settings have not yet been specified by the 
user. The chartSettings structure is set up initially with hor
izontal bar chart and automatic scaling selections; all of the 
other fields are set to 0. 
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GetChartlnfo Method Code 

The GetChartlnfo method returns the current contents of 
the chartSettings structure. The code is as follows: 

chartlnfo CChartlnfo::GetChartlnfo(void) 
{ 

return chartSettings; 

SetChartlnfo Method Code 

The SetChartlnfo method stores the specified settings into 
the chartSettings instance variable. The code is as follows: 

void CChartlnfo::SetChartlnfo (chartlnfo thelnfo) 
{ 

chartSettings = thelnfo; 

GetHScale Method Code 

The GetHScale method converts the hMinScale and hMax
Scale strings in the chartSettings variable into double-preci
sion floating-point values in a type-minMax structure. The 
code is as follows: 

minMax CChartlnfo::GetHScale(void) 
{ 

extended minVal, maxVal; 
minMax theScale; 
minVal = str2num (chartSettings.hMinScale); 
maxVal = str2num (chartSettings.hMaxScale); 
x80tox96 (&minVal, &theScale.min); 
x80tox96 (&maxVal, &theScale.max); 
return theScale; 

The GetHScale method uses the SANE libraiy str2num func
tion to convert the strings to extended floating-point values. 
Then these are converted to double-precision values and 
stored into the structure, using the x80tox96 SANE function. 
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GetVScale Method Code 

The GetVScale method converts the vMinScale and vMax
Scale strings in the chartSettings variable into double-preci
sion floating-point values in a type-minMax structure. The 
code is as follows: 

minMax CChartlnfo::GetVScale(void) 
{ 

extended minVal, maxVal; 
minMax theScale; 

minVal = str2num (chartSettings.vMinScale); 
maxVal = str2num (chartSettings.vMaxScale); 
x80tox96 (&minVal, &theScale.min); 
x80tox96 (&maxVal, &theScale.max); 
return theScale; 

GetHData Method Code 

The GetHData method converts the string representation of 
the horizontal data range stored in the hDataRange field of 
the chartSettings structure into a Rect structure, where the 
left and top members specify the starting column and row 
and the right and bottom members specify the ending column 
and row. The code is as follows: 

Rect CChartlnfo::GetHData(void) 
{ 

return Range2Rect (chartSettings.hDataRange); 

This method uses a utility Range2Rect method that will be 
described shortly. 

GetVData Method Code 

The GetVData method converts the string representation of 
the vertical data range stored in the vDataRange field of the 
chartSettings structure into a Rect structure, where the left 
and top members specify the starting column and row and 
the right and bottom members specify the ending column and 
row. The code is as follows: 
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Rect CChartlnfo::GetVData(void) 

{ 

return Range2Rect (chartSettings.vDataRange); 

The GetVData method also uses the Range2Rect method to 
convert the string into a Rect structure. 

GetHLabel Method Code 

The GetHLabel method converts the string representation of 
the horizontal label range stored in the hLabelRange field of 
the chartSettings structure into a Rect structure, where the 
left and top members specify the starting column and row 
and the right and bottom members specify the ending column 
and row. The code is as follows: 

Rect CChartlnfo::GetHLabel(void) 

{ 

return Range2Rect (chartSettings.hlabelRange); 

GetVLabel Method Code 

The GetVLabel method converts the string representation of 
the vertical label range stored in the vLabelRange field of the 
chartSettings structure into a Rect structure, where the left 
and top members specify the starting column and row and 
the right and bottom members specify the ending column and 
row. The code is as follows: 

Rect CChartlnfo::GetVLabel(void) 

{ 

return Range2Rect (chartSettings.vlabelRange); 

Both the GetHLabel and GetVLabel method use the Range2-
Rect method to convert their respective strings to the Rect 
structure form. 



Range2Rect 
method code 
(beginning) 
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Range2Rect Method Code 

The Range2Rect method is a utility called by the various 
data and label range access methods to convert the cell 
ranges specified in the Chart dialog to numeric column and 
row values. The beginning and ending column and row values 
are returned in the form of a Rect structure: 

Rect CChartlnfo::Range2Rect(StringPtr range) 
{ 

short len, i, col, row, OK= O; 
Point from, to; 
Rect aRect; 
StringPtr s; 
unsigned char ch; 

len = range[O]; 
for(i=O, S=&range[1]; (ch=GC(s, &i, len)) =='' && i < len;) 
{ 

} 

II skip over blanks 
continue; 

if( ch>= 'A' && ch<= 'Z' II ch>= 'a' && ch<= 'z') 
{ 

col = (ch & -Ox20) - 'A'; 
if((ch=GC(s, &i, len)) >= 'O' && ch<= '9') 
{ 

} 

row= ch - 'O'; 
OK= 1; 
if((ch=GC(s, &i, len)) >= 'O' && ch<= '9') 
{ 

} 

row*=10; 
row+= (ch - 'O'); 

else if (ch == '.' && GC(s, &i, len) == '.') 
{ 

} 

from.h =col; 
from.v = row-1; 
0K=2; 

else 
{ 

OK=O; 

else 
{ 
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Range2Rect 
method.code 
(continued) 

OK=O; 

} 
else 
{ 

OK=O; 
} 
switch (OK) 
{ 

} 

case 0: 
{ 

SetRect ( &aRect, -1 , -1 , -1 , -1 ) ; 
return aRect; 
break; 

case 1: 
{ 

from.h = col; 
from.v = row-1; 
if ((ch=GC(s, &i, len)) == '.' && GC(s, &i, len) == '.') 
{ 

0K=2; 
} 
else 
{ 

OK=O; 
} 
break; 

if (OK!= 2) 
{ 

SetRect (&aRect, -1, -1, -1, -1); 
return aRect; 

} 
OK=O; 
if((ch=GC(s, &i, len)) >='A' && ch<= 'Z' II ch>= 'a' && ch<= 'z') 
{ 

col = (ch & -Ox20) - 'A'; 
if((ch=GC(s, &i, len)) >= 'O' && ch <= '9') 
{ 

row = ch - 'O'; 
OK= 1; 
if((ch=GC(s, &i, len)) >= 'O' && ch<= '9') 
{ 

} 

row*= 10; 
row+= (ch - 'O'); 

else if (ch == '\O') 



Range2Rect 
method code 
(concluded) 

OK= 1; 

else 
{ 

else 
{ 

OK=O; 

OK=O; 

else 
{ 

OK=O; 
} 
if(OK == 1) 
{ 
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SetRect(&aRect, from.h, from.v, col, row-1); 
return aRect; 

else 

SetRect(&aRect, -1, -1, -1, -1); 
return aRect; 

The Range2Rect method parses the string that contains a 
data range and creates a Rect structure in which the left and 
top members contain the beginning column and row of the 
range and the right and bottom members contain the ending 
column and row of the range. Ranges are specified as a pair 
of worksheet cells, where columns are labeled from A to Z 
and rows are numbered from 1 to 50. A range consists of a 
cell number, followed by two periods and a second cell num
ber (e.g., A3 .. A9 or Bl3 .. Wl3). A range can only be a single 
column or row-never a rectangular group of columns or 
rows. 

The method begins with a local variable called OK set to 0, 
indicating that the result is initially invalid. Only if the speci
fied range meets the requirements of a proper range is the 
OK value set to 1. After the string is parsed, the OK value is 
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Exercises 

tested, and if it is 1, the proper Rect structure is returned; 
otherwise, a Rect of {-1, -1, -1, -11 is returned. 

GC Method Code 

The Range2Rect method uses the GC method to fetch the 
next character from the range string. The code for this 
method is as follows: 

unsigned char CChartlnfo::GC(StringPtr s, short *index, short len) 

{ 

unsigned char ch; 

if (*index < len) 

{ 
ch= s[(*index)++]; 

else 

ch= '\O'; 

return ch; 

If the end of the string is reached, the GC method returns a 
binary 0 character. Otherwise, the next character in the 
string is returned, and the string index is incremented in 
preparation for the subsequent call. 

1. Explain the necessity of initializing the Chart dialog with 
its previous settings. Describe how the DoChart function 
performs this task. 

2. Explain the operation of the DoComm.and method in the 
CChart class. In what way does the method respond to 
the user's selections in the dialog? In what way does the 
appearance of the dialog change when each of the differ
ent chart types is chosen, in turn? What happens if auto
matic versus manual scaling is selected? 
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3. What is the purpose of the Validate method in the CChart 
class? What principle feature of object-oriented program
ming does the definition of this method illustrate? 

4. Describe the operation of the DrawHBarChart method. 
What challenges does it face, and how are these handled 
with respect to the choice of automatic or manual scal
ing? How could the automatic scaling be improved? 

5. The charting methods use the current size of the Graph
Window to determine the optimal drawing area. In what 
cases is this preference modified? 

6. How could the charting methods be improved to use a 
varying number of divisions on the "value" axis? In what 
way would this improve the usefulness of the charts? 
Implement your suggestions. 1 

7. Could the X-Y chart be modified to provide a useful line
chart capabili1y? What would be required to implement 
this feature for arbitrary cell values in a range? (Hint 
Most line charts are drawn with increasing values when 
viewed from left to right or bottom to top.) 

8. If the charting functions of the Ensemble application are 
modified to support pie charts, what are the major prob
lems that you would face in annotating the charts? What 
modifications would be necessary to integrate the new 
features into the code described in this chapter? Imple
ment these modifications. 2 

1. Modifying the number of divisions in a chart is a task of medium complexity. It will require 
some additional work, but should not be a major task. It could be assigned as an extra-credit 
project. 

2. Implementation of pie charts is a very extensive task. It will require good knowledge of the 
built-in Quickdraw facilities for drawing wedges and will require the implementation of com
plex techniques for labeling the wedges. It could be assigned as an extensive extra-credit 
project. 
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9. The exercises in Chapters 8 and 11 indicate that you 
should consider the implementation of multiple contigu
ous or noncontiguous cell selections in the worksheet. 
How would implementation of this feature relate to the 
charting function? What modifications to the design and 
implementation of the charting function would facilitate 
interfacing with the worksheet module?1 (Hint Charting a 
range of preselected cells is a somewhat standard practice 
in major spreadsheet applications.) 

1. Implementation of a more direct interface between the worksheet and the charting functions is 
a complex task. It should only be undertaken as an extensive extra-credit project. 
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Printing Ensemble's Windows 

This chapter describes the new custom code that we have 
added to allow the user to print the contents of the Notebook, 
Worksheet, or Chart windows. 

The THINK Class Library implements a method to print the 
contents of the pane whose handle is stored in the itsMain
Pane instance variable in the CEnsembleDoc class. There is 
no direct provision for printing other, subsidiary, window 
panes. 

In the TCL, the CPrinter instance manages the communica
tion between a document and the Macintosh print manager. 
Each document can have its own printer object, but there 
can only be one printer object per document. Because the 
Ensemble application is a single-document multiple-window 
model, we need to provide some additional code to permit 
printing the additional window panes. 

The remainder of the chapter discusses the custom code that 
has been added to allow the user to print the contents of the 
frontmost window of the Ensemble application. By activating 
each window, in turn, the contents of the Notebook, Work
sheet, and Chart windows can be printed. 

Printing the MainWindow's Pane 

The CMainWindow instance defines a window that contains 
a single CEditText pane. This window is directly owned by 
the CEnsembleDoc class, which is a direct descendant of the 
CDocument class in the TCL. Thus, it is very easy to print 
the contents of the window's main pane (called itsMainPane). 
At the time the user has activated the MainWindow, the En-

453 
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Figure 15-1 
Print structure of 
MainWindow in 
Ensemble 
application 
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ure 15-1. 
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Notice that the other two windows aren't shown. For all prac
tical purposes, they are not included in the chain of com
mand when the MainWindow is active. All menu commands 
are directed to the current gGopher, which points to the in
stance of CMainWindow. Therefore, the DoCommand 
method in that class will be the first to receive any commands 
from the user, including the Print and Page Setup com
mands in the File menu. The code in Ensemble's MainWin
dow module doesn't currently handle these commands, so 
they are passed on in the chain of command to be handled by 
the CDocument class in the TCL. 

Before the CDocument class will handle either the Print or 
Page Setup commands, an instance of CPrinter must have 
been created and stored into the document's itsPrinter in
stance variable. This is accomplished as a side effect of the 
creation of the CEnsembleDoc class, in the ZEnsembleApp 
CreateDocument method. By passing the value TRUE as the 
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second parameter to the IEnsembleDoc method (see 
page 32), the document's printable instance variable will be 
set to TRUE, and during the execution of the inherited !Docu
ment method, an instance of CPrinter will be created and 
stored in the document's itsPrinter instance variable. 

The one remaining task to enable the text contained in the 
MainWindow to be printed out is to set the document's its
MainPane instance variable. Previously, AppMaker's default
generated code set the CMainWindow instance's itsMain
Pane to NULL in the IZMainWindow method (see page 71). 
The document's itsMainPane instance variable is set directly 
from the value contained in the corresponding variable in the 
MainWindow class, as shown in the listing of the BuildWin
dows method on page 365. To rectify the situation of the its
MainPane being NULL in the CMainWindow class, we have 
added one line of code in the IMainWindow method: 

void CMainWindow::IMainWindow(CDirector *aSupervisor, 
CEnsembleData *theData) 

itsData = theData; 
inherited::IZMainWindow (aSupervisor); 
itsMainPane = Field3; 

The code for the revised IMainWindow method puts the han
dle to the EditText pane (Field3) into the itsMainPane in
stance variable, from which the BuildWindows method can 
extract the value and store it into the document's itsMain
Pane instance variable. 

When the preceding simple modification has been made, and 
the application is recompiled, the user will be able to print 
the contents of the CMainWindow class's EditText pane. 
The TCL contains all of the logic to accomplish this task. The 
following steps enumerate the actions taken by the relevant 
code: 

1. The user chooses the Print command from the File 
menu, and this command is sent to the CMainWindow 
class's DoCommand method. This method does not need 
to handle the command, so it passes it on to its inherited 
method. 
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2. The CDocument class intercepts the Print command 
(cmdPrint) and verifies that the itsPrinter instance is not 
NULL. The method then sends a DoPrint message to the 
correct itsPrinter instance. 

3. The DoPrint method calls the toolbox Print Manager to 
show the print job dialog. The user is given the opportu
nity to set the page range, number of copies, and other 
parameters that are provided in this standard dialog. If 
the user dismisses the dialog with Cancel, the print pro
cess is terminated at that point. Otherwise, the DoPrint 
method calls the PrintPageRange method (in CPrinter) 
to print out the necessary number of pages for the cur
rent document's itsMainPane. 

4. The first act of the PrinlPageRange method is to send an 
AboutToPrint message to the document (CEnsembleDoc 
in this case). This message contains the first and last 
page numbers to be printed, as determined from the print 
job dialog in the previous step. In the absence of an over
ride method, the AboutToPrint method in the CDocu
ment class is called. 

a. The AboutToPrint method calculates the pageHeight 
and pageWidth instance variables, checks the begin
ning and ending page numbers for consistency, and 
calculates the pageCount value. 

b. Then, an AboutToPrint message is sent to the its
MainPane instance. This enables the pane to perform 
any necessary initialization prior to commencing the 
print operation. 

5. The CPrinter class's PrinlPageRange method continues 
by calling the toolbox PrValidate function to verify that 
the printing information is valid and that a printer is 
attached to the system. If a valid result is returned, the 
method calls the ResetPagination method to clear out 
any previously set horizontal and vertical strip counts for 
the document. Then, if no pagination has previously been 
performed, a Paginate message is sent to the document. 



Printing the Main Window's Pane 451 

a. The CDocument class's Paginate method gets the 
existing print record (print job settings) and recalcu
lates the pageHeight and pageWidth values. 

b. Then, the Paginate method sends a Paginate mes
sage to the document's itsMainPane instance, allow
ing the pane to paginate its contents according to the 
type of information contained in the pane. 

c. In lieu of an override method, the Paginate message 
is intercepted by the method with the same name in 
the CAbstractText class. This method calls upon the 
CEditText class's GetNumLines method to determine 
the number of lines of text in the current EditText 
buffer. Using the GetNumLines method, Paginate 
calls the CPrinter class's SetVertPageBreak method 
with appropriate vertical positions for pages to be bro
ken, creating a set of horizontal strips (pages) contain
ing complete lines of text. No pages are broken with 
partial lines (e.g., a line split horizontally within its 
characters between pages). If a line will not fit on a 
page, the entire line is moved to the next page on 
which it will fit. 

6. The PrintPageRange method continues by opening the 
print manager and calling the toolbox PrOpenDoc routine 
to initialize a printer grafPort and make it the active port. 
Then the method enters a loop, where the following 
actions are taken: 

a. The toolbox PrOpenPage is called to prepare the 
printer grafPort to receive the QuickDraw instructions 
to print the current page. 

b. The document is sent a Prin1PageOfDoc message, 
which the CDocument class intercepts and sends on 
as a PrlntPage message to the itsMainPane instance. 

c. The CEditText class has a PrintPage method that 
switches the EditText port to the current (printer) 
port, expands the size of the port to encompass an 
entire page width and height, calls the inherited 
PrintPage method, and then resets the EditText port 
back to the screen port. 
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d. The inherited PrintPage method is found in the CPan
orama class. This method sends the CPrinter 
instance a message to get the area (a Rect) associated 
with the current page, scrolls the pane to the begin
ning position of the page, and then calls the DrawAll 
method in the CPane class. 

e. The DrawAll method in the CPane class calls the 
Draw method for the current pane and all of its sub
panes (of which there are none for the EdiIText pane). 
The Draw method in the CEditText class calls TEUp
date to cause the text at the current pane position to 
be redrawn. 

7. The loop concludes in the PrintPageRange method of the 
CPrinter class by calling the toolbox PrClosePage routine 
to perform any post-page-printing actions. 

8. When all of the pages in the document's itsMainPane 
have been printed, the PrintPageRange method calls the 
PrCloseDoc toolbox routine to finish printing the last 
page of the document, closes the printer port, and ends 
the printing task. The ClosePrintMgr method in the 
CPrinter instance is called to ensure that the printing
oriented controls and variables are reset. Then, the 
method sends a DonePrinting message to the document, 
which, in turn, sends that message to the itsMainPane 
instance. 

9. The CEditText class intercepts the DonePrinting mes
sage to recalculate the EdiIText pane dimensions, reset 
the coordinates, and activate the EdiIText pane (which 
will redisplay the blinking cursor in that pane). 

10. The PrintPageRange method returns to the DoPrint 
method, which, in turn, returns to the CDocument 
class's DoCommand method, completing the execution of 
the Print command. 

If the printer is connected via AppleTalk and the print moni
tor or other spooler is active, the process just described will 
be accomplished in a very short time. After all of the pages 
have been drawn, the Ensemble application will be ready to 
accept any further commands. 
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Printing the GraphWindow's Pane 

Figure 15-2 
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This section describes the custom code modifications that we 
have made to support printing the charts drawn in the 
CGraphWindow window. 

The THINK Class Library is not designed for printing other 
than a single main pane, so to print the panes in the addi
tional windows, we have to "lie" to the TCL about which pane 
is the document's itsMainPane and also about which in
stance of CPrinter is itsPrlnter. Fortunately, the code to cir
cumvent the design of the TCL is quite straightforward. When 
the GraphWindow is the frontmost window, the dynamic 
structure of the Ensemble application appears as displayed 
in Figure 15-2. 
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The figure shows that CGraphWindow and its superclass, 
ZGraphWindow, inherit their behavior from the TCL's CDi
rector class. There is no code in the TCL that provides the 
ability to directly print a window owned by a CDirector. This 
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is not the case for the MainWindow, which is owned by the 
document. 

The first step in providing support for printing the main pane 
in the CGraphWindow class is to define two new instance 
variables called itsMainPane and itsPrinter, respectively. The 
itsPrinter instance is created and initialized in the IGraph
Window method. The itsMainPane instance variable will be 
initialized later. The new IGraphWindow code is as follows: 

void CGraphWindow::IGraphWindow(CDirector 
CEnsembleData 

Str255 theFilename; 

itsData = theData; 
inherited::IZGraphWindow (aSupervisor); 
gDecorator->StaggerWindow (its Window); 

II any additional initialization for your window 
itsChartlnfo = new CChartlnfo; 
itsChartl nfo->IChartl nfo(); 

*aSupervisor, 
*theData) 

itsPrinter = new CPrinter; 
itsPrinter->IPrinter((CDocument *)aSupervisor, NULL); 

II 
II Put the window's name in the title 
II 
if(((CEnsembleDoc *) aSupervisor)->itsFile != NULL) 
{ 

( (CEnsembleDoc *) aSupervisor)->itsFile->GetName(theFilename); 
itsWindow->SetTitle(theFilename); 

The next step in supporting printing for the main pane in the 
CGraphWindow class is to add some special code to the Do
Command method. Fortunately, when it is active, the 
CGraphWindow is at the head of the chain of command. This 
means that its DoCommand method will receive the Print 
and Page Setup commands first (because the gGopher 
points to the CGraphWindow instance). 

If you inspect the customized DoCommand method for the 
CGraphWindow class, as presented on page 406, you'll see 
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that it contains only a case to invoke the Chart dialog and a 
default case that calls the inherited method in the ZGraph
Window superclass. You can see that this method merely 
passes on the command, as shown in the listing on page 367. 
What we need to do is intercept the Print and Page Setup 
commands inside the DoCommand method in the CGraph
Window class. The revised code for this method is as follows: 

void CGraphWindow::DoCommand(long theCommand) 
{ 

switch (theCommand) 
{ 

case cmdChart: 
{ 

DoChart(this); 
if(itsChartlnfo->chartSettings.modified) 

{ 
User4->Refresh(); 

break; 

case cmdPageSetup: 
case cmdPrint: 

PrintChart((CEnsembleDoc *) itsSupervisor, theCommand); 

break; 

default: 
{ 

inherited::DoCommand (theCommand); 

break; 

Notice that in the new version of the DoCommand method, 
both the cmdPageSetup and cmdPrint commands are being 
intercepted. In both of these cases, we call a new method 
called PrintChart, with arguments of the CGraphWindow's 
supervisor (which happens to be the CEnsembleDoc in
stance, as you can see from the cast) and also the command 
that is to be executed. The code for the new PrintChart 
method is as follows: 
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void CGraphWindow::PrintChart (CDocument *itsSupervisor 
long theCommand) 

CPane 
CPrinter 

*saved Pane; 
*savedPrinter; 

savedPane = itsSupervisor->itsMainPane; 
savedPrinter = itsSupervisor->itsPrinter; 
itsSupervisor->itsMainPane = User4; 
itsSupervisor->itsPrinter = itsPrinter; 
itsPrinter->ResetPagination(); 

inherited::DoCommand (theCommand); 

itsSupervisor->itsMainPane = savedPane; 
itsSupervisor->itsPrinter = savedPrinter; 

The PrintChart method is the key to printing additional win
dows using the current structure of the TCL. The method ac
cesses the itsMainPane and itsPrinter instance variables in 
the CEnsembleDoc instance (itsSupervisor) and temporarily 
saves these values in the saved.Pane and saved.Printer vari
ables. It then sets the document's itsMainPane to the User4 
instance, which is the instance of CPanorama in which the 
charts are drawn. The document's itsPrinter is replaced by 
the CGraphWindow's instance of CPrinter (created in the 
IGraphWindow method, shown on page 460). The itsPrinter 
variable is sent a ResetPagination message, to clear out any 
horizontal or vertical strips that may previously have been 
set. 

After the preceding preparations are complete, we can call 
the inherited DoCommand method, which will pass the Print 
or PageSetup command through the chain of command, un
til it is intercepted by the CDocument DoCommand method, 
as described in step 2 on page 455. 

The operation of the TCL with regard to handling the Print 
and Page Setup commands is almost identical to that previ
ously described, up to the point where the Paginate and 
Draw methods are called. In the case of the CPanorama 
methods that handle the User4 instance of itsMainPane, 
pagination will depend on the size of the panorama. We have 
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purposely defined its dimensions to correspond to a letter
sized page (see page 407). 

The existing CUser4 Draw method will draw the currently se
lected chart into the printer port, according to the code pro
vided in the TCL for switching the printer and screen ports 
when necessary. 

After the Print or Page Setup command has been handled, 
control will return to the DoCommand method in the 
CGraphWindow class, immediately following the call to the 
inherited DoCommand method. This is key, because upon 
return of control, the code restores the values of the docu
ment's itsMainPane and itsPrinter to the values saved in 
savedPane and savedPrinter, respectively. At this point, the 
printing operation is complete. 

Printing the CalcWindow's Pane 

ICalcWindow 
method code 
(beginning} 

The provisions to print the CCalcWindow class's main pane 
are only slightly more elaborate than those shown for print
ing the CGraphWindow's pane. When the CCalcWindow is 
frontmost, the dynamic structure of the Ensemble applica
tion is as shown in Figure 15-3. As was the case with the 
CGraphWindow class, the first step in supporting printing of 
the CCalcWindow's main pane is to create two new instance 
variables named itsMainPane and itsPrinter. The itsPrinter 
variable is created and initialized in the ICalcWindow 
method. Because the majority of this code is identical to the 
listing of the ICalcWindow method in Chapter 11, only the 
initial portion of the code is shown: 

void CCalcWindow::ICalcWindow(CDirector 
CEnsembleData 

Rect 
Str255 

aRect; 
theFilename; 

long index; 
CCellData *aStyle; 
celllnfo cell Style; 

itsData = theData; 
inherited::IZCalcWindow (aSupervisor); 
gDecorator->StaggerWindow (itsWindow); 

*aSupervisor, 
*the Data) 
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ICalcWindow 
method code 
(concluded) 

Figure 15-3 
Print structure of 
CalcWindow in 
Ensemble 
application 
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The creation of the CPrinter instance and its storage into the 
itsPrinter instance variable are shown in this abbreviated 
listing of the ICalcWindow code. To handle the Print and 
Page Setup commands, we have enhanced the DoCommand 
method in the CCalcWindow class. In addition, we have had 
to override a couple of the methods in the CList15 class (the 
class that implements the CArrayPane instance that con
tains the worksheet data). The code for the AboutToPrint 



DoCommand 
method code 
(beginning) 
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and DonePrinting override methods will be presented 
shortly. 

The new code for the DoCommand method is very similar to 
what was presented for the CGraphWindow class's method. 
The previous listing of the DoCommand method is shown in 
Chapter 11, and only a few lines have been added to imple
ment printing. Only these lines are shown in the following 
code: 

void CCalcWindow::DoCommand (long theCommand) 
{ 

Cell a Cell; 
short 
short 
short 
cell Info 
cell Info 
CWSEntry 
long 

height; 
width; 
changeStyle; 
style Info; 
old Style; 
*an Entry; 
param; 

switch (theCommand) 
{ 

case cmdEnterButton: 
{ 

} 

DoEnterButton (); 
break; 

case cmdCancelButton: 
{ 

} 

DoCancelButton (); 
break; 

case cmdPageSetup: 
case cmdPrint: 
{ 

PrintWS((CEnsembleDoc *) itsSupervisor, theCommand); 
break; 

case cmdWorksheet: 
{ 

II 
II ALL THE CODE INSIDE THIS CASE HAS 
II PREVIOUSLY BEEN SHOWN IN CHAPTER 11 
II 
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DoCommand 
method code 
(concluded) 

default: 
{ 

inherited::DoCommand (theCommand); 
break; 

The foregoing listing includes the addition of a case to handle 
both the Print and Page Setup commands. The code calls a 
new method called PrintWS, with arguments of itsSupervisor 
(which is the CEnsembleDoc instance, as can be seen from 
the cast) and theCommand (which is the command to be exe
cuted). The code for the new PrintWS method is as follows: 

void CCalcWindow::PrintWS (CDocument *itsSupervisor, 
long theCommand) 

CPane *savedPane; 
CPrinter *savedPrinter; 

savedPane = itsSupervisor->itsMainPane; 
savedPrinter = itsSupervisor->itsPrinter; 
itsSupervisor->itsMainPane = List15; 

II 
II don't print the worksheet borders 
II 
List15->SetCo1Borders(O, patCopy, ltGray); 
List15->SetRowBorders(O, patCopy, ltGray); 

itsSupervisor->itsPrinter = itsPrinter; 
itsPrinter->ResetPagination(); 

inherited::DoCommand (theCommand); 

itsSupervisor->itsMainPane = savedPane; 
itsSupervisor->itsPrinter = savedPrinter; 

II 
II reset the worksheet borders 
II 
List15->SetColBorders(1, patCopy, ltGray); 
List15->SetRowBorders(1, patCopy, ltGray); 
List15->Refresh(); 
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As was shown in the listing of the PrintChart method (on 
page 462), the first act of the PrintWS method is to save the 
current contents of the document's itsMainPane and 
itsPrinter instance variables into the savedPane and saved
Printer local variables. It then sets the document's itsMain
Pane to the List 15 instance (which is the CArrayPane 
instance that holds the worksheet display). 

Because we don't want the cell borders to show up on the 
printout, we send commands to the List15 instance that set 
the column and row border widths to 0. This effectively sup
presses printing of the borders because the TCL checks their 
widths to determine whether they should be drawn. Next, the 
document's itsPrinter instance variable is replaced by the 
itsPrinter instance created in the ICalcWindow method, and 
a ResetPagination message is sent to the instance to clear 
any previously defined horizontal or vertical page strip set
tings. At this point, the inherited DoCommand method can 
be called to initiate printing of the pane. All of the code previ
ously described regarding printing of the CMainPane in
stance (beginning with step 2 on page 455) is carried out for 
the Print or Page Setup command. The description of the 
printing process indicates (in step 4) that the PrintPage
Range method calls the document's AboutToPrint method, 
which, in turn, calls the corresponding method in the its
MainPane instance (described in step 4a on page 456). In the 
case of the CCalcWindow pane, we have supplied an override 
for the AboutToPrint method. The code for this override is as 
follows: 

void Clist15::AboutToPrint (short *firstPage, short *lastPage) 
{ 

inherited::AboutToPrint (firstPage, lastPage); 
saveHOrigin = hOrigin; 
saveVOrigin = vOrigin; 
Offset(hOrigin, vOrigin, FALSE); 

We need to override the AboutToPrint method because the 
worksheet pane (List15) isn't located at the top left corner of 
the window. Printing its contents in the current orientation 
will cause the cells to be off set both horizontally and verti
cally. To correct this situation, we have defined two new in
stance variables in the CList15 class that will hold the 
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existing horizontal and vertical pane origin values. The 
AboutToPrint code first calls the inherited method, then 
stores the hOrigin and vOrigin values into the new saveHOr
igin and saveVOrigin instance variables, and then sends an 
Offset message to the pane to move it physically to the top 
left corner of the window's frame. By passing FALSE as the 
third argument to this method, we prevent the pane from be
ing redrawn in its new position; therefore, the screen display 
is not changed. 

The Paginate method for the worksheet pane is inherited 
from the CTable class. The method will break up the work
sheet into horizontal and vertical strips that contain an inte
gral number of whole cells. 

Drawing the contents of the worksheet is accomplished by a 
combination of the PrintPageRange and its subsidiary meth
ods, as well as by code in the DrawCell and DrawWSCell 
methods for the CList15 class. The TCL takes care of switch
ing the ports between the printer port and screen display 
port, as required. 

When the worksheet's contents are completely printed (and it 
should be noted that only the portions of the worksheet that 
actually contain data will be printed), the PrintPageRange 
method calls the document's DonePrinting method, which, 
in turn, calls the corresponding method for the itsMainPane 
instance. These actions are described in step 8, on page 458. 
In our case, an override method in the CList15 class has 
been provided for the DonePrinting method. The code is as 
follows: 

void Clist15: :DonePrinting (void) 

{ 
inherited::DonePrinting(); 
Offset(-saveHOrigin, -saveVOrigin, TRUE); 

The DonePrinting method first calls the inherited method 
and then moves the Listl5 pane back to its original location, 
using the values saved in the saveHOrigin and saveVOrigin 
instance variables. We also provide a third argument of TRUE 

to the Offset method, which causes the pane to be redrawn. 



Figure 15-4 
Pagination of the 
CList15 worksheet 
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When the DonePrinting method returns to the TCL and all of 
the other cleanup tasks are complete, control returns to the 
PrintWS method in the CCalcWindow class (see page 466). 
Control returns to the code immediately following the call to 
the inherited DoCommand method. The code that follows re
stores the itsMainPane and itsPrinter instance variable val
ues in the CEnsembleDoc instance and then restores the 
I-pixel cell borders by calling the SetColBorders and Set
RowBorders methods for the CList15 object. The final action 
is to send a Refresh message to the pane, to redraw the 
worksheet with its borders. 

The printed version of the worksheet consists of a series of 
vertical and horizontal strips, each of which occupies a 
printed page, as shown in Figure 15-4. 

According to the pagination algorithm, the worksheet is di
vided into page-sized groups of cells. Pages can have a variable 
number of cells, depending on the row and column widths in 
the worksheet. The pages are printed from left to right and 
from top to bottom. The top left cell on page 1 is cell Al. 
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Exercises 

If the worksheet consists only of a few cells, it is advanta
geous to locate them beginning in cell Al and in cells in that 
region of the worksheet. By defining cells in the rightmost 
columns or bottommost rows, a set of blank pages might be 
printed before the desired data are output. 

There is no provision for printing a portion of the worksheet 
in this design. As indicated, if the worksheet contains only a 
few cells and the cells are placed in the top left area of the 
worksheet, only a single page will be printed. 

The printing strategy presented for the CGraphWindow and 
CCalcWindow panes will apply equally to additional windows 
if these are added to the Ensemble design. In every case, it 
will be necessary to intercept the Print and Page Setup com
mands, so that the itsMainPane and itsPrinter variables in 
the document instance can be replaced by corresponding 
variables for the window whose pane is to be printed. It is 
also necessary to restore the saved values after printing is 
complete. 

1. Describe the difference between printing the contents of 
the Main Window and of the subsidiary windows. Discuss 
how this difference could be eliminated. (Hint Perhaps a 
different application model would be required, or perhaps 
the printing and command-handling methods could be 
insulated from the programmer, as they are when print
ing the MainWindow.) 

2. Explain why the worksheet pane had to be moved so that 
it would print with its top left cell at the top left margin of 
the page. 

3. Describe what modifications would be necessary to print 
only a portion of the worksheet window. In what way 
could this relate to the selection of multiple contiguous or 
noncontiguous cells in the worksheet, as suggested in 
Chapters 8 and 11? 
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4. How would you handle printing a title on the first page of 
a printout and page numbers or other header or footer 
material? What TCL classes and methods would you need 
to override, and what additional methods would need to 
be written?1 

1. Examination of the complexities of pagination and printing individual pages is an involved 
task. Preparation of an appropriate answer to this question would require a great deal of 
research. We suggest that this be assigned only as an extra-credit project or be undertaken as 
a section of the lesson plan. Printing is both a complex and necessary task. Many applications 
will require formatted printed output, as opposed to the printouts that mimic the screen dis
plays implemented in the Ensemble application. 



Chapter 16 

Completing the Ensemble Application 

This chapter describes the final steps that will transform the 
Ensemble application into a stand-alone double-clickable 
Macintosh application. 

We will discuss a couple of simple code additions that assign 
a Creator code to the application and also specify a Type code 
for the application's data file. 

We will also provide a tutorial on using Apple's ResEdit pro
gram to create the custom resources that provide unique 
icons for both the application and its data file. 

Finally, we will compile the Ensemble project one more time 
and link it into a stand-alone application. Once that has been 
done, it will be available for use by double-clicking either the 
application or one of its data files. 

Defining Ensemble's Creator and File Type Codes 

As you are probably aware, all Macintosh files (including ap
plications) have both a Creator code and a Type code. The 
Type code for an application is always 'APPL'; however, its 
Creator code can be any four-character identifier that doesn't 
conflict with one used for another application. 

We will use 'Nsbl' for Ensemble's Creator code, as this code is 
not presently being used (as far as I can tell). In addition to 
the Creator code, we will need a unique Type code for the ap
plication's data file. We have decided to use 'Nsbf for this 
purpose. Therefore, the data files written and read by Ensem
ble, after we have made the changes to be described, will have 
a Creator code of 'Nsbl' and a Type code of 'Nsbf. 

473 
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The changes to implement these codes are very simple. They 
are made in the CEnsembleApp.h file, to establish the defini
tions for the kSignature and kFileType constants. These 
new definitions are as follows: 

#define kSignature 'Nsbl' 

#define kFileType 'Nsbf 

The definitions are used in various places in the application, 
especially in the CEnsembleApp class's SetUpFileParame
ters method: 

void CEnsembleApp::SetUpFileParameters(void) 

{ 

inherited::SetUpFileParameters (); 

sfNumTypes = 1; 

sfFileTypes [O] = kFileType; 

gSignature = kSignature; 

The sfFileTypes array is initialized to contain a single new 
Type code corresponding to the kFileType definition. 

Creating Unique Application and File Icons 

After the changes have been made to define the Creator and 
Type codes, the source code for the Ensemble application is 
complete and can be saved. The next step in creating a cus
tom application is to design the family of icons that are dis
played on the desktop for the application and its files, as well 
as other resources that establish the unique identity of the 
application. The best way to accomplish this is to make a 
copy of the Ensemble.n.rsrc AppMaker resource file and use 
the ResEdit application that came with your THINK C prod
uct. The following steps describe how to modify the file: 

1. Launch your copy of ResEdit (version 2.1 or later) and 
open the Ensemble.n.rsrc copy file. You should see a 
window similar to what is shown in Figure 16-1. 
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2. Locate the resource icon labeled BNDL. This is the Bun
dle resource. Double-click to open this resource, as 
shown in Figure 16-2. 

~D Ensemble. rr .rsrc copy 0~ 

0101 I IOI 01011101 01011101 0101 I IOI 

~ 
{f 

0010 1001 (u)IOIOOI 0010 1001 0010 1001 
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3. You should see a list of BNDL resources, as shown in Fig
ure 16-3. Notice that only a BNDL with a resource ID 
of 128 is shown. 
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Figure 16-3 
List ofBNDL 
resources 

Figure 16-4 
BNDL with ID = 128 
open 

Figure 16-5 
BNDL extended view 
selected 

=o= BNDLs from Ensemble. n .rs re copy =~::r 

4. Double-click on the BNDL whose ID is 128 to open it. You 
should see a window with the appearance shown in Fig
ure 16-4. Notice that the bundle contains icons for a 
generic application ('APPL') and also a generic document 
('DOC'). 

~D~ BNOL "Bundle" ID = 128 from Ens ~ 

signature: lflut!t!WI 

Type Finder I cons 

APPL 

DOC 

5. Choose ·the Extended View command from the BNDL 
menu at the top of the screen, as shown in Figure 16-5. 

6. You should see an extended view of the BNDL #128 
resource, as shown in Figure 16-6. This view includes 
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some additional fields that we must complete to set the 
application's signature (Creator code) and to create the 
version resource. 

§0 BNDL "Bundle" ID = 128 from Ensemble. n .rsrc copy 
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7. Fill in the additional fields in the extended view to match 
the settings shown in Figure 16-7. The modified resource 
should have 'Nsbl' in place of the 'XXXX' in the Signature 
field, and the ID String should contain "Ensemble vl.O 
© 1992 Richard Parker", instead of the "Generic Appli
cation vl.O" text that was shown in Figure 16-6. 

§0 BNDL "Bundle" ID = 128 from Ensemble. n .rsrc copy 
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Figure 16-8 
BNDL Extended 
View cleared 

Figure 16-9 
Opening APPL icon 
editor 

8. After the additional fields have been modified, choose the 
Extended View command from the BNDL menu, as 
shown in Figure 16-5, to collapse the view. 

9. The next step is to open the icon editor for the APPL icons 
by double-clicking on the Finder Icons pane, as shown in 
Figure 16-9. 

~0~ BNDL "Bundle" ID = 128 from Ens ~ 
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10. The APPL icon editor is shown in Figure 16-10. This edi
tor allows you to create application icons for both mono
chrome and color displays. The monochrome icon is 
called ICN#, and its small version is called ics# . It also 
allows the creation of large and small 8-bit color (icl8 and 
ics8) icons, as well as 4-bit color (icl4 and ics4) icons. (It 
is not possible to show the color versions of the icons in 
this book.) To begin the creation of the monochrome icon, 
choose the ICN# icon, as shown in the figure. 

11. The next step requires that you select the entire icon in 
the large "Fat-Bits" window by choosing the Select All 
command from the Edit menu or by pressing the Com
mand-A key combination. The entire default icon will be 
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§0 Icon Family "Rppl" ID= 128 from Ensemble.n.rsrc copy 
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surrounded by a "marquee." Press the delete key to 
delete the default icon. 

12. Select the open-circle tool from the tool palette, position 
the cross hair cursor at the top left corner of the square 
icon pane, and drag down and to the right until you reach 
the bottom right corner of the pane. When you release the 
mouse button, you should see an unfilled circle (a black 
circle with a white interior) in the pane. If this didn't work 
as you expected, you can delete whatever was drawn and 
by again. 

13. The next step is to select the pencil tool and create the 
block "E" that occupies most of the interior of the icon. 
The final step in completing the icon is to create the 
mask. Click to select the mask, and delete its current 
contents, in the same manner as you deleted the default 
ICN# icon. Select the filled-circle tool, position the cross 
hairs at the top left corner of the large pane, and drag 
down and to the right until a filled circle occupies the 
interior of the pane. The completed result, with both the 
ICN # and the mask, is shown in Figure 16-11. 

14. Figure 16-12 shows the completed versions of the other 
icons. The small monochrome icon (icn#) was created 
from scratch using the same techniques described for 
creating the large icon (ICN#) and its mask. To create the 
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Figure 16-11 
ICN# icon created 

Figure 16-12 
Completed family of 
application icons 

color versions of the icons, we copied the monochrome 
versions and pasted them into the corresponding large or 
small color icons. We changed the black circle to a shade 
of green by selecting the color from the color palette, and 
we used the pencil or bucket tools to change individual 
and a series of connected pixels, respectively. The block 
"E" was created in the same shade of green, and the inte
rior of the circle was filled with a yellow color. The 8-bit 
and 4-bit icons use the same color scheme. 

15. When all of the application icons (or only the mono
chrome versions if you don't have a color monitor) are 
complete, you can dismiss the icon editor by clicking in 



Figure 16-13 
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its close box. The BNDL pane will reappear, but will con
tain the newly created icons for the APPL file type. 

16. The next step is to create custom icons for the data file 
that is read and written by the Ensemble application. 
First, click in the space where the DOC type name is dis
played, and change it to read Nsbf, as shown in Figure 
16-13. Then reopen the icon editor by double-clicking on 
the Finder icons pane, as shown in the figure. 

~D~ BNDL "Bundle" ID = 128 from Ens 

Signature: I Nsbl 

Type Finder I cons 

RPPL 
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17. Creating the icons for the Nsbf file type is carried out in 
much the same way as the steps previously described for 
creating the application icons. In this case, however, we 
don't want to delete the existing icons completely; rather, 
we merely want to delete the "XXXX" that appears in 
each and replace this with a block "E" that fills most of 
the document's outline. We will not have to change the 
mask for any of the new icons, because it already covers 
the complete outline of the document. To delete the X's, 
you can either select the pencil tool and click on each 
black pixel individually or use the marquee tool to select 
the entire group of pixels making up the "XXXX" image 
and then press the delete key. The completed set of docu
ment icons for the Nsbf file type is shown in Figure 16-14. 
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Figure 16-14 
Nsbf icon designs 
complete 

Figure 16-15 
BNDL with all icon 
designs complete 

The color versions of these icons use the same green "E" 
and yellow background as in the application icon design. 
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18. When the Nsbf designs are complete, you can dismiss the 
icon editor by clicking in its close box. The BNDL pane 
will now display both sets of completed icons, as shown in 

Figure 16-15. 

§0§ BNDL "Bundle" ID = 128 from Ens 
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Figure 16-17 
Modified vers 
resource 

Creating Unique Application and File Icons 483 

19. You can now close the BNDL 128 pane and its corre
sponding list of BNDL resources. Next, double-click on 
the vers (version) resource to open it up, as shown in Fig
ure 16-16. 
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20. Modify the fields in the vers resource to match the set
tings in Figure 16-17. We've changed the version number 
to 1.0.0, the release to Final, the short version string 
to 1.0, and the long version string to "Ensemble vl.O © 
1992 Richard Parker". 

~D~ uers ID = 1 from Ensemble. ff .rsrc copy ~ 

Uersion number: LJ . LI . LI 
Release:._! _F_i_n_a_I ____ T__.I Non-release: LJ 
country Code:l._o_o_-_u_sn _____ T__,I 

Short uersion string:! .... 1_._o _________ ~ 

Long uersion string (uisible in Get Info): 

I Ensemble ul .o © 1992 Richard Parker 

21. When the vers resource has been modified as specified, 
you can close its window. The next step is to modify the 
FREF (File Reference) resource. Double-click on the 
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Figure 16-18 
Opening the FREF 
resource 

Figure 16-19 
FREF 129 chosen 

FREF icon, as shown in Figure 16-18. This displays the 
list of FREF resources. 

~D Ensemble. n .rsrc copy E!l~ 
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~~ 
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22. Choose the FREF resource ID #129, whose name is 
"DOC" in the list shown in Figure 16-19. Just click once 
on the list item to select it. 

~D~ FREFs from Ensemble.n.rsrc copy ~BJ~ 

23. After selecting the FREF m #129 entry, pull down the 
Resource menu and choose the Get Resource Info com
mand, as shown in Figure 16-20. 

24. The "resource information" window will show the settings 
for the FREF ID # 129 selection, as shown in Figure 
16-21. Change the Name field from DOC to Nsbf, as 
shown. Close the "info" window, and save the resource file 
by pulling down the File menu and choosing Save. 

25. This completes the modifications to the AppMaker 
Ensemble.1t.rsrc copy file. You can quit ResEdit by pull
ing down the File menu and choosing Quit. 



Figure 16-20 
Choosing the Get 
Resource Info 
command 

Figure 16-21 
NameofFREF 
ID #129 changed to 
Nsbf 
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Resource Window Uiew 
Create New Resource ~K 
Open Resource Editor 
Open Using Template ... 
Open Using HeH Editor 

Reuert This Resource 

Get Resource Info ····... :~:I 

§D::i Info for FREF 129 from Ensemble.TJ.rsrc co ~ 

Type: FREF Size: 7 

ID: 1129 

Name: :N=s=b=f==================== Owner type 

Owner ID: DRUR ~ 
>-----1 WDEF 

Sub ID: MDEF ~ 

Rttributes: 
D System Heap D Locked D Preload 
D Purgeable D Protected D Compressed 

Creating the Stand-alone Ensemble Application 

If the modifications to the Ensemble.n.rsrc copy file were ac
complished without any problems, you can throw the original 
Ensemble.n.rsrc file into the trash and rename the copy with 
the original's name. If you ran into any problems, you can 
throw the copy into the trash, make a new copy of the original 
and redo the steps in the previous section. 

In this section, we are going to create the final stand-alone 
Ensemble application. To accomplish this objective, we per
form the following steps: 
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Figure 16-22 
Changing the Creator 
to Nsbl 

1. Launch THINK C by double-clicking on the Ensemble.n 
project file. 

2. Pull down the Project menu and choose the Bring Up To 
Date command. The compiler might not need to recom
pile the project. This is just a precautionary measure. 

3. Pull down the Project menu and choose the Set Project 
Type command. 

4. In the Project Type dialog, change the Creator code from 
XXXX to Nsbl, as shown in Figure 16-22, and then click 
the OK button. 

® Rpplication 

O Desk Rccessory 

O Deuice Driuer 

O Code Resource 

Partition (K) ~ 

SIZEFlags !3 lseFD I 

(( OK )J 

File Type I RPPL I 
Creator lll'lilmll 

0 Far CODE 

D Far ORTH 

D Separate STRS 

( Cancel 

5. Pull down the Project menu and choose the Build Appli
cation command. 

6. THINK C will display the Build Application dialog shown 
in Figure 16-23. Make sure that the file name for the 
application is Ensemble, and then click Save. THINK C 
will link and then write out the executable application 
file. When this is complete, you can quit the THINK C 
application. 

Completing the Process 

When you quit THINK C, as indicated in the previous section, 
you may find that the application does not yet display its new 
application icon. If this is the case, you can try closing the 



Figure 16-23 
The Build 
Application dialog 

le Ensemble #6 mod'd .... I 
c:i S<W(Hm.:11 .:1 
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~Dianne 

( fj~~c1 

( Desktop ) 

¢ Saue B 
( Cancel ) 

folder in which it resides and then reopening it. If the icon 
still doesn't appear, you'll have to restart your computer and 
rebuild your desktop. 

Rebuilding the desktop is simple. In the Finder, choose the 
Restart command from the Special menu. Then, immedi
ately press and hold down both the Command and Option 
keys. Continue holding down these keys, until the operating 
system displays a dialog that asks you whether you really 
want to rebuild your desktop. Bear in mind that if you do, 
you will lose any comments you have keyed into the Get Info 
boxes for any of your files or applications. If you don't want to 
lose any of your comments, click the Cancel button, which 
will bypass the rebuilding process and restart the computer 
in the normal fashion. If you do choose to rebuild, click the 
OK button and the desktop will be rebuilt. 

If you have multiple hard disks, you can choose to rebuild the 
desktop only on the disk that contains the Ensemble applica
tion. Clicking Cancel in the dialog requesting permission to 
rebuild another disk's desktop will not prevent a dialog for 
each disk from being shown. Click OK for the one that con
tains the Ensemble application. 

When the process is complete, you should see the new icon 
for your Ensemble application. Figure 16-24 shows the com
plete set of files for the Ensemble project, including a file that 
contains the "Amazing Widgets" data file. The files are shown 



488 Chapter 16:>-Completing the Ensemble Application 

Figure 16-24 
A complete set of files 
for the Ensemble 
application 

Iii Ensemble.11 

~ EnsembleMain.c 

~EnsembleApp.c 

~EnsembleData.c 

~ EnsembleDoc.c 

~ FontData.c 
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®Ensemble 
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~ Chartlnfo.h 
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~zChart.h 

li'.J SavedData 

in the "by Small icon" view. The application and its data file 
are shown at the bottom right of the figure. 

If you want to see the application's icon as well as its version 
string, click on the application to select it, and then pull 
down the File menu and choose the Get Info command. A 
picture of the Get Info window is shown in Figure 16-25. 

To change the Type and Creator codes of the existing "Saved
Data" file (so that it will be recognized by the Ensemble appli
cation), you should do the following: 

1. Launch ResEdit, pulling down its File menu and then 
choosing the Get File/Folder Info command. 

2. ResEdit will display a standard Open File dialog box, and 
you can navigate to the folder in which the "SavedData" 
file is stored, select the file, and click Get Info, as shown 
in Figure 16-26. 

3. When the Get Info button is clicked, ResEdit will display 
a large dialog that contains many settings for the file. 
Change the file Type and Creator to Nsbf and Nsbl, 
respectively. Also, make sure that the "Inited" checkbox is 
not checked, as shown in Figure 16-27. 

After these changes have been made to the file, you should 
quit ResEdit, saving the changes to the file, and the Finder 



Figure 16-25 
Contents of the 
Ensemble 
application's Get 
Info window 

Figure 16-26 
ResEdit's standard 
file dialog with Get 
Info selected 
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§0 Ensemble Info 

@ Ensemble 

Kind: application program 
Size: 196K on disk ( 199,803 bytes 

used) 
Uhere: Dianne: Ensemble: Ensemble 

•6 mod'd: 

Created: Thu, Har 12, 1992, 2: 10 PH 
nod if i e_ Thu, Har 12, 1992, 2: 11 PH 
Uers i on : Ensemb I e v 1 . 0 Si 1992 

Richard Parker 
Co••ent_ 

0Locked 

r-... ne•ory ........................................... , 
i Suggested s ... 400 K i 
! Current siz ... ~ K ! 
: ..................................................................... ; 

D CalcWindow.c 
D CalcWindow.h 
D CellData.c 
D CellData.h 
D Chart.c 
D Chart.h 
D Chartlnfo.c 
D Chartlnfo.h 
~Ensemble 

D Use Alias instead of original 

c::i Dianne 

i: j(~( t 

Desktop 

Cancel 

Get Info 

icon for the "SavedData" file should display the new icon. If it 
does not, you will once again have to rebuild the desktop file, 
following the method described at the beginning of this sec-
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Figure 16-27 
ResEdit Info for 
SavedData 

rne:~I ~~~ 
Type: INsbf 

D Locked 

D File Locked D Resources Locked File In Use: No 
D Printer Driuer Multifinder Compatible File Protected: No 

Created: I Fri, Jan 17, 1992 I Time: 16:05:41 PM 

Modified: I Thu, Mar 12, 1992 I Time: I 2:29: 17 PM 

Size: O bytes in resource fork 
3422 bytes in data fork 

Finder Flags: @ 7.H O 6.0.H 

0 Has BNDL 0 No INITs Label:I None .., I 
D Shared D lnited D lnuisible 

D Stationery D Hlias D Use Custom I con 

tion. It is not necessary to change the information for the 
"SavedData" file, unless you want to open the file with the 
Ensemble application. If you don't change the file's Type and 
Creator codes, when you choose the Open command from 
Ensemble's File menu, the file will not be visible in the dia
log. Only files with Creator and Type codes of Nsbl and Nsbf, 
respectively, will be seen. 

If you change the Type and Creator codes of the "SavedData" 
file, you can launch the Ensemble application by double
clicking on the file. 

If you don't change the Type and Creator codes, any subse
quent files written by the application will automatically be as
signed the correct codes and will display the unique icons. 

Summary: Application Development 

The Ensemble application illustrates many of the important 
design and programming considerations that go into the de
velopment of a nontrivial THINK C application. The combina
tion of AppMaker and THINK C is very powerful and offers a 
streamlined approach to object-oriented programming. 

While your own applications will differ from the specifics of 
the Ensemble application, many of the techniques used to 
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create the user interface and to interface with both the gener
ated code and the THINK Class Library will be very similar to 
those shown in this book. 

One conclusion is sure: It is easily possible to create a com
plex application by using these tools in a series of incremen
tal steps, with the ability to verify the functionality of the 
application at each stage of development. This alone should 
give you the desire to begin using AppMaker with THINK C for 
all of your application development projects. 

1. Describe what changes are needed to support additional 
file types in an application. What areas of the code are 
affected if multiple types of input data are supported? 

2. Describe the function of Type and Creator codes. Where is 
the icon for a particular type of data file stored? 

3. Define your own custom icon for the Ensemble applica
tion. Explain under what circumstances each of the 
ICN#, icl4, icl8, ics#, ics4, and ics8 icons are used. 
What would happen if any of these were missing? 
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ZMainWindow 
IZMainWindow, 35, 71 

ZNotebook 
IZNotebook, 73-74 
NewList25, 76 
NewList29, 77 
UpdateMenus, 77 

ZWorksheet 
IZWorksheet, 269-272 
NewList24, 273 
NewList28, 273 
UpdateMenus, 274 

Modifying the Input/Output Code, 289-298 

N 
negLogs Lookup Table, 438 
New AppMaker resource file, 3 
New CWSEntry Class Code, 239-242 
New Generated Code for CChart, 375-379 
New Generated Code for CUser4, 370-371 
New Generated Code for DoChart, 371-373 
New Generated Code for ZChart, 373-375 
New Generated Code in CGraphWindow, 

367-370 
New Generated Code in ZCalcWindow, 170 
New Generated Code in ZEnsembleDoc, 

170,364-365 
New Generated Code in ZGraphWindow, 

36&-367 
NewFile Method, 33 
NewList Method Code, 172-173 
NewUser Method Code, 173 
NewUser4 Method Code, 367 
Notebook Dialog Construction, 59 

0 
Open Document Code, 97 

p 
ParseEntry Method Code, 221-224 
posLogs Lookup Table, 438 
Printing 

Worksheet Pagination, 469 
Printing Ensemble's Windows, 453-470 
Printing the CalcWindow's Pane, 463-470 
Printing the GraphWindow's Pane, 459-463 
Printing the MainWindow's Pane, 453-458 
Processing Events, 30-36 
ProviderChanged Method Code, 182-183, 

R 

217-218,308-311,369-370,377-
379 

Range2Rect Method Code, 447--450 
ReadData Method Code, 187, 294-295 
ReadStyles Method Code, 295-296 
ReadWSEntries Method Code, 190, 29&-

298 
Res Edit 

AETx #135 settings, 165 
AppMakerTMPL's installed, 153 
AppMaker's Resources, 152 
AppMaker's TMPL templates, 150-154 
AThl #137 settings, 160 
AThl #138 settings, 161 
BNDL 

selecting Extended View, 476 
BNDL #128 

all icons defined, 482 
APPL Icon family, 480 
default APPL Icons, 4 79 
deselecting Extended View, 478 
extended view, 477 
extended view modified, 4 77 
File Type Icon, 482 
modified APPL Icon, 480 
opening APPL Icon editor, 478 
opening file type editor, 481 

BNDL #128 default Icons, 476 
BNDL #128 entry, 476 
Bord #134 settings, 157 
Bord #136 settings, 158 
changing FREF # 129 name, 485 
changing the CalcWindow resources, 

150-165 
editing AETx resources, 163-164 
editing AThl resources, 158-160 
editing Bord resources, 155-158 



editing Pane resources, 160-163 
Ensemble's AETx resources, 164 
Ensemble's ATbl resources, 159 
Ensemble's Bord resources, 156 
Ensemble's Pane resources, 162 
Ensemble's Resources, 4 75 
Ensemble's resources, 155 
FREF #129 chosen, 484 
Get Info Dialog, 490 
Get Resource Info command, 485 
Getlnfo, 489 
modified vers resource, 483 
opening AETx resources, 164 
opening ATbl resources, 159 
opening BNDL resources, 4 75 
opening Bord resources, 155 
opening FREF resource, 484 
opening Pane resources, 161 
opening vers resource, 483 
Pane #129 settings, 162 
Pane #130 settings, 163 
Pane #131 settings, 163 
Preferences resources, 153 

Revert Document Code, 104 
RoundDown Function Code, 438-439 
RoundUp Function Code, 439-441 

s 
Save Document As Code, 102 
Save Document Code, 100 
SetChartlnfo Method Code, 444 
Sizing the Font Name List, 114 
Sizing the Font Size List, 115 
Standard OK & Cancel Buttons, 75 

T 
TCLClasses 

CBartender, 26 
CClipboard, 26 
CCluster, 288 
CDecorator, 26 
CDesktop, 26 
CDialogDirector, 272 
CList, 288 
CSwitchboard, 27 

TCLMethods 
FrameToQDR, 179 

THINKC 
Add dialog 

>Index 501 

Add All, 147, 259, 353 
Done, 147, 259, 353 

adding source files, 14, 258-259 
bring project up to date, 15 
Build Application dialog, 487 
compilation, 15, 146-149 
compiling the ChartWindow code, 351-

358 
compiling the EditText code, 63-64 
compiling the Worksheet code, 259-261 
creating the initial project file, 12 
launching from project file, 146 
Make dialog 

Make, 149, 261, 358 
Quick Scan, 149, 260, 357 
Use Disk, 63, 148, 260, 357 

Moving Segments, 352-356 
Project 

Bring Up To Date, 259 
Run, 149 

Project Type dialog 
Changing Creator to Nsbl, 486 

removing source files, 15 
running a project, 17 
running Ensemble, 17, 149-150, 261-

262 
Source 

Add, 353 
Make, 63 

THINK C Pane Sizing Parameters, 151 
Toolbox Calls 

GetPenState, 179 
PenNormal, 1 79 
SetPenState, 179 

u 
UpdateMenus Method Code, 174, 180, 216, 

331,369,375,376,405 
User Draw Method Code, 178 
User IViewTemp Method Code, 178 
User NewUser Method Code, 179 

v 
Vertical Bar Chart Example, 421 
Viewing Tools as Text in AppMaker, 131 



502 >-Index 

w 
Worksheet CCellData Object Declaration, 

286 
Worksheet Cell Entry Structure, 190 
Worksheet Dialog ViewID Definitions, 304 
Worksheet Print Pagination, 469 
Worksheet Window Example, 416 
WriteData Method Code, 192, 290-292 
WriteStyles Method Code, 292-293 
WriteWSEntries Method Code, 195, 293-

294 
WSCellEntry Structure, 190 
WSCellEntry structure 

revised, 294 

x 
X-Y Chart Example, 428 



1M 

SYMANTEC. 

Put Your Learning to Work with THINK C.™ 

Special Offer for Purchasers of 
"Easy Object Programming for the Macintosh" 

Buy THINK C for $169, save 43% off the retail price of $299! 

THINK C is the ultimate development environment for the Macintosh. Featuring an extremely 
fast, ANSI C compiler, an even faster linker, a multi-window text editor and a powerful source
level debugger, THINK C gives you the power to develop any Macintosh application, desk 
accessory, device driver or code resource. 

• Superior Code Generation: THINK C performs 10 to 20 times faster than any other C 
compiler without compromising code quality. The global optimizer further refines code size 
and speed of your executable program. 

• Complete Integration: All the tools - editor, compiler, optimizer, linker, debugger and 
browser are fully integrated for unsurpassed turnaround time from idea to completed 
program. 

• Object Oriented Programming: The THINK™ Class Library provides the building blocks 
for writing your programs, including all the components for Macintosh user interface such 
as windows, menus and controls. 

Order Form - THINK C Special Offer 

D Please send me one THINK C for $169 plus $8 shipping. Please add appropriate tax. 

0 Check 0 Visa/MasterCard/AMEX #: Exp Date: ___ _ 

Name: ____________ ~ 

Street:------------------- Phone: _______ _ 

City:-------------- State: Zip:---------

Country: ___________ _ 

Please mail check or credit payment to: Symantec Fulfillment Center, Attn: THINK C Prentice Hall 
Offer, PO Box 5224, Englewood, CO 80155-5224. Telephone orders: (800) 228-4122, ext. AH02. 
Offer valid until July 30, 1993. Please allow 2-3 weeks for processing your order. 

State Sales Tax: 3%(CO), 4%(GA,MI,NY), 4.5%(V A), 5%(AZ,IN,IA,MA,MD,OH,WI),5.725%(MO), 6%(CT,DC,FL,NJ ,PA), 
6.25%(1L,TX), 6.5%(MN,W A), 7 .25%(CA). Please also add local sales tax in AZ, CA, CO, GA, MN, NY, OH, TX, WA, WI, 
VA, Canada (7% ) 

Offer good in US and Canada only. Units not to be resold. All payments must be in US dollars and checks must be drawn on 
a US bank. 

TIIlNK, TIIlNK C and Symantec are trademarks of Symantec Corporation. ©1992 Symantec Corporation. All rights reserved. 



B•O•W•E•R•S 
Development 

Announcing 
"App Maker for the TCL" 

Get the advantages of AppMaker but pay for only TCL support! 
Buy AppMaker for the TCL for $99, save 2/3 off the AppMaker retail price 
Of $299 (AppMaker for the TCL generates code for Symantec's THINK Class Library). 

Add support for the complete language set for an additional $99. (Call 
for special Educational pricing). Adds support for THINK c and Pascal (procedural and 
object-oriented), MPW C and Pascal, MacApp, and A/UX. Additional add-on products are available 
for FOR1RAN and XVT. 

AppMaker Is a productivity tool: AppMaker generates your user interface code, 
letting you concentrate on coding your application. Users report saving weeks, even 
months of development time. 

AppMaker Is a prototyping tool: point and click to design your user interface. 
Present a user interface at a design meeting in the morning, have changes to the design 
coded by the afternoon. 

AppMaker Is a learning tool: use AppMaker, the THINK Class Library, and Rich 
Parker's book to learn THINK C or Object-Oriented Programming. 

Order Form - AppMaker for the TCL 

D Please send me AppMaker for the TCL for $99 plus $5 shipping. (Massachusetts residents please 
add $4.95 sales tax.) 

D Please send me support for the complete language set for $198 plus $5 shipping. (Massachusetts 
residents please add $9.90 sales tax.) (Call for Educational pricing). 

VISA/MasterCard#: _____________ Exp. Date~: ______ _ 

Name on Card: -----------Company: _________ _ 

Street:-------------- Phone:~----------

City: __________ State: __ Zip: ____ Country:. ____ _ 

Signature:--------------------------

Send Check or Money Order to: Bowers Development Corp., 97 Lowell Road, Concord, MA 
01742. Telephone Orders: 508-369-8175 or FAX orders: 369-8224. 

Offer good thru June 30, 1993. 
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Apple Macintosh 3-1/2" 800Kb disk 
By Richard 0. Parker Prentice-Hall 

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDmONS BEFORE OPENING TIDS 
DISKETTE PACKAGE. OPENING THIS DISKETTE PACKAGE INDICATES YOUR ACCEPTANCE OF THESE 
TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, YOU SHOULD PROMPTLY RETURN THE 
PACKAGE UNOPENED, AND YOUR MONEY WILL BE REFUNDED. 

IT IS A VIOLATION OF COPYRIGHT LAW TO MAKE A COPY OF THE ACCOMPANYING SOFTWARE EXCEPT 
FOR BACKUP PURPOSES TO GUARD AGAINST ACCIDENTAL LOSS OR DAMAGE. 

Prentice-Hall, Inc. provides this program and licenses its 
use. You assume responsibility for the selection of the 
program to achieve your intended results, and for the in
stallation, use, and results obtained from the program. This 
license extends only to use of the program in the United 
States or countries in which the program is marketed by 
duly authorized distributors. 

LICENSE 

You may: 

a. use the program; 

b. modify the program and/or merge it into another pro-
gram in support of your use of the program. 

LIMITED WARRANTY 

THE PROGRAM IS PROVIDED "AS IS" WITHOUT 
WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABIL
ITY AND FITNESS FOR A PARTICULAR PURPOSE. 
THE ENTIRE RISK TO THE QUALITY AND PERFOR
MANCE OF THE PROGRAM IS WITH YOU. SHOULD 
THE PROGRAM PROVE DEFECTIVE, YOU (AND NOT 
PRENTICE-HALL, INC. OR ANY AUTHORIZED DIS
TRIBUTOR) ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR, OR CORRECTION. 

SOME STATES DO NOT ALLOW THE EXCLUSION 
OF IMPLIED WARRANTIES, SO THE ABOVE EX
CLUSION MAY NOT APPLY TO YOU. THIS WAR
RANTY GIVES YOU SPECIFIC LEGAL RIGHTS AND 
YOU MAY ALSO HAVE OTHER RIGHTS THAT VARY 
FROM STATE TO STATE. 

Prentice-Hall, Inc. does not warrant that the functions con
tained in the program will meet your requirements or that 
the operation of the. program will be uninterrupted or error 
free. 

However, Prentice-Hall, Inc., warrants the diskette(s) on 
which the program is furnished to be free from defects in 
materials and workmanship under normal use for a period 
of ninety (90) days from the date of delivery to you as 
evidenced by a copy of your receipt. 

LIMITATIONS OF REMEDIES 

Prentice-Hall's entire liability and your exclusive remedy 
shall be: 

I. the replacement of any diskette not meeting Prentice
Hall 's "Limited Warranty" and that is returned to 
Prentice-Hall with a copy of your purchase order, or 

2. if Prentice-Hall is unable to deliver a replacement 

diskette or cassette that is free of defects in materi
als or workmanship, you may terminate this Agreement · 
by returning the program, and your money will be re
funded. 

IN NO EVENT WILL PRENTICE-HALL BE LIABLE TO 
YOU FOR ANY DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST SAVINGS OR OTHER INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
THE USE OR INABILITY TO USE SUCH PROGRAM 
EVEN IF PRENTICE-HALL OR AN AUTHORIZED DIS
TRIBUTOR HAS BEEN ADVISED OF THE POSSIBIL
ITY OF SUCH DAMAGf.:S, OR FOR ANY CLAIM BY 
AN OTHER PARTY. 

SOME STATES DO NOT ALLOW THE LIMITATION 
OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIM
ITATION OR EXCLUSION MAY NOT APPLY TO YOU. 

GENERAL 

You may not sublicense, assign, or transfer the license or the 
program except as expressly provided in this Agreement. 
Any attempt otherwise to sublicense, assign, or transfer 
any of the rights, duties, or obligations hereunder is void. 

This Agreement will be governed by the laws of the State 
of New York. 

Should you have any question concerning this Agreement, 
you may contact Prentice-Hall, Inc., by writing to: 

Prentice Hall 
College Division 
Englewood Cliffs, N.J. 07632 

Should you have any questions concerning technical sup
port you may write to: 

Richard 0. Parker 
1004 Magnolia Avenue 
Modesto, CA 95350 

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS 
AGREEMENT, UNDERSTAND IT, AND AGREE TO 
BE BOUND BY ITS TERMS AND CONDmONS. YOU 
FURTHER AGREE THAT IT IS THE COMPLETE AND 
EXCLUSIVE STATEMENT OF THE AGREEMENT BE
TWEEN US THAT SUPERCEDES ANY PROPOSAL OR 
PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY 
OTHER COMMUNICATIONS BETWEEN US RELAT
ING TO THE SUBJECT MATTER OF TIDS AGREE
MENT. 

ISBN 0-13-092966-2 
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EasY- Object 
Programming_ 

for the Macintosh Using 
AppMaker"and THINK C"' 

Richard 0. Parker 
It is an excellent book that builds from beginning to end a nontrivial application 
in an evolutionary manner, showing all the steps along the way. 
-Spec Bowers, Bowers Development 

The author presents a new approach that takes much of the drudgery out of 
object-oriented programming on the Mac. 
-Kurt Schmucker, Apple-Advanced Technology Group 

This in-depth exploration of object-oriented programming in C shows readers 
how a complex application can be easily created in a step-by-step manner 
using state-of-the-art Macintosh tools. Ideal for professionals familiar with the 
basic concepts of C programming, the THINK Class Library, and the fundamen
tal concepts underlying 0-0 programming. This tour-de-force of application 
development uses the following object-oriented techniques: 

• Describes the evolution of a complete, multipurpose, object-oriented 
application at various stages of object-oriented design and development. 

• Provides data flow diagrams that illustrate the dynamic structure of the 
application at various stages of object-oriented design and development. 

• Presents a great number of features in the THINK C Class Library with 
detailed descriptions and diagrams that illustrate the Library's structure and 
features. 

• Contains a detailed examination of the AppMaker code and features tutorials 
on how to use AppMaker to produce the various user interface elements for 
the window dialog boxes as well as the menus used in the application 

• Includes a Special Offer on AppMaker and THINK Cl 
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